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What's New

Typesetting Documents is a response to the many users who have requested more infor-
mation about LATEX typesetting in Scienti�c WorkPlace (SWP) and Scienti�c Word
(SW). This revised edition contains expanded information about typesetting in Versions
3.5, 4, and 5 of SWP and SW. It presents many new techniques for achieving special
typesetting effects and includes a new chapter containing extensive troubleshooting in-
formation.

About This Manual

Our purpose is threefold:
� to answer common questions and solve common problems related to typesetting in
SWP and SW;

� to help you choose document shells appropriately;
� to explain when and how you can tailor typesetting speci�cations and document
shells from within the program so that you can create documents that more precisely
meet your typesetting needs.
To these ends, we begin the manual with what may be the only thing you need to

read: the answers to the questions users ask most frequently about working with LATEX
typesetting in SWP and SW. Chapter 1 �Tailoring Typesetting to Your Needs� provides
tips on modifying page layout, document elements, tables and �gures, and mathematics
in SWP and SW documents.
If you need more basic information, we suggest you start with Chapter 2 �Working

with Typesetting Speci�cations and Document Shells.� The chapter brie�y discusses the
structure of LATEX documents. It explains how typesetting speci�cations work and ad-
dresses the most basic and perhaps most important document development task: how to
choose a document shell�or template�that meets the typesetting requirements of you
and your publisher. The chapter discusses how and to what extent you can tailor a doc-
ument using available document class and LATEX package options and, where necessary,
TEX commands. Chapter 2 also explains how to create SWP and SW documents using
typesetting speci�cations obtained from an outside source and how to work with LATEX
documents not created with SWP or SW.
The LATEX packages provided with the program are the focus of Chapter 3 �Using

LATEX Packages.� The discussion explains how the packages extend TEX typesetting ca-
pabilities and notes how each package interacts with and, occasionally, con�icts with
other typesetting elements.
Chapter 4 "Troubleshooting" offers information to help you isolate and resolve com-

mon errors generated by SWP and SW and by LATEX and PDFLATEX. The information
is related to problems that can occur at various stages of document preparation.
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Accompanying this manual is another volume, A Gallery of Document Shells for
Scienti�c WorkPlace and Scienti�c Word, available on your program CD as a PDF �le.
A Gallery of Document Shells explains the key characteristics of the shells provided with
the program. It contains brief discussions and illustrations of typeset documents created
with each shell except those created with Scienti�c Notebook, which were intended
for direct printing instead of typesetting.
Please note that this manual doesn't apply to Scienti�c Notebook or Scienti�c

Viewer, which don't support typesetting. The manual excludes any detailed discussion
of the processes involved in producing a document without typesetting. Further, it ex-
cludes an in-depth discussion of working with document shells created with the Style
Editor. Extensive Style Editor documentation is available online (see Online Help on
page xv).
This manual assumes that you have successfully installed SWP or SW and that you

have a working knowledge of the program. Although certain procedures are explained
here, you will �nd fuller explanations in these accompanying manuals:
� Getting Started with Scienti�c WorkPlace, Scienti�c Word, and Scienti�c Notebook
� Creating Documents with Scienti�c WorkPlace and Scienti�c Word
� Doing Mathematics with Scienti�c WorkPlace and Scienti�c Notebook
The instructions in this manual occasionally differ for different versions of SWP

and SW. When several sets of instructions are provided, be sure to follow the set of
instructions corresponding to your version of the product.
This manual also assumes you're familiar with basic TEX, the extraordinary math-

ematics typesetting program and language designed by Donald Knuth, and with LATEX,
the set of macros designed by Leslie Lamport to enhance TEXwith document-structuring
features such as tables of contents, chapters and sections, lists, and bibliographies.
The Windows implementation of TEX and LATEX that is supplied with the program is
TrueTEX, a product of TrueTEX Software. The TrueTEX software distributed with Ver-
sion 5 of SWP and SW includes PDFTEX support.
The manual often includes detailed information about TEX and LATEX, document

classes, LATEX packages, typesetting options, and document shells. While a good un-
derstanding of TEX and LATEX will help you better understand how these often complex
elements interact, a thorough discussion of TEX and LATEX is beyond our scope here. If
you need additional information, we suggest you refer to these excellent sources:
� The TEXbook by Donald E. Knuth.
� LATEX, A Document Preparation System by Leslie Lamport.
� The LATEX Companion byMichel Goossens, FrankMittelbach, and Alexander Samarin.
� A Guide to LATEX: Document Preparation for Beginners and Advanced Users by
Helmut Kopka and Patrick W. Daly.

� The TEX Users Group website at http://www.tug.org.
� The Usenet newsgroup news:comp.text.tex.
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Typesetting Basics
With Version 3.0 and later of SWP and SW, you can produce your documents either
with or without LATEX typesetting. Our focus here is on typesetting. Even if you have a
basic understanding of the program, it's important to review how typesetting works and
why the appearance of your printed document differs so noticeably when you typeset
compared to when you don't. You can �nd basic information in more detail in the online
Help and in Creating Documents with Scienti�c WorkPlace and Scienti�c Word.
With Version 5.0, we introduced an important new feature: creating typeset Portable

Document Format (PDF) �les with PDFTEX, which provides all the beauty and features
of LATEX typesetting in PDF form. Now you can use SWP and SW to typeset �les for
viewing across platforms with PDF viewers.
In our documentation, we refer to the processes that you use to typeset your doc-

uments with LATEX as typeset compile, typeset preview, and typeset print. We refer to
the processes that you use to typeset your documents with PDF as typeset compile PDF,
typeset preview PDF, and typeset print PDF. All these processes are available only as
commands on the Typeset menu or as buttons on the Typeset toolbar. In general, we
use the term typesetting to refer to either set of processes. Where necessary, we distin-
guish between them. We refer to the processes that don't involve typesetting as preview
and print. These commands are available on the File menu and the Standard toolbar.

Producing Documents with Typesetting
When you process your document with LATEX, the program compiles it with LATEX to
create a device independent�or DVI��le, which is a �nely typeset version of your
document. The DVI �le may contain automatically generated document elements such
as cross-references, tables of contents, and numbers for equations. The program then
sends the DVI �le to the typeset previewer or to the printer.
Typesetting with PDFTEX in Version 5 is just like typesetting with LATEX, except that

you produce a PDF �le. Like the DVI �le, the PDF �le is a �nely typeset version of your
document. It contains the same automatically generated document elements and, if you
have added the hyperref package to your document, live hypertext links, bookmarks,
and thumbnails. The PDF �le also contains embedded fonts and, if you have speci�ed
PDF output settings, graphics converted to formats appropriate for PDF viewers. The
program sends the PDF �le to the screen or the printer using your PDF software.
The appearance of the PDF and DVI �les is almost identical. However, a typeset

document has a noticeably different appearance from what you see as you work in the
document window or when you produce your document without typesetting.
The typeset appearance of your document depends on typesetting speci�cations from

three different sources, all set initially by the shell you use to create your document:
� The typesetting speci�cations, a collection of TEX and LATEX instructions related to
typesetting document elements, including those represented by the tags on the Tag
toolbar in the program window.

� Any LATEX packages or options speci�ed for the document or the shell.
� Any additional LATEX commands that appear in the document preamble or in the body
of the document.

These speci�cations don't affect the appearance of your document if you don't typeset.
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The chapters that follow explain how to modify some of these speci�cations from
within SWP and SW. However, we advise against attempts at extensive modi�cation
of the speci�cations if you aren't extremely familiar with TEX and LATEX.

I To typeset a document
1. If you have Version 5, select an output option for typesetting:

a. From the Typeset menu, choose Output Choice.
b. Select the option you want. DVI Output is the default.
c. If you're creating a PDF �le,
i Check Convert .tex link targets to .pdf to convert any .tex extensions in hy-
pertext link addresses to .pdf extensions.
ii Choose PDF Graphics Settings to specify the �le type and location of graphics
and plots exported during the typesetting process, and then choose OK.

d. Choose OK.

2. On the Typeset toolbar, click the button for the typesetting command you want
or, from the Typeset menu, choose the command (commands for typesetting with
PDFLATEX appear only in Version 5):

Menu Command Button

Typeset Compile

Typeset Preview

Typeset Print

Menu Command Button

Typeset Compile PDF

Typeset Preview PDF

Typeset Print PDF

3. If you choose a Compile command, select the options you want and choose OK.

Note that the Compile dialog box indicates the name and location of the typeset �le
to be created.

4. If you choose a Preview or Print command, set the number of LATEX passes.

The program compiles your document if necessary, saving a transcript of the process
in a .log �le. When the compilation is complete, the program either displays your
typeset document in the TrueTEX Previewer or prints it on the printer you indicate.
If you chose to create a typeset PDF �le, the program opens your PDF viewer to
display the typeset �le or print your document.

You can also print your document from the TrueTEX Previewer or your PDF viewer.

Producing Documents without Typesetting

When you produce your document without typesetting it, the program sends the docu-
ment directly to a non-LATEX previewer or to the printer using many of the same routines
with which it displays the document in the document window. Consequently, what you
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see in the preview window or in print is similar to what you see as you work on your
document in the document window. (The program doesn't re�ect the page setup speci-
�cations or the print options in the document window.)
When you don't typeset, the appearance of your document depends on three sets of

speci�cations; like the typesetting speci�cations, they are all set initially by the docu-
ment shell:
1. The style, a collection of the speci�cations for the appearance of each tag in the
document window and in print.

2. The page setup speci�cations.

3. The print options.

The online Help and Creating Documents with Scienti�c WorkPlace and Scienti�c Word
provide information about modifying these speci�cations and about previewing and
printing without typesetting. These three sets of speci�cations don't affect the type-
set appearance of your document in any way, although the style determines how the
document appears on the screen when you're working on it.

Understanding the Differences in the Final Product
Each time you produce your document in SWP or SW, you can choose whether or not
to typeset it. The results differ noticeably.
If you typeset, the program compiles the document and generates any speci�ed au-

tomatic elements such as front matter items (tables of contents or lists of �gures and
tables), cross-references, footnotes and margin notes, numbered equations, indexes, and
bibliographies. LATEX and PDFLATEX also provide hyphenation, kerning, ligatures, so-
phisticated paragraph and line breaking, and other automatic formatting features.
If you don't typeset, the program produces the document using many of the same

routines it uses to display the document in the document window. No document elements
are automatically generated, and the printed results are similar to what you see as you
work on the document.

Conventions
Understanding the notation and the terms used in our documentation will help you un-
derstand the instructions. We assume you're familiar with basic Windows procedures
and terminology. If necessary, review your Windows documentation. In our manuals,
we use the notation and terms listed below.

General Notation

� Text like this indicates the name of a menu, program command, or dialog box.
� TEXT LIKE THIS indicates the name of a keyboard key.
� Text like this indicates information you should type exactly as it is shown.
� Text like this is a placeholder for a information that you must supply.
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� Text like this indicates the name of a �le or directory, a LATEX command, or
other code.

� Text like this indicates a term that has special meaning in the program.
� Typeset your �le means to process your document with LATEX or, if you have Version
5, PDFLATEX.

� Choose means to designate a command for the program to carry out. As with all
Windows applications, you can choose a command with the keyboard or the mouse.
Commands may be listed on a menu or shown on a button in a dialog box. For
example, the instruction �From the File menu, choose Open� means you should
�rst choose the File menu and then from that menu, choose the Open command.

� Select means to highlight the part of the document that you want your next action to
affect or to highlight a speci�c option in a dialog box or list.

� Check means to turn on an option in a dialog box.

Keyboard Conventions
We also use standard Windows conventions to give keyboard instructions.
� The names of keys in the instructions match the names shown on most keyboards.
They appear like this: ENTER, F4, SHIFT.

� A plus sign (+) between the names of two keys indicates that you must press the �rst
key and hold it down while you press the second key. For example, CTRL+G means
that you press and hold down the CTRL key, press G, and then release both keys.

� The notation CTRL+word means that you must hold down the CTRL key, type the
word that appears in bold type after the +, then release the CTRL key. Note that if a
letter appears capitalized in the instructions, you should type that letter as a capital.

Mouse Conventions
The program uses these mouse pointers:

Pointer Indication

The pointer is over text

The pointer is over mathematics

A selection is being dragged

A selection is being copied

A selection is being copied or dragged with the right mouse button

A graphic is being panned
A graphic is being resized
The pointer is over a hypertext link

Additionally, the program displays a pointer for the computational engine when a com-
putation is in progress.
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In this manual we give mouse instructions using standardWindows conventions. The
instructions assume you have not changed the mouse button defaults.
� Point means to move the mouse pointer to a speci�c position.
� Click means to position the mouse pointer, then press and immediately release the
left or right mouse button without moving the mouse.

� Double-click means to position the mouse pointer, then click the left mouse button
twice in rapid succession without moving the mouse.

� Drag means to position the mouse pointer, press the left mouse button and hold it
down while you move the mouse to a new location, then release the button.
As in most Windows applications, you can use the right mouse button to display a

Context menu for the current selection or the item under the mouse pointer. Pressing

the Application key also displays the menu.

Getting Help
In addition to the information available in the manuals supplied with the program, you
can get information about SWP and SW from the online Help system, the library of
reference materials about mathematics and science, and, if you have an Internet connec-
tion, the MacKichan Software website. If these resources don't contain the information
you need, technical support is available. We also regularly make additional information
available on our unmoderated discussion forum and email list. You can �nd an errata
sheet for this book at this URL: http://www.mackichan.com/techtalk/errata.html.

Online Help
Without leaving SWP and SW, you can search the online Help system to �nd infor-
mation about all program commands and operations, including those related to numeric,
symbolic, and graphic computations. Also, you can �nd additional material regard-
ing TEX, LATEX, LATEX packages, and other related topics. In addition, two associated
programs�the Style Editor and the Document Manager�have their own online Help
systems.

I To get help from the Help menu
Choose To
Contents See a list of online information
Search... Find a Help topic
Index Access the online index to Computing Techniques,

General Information, or the Reference Library
MacKichan Software Open the link to the MacKichan Software, Inc.
Website website

Register... Register your software and obtain a license
System Features... See a list of available features; change the serial

number for your installation
License Information Obtain information about registering your system
About... Obtain information about your installation

I To go directly to the Help Contents, press F1.



xvi What's New

Supplemental Technical Documents
We urge you to explore the supplemental technical documents supplied with the pro-
gram. You can use SWP or SW to open, view, and print the documents. In particular,
we urge you to read the following documents:
� In the Helpngeneral directory, the document techrefv5.tex, which con-
tains technical information on the features in Version 5.

� In the Play directory, the sample documents, which demonstrate the use of compu-
tation in SWP.

� In the SWSamples directory,
� The sample documents, which illustrate the use of various LATEX packages in
SWP and SW.

� The �le OptionsPackagesLaTeX.tex, which describes and contains links
to information about the options, packages, and other TEX-related items provided
with the program.

� The �le BibTeXBibliographyStyles.tex, which lists and describes the
BIBTEX style (.bst) �les installed with the program.

Obtaining Technical Support
If you can't �nd the answer to your questions in the manuals or the online Help, you can
obtain technical support from our website at

http://www.mackichan.com/techtalk/knowledgebase.html

or from our Web-based Technical Support forum at

http://www.mackichan.com/techtalk/UserForums.htm

You can also contact our Technical Support staff by email, telephone, or fax. We urge
you to submit questions by email whenever possible in case our technical staff needs to
obtain your �le to diagnose and solve the problem.
When you contact us by email or fax, please provide complete information about

the problem you're trying to solve. We must be able to reproduce the problem exactly
from your instructions. When you contact us by telephone, you should be sitting at your
computer with the program running.
Please provide the following information any time you contact Technical Support:

� The MacKichan Software product you have installed.
� The version and build number of your installation (see Help / About...).
� The serial number of your installation (see Help / System Features...).
� The version of the Windows system you're using.
� The type of hardware you're using, including printer and network hardware.
� A description of what happened and what you were doing when the problem oc-
curred.

� The exact wording of any messages that appeared on your computer screen.
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I To contact Technical Support
� Contact Technical Support by email, fax, or telephone between 8 AM and 5 PM Pa-
ci�c Time:

Internet email address: support@mackichan.com
Fax number: 360-394-6039

Telephone number: 360-394-6033
Toll-free telephone: 877-SCI-WORD (877-724-9673)

Additional Information
You can learn more about SWP and SW on our website, which we update regularly to
provide the latest technical information about the program. The site also houses links to
other TEX and LATEX resources. We maintain an unmoderated discussion forum and an
unmoderated email list so our users can share information, discuss common problems,
and contribute technical tips and solutions. You can link to these valuable resources
from our home page at http://www.mackichan.com.





1 Tailoring Typesetting to Your
Needs

The typeset appearance of your SWP or SW document depends on typesetting spec-
i�cations, all set initially by the shell you use to create the document. Starting a new
document with a carefully chosen shell is important; it minimizes the typesetting modi�-
cations you may have to make. If the document shell adheres closely to your typesetting
requirements, you may then be able to create the perfect typeset appearance for your
document just by making one or two small changes from within the program. Once
you've tailored your document to your typesetting requirements, you can export it as a
shell so that you can use it repeatedly. See Chapter 2 �Working with Typesetting Speci-
�cations and Document Shells� for a more detailed explanation of basic LATEX document
structure and for information about choosing an appropriate shell and creating your own
shells.
The information in this chapter answers the typesetting questions we receive most

often from users. The questions involve page layout, front and back matter, tables and
graphics, and mathematics. The table near the end of the chapter refers you to additional
information about other typesetting tasks. If you have a basic knowledge of TEX and
LATEX and are familiar with SWP or SW, this chapter may be all you need to adapt an
existing document shell to your requirements.
You can �nd more information in the online Help system, in links from the �le

OptionsPackagesLaTeX.tex in the SWSamples directory of your installation,
and in the TEX and LATEX references noted on page x.

Note The instructions for the basic processes to which we refer in this chapter appear
in Chapter 2.

Cautions

The techniques we suggest for modifying the typeset appearance of your document in-
volve working from within SWP or SW rather than using an ASCII editor to work
directly with the TEX and LATEX code. The techniques involve modifying the docu-
ment class options (see page 67), adding and modifying LATEX packages (see page 75),
and inserting TEX commands in your document (see page 80). The techniques should
work successfully for typesetting both device independent (DVI) �les and, in Version 5,
Portable Document Format (PDF) �les.
The suggested techniques are general. They work with many, but not all, document

shells. The techniques are most likely to be successful with document shells based on
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standard LATEX typesetting speci�cations. They are less likely to be successful if you
have added an unusual combination of packages to your document, because they may
cause LATEX con�icts. If your document uses a Style Editor shell, you may �nd that
using the Style Editor to make the changes you need is easier and more successful than
working from within the document. The suggestions in this chapter may not work with
Style Editor documents.
We are unable to predict the effect of these modi�cations on documents created with

LATEX typesetting speci�cations that you have added to the program. In other words,
we can't guarantee results. Please note that we do not support documents created with
typesetting speci�cations not provided with our program. Note too that some LATEX
packages are distributed with the program only as a convenience or for compatibility
and may not necessarily work with SWP or SW or with other packages.
Some of the suggestions involve bypassing the way LATEX naturally works, an ap-

proach that can sometimes have unpredictable results. Other suggestions involve plac-
ing LATEX code in the document preamble and otherwise sending commands directly to
LATEX. Any time you add TEX �elds or raw TEX code to your document, you run the risk
of damaging it.

Important Even seemingly small coding errors can have large and unwelcome ef-
fects. Errors may prevent compilation, or they may damage or truncate your document
irrevocably. Save a copy of your document before you attempt any of the modi�cations
suggested here.

Most importantly, we urge you not to attempt extensive modi�cations of the typeset-
ting speci�cations unless you're very familiar with TEX and LATEX.

Tailoring the Page Layout

Making small changes to the page layout may yield the perfect typeset appearance for
your document. Often, the most straightforward way to affect the page layout is by
modifying one or more of the class options in effect for your document, and most of the
techniques presented in this section take advantage of that capability. The class options
control many fundamental aspects of page layout and document design, such as paper
size, body text point size, title and author information, page orientation, or columns. See
LATEX Class Options on page 67 for more information.

Remember Save a copy of your document before you attempt to modify it.

Changing the Margins

Your document has two sets of margins, one for producing your document without type-
setting and one for producing your document with typesetting. If you don't intend to
typeset your document, you can change the margins using the page setup speci�cations.
Access this set of speci�cations with the Page Setup command on the File menu. Re-
member that the changes you make to the margins using the page setup speci�cations
have no effect on the typeset appearance of your document.
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Margins for typesetting are generally set in the document class speci�cations (.cls)
�le; see page 65. The .cls �le usually contains different margin defaults for each
paper size, so changing the paper size default automatically changes the margin defaults.
The LATEX article class de�nes margins of about 1 78 inches on all sides when 8

1
2x11

inch paper is speci�ed, but those margins change subtly when A4 paper is speci�ed.
Regardless of the paper size, you can modify the margin settings for most but not all
shells by adding the geometry package (see page 130). See Changing the Headers and
Footers on page 5 for additional information.

Fitting More Text on a Page
Without any other modi�cations, adding the geometry package to a document enlarges
the margins. This happens because LATEX gives precedence to the geometry package
margin settings, which usually differ from those of the document class. When you add
geometry to your standard LATEX article class document, the package speci�es a 1 516 -
inch margin on the right, left, and top and a 2-inch margin on the bottom.
If you need to �t a little more text on a single page of your document, place the

Enlarge Page (TeX Field) fragment near the top of the page and place a page break
where you want the page to end. When you typeset your document, LATEX places all the
text before the page break on the page.

Changing the Margin Settings
You can use the default margins for the geometry package or specify the margins you
want by adding a command to the preamble of your document.

I To change the margins of a document
1. Add the geometry package to your document.

2. From the Typeset menu, choose Preamble.

3. Click the mouse in the entry area.

4. On a new line at the end of the entries, type

ngeometry{left=win,right=xin,top=yin,bottom=zin}
where w and x are the measurements for the left and right margins, y is the measure-
ment for the top margin, and z is the measurement for the bottom margin. The syntax
shown in this instruction uses inches as the measurement unit, but you can use any
of the usual TEX measurement units in the command:

Unit Value
sp Scaled point (65536 sp = 1 pt)
pt Point ( 1

72:27 in)
bp Big point ( 172 in)
dd Didôt point (0.376 mm)
mm Millimeter
pc Pica (12 pt)
cc Cicero (12 dd)
cm Centimeter
in Inch

5. Choose OK.
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Changing the Line Spacing
SWP and SW support multiple-line spacing in typeset documents. The typesetting
speci�cations for each document shell initially determine the line spacing of documents
created with the shell. Some speci�cations have class options that change the line spac-
ing, but others don't. Although line-spacing speci�cations are sometimes presented as
draft or manuscript (double spacing) or as �nal or camera-ready (single spacing), print
quality options don't necessarily imply line-spacing changes. See LATEX Class Options
on page 69 for more information about examining and changing class options.
When class options for line spacing aren't available, you can use the LATEX setspace

package (see page 161) to change line spacing. With the package, you can select single,
one-and-one-half, or double spacing for the document as a whole or for parts of the
document. If you �nd a shell that otherwise meets your typesetting requirements, add
the setspace package and then change the spacing as needed.
Some shells and some documents created with older versions of SWP and SW may

require the doublespace package, now superseded by setspace. The doublespace
package is provided with the program only for compatibility. We recommend you use
the setspace package instead. Note that if your document was created with a Style
Editor shell, these packages probably won't work. Use the Style Editor to make any
necessary line spacing changes.

I To change the line spacing of the entire document
1. Add the setspace package to your document.

2. If you're using Version 4.0 or later,

a. On the Typeset toolbar, click the Options and Packages button or, from the
Typeset menu, choose Options and Packages.

b. Choose the Package Options tab.
c. From the Packages in Use box, select setspace and chooseModify.
d. In the Category box, select Line Spacing.
e. In the Options box, select the spacing you want.
f. Choose OK twice to return to your document.

or

If you're using an earlier version of the program,

a. From the Typeset menu, choose Preamble and click the mouse in the entry area.
b. On a new line at the end of the entries, type the command that corresponds to the
spacing you want: nsinglespacing, nonehalfspacing, or ndoublespacing.

c. Choose OK.

I To change the line spacing for a portion of a document
1. Add the setspace package to your document.

2. Place the insertion point at the start of the �rst paragraph whose spacing you want to
change.
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3. Enter a TEX �eld.

4. In the entry area,
� Type nsinglespacing, nonehalfspacing, or ndoublespacing, depending on the
spacing you want.

or
� Type nsetstretch{x} where x is a number indicating the spacing you want.
For example, the command nsetstretch{3} produces triple spacing.

5. Choose OK.

6. Place the insertion point where you want to return to the original spacing.

7. Repeat steps 3�5.

Changing the Font Size of Body Text

Most document classes have a default setting for the font size used for body text. You
can change the setting by modifying the document class options. Note that the body text
font size is used as the basis for determining many other typesetting speci�cations, such
as script size. Note also that some typesetting speci�cations override the font size class
options.

I To change the body text font size with the class options

1. On the Typeset toolbar, click the Options and Packages button or, from the
Typeset menu, choose Options and Packages.

2. Choose the Class Options tab and chooseModify.

3. In the Category box, select Body text point size.

4. In the Options box, select the font size you want.

5. Choose OK.

6. Choose OK to return to your document.

Changing the Headers and Footers

Most typesetting speci�cations automatically generate page headers and footers using
information from various LATEX counters to generate header and footer content, such as
page numbers or chapter and section headings. You may need to modify the content or
format of the headers and footers or even suppress it on certain pages. Two packages�
fancyhdr and geometry (see pages 125 and 130)�can simplify many of these changes.
TEX commands accomplish the rest.
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Specifying Header and Footer Information
LATEX automatically creates headers and footers from the information in the typesetting
speci�cations and the section headings in your document. You can override the auto-
matic headers and footers by adding the fancyhdr package and making some changes
to the preamble or to the body of your document. Occasionally, the typesetting speci-
�cations override the page style for certain pages, especially exceptional pages such as
the title page or the �rst page of a chapter or section. Instead of specifying the head-
ers and footers for the entire document, you can specify them for a particular page by
placing TEX commands in the body of the document instead of the preamble. Also, you
may want to suppress header and footer information on certain pages; see page 7 for
instructions.
The instructions below explain how to specify a header that has the title of the work

on the right and a footer that has the author's name on the left and the page number on
the right. Use the commands in step 4 as models for creating the headers and footers
you want.

I To specify header and footer information for the entire document
1. Add the fancyhdr package to your document.

2. From the Typeset menu, choose Preamble.

3. Click the mouse in the entry area.

4. At the end of the entry area, add new lines to specify the content of the right, center,
and left areas of the header and footer (any information that follows a % is a comment
and is not necessary):

npagestyle{fancy}
nlhead{}%Leave the left of the header empty
nchead{}%Leave the center of the header empty
nrhead{Title of This Document} %Display this text on the right of the header
nlfoot{By Author}%Display this text on the left of the footer
ncfoot{}%Leave the center of the footer empty
nrfoot{Page:n nthepage}%Print the page number in the right footer
nrenewcommand{nheadrulewidth}{0pt}%Do not print a rule below the header
nrenewcommand{nfootrulewidth}{0pt}%Do not print a rule above the footer

5. Choose OK.

I To specify header and footer information for selected pages
1. Add the fancyhdr package to your document.

2. Place the insertion point on the page for which you want to specify header or footer
information.
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3. Enter an encapsulated TEX �eld containing the lines that follow to specify the content
of the right, center, and left areas of the header and footer.

Modify the commands as necessary (any information that follows a % is a comment
and is not necessary):

nthispagestyle{fancy}
nlhead{}%Leave the left of the header empty
nchead{}%Leave the center of the header empty
nrhead{Title of This Document} %Display this text on the right of the header
nlfoot{By Author}%Display this text on the left of the footer
ncfoot{}%Leave the center of the footer empty
nrfoot{Page:n nthepage}%Print the page number in the right footer
nrenewcommand{nheadrulewidth}{0pt}%Do not print a rule below the header
nrenewcommand{nfootrulewidth}{0pt}%Do not print a rule above the footer

4. Choose OK.

Suppressing Headers and Footers
On individual pages of your document, you can suppress the header and footer or you
can take a more extreme approach and entirely eliminate the space allotted for them, as
described on page 8. See page 70 for illustrations of standard LATEX page layouts.

I To suppress the header and footer on an individual page
1. Place the insertion point on the page for which you want no header or footer.

If the page has a section heading, place the insertion point after the heading.

2. Enter an encapsulated TEX �eld.

3. In the entry area, type nthispagestyle{empty} and choose OK.

When you typeset preview your document, you may �nd that the typesetting spec-
i�cations for the �rst page of a part or chapter have been de�ned differently from the
rest of the document and have not been affected by your change. In this case, you must
suppress the header and footer information on the individual pages.
If you create special headers and footers with the fancyhdr package, as described

on page 6, you may want to suppress headers and footers on certain pages. In particular,
you may not want a page number on the �rst page of a chapter or section. You can
override the fancyhdr package to suppress the information.

I To suppress headers and footers created with fancyhdr
1. Place the insertion point on the page for which you want to suppress headers and
footers, and enter an encapsulated TEX �eld.

2. In the entry area, type nthispagestyle{plain} and choose OK.
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Changing the Format of the Header and Footer Space
If you want to expand the amount of information you can get on a page, you can elim-
inate headers and footers entirely and expand the text area into the space they ordinar-
ily occupy. Use the geometry package with some TEX commands to accomplish the
change. On the other hand, you may �nd that the space allotted for headers and foot-
ers is inadequate. You can increase the space easily. Also, you can separate the headers
from the text by adding a line, or rule, under the header; use the fancyhdr package and
a few TEX commands in the document preamble.

I To eliminate the header and footer space throughout the document
1. From the Typeset menu, choose Preamble and click the mouse in the entry area.

2. On a new line at the end of the entries, type npagestyle{empty} and choose OK.

3. On the Typeset toolbar, click the Options and Packages button or, from the
Typeset menu, choose Options and Packages.

4. Choose the Package Options tab.

5. Add the geometry package to your document.

6. In the Packages in Use box, select geometry and chooseModify.

7. In the Category box, select Header/footer space.

8. In the Options box, select No header space, No footer space, or No header or
footer space.

9. Choose OK twice to return to your document.

I To increase the space available for headers and footers
1. From the Typeset menu, choose Preamble and click the mouse in the entry area.

2. Change the header space:

a. Add a new line at the end of the preamble entries.
b. Type nsetlength{nheadheight}{x} where x is the height of the header you want.
You can use any TEX measurement unit.

3. On a new line, type nsetlength{ntextheight}{x} where x is the desired text height.
The text height should re�ect the original text height set for the document less the
amount you added to the header.

4. On a new line, type nsetlength{nfootskip}{x} where x is the distance from the bot-
tom of the text to the bottom of the footer.

5. Choose OK.
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I To add a rule under the header
1. Add the fancyhdr package to your document.

2. Enter an encapsulated TEX �eld on the �rst page of the body of the document.

3. In the entry area, type these two commands:

npagestyle{fancy}
nrenewcommand{nheadrulewidth}{xpt}
where x is the point size of the rule you want.

For reference, this is a 1-point rule and this is a 5-point rule .
If you want to remove a rule under a header, set the headrulewidth to zero.

4. Choose OK.

Fitting Headings into Headers
If you �nd that a heading is too long to �t in the header, you can de�ne a short heading
to use in its place. The short title will appear in the page header and also in the table
of contents of your document (see page 18). This technique works for standard LATEX
typesetting speci�cations, but may not work for other typesetting speci�cations.

I To de�ne a short heading for a section
1. Place the insertion point at the beginning of the section heading.

2. Type the short heading enclosed in square brackets.

The heading might then look something like this:

[New Shorter Heading]A Much Longer Heading to Announce This Section of
My Document

Changing the Page Numbering

Page numbering is produced automatically by the typesetting speci�cations for your
document and in particular by the document class for the shell. However, you may
require subtle changes in the page numbering scheme, perhaps to reset the numbering
at some point in your document, to use lowercase roman numerals instead of arabic
numbers in the front matter, to move the page number elsewhere on the page, or to
remove it altogether. You can change the page numbering in your document by using
packages and, in some cases, by inserting TEX commands in the body of your document.
You may �nd additional information is helpful when you try to modify the page num-

bering. See the TEX and LATEX resources noted on page x and the information available
about the fancyhdr package on page 125.
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Resetting the Page Number
Page numbering sometimes requires subtle changes. You may need to set an arbitrary
page number at some point in your document.

I To set an arbitrary page number
1. Place the insertion point where you want the page number to be reset.

2. Enter an encapsulated TEX �eld.

3. In the entry area, type nsetcounter{page}{x} where x is the number from which you
want page numbering to begin at this point.

4. Choose OK.

Changing the Page Numbering Style
You may need to use a different style for the page numbers in one part of your document.
With a LATEX command, you can change the page numbering style to upper- or lowercase
roman numerals, upper- or lowercase letters, or arabic numbers. When you change the
page numbering style, LATEX resets the page number to 1, so you may want to reset the
page number after you change the style.

I To change the style of the page numbering
1. Place the insertion point on the page whose page numbering style you want to
change.

2. Enter an encapsulated TEX �eld.

3. In the entry area, type the command corresponding to the page numbering style you
want:
Command Page numbering style
npagenumbering{roman} lowercase roman numerals: i, ii, iii, ...
npagenumbering{Roman} uppercase roman numerals: I, II, III, ...
npagenumbering{arabic} arabic numbers: 1, 2, 3, ...
npagenumbering{alph} lowercase letters: a, b, c, ...
npagenumbering{Alph} uppercase letters: A, B, C, ...

4. Choose OK.

Shells based on the standard LATEX book document class (see page 67) use lowercase
roman numerals for the page numbers in the front matter of the document but arabic
numbers for page numbers throughout the rest of the document. If the shell you've
chosen has a different document class and therefore a different page numbering scheme,
you can change the numbering by placing LATEX commands in your document.
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I To use roman numerals in the front matter only
1. From the Typeset menu, choose Preamble.

2. Click the mouse in the entry area.

3. Create a new line at the end of the preamble entries.

4. Type npagenumbering{roman} and choose OK.

5. Place the insertion point at the beginning of the �rst paragraph of body text in your
document.

6. Enter an encapsulated TEX �eld.

7. In the entry area, type npagenumbering{arabic} and choose OK.
Remember that LATEX will reset the page number to 1; reset the page number if
necessary.

Moving the Page Number
If your document style places the page number in a less than ideal spot, you can move
it with the fancyhdr package. The package de�nes the content of the right, center, and
left sections of the header and footer. You can place the page number in one of these
areas. For more information about the fancyhdr package, see the online Help system
and the information on pages 5 and 125.
Because your document shell may already de�ne the content of some header and

footer areas, you may need to rede�ne them before your changes will work correctly.
For example, if you want to remove the page number from the bottom center of the
page, you must rede�ne the area as blank so the number doesn't appear there. The
instructions below explain how to move a page number from the center bottom of the
page to the top right. Use them as a guideline for moving page numbers to any part of
the header or footer.

I To move the page number from the bottom center to the top right of the page
1. Add the fancyhdr package to your document.

2. Move the page number:

a. In the body of the document, enter an encapsulated TEX �eld.
b. In the entry area, type npagestyle{fancy} to establish a new page style.
c. On the next line, type nfancyhf{} to clear the header and footer.
d. On the next line, type nrhead{nthepage} to force the page number to the top right
of the page.

e. If you want to remove the automatically created rule under the header, type the
command nrenewcommand{nheadrulewidth}{0pt} on the next line.

f. If you want to remove the automatically created rule above the footer, type the
command nrenewcommand{nfootrulewidth}{0pt} on the next line.

g. Choose OK.
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or

a. From the Typeset menu, choose Preamble, and click the mouse in the entry area.
b. Start a new line at the end of the preamble entries.
c. Type the commands speci�ed in steps 2b�f, above, then choose OK.

Removing the Page Number
If the typesetting instructions for your document specify that a page number occurs on
a page where you prefer not to have a number, you can suppress page numbering on the
page by inserting a LATEX command in the body of your document. Page numbering will
continue as before on the next page of the document.

I To suppress the page number on a page
1. Place the insertion point on the page for which you want no page number.

2. Enter an encapsulated TEX �eld.

3. In the entry area, type nthispagestyle{empty} and choose OK.

Creating Multiple Columns
Most SWP and SW documents can be typeset in multiple columns. The typesetting
speci�cations for each document shell determine the number of columns initially created
with the shell, but you can modify the setting. Although most shells default to a single
column, some default to double columns; skim through A Gallery of Document Shells
to identify the double-column shells.
Creating double-column output for your document may require little more than chang-

ing the document class options. If you specify the double-column option, LATEX typesets
the entire body of the document in two columns. The option doesn't necessarily apply
to all parts of the document front matter.
If you want �ner control over which document elements are and are not typeset in

multiple columns, you can use the multicol package to create as many as 10 columns of
text, and to combine single and multiple columns on the same page. For more informa-
tion, see page 143.

I To create double columns

1. On the Typeset toolbar, click the Options and Packages button or, from the
Typeset menu, choose Options and Packages.

2. Choose the Class Options tab and then chooseModify.

3. In the Category box, select Columns.

4. In the Options box, select Two columns and choose OK.

5. Choose OK to return to your document.
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I To create multiple columns
1. Add the multicol package to your document.

2. De�ne the start of the multicolumn environment:

a. Place the insertion point where you want multiple columns to begin and enter an
encapsulated TEX �eld.

b. In the entry area, type nbegin{multicols}{x} where x is the number of columns
you want.

c. Choose OK.

3. De�ne the end of the multicolumn environment:

a. Place the insertion point where you want multiple columns to end and enter an
encapsulated TEX �eld.

b. In the entry area, type nend{multicols}.
c. Choose OK.

Changing the Page Orientation
You can typeset most documents using portrait or landscape orientation for all or part
of the document. You can change the orientation of your entire document by changing
the options for the document class or by adding the geometry package to the document
and then modifying the package options. Because the document class and package op-
tions you specify can con�ict, you must be careful not to use contradictory orientation
settings. The printed output depends on your printer's capabilities and settings..

I To change the orientation of the entire document
� Use the class options:

a. On the Typeset toolbar, click the Options and Packages button or, from the
Typeset menu, choose Options and Packages.

b. Choose the Class Options tab and chooseModify.
c. In the Category box, select Orientation.
d. In the Options box, select the orientation you want, and then choose OK.
e. Choose OK to return to your document.

or
� Use the geometry package:

a. On the Typeset toolbar, click the Options and Packages button or, from the
Typeset menu, choose Options and Packages.

b. Choose the Package Options tab.
c. Add the geometry package to your document.
d. From the Packages in Use box, select geometry and chooseModify.
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e. In the Category box, select Orientation.
f. In the Options box, select the orientation you want, and then choose OK.
g. Choose OK to return to your document.

If you need to create a section of your document in a different orientation, we suggest
that you use the portland package (see page 152). You can also use packages that
provide text rotation, such as lscape (page 139) or rotating (page 156), to orient pages
differently. However, packages that use rotation aren't compatible with the TrueTEX
Previewer provided with SWP and SW. Note that PDF viewers do support rotation, so
you can successfully use the packages to rotate text in typeset PDF �les.

I To change the orientation of a single page
1. Add the portland package to your document.

2. Place the insertion point where you want the orientation change to occur.

3. Enter a TEX �eld.

4. In the entry area, type nlandscape or nportrait, depending on the orientation you
want.

5. Choose OK.

6. Place the insertion point where you want to return to the original orientation.

7. Enter a TEX �eld.

8. In the entry area, type nportrait or nlandscape, whichever is appropriate.

9. Choose OK.

Remember that you may need to change the orientation settings for your printer so
that your document prints properly. Instructions differ for each printer, but most changes
originate from a Setup tab. The instructions below are guidelines only.

If you have a single page with an orientation different from that of the rest of the
document, you may need to print it separately after changing the printer settings accord-
ingly.

I To change the printer settings for a different orientation
1. If you're printing from the document window, choose Print or Print PDF from the
Typeset menu.

or

If you're printing from a previewer, choose Print or Print Setup from the Filemenu.

Note that menu commands may differ depending on your print driver and previewer.

2. Look for a Setup or Properties tab or button and choose it.
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3. Select the orientation you want.

4. Choose OK to return to your document or to the previewer.

Note that you may want to change the orientation of the TrueTEX display in order to
properly preview documents with landscape orientation.

I To change the orientation of the TrueTEX Previewer display

1. On the Typeset toolbar, click the Typeset DVI Preview button or, from the
Typeset menu, choose Preview.

2. From the Options menu in the TrueTEX Previewer, choose Preferences.

3. Choose Page Orientation and select the orientation you want.

The TrueTEX Previewer remembers the page orientation most recently set and uses
it the next time you preview a document.

Changing to a Different Paper Size

The program can typeset most documents for a variety of paper sizes. You can spec-
ify the paper size by changing the class options or by adding the geometry package.
(The package works with most but not all shells; for more details about the geometry
package, see page 130.) Because the document class and package options you specify
can con�ict, you must be careful not to use contradictory paper size settings. Printing
the document successfully involves changing the settings for your printer and, of course,
using the correct paper in the printer.

I To change the paper size
� Modify the class options:

a. On the Typeset toolbar, click the Options and Packages button or, from the
Typeset menu, choose Options and Packages.

b. Choose the Class Options tab and chooseModify.
c. In the Category box, select Paper size.
d. In the Options box, select the paper size you want, and then choose OK.
e. Choose OK to return to your document.

or
� Use the geometry package:

a. On the Typeset toolbar, click the Options and Packages button or, from the
Typeset menu, choose Options and Packages.

b. Choose the Package Options tab.
c. Add the geometry package to your document.
d. From the Packages in Use box, select geometry and chooseModify.
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e. In the Category box, select Paper size.
f. In the Options box, select the paper size you want.
g. Choose OK twice to return to your document.

I To change the TrueTEX Previewer settings for paper of a different size

1. On the Typeset toolbar, click the Typeset DVI Preview button or, from the
Typeset menu, choose Preview.

2. From the Options menu in the TrueTeX DVI Previewer window, choose Prefer-
ences and then choose Page Size.

3. Select the paper size you want and choose OK.

The TrueTEX Previewer remembers and uses the page size selected most recently the
next time you preview a document.

I To change the printer settings for a different paper size
1. From the Typeset menu, choose Print or Print PDF.

2. In the Page Setup tab, scroll the list of sizes in the Paper Size box to select the
size you want.

Commands and their menu location may differ depending on your print driver.

3. Choose OK to close the succession of dialog boxes and begin printing.

Tailoring the Front and Back Matter

The typesetting speci�cations determine the appearance of elements in the front and
back matter of your document. The front matter is the information that appears before
the body of your document, including elements such as a title area, table of contents, list
of �gures, and abstract. The back matter is the information that follows the body of the
document, perhaps including an appendix, bibliography, and index. The appearance of
the front and back matter may require modi�cation to adhere to your requirements. You
can make many of these changes from within SWP and SW.

Changing the Title Page

The typesetting speci�cations determine which elements appear on the title page of your
document. If you need different information on the title page of your book, report, or
thesis, you can discard the automatically generated front matter and place the informa-
tion you want in a titlepage environment and a series of TEX �elds in the body of your
document. You must provide all required formatting for the information on the new
page. Also, because the titlepage environment resets the page number of the following
page to 1, you may need to reset the page numbering scheme; see page 9.
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I To create a customized title page
1. At the beginning of the body of your document, enter an encapsulated TEX �eld.

2. In the entry area, type nbegin{titlepage} and choose OK.

3. Enter the information for the title page, using tags and spacing commands to format
the information according to your requirements.

4. At the end of the information, enter an encapsulated TEX �eld.

5. In the entry area, type nend{titlepage} and choose OK.

6. If you want to insert a table of contents or another front matter element such as a list
of �gures, or list of tables, enter an encapsulated TEX �eld.

7. In the entry area, type the TEX command for the element.

These commands include ntableofcontents, nlistof�gures, and nlistoftables.

8. Choose OK.

9. On the Typeset toolbar, click the Front Matter button or, from the Typeset
menu, choose Front Matter.

10. Delete everything and choose OK.

11. Save and preview the document, setting the number of LATEX passes to 3 if your
document has a table of contents.

Some journals require that information about the author be included in an unnum-
bered footnote, with the footnote marker appearing as an asterisk next to the author's
name in the title area and the footnote itself appearing with an asterisk at the bottom of
the title page or �rst page.

I To add an unnumbered footnote to the title page
1. From the Typeset menu, choose Front Matter.

2. Place the insertion point at the end of the author's name in the Author �eld.

3. On the Field toolbar, click the Note button or, from the Insert menu, choose
Note.

4. Enter the text of the footnote.

5. In the Type of Note area, select footnote and choose OK.

When you typeset the document, the footnote appears with an asterisk at the bottom
of the �rst page. Footnotes in the body of the document are numbered beginning with
1. Results can differ if the class options for the document include a title page option and
that option is selected, as explained on page 69. We suggest you experiment using the
style you have selected for your document.
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In addition to the creation and revision dates automatically included in the Document
Info, the front matter of your document can contain a publication date.

I To create a publication date

1. On the Typeset toolbar, click or, from the Typeset menu, choose Front Mat-
ter.

2. Enter the date:
� If you want the current date as the date of publication, do not include a Date
�eld. If a Date �eld is already present, place the insertion point immediately to
the right of the �eld and apply the Remove Item tag.
LATEX adds the current date automatically.

� If you want to specify a different date of publication and a Date �eld is already
present, place the insertion point immediately to the right of the �eld and type
the date you want.

� If you want to specify a date of publication and a Date �eld isn't present,
i Place the insertion point at the end of the �eld that should immediately precede
the date and press ENTER.
ii Apply the Date item tag and type the date.
Make sure the Date �eld appears before the Make Title �eld.

3. Complete the front matter and choose OK.

Changing the Table of Contents

The typesetting speci�cations de�ne the way each division of your document is pre-
sented in the table of contents. They determine which division headings appear in
the contents, whether unnumbered headings are included, and how certain headings are
listed. Changing these speci�cations from within the program is straightforward.

Changing the Division Levels Displayed in the Table of Contents
The tocdepth counter setting in the typesetting speci�cations determines which di-
vision headings are included in the table of contents. LATEX uses section as level 1,
regardless of the document class. For information about which division headings carry
numbers, both in the table of contents and the text, see page 28.

I To modify the level of division headings re�ected in the table of contents
1. From the Typeset menu, choose Preamble and click the mouse in the entry area.

2. On a new line at the end of the entries, type nsetcounter{tocdepth}{x} where x is
the deepest heading level you want to display.

3. Choose OK.
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Creating Page Breaks in the Table of Contents
LATEX generates the entries in a typeset table of contents from the division headings in
your document. You can force a table of contents entry to move from the bottom of one
page to the top of the next, or vice versa. Use LATEX commands in the body of your
document to lengthen pages and create page breaks in the table of contents.

I To force an entry to the next page of the table of contents
1. Compile your document to generate a table of contents.

2. Determine the table of contents entry you want to force to the next page.

3. In the body of your document, �nd the corresponding division heading.

4. Place the insertion point immediately above the heading.

5. Enter a TEX �eld.

6. In the entry area, type naddtocontents{toc}{nprotectnpagebreak}.

7. Choose OK.

When you compile your document to create a new table of contents, LATEX places a
page break before the table of contents entry for the division heading, and forces the
entry to the next page of the table of contents. The body of your document remains
unchanged.

I To force an entry to the previous page of the table of contents
1. Compile your document to generate a table of contents.

2. Determine the table of contents entry you want to force to the previous page.

3. In the body of your document, �nd the corresponding division heading.

4. Place the insertion point immediately above the heading and enter a TEX �eld.

5. In the entry area, type naddtocontents{toc}{nprotectnenlargethispage*{1000pt}}
where the actual point value depends on how much information you're trying to �t
on the page.

6. Choose OK.

7. Place the insertion point in the paragraph following the heading and enter a TEX �eld.

8. In the entry area, type naddtocontents{toc}{nprotectnpagebreak} and choose OK.
When you compile your document to create a new table of contents, LATEX forces the
entry for the division heading to the previous page of the table of contents and places
a page break after the entry. The body of your document remains unchanged.

Creating Short Table of Contents Entries
If a division heading in your document is long, you can de�ne a short heading for use in
the table of contents. The short heading is also used for the page header, as described on
page 9.
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I To de�ne a short heading for a division
1. Place the insertion point at the beginning of the division heading.

2. Type the short heading enclosed in square brackets.

The heading might then look something like this:

[Short Heading]A Long Heading to Announce This Section of My Document

Listing Unnumbered Divisions
Generally, the speci�cations exclude unnumbered divisions, such as the introduction or
acknowledgments, from the table of contents. You can force LATEX to include them.

I To include an unnumbered division in the table of contents
1. Place the insertion point just after the unnumbered heading.

2. Enter an encapsulated TEX �eld.

3. In the entry area, type naddcontentsline{toc}{sectionlevel}{Name} where section-
level is the level of the heading you want to include, such as chapter or section, and
Name is the text you want to appear in the table of contents.

4. Choose OK.

Listing the Bibliography and Index
The headings for two divisions�the bibliography and the index�are both unnumbered
and automatically generated. They typically appear in the body of the document but not
in the table of contents. You can create a contents entry for both.

I To add the bibliography or index to the table of contents
1. Create the bibliography list or index entries.

2. Typeset compile the document to generate the index and, if you're using BIBTEX, the
bibliography.

3. Create the table of contents entry:
� If you have Version 4.0 or later, add the tocbibind package to your document.
The package automatically includes the bibliography and the index in the table
of contents.
or

� If you have an earlier version,
i Place the insertion point just before the index or the gray box for the BIBTEX
bibliography.
ii Enter an encapsulated TEX �eld.
iii In the entry area, type nclearpage if you're working in an article or report shell
or ncleardoublepage if you're working in a book shell.
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iv Press ENTER.
v Type naddcontentsline{toc}{divisionlevel}{Name} where divisionlevel is the
level of the heading you want to include, such as chapter or section, and Name
is the text you want to appear in the table of contents.

vi Choose OK.

Listing the Appendices
Typesetting speci�cations can automatically format certain table of contents entries. For
example, some speci�cations create contents entries for each appendix using the appen-
dix number only; others precede the number with the word Appendix. If your document
shell uses only the appendix number in the table of contents, you can modify the entry
by adding the word Appendix.

I To force the word Appendix to appear in the table of contents
1. Place the insertion point where you want the appendix title to appear in the document.

2. Enter an encapsulated TEX �eld.

3. In the entry area,
� If you're using an article shell, type
nsection*{Appendix x. The Title of the Appendix}
where x. The Title of the Appendix indicates the number and title of the appen-
dix.

or
� If you're using a book shell, type
nchapter*{Appendix x. The Title of the Appendix}.

This command removes the automatic generation of the appendix number and changes
the appearance of the title in the text to what you have entered inside the curly braces.

4. Type a second command to add the now unnumbered section to the table of contents:

naddcontentsline{toc}{section}{Appendix x. The Title of the Appendix}.
If you're using a book or report shell, substitute the word chapter for the word sec-
tion.

5. Choose OK.

Changing the List of Figures

If the captions for the �oating graphics in your document are too long to appear in a list
of �gures, you can shorten the way they appear in the list of �gures but keep the full text
of the caption in the body of your document.
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I To de�ne a short caption for a �oating graphic
1. Select the graphic.

2. Choose Properties.

3. Choose the Labeling tab.

4. Choose the position of the caption in the body of the document (Above or Below).

5. In the Caption text area, type the caption as you want it to appear in the body of
your document.

6. Check the box marked Short form.

7. In the Caption text area, type the caption as you want it to appear in the list of
�gures.

8. Choose OK.

Creating an Unnumbered Manual Bibliography

At times, you may want to customize the typeset appearance of items in a manual bibli-
ography and the citations that refer to them. For example, you may want to remove the
numbers from the bibliography item list, alphabetize the items themselves, or create ci-
tations with certain content, such as the author's name and year of publication. See page
36 for additional information about formatting citations.

I To create an unnumbered manual bibliography
1. Create your document using one of the standard LATEX shells.

2. From the Typeset menu, choose Bibliography Choice, check Manual Entry, and
choose OK.

3. Remove the typesetting of the labels from the bibliography item list:

a. From the Typeset menu, choose Preamble.
b. Click the mouse in the entry area and add these lines to the end of the preamble:
nmakeatletter
ndefn@biblabel#1{nhspace*{-nlabelsep}}
nmakeatother

c. Choose OK.

4. Create the bibliography item list, giving a label to each item:

a. Place the insertion point where you want the bibliography item list to begin.
b. Apply the Bibliography Item tag.
c. In the Key box, type a key for the item.
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d. In the Label box, type the citation information as you want it to appear in the text.
The typesetting speci�cations de�ne the appearance of the label, adding brackets
automatically as necessary.

e. Choose OK.
f. Type the bibliography item as you want it to appear in the list and press ENTER.
g. Repeat steps c�f for each item in the list, and then press F2 to exit the list.

5. Manually alphabetize the bibliography items.

6. Create citations in the text:

a. Place the insertion point where you want a citation to appear.

b. On the Typeset Objects toolbar, click the Citation button or, from the Insert
menu, choose Typeset Object and then choose Citation.

c. In the Citation dialog box, enter the key of the item you want to cite and choose
OK.

7. Typeset your document.

LATEX places the label for the bibliography item in the citation but omits it from the
bibliography list.

Creating an Appendix for Each Chapter

Creating a single appendix for your document requires no special procedures, but cre-
ating an appendix for each chapter of a book or report or for each section of an article
requires the addition of the appendix package (see page 103). The package implements
a subappendices environment to contain the appendix.

I To create subappendices
1. Add the appendix package to your document.

2. Begin the subappendices environment:

a. Place the insertion point where you want the appendix to appear.
b. Enter an encapsulated TEX �eld.
c. In the entry area, type nbegin{subappendices} and choose OK.

3. Type the title of the appendix and apply the section tag (for appendices within chap-
ters of a book or report) or the subsection tag (for appendices within sections of an
article).

4. Type the content of the appendix.

5. If you want additional subappendices, repeat steps 3 and 4.
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6. End the subappendices environment:

a. Place the insertion point where you want the appendix to end and enter an encap-
sulated TEX �eld.

b. In the entry area, type nend{subappendices} and choose OK.

The subappendices you create are numbered with the chapter or section number and
an uppercase alphabetic letter, as in 2.A, 2.B, and so on. You can modify the numbering
scheme to remove the chapter or section number.

I To remove the number from a subappendix
1. From the Typeset menu, choose Preamble and click the mouse in the entry area.

2. On a new line at the end of the preamble entries,
� For books and reports, type
nrenewcommand{nsetthesection}{nAlph{section}}
or

� For articles, type
nrenewcommand{nsetthesubsection}{nAlph{subsection}}

3. Choose OK.

Creating Two Separate Indices
Some publications require that you include both a subject index and an author index
in your document. You can generate a double index if you use both the makeidx and
nomencl packages in your document (see pages 140 and 146). The makeidx package
generates a standard subject index. You can use the features of the nomencl package,
along with the MakeIndex program provided with SWP and SW, to create the author
index.

I To generate two indices
1. Add the makeidx and nomencl packages to your document.

2. Modify the options for the nomencl package:

a. From the Typeset menu, choose Options and Packages and choose the Pack-
age Options tab.

b. In the Packages in Use box, select nomencl and chooseModify.
c. In the Category box, choose Add page references.
d. Select the Yes option.
e. Choose OK to close the dialog boxes and return to your document.

3. Create standard index entries for the subject index throughout your document.

4. Create each entry for the author index:

a. Place the insertion point to the right of the name you want to index.
b. Enter an encapsulated TEX �eld.
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c. In the entry area, type nnomenclature{name}{nhspace{-1ex}} where name is the
author name you want to appear in the list, shown as you want it to appear, and
the second parameter is some negative horizontal space that offsets a blank space
added by the package before the page number.
The word page is added automatically.

d. Choose OK.

5. Modify the document preamble:

a. From the Typeset menu, choose Preamble and click the mouse in the entry area.
b. If you're using the Portable LATEX �lter, skip to step 5d.
c. If the highest division level in your document is section (that is, the chapter divi-
sion isn't used):
i Save, close, and reopen the document.
ii From the Typeset menu, choose Preamble.
iii Click the mouse in the entry area and scroll to the bottom.
iv After the line ninput{tcilatex}, add a new line and type
nletnchapternunde�ned

d. On a new line at the end of the preamble entries, add nmakenomenclature (in
Version 5.5) or nmakeglossary (in earlier versions).

e. Add these new lines:
nmakeindex
nrenewcommand{nnomname}{Author Index}
nrenewcommand{nindexname}{Subject Index}

f. Choose OK.

6. Include both indices in your document:

a. Place the insertion point at the end of your document.
b. Enter an encapsulated TEX �eld.
c. In the entry area, type
nprintnomenclature (in Version 5.5) or nprintglossary (in earlier versions)
nprintindex
The order of these commands determines the order in which the indices are printed.
The nprintnomenclature or nprintglossary command indicates the
author index; the nprintindex command indicates the subject index. Change
the order as necessary.

d. Choose OK.

7. Compile your document to create the subject index:

a. Save the document.

b. On the Typeset toolbar, click the Typeset DVI Compile button or, from the
Typeset menu, choose Compile.

c. Check Generate an Index and choose OK.
Make sure the number of LATEX passes is set to 2.
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8. Typeset compile your document from outside SWP or SW to create an .nlo �le
for the author index:

a. From the SWP or SW submenu in the Windows Programs list, choose the
TrueTEX Formatter.

b. Select the �le and choose OK.

9. Run the MakeIndex program to create the author index:

a. From the Windows Start menu, choose Run.
b. Enter the command appropriate for your version of SWP or SW in the Open
box, changing the name of the program dirsectory as necessary. Where line breaks
occur in these instructions, enter a space.
�With Version 5.5, enter this command on a single line:
c:nswp55nTCITeXnweb2cnmakeindex -o
c:nswp55ndocsn�lename.nls -s
c:nswp55nTCITeXnTeXnLaTeXncontribnnomenclnnomencl.ist
c:nswp55ndocsn�lename.nlo
�With Version 4.x or 5.0, enter this command on a single line:
c:nswp50nTCITeXnweb2cnmakeindex -o
c:nswp50ndocsn�lename.gls -s
c:nswp50nTCITeXnTeXnLaTeXncontribnsupportednnomenclnnomencl.ist
c:nswp50ndocsn�lename.glo
�With an earlier version of the program, enter this command on a single line:
c:nswp35nTCITeXnSWToolsnbinnmakeindx -o
c:nswp35ndocsn�lename.gls -s
c:nswp35nTCITeXnTeXnLaTeXncontribnsupportednnomenclnnomencl.ist
c:nswp35ndocsn�lename.glo

c. Choose OK.

10. Typeset compile the document �le from outside the program.

Note If you compile using SWP or SW, the compiler won't �nd the .nls or .
gls �le and won't include the author list in the typeset document.

a. From the SWP or SW submenu in the Windows Programs list, choose the
TrueTEX Formatter.

b. Select the �le and choose OK.
If your document contains a table of contents or cross-references, you many need
to compile it two or three times.

Tailoring the Body of the Document

The typesetting speci�cations determine the appearance of division headings, text, lists,
footnotes and other generated elements, and other parts of the body of your document.
Using LATEX packages and TEX commands, you can modify the typeset appearance of
these various elements.
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Changing the Appearance of Division Headings
The typesetting speci�cations for your document determine how the program treats the
headings and numbers for chapters, sections, and other divisions. You may need to
modify the speci�cations for all division headings or just for a few occurrences of a
given division to achieve a different placement, numbering scheme, or naming scheme.

Repositioning Headings
The designers of most document shells carefully consider the placement of chapter, sec-
tion, and other division headings. Nevertheless, you may need to change some or all of
the heading placement speci�cations. With the commands available through the sectsty
package (see page 159), you can change the location of a category of division headings,
such as all chapter headings or all subsection headings. Note, however, that this process
also removes the division number and therefore excludes the division from the table of
contents. (See page 20 for information about adding the unnumbered division to the ta-
ble of contents.) If your document was created with a Style Editor shell, use the Style
Editor to reposition the headings.

I To relocate all headings for a given division level
1. Add the sectsty package to your document.

The package works for documents created with standard LATEX article, book, and re-
port shells. If the package isn't listed as available, it will not work for your document;
don't attempt to go native to add the package.

2. From the Typeset menu, choose Preamble and click the mouse in the entry area.

3. On a new line at the end of the preamble entries, type this command for each division
heading level you want to move: ndivisionfont{x}
where ndivisionfont re�ects the heading you want to move (such as npartfont,
nallsectionsfont, nchapterfont, or nsectionfont) and x is the com-
mand for the new heading location:

Command Effect
ncentering Centered heading
nraggedleft Set �ush right with a ragged left margin
nraggedright Set �ush left with a ragged right margin

4. Choose OK.

If you need to relocate only one heading instead of an entire category of headings,
you can replace the heading with a TEX command. The process maintains the division
number and includes the division in the table of contents. We don't recommend this
process for shells with numbered chapter headings preceded by the word Chapter.

I To relocate a single division heading
1. Place the insertion point where you want the heading to appear and enter an encap-
sulated TEX �eld.

2. In the entry area, type {nlocationndivision{Name}} where location is the location
you want, division is the division level you want to move, and Name is the name of
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the heading as you want it to appear. Use ncentering, nraggedleft, or nraggedright
to de�ne the location, as described above.

3. Choose OK.

4. Delete the original heading.

Adding and Removing Division Numbering
Occasionally, you may need to extend numbering to deeper levels of division headings
than the document shell speci�es. On the other hand, you may need to remove the
number from all headings below a certain level or from an individual heading. (See
page 20 for instructions about adding the unnumbered division to the table of contents.)

I To extend or remove division numbering
1. From the Typeset menu, choose Preamble and click the mouse in the entry area.

2. On a new line at the end of the preamble entries, type nsetcounter{secnumdepth}{x}
where x is the deepest heading level you want to number.

x If division numbers are to extend only to
-1 Parts
0 Chapters
1 Sections
2 Subsections
3 Subsubsections
4 Subsubsubsections
5 Subsubsubsubsections

Remember that LATEX uses section as level 1, regardless of the document class.

3. Choose OK.

I To remove the number from an individual division heading
� If you're using Version 4.0 or later,

a. Place the insertion point at the beginning of the heading and choose Properties.
b. In the Section Properties dialog box, check Unnumbered.

c. Choose OK

or
� If you're using an earlier version,

a. Place the insertion point where you want the heading to appear and enter an en-
capsulated TEX �eld.

b. In the entry area, type ndivision*{Name}where division is the level of the heading
and Name is the name of the division as you want it to appear.
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c. Choose OK.
d. Delete the original heading.

Note that LATEX ignores unnumbered divisions when it creates page headers. Thus,
if you create an unnumbered appendix, the page headers on the appendix pages re�ect
the name of the previous division heading rather than the appendix..

Changing the Division Numbering Scheme
You may need to change the style of the numbers used to designate a certain division
level. For example, you may want chapters to have uppercase roman numerals, sections
to have capitalized alphabetic characters, and subsections to have arabic numbers. You
can insert TEX commands in the preamble of your document so that your headings are
numbered according to a particular scheme.

I To change the numbering scheme for division headings
1. From the Typeset menu, choose Preamble and click the mouse in the entry area.

2. At the end of the preamble entries, type nrenewcommand{nlevel}{scheme{counter}}
where level is the division level you want to renumber, such as thechapter or thesub-
section; scheme is the numbering scheme, such as Roman or arabic (see page 10 for
a list of numbering schemes); and counter is the counter for the division level, such
as part or chapter.

3. Choose OK to return to your document.

To produce chapters with uppercase roman numerals, sections with capitalized al-
phabetic characters, and subsections with arabic numbers, use these commands:
nrenewcommand{nthesection}{nAlph{section}}
nrenewcommand{nthechapter}{nRoman{chapter}}
nrenewcommand{nthesubsection}{narabic{subsection}}

Changing Automatic Division Numbering
You can begin division numbering in your document with a number other than 1 by
adding a command to the document preamble.

I To create division numbering that doesn't begin with 1
1. From the Typeset menu, choose Preamble and click the mouse in the entry area.

2. On a new line at the end of the preamble entries, type nsetcounter{name}{x} where
name is the division for which you want to modify the numbering, as shown in the
following table, and x is one less than the starting number you want.

Division name
Part part
Chapter chapter
Section section
Subsection subsection
Subsubsection subsubsection
Subsubsubsection paragraph
Subsubsubsubsection subparagraph

3. Choose OK.
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The command increments the division counter before it is �rst used by the document.
As an illustration, if you want the �rst section in the document to carry the number 2,
use the command nsetcounter{section}{1} in the preamble.

Changing Automatic Division Names
Some typesetting speci�cations automatically give names, such as Chapter or Refer-
ences, to certain heading levels. If necessary, you can change the automatic names from,
for example, Chapter to Lesson or from References to Bibliography. Making changes to
the headings speci�cations can have wide-ranging effects, particularly if your document
has a table of contents.

I To change an automatically generated division name
1. From the Typeset menu, choose Preamble and click the mouse in the entry area.

2. At the end of the preamble entries, add a new line and type

nrenewcommand{nname}{Newname}
where name is the title of the part of the document you want to change (see the list
below) and Newname is the title you want.

3. Choose OK.
Document part name Document part name
Preface prefacename Table tablename
References refname Part partname
Abstract abstractname encl enclname
Bibliography bibname cc ccname
Chapter chaptername To headtoname
Appendix appendixname Page pagename
Contents contentsname see seename
List of Figures list�gurename see also alsoname
List of Tables listtablename Proof proofname
Index indexname Glossary glossaryname
Figure �gurename

Thus, you can use the command nrenewcommand{ncontentsname}{Table
of Contents} to change the title Contents to Table of Contents. Similarly, to change
Chapter to Lesson, use nrenewcommand{nchaptername}{Lesson}; to change
References to Bibliography, use nrenewcommand{nrefname}{Bibliography}.
Other titles work the same way. Note that the babel package works successfully with
rede�ned titles. If you're using babel, the commands must be placed in the body of the
document inside a TEX �eld.
Each document class treats the bibliography title differently. To save work, you can

use the chbibref package (see page 113) to change the title for three LATEX document
classes: article, book, and report.
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I To change the title of the bibliography for all document classes
1. If you're using Version 3.51 or lower, obtain and install the chbibref package.

The package is distributed with Versions 4.0 and later.

2. Add the chbibref package to your document.

3. From the Typeset menu, choose Preamble and click the mouse in the entry area.

4. At the end of the preamble, add a new line and type nsetbibref{name} where name
is the bibliography title you want.

Note If you're using babel, place the command in the body of the document inside
a TEX �eld.

5. Choose OK.

Changing the Appearance of Paragraphs

In documents based on standard LATEX typesetting speci�cations, the paragraphs that
immediately follow section headings are not indented, but subsequent paragraphs are
indented, as in this manual.
You can remove indention for all paragraphs in your document by modifying the

document preamble. However, because the beginning of unindented paragraphs is some-
what harder to see, you may also want to increase the spacing between paragraphs.

Removing Indention from Paragraphs
LATEX determines the paragraph indention by the length nparindent. You can set this
length to zero in the document preamble.

I To remove indention for all paragraphs in the document
1. From the Typeset menu, choose Preamble and click the mouse in the entry area.

2. At the end of the preamble, add a new line and type nsetlength{nparindent}{0in}.

3. Choose OK.

4. Typeset preview the document to make sure the indention is correct.

Changing Paragraph Justi�cation
Although most LATEX typesetting speci�cations default to full justi�cation for text in
paragraphs, you can create text that isn't fully justi�ed for all or part of the body of your
document.

Justifying the Entire Document
Using Version 5.0 or later, you can change the justi�cation of the entire body of your
document with the ragged2e package, or, using any version of the program, with dec-
larations in the document preamble
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I To use ragged2e to typeset an entire document as ragged right
1. Add the ragged2e package to your document.

2. From the Typesetmenu, chooseOptions and Packages and then choose thePack-
age Options tab.

3. From the Packages in Use list, select the ragged2e package and chooseModify.

4. In the Category box, select Commands in effect and in the Options box select
New ragged2e.

5. In the.Category box, select Complete document ragged right and in theOptions
box select Yes.

6. Choose OK twice to close the dialogs.

The ragged2e package turns off normal paragraph indention, but you can restore it
with a command in the document preamble.

I To restore paragraph indention when using the ragged2e package
1. From the Typeset menu, choose Preamble.

2. Start a new line and type nsetlength{nRaggedRightParindent}{nparindent}

3. Choose OK twice to close the dialog.

I To change the justi�cation of your document from the preamble
1. From the Typeset menu, choose Preamble.

2. Add a new line.

3. Type the justi�cation declaration you need: ncentering, nraggedright, or nraggedleft.

4. Choose OK to return to your document.

The ragged right option turns off normal paragraph indention, but you can preserve
it by following the alternate steps below.

I To preserve paragraph indention with ragged right justi�cation
1. From the Typeset menu, choose Preamble.

2. Start a new line and type
nnewdimennsaveparindent
nsaveparindentnparindent
nraggedright
nparindentnsaveparindent

3. Choose OK twice to close the dialog.
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Justifying Part of a Document
You can change the justi�cation of a portion of your document with Section/Body tags
or with LATEX environments in TEX �elds in the body of your document.
Three environments correspond to alternate justi�cation settings: center, �ushleft,

and �ushright. The center environment is available with the Centered tag, available from
the Section/Body Tag popup list; apply the tag to the paragraph you want to center. With
Version 5.0 Build 2606 and later, you can turn on the Flush Left and Flush Right tags
from the Tag Appearance dialog box, if they don't already appear in the Section/Body
Tag list for your document.
Justi�cation for a portion of your document can also be set by including LATEX com-

mands (ncentering, nraggedright, or nraggedleft) in the body of your doc-
ument.

I To modify paragraph justi�cation for a portion of a document
1. Place the insertion point at the beginning of the text for which you want to change
the justi�cation.

2. Enter a TEX �eld and, if you're using Version 4.1 or earlier, encapsulate the �eld..

3. In the entry area, enter nbegin{�ushleft} or nbegin{�ushright} and choose OK.

4. Place the insertion point at the end of the text for which you want to change the
justi�cation.

5. Enter a TEX �eld and, if you're using Version 4.1 or earlier, encapsulate the �eld..

6. In the entry area, enter nend{�ushleft} or nend{�ushright} and choose OK.

Changing the Spacing Between Paragraphs
LATEX de�nes the space between paragraphs by the length nparskip. The default space
is 0pt plus 1pt, which means the spacing between lines can increase by as much as 1pt,
depending on how LATEX �ts the text vertically on the page. The increase translates to
about 110 to

1
12 of the height of a line of text, depending on the base font point size.

If you have removed paragraph indention, a reasonable space between paragraphs is
about the height of a line of text, with additional stretch or shrinkage to allow LATEX to �t
text on a page the best way possible. Therefore, if the base font size is 10pt, you might
use a nparskip value of 10pt plus 1pt minus 1pt.

I To modify spacing between paragraphs
1. From the Typeset menu, choose Preamble.

2. Click the mouse in the entry area and place the insertion point on a new line at the
end of the entries.

3. Type nsetlength{nparskip}{10pt plus 1pt minus 1pt}, adjusting the values accord-
ing to your needs.
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4. Choose OK.

5. Typeset preview the document to make sure the spacing is correct..

Changing the Appearance of Numbered Lists

The program can accept a wide variety of numbering schemes for all four levels of list
items, which are designated in TEX as theenumi through theenumiv. You can change the
default scheme for your entire document by entering TEX commands in the preamble
or change the scheme for a portion of the document by entering TEX commands in the
body of the document. You can also use the points or newpnts package (see page 151)
to begin the list at a number other than one.

I To change the list numbering scheme for the entire document
1. From the Typeset menu, choose Preamble and click the mouse in the entry area.

2. On a new line at the end of the entries, type this command for each list level you
want to renumber: nrenewcommand{nlevel}{nstyle{level_counter}}
where level is the numbered list level you want to renumber (theenumi, theenumii,
theenumiii, or theenumiv), style is the numbering style you want (Roman, roman,
Alph, alph, or arabic), and level_counter is the counter for the list level (enumi,
enumii, enumiii, or enumiv).

3. Choose OK.

For example, many people want list levels numbered as a standard outline: I, A, 1, a.
You can achieve an outline numbering scheme by entering these commands:
nrenewcommand{ntheenumi}{nRoman{enumi}}
nrenewcommand{ntheenumii}{nAlph{enumii}}
nrenewcommand{ntheenumiii}{narabic{enumiii}}
nrenewcommand{ntheenumiv}{nalph{enumiv}}

I To change the list numbering scheme for a portion of the document
1. Begin the new numbering scheme:

a. Place the insertion point where you want the numbering scheme to begin.
b. Enter an encapsulated TEX �eld.
c. In the entry area, type this command for each list level you want to renumber:
nrenewcommand{nlevel}{nstyle{level_counter}}
where level is the numbered list level you want to renumber (theenumi, theenumii,
theenumiii, or theenumiv), style is the numbering style you want (Roman, roman,
Alph, alph, or arabic), and level_counter is the counter for the list level (enumi,
enumii, enumiii, or enumiv).

d. Choose OK.

2. Revert to the original numbering scheme:
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a. Place the insertion point where you want the numbering scheme to revert to the
default.

b. Enter an encapsulated TEX �eld.
c. In the entry area, type this command for each list level you renumbered:
nrenewcommand{nlevel}{nstyle{level_counter}}
and designate the original style of the counter.

d. Choose OK.

I To create a numbered list that doesn't begin with 1
1. Add the points or newpnts package to your document.

2. Place the insertion point where you want the numbered list to begin.

3. Enter an encapsulated TEX �eld.

4. In the entry area, type nsetcounter{enumi}{x}nRESUME
where x is a value one less than the starting number you want.

In other words, if you want your list to begin at 10, use the command

nsetcounter{enumi}{9}nRESUME. Note that the command is case-sensitive.

5. Choose OK.

You can also use the points or newpnts package to create a numbered list inter-
rupted by an unnumbered paragraph.

I To create an interrupted numbered list
1. Add the points or newpnts package to your document.

2. Place the insertion point where you want the numbered list to begin.

3. Enter an encapsulated TEX �eld.

4. In the entry area, type nsetcounter{enumi}{x}nRESUME where x is a value one
less than the starting number you want.

The command is case-sensitive. If you want your list to begin at 1, use the command
nsetcounter{enumi}{0}nRESUME.

5. Choose OK.

6. Begin entering the numbered list.

7. Enter the unnumbered paragraph that interrupts the list.

8. At the end of the unnumbered paragraph, enter an encapsulated TEX �eld.

9. In the entry area, type nRESUME and choose OK.

10. Complete the list.
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Customizing the Appearance of Citations

By default, standard LATEX shells place square brackets around citations. You may want
to remove the brackets, especially if you add labels for items in a manual bibliography,
so that the label appears as a natural part of your text. Suppose the citation in this
sentence

As shown by , the methodology was inadequate to....

refers to a bibliography item for which the label is Pearson 2004, and you want the
typeset text to read

As shown by Pearson 2004, the methodology was inadequate to....

When you typeset the document, the label appears as the citation, but inside square
brackets:

As shown by [Pearson 2004], the methodology was inadequate to....

You can remove the brackets by modifying the typesetting speci�cations or by using the
cite package (see page 114).

I To omit brackets around all inline citations
1. Create your document using a standard LATEX shell.

2. Remove the brackets from the typesetting speci�cation for citations:

a. From the Typeset menu, choose Preamble and click the mouse in the entry area.
b. Add these lines to the preamble:
nmakeatletter
nrenewcommand{n@cite}[1]{#1}
nmakeatother

c. Choose OK.

3. Create a manual bibliography with labels for each item and create the citations in the
text.

4. Typeset your document.

I To use the cite package to omit brackets around inline citations
1. Add the cite package to your document.

2. From the Typeset menu, choose Preamble and click the mouse in the entry area.

3. On a new line at the end of the preamble, type nletncite=nciten and choose OK.

4. Create a manual bibliography with labels for each item and create the citations in the
text.

5. Typeset your document.
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Underlining and Striking Through Content

Although the program has no underlining command in the usual sense, you can add
emphasis to your content with simple underlines if you use the ulem package. The
package temporarily changes the behavior of the nem and nemph commands to support
single and double underlining, wavy underlining, a single line drawn through text, and
text marked over with slashes, as shown on page 176.

I To add simple underlines
1. Add the ulem package to your document.

2. Select the information you want to underline and apply the Emphasize tag to it.

I To add varied underlines and strikethroughs
1. Add the ulem package to your document.

2. Place the insertion point where you want the underline or strikethrough to begin.

3. Enter an encapsulated TEX �eld.

4. In the entry area, type ncommand{text} where command is one of the following:
Command Effect
nuline Single underline
nuuline Double underline
nuwave Wavy underline
nsout Line through text
nxout Text marked over with slashes

and text is the information you want emphasized.

5. Choose OK.

Stopping Hyphenation

By default, the typesetting speci�cations for most shells specify hyphenation. With the
hyphenat package (see page 135), you can suppress all hyphenation.

I To suppress hyphenation in a document
1. Add the hyphenat package to your document.

2. On the Typeset toolbar, click the Options and Packages button or, from the
Typeset menu, choose Options and Packages.

3. Choose the Package Options tab.
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4. In the Packages in Use box, select hyphenat and then chooseModify.

5. In the Category box, choose Hyphenation.

6. In the Options box, select None.

7. Choose OK twice to return to your document.

Note that because theNone option prevents all hyphenation, you may get LATEXmessages
about bad line breaks and overfull boxes when you typeset compile your document. See
Chapter 4 "Troubleshooting."

Working with Footnotes

Although numbered footnotes are usually the default, the program can designate foot-
notes with symbols and can typeset both footnotes and endnotes for most documents.

Using Symbols to Designate Footnotes
You can use standard footnote symbols instead of numbers to designate footnotes by
modifying the preamble and then indicating the symbol you want when you enter the
footnote.

I To designate footnotes with symbols
1. Open your document.

2. Modify the preamble:

a. From the Typeset menu, choose Preamble and click the mouse in the entry area.
b. Type nrenewcommand{nthefootnote}{nfnsymbol{footnote}}.
c. Choose OK.

3. Insert the footnote:

a. Place the insertion point where you want the footnote.
b. From the Insert menu, choose Note.
c. In the Type of Note box, select footnote.
d. Type the text of your footnote.

4. Specify the symbol you want:

a. Choose Options.
b. Check Override Automatic Number.
c. In the Footnote Number box, enter the number for the symbol you want from the
table on the next page.

d. Choose OK twice to return to your document.



Tailoring Mathematics 39

Number Symbol
1 asterisk *
2 dagger y
3 double dagger z
4 section symbol §
5 paragraph {
6 parallel lines jj
7 two asterisks **
8 two daggers yy
9 two double daggers zz

Changing Footnotes to Endnotes
You can gather footnotes in a list at the end of your document by adding the endnotes
package (see page 121). Instead of replacing the list of footnotes generated by LATEX,
the package stores the endnote list in a separate �le with the extension .ent and deletes
the list after you typeset your document.

I To typeset existing footnotes as endnotes
1. Add the endnotes package to your document.

2. From the Typeset menu, choose Preamble and click the mouse in the entry area.

3. At the end of the preamble entries, add a new line and type
nletnfootnote=nendnote.

4. Choose OK.

5. Place the endnotes list in your document:

a. Place the insertion point at the end of your document.
b. Enter an encapsulated TEX �eld.
c. If you want the endnotes to begin on a new page, type nnewpage and press ENTER.
d. Type nbegingroup and press ENTER.
e. If you want the endnotes to be set in a normal size font instead of a smaller font,
type nrenewcommand{nenotesize}{nnormalsize} and press ENTER.

f. If you want to list the endnotes in the table of contents, type the command
naddcontentsline{toc}{section}{Notes} and press ENTER.

g. Type ntheendnotes and press ENTER.
h. Type nendgroup and choose OK.

Tailoring Mathematics
Together with LATEX, SWP and SW provide for detailed formatting of mathematics.
The document shells provided with the program have been designed to produce typeset
mathematics that meet the formatting requirements of many different publishers. Nev-
ertheless, your document may require some modi�cations.
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Changing Theorem Numbering
Theorems and theorem-like statements may be numbered consecutively throughout your
document (Theorem 1, Corollary 2, Lemma 3, Theorem 4, ...) or they may be numbered
independently (Theorem 1, Corollary 1, Lemma 1, Theorem 2, ...). Usually, the num-
bering scheme is established with nnewtheorem statements. The basic syntax for the
nnewtheorem command is

nnewtheorem{counter}[counter_basis]{counter_title}

where counter is the environment to be counted (such as theorem, lemma, or corollary),
counter_basis is the source of the count, and counter_title is the label for the environ-
ment.
In most document shells that have theorem-like environments, the environments are

numbered on the basis of the theorem environment. Therefore, in the preamble of the
document, you might see a series of statements similar to these:
nnewtheorem{theorem}{Theorem}
nnewtheorem{algorithm}[theorem]{Algorithm}
nnewtheorem{axiom}[theorem]{Axiom}
nnewtheorem{condition}[theorem]{Condition}
nnewtheorem{conjecture}[theorem]{Conjecture}
nnewtheorem{corollary}[theorem]{Corollary}

...
The �rst statement establishes independent numbering for theorems; the other state-
ments number all other theorem-like environments on the basis of the theorem counter.
Thus, these statements produce a single numbering sequence for all types of theorem
environments and might yield a numbering sequence such as this: Theorem 1, Theorem
2, Conjecture 3, Theorem 4, Conjecture 5, ....
Usually, the nnewtheorem statements appear in the document preamble. If so, you

can modify the preamble to change the numbering scheme as necessary. The instructions
in this section pertain only to those documents for which theorem numbering schemes
are de�ned in nnewtheorem statements in the document preamble.
Sometimes the nnewtheorem statements are included in the typesetting speci�ca-

tions for the shell. In this case, don't attempt to change the numbering scheme. If you
need a different numbering scheme for theorem environments, choose a different shell
for your document.

Creating Independent Numbering for Theorem Environments
You can number theorem environments independently of one another by modifying
nnewtheorem commands in the document preamble. By eliminating or varying the
counter_basis argument in the command, you can create a large variety of numbering
schemes for theorem environments.

I To number a theorem environment independently
1. From the Typeset menu, choose Preamble and click the mouse in the entry area.

2. Scroll through the commands to �nd the nnewtheorem statement for the environ-
ment whose numbering you want to change.
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3. Remove the [counter_basis] argument from the command.

4. Choose OK.

The [counter_basis] argument has been removed from these preamble state-
ments:
nnewtheorem{theorem}{Theorem}
nnewtheorem{algorithm}{Algorithm}
nnewtheorem{axiom}{Axiom}
nnewtheorem{condition}{Condition}
nnewtheorem{conjecture}{Conjecture}
nnewtheorem{corollary}{Corollary}

...
to cause the theorem-like environments to be numbered independently. Your document
might contain a series like this: Theorem 1, Theorem 2, Conjecture 1, Theorem 3, Con-
jecture 2, ....
You can create a scheme in which the numbering of one theorem environment is

restarted with each instance of a second environment. For example, you might restart
the lemma counter for each new theorem.

I To restart one theorem environment based on another theorem environment
1. From the Typeset menu, choose Preamble and click the mouse in the entry area.

2. Scroll through the commands to �nd the nnewtheorem statement for the environ-
ment whose numbering you want to restart.

3. Remove the [counter_basis] argument from the command.

4. Start a new line and add these statements:

nmakeatletter
n@addtoreset{restart environment}{reset basis}
nmakeatother
where restart environment is the counter of the theorem environment to be restarted
and reset basis is the counter of the environment that causes the restart.

5. Choose OK.

These preamble statements
nnewtheorem{theorem}{Theorem}

...
nnewtheorem{lemma}{Lemma}
nmake@letter
n@addtoreset{lemma}{theorem}
nmakeatother

...
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cause the lemma counter to be restarted for each new theorem, as in this series: Theorem
1, Lemma 1, Lemma 2, Theorem 2, Lemma 1, Lemma 2, Theorem 3, Lemma 1,....
Optionally, you can create a scheme in which one theorem environment is counted

inside another, such as lemmas within theorems. The inside environment has both the
number of the outside environment and its own number, which is restarted with each
new outside environment, as in Theorem 1, Lemma 1.1, Theorem 2, Lemma 2.1, Lemma
2.2,....

I To count one theorem environment inside another
1. From the Typeset menu, choose Preamble and click the mouse in the entry area.

2. Scroll to �nd the nnewtheorem statement for the inside environment.

3. Remove the [counter_basis] argument from the command.

4. Start a new line and add this statement:

nnumberwithin{inside environment}{outside environment}

5. Choose OK.

These preamble statements
nnewtheorem{theorem}{Theorem}

...
nnewtheorem{lemma}{Lemma}
nnumberwithin{lemma}{theorem}

...
cause lemmas to have both the theorem number and the number of the lemma.

Resetting Theorem Numbering For New Divisions
Instead of numbering theorem-like statements consecutively throughout your document,
you may want to reset the numbering to 1 for each new document division. You can
achieve this effect with an alternate form of the nnewtheorem command that bases
the numbering on a division counter instead of a theorem environment counter. The
command syntax is

nnewtheorem{counter}{counter_title}[numbered_within]

where counter is the environment to be counted (such as theorem, corollary, or lemma),
counter_title is the label for the environment, and numbered_within is the name of an
already de�ned counter, usually some divisional unit, such as part, chapter, or section.
The numbered_within argument determines when the counter is reset to 1 for this par-
ticular theorem environment. For example, the command

nnewtheorem{conjecture}{Conjecture}[chapter]

causes each new conjecture in your document to be labeled Conjecture and to be num-
bered in sequence by chapter. You might see numbers such as Conjecture 1.1, Conjec-
ture 1.2, Conjecture 2.1, ..., in which the �rst digit is the chapter number and the second
digit is the number of the conjecture within the chapter.
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I To reset the counter for a theorem environment
1. From the Typeset menu, choose Preamble and click the mouse in the entry area.

2. Scroll through the commands to �nd the nnewtheorem statement for the environ-
ment whose numbering you want to reset.

3. Remove the [counter_basis] argument from the command.

4. Add the [numbered_within] argument to the end of the command.

5. Choose OK.

Thus, if you want to reset the numbering for theorem-like environments at the begin-
ning of every chapter, your preamble might contain these lines:
nnewtheorem{theorem}{Theorem}[chapter]
nnewtheorem{algorithm}{Algorithm}[chapter]
nnewtheorem{axiom}{Axiom}[chapter]
nnewtheorem{condition}{Condition}[chapter]
nnewtheorem{conjecture}{Conjecture}[chapter]
nnewtheorem{corollary}{Corollary}[chapter]

...
and you might see a numbering series like this: Theorem 1.1, Theorem 1.2, Conjecture
1.1, Theorem 2.1, Conjecture 2.1, Theorem 2.2, ....

Changing Theorem Formatting

Many typesetting speci�cations set the content of theorem environments in italics, but
you can override the speci�cations and use upright fonts for theorems instead.

I To set theorems in upright fonts
1. Add the theorem package to your document.

2. From the Typeset menu, choose Preamble and click the mouse in the entry area.

3. If you want to set all theorem environments in an upright font, place the insertion
point on a new line at the beginning of the preamble, before any nnewtheorem
statements.

or

If you want to set a speci�c theorem environment in an upright font, place the inser-
tion point on a new line immediately before the nnewtheorem statement for that
environment.

4. If you want to change the font that LATEX uses for the header of the theorem environ-
ment, type ntheoremheaderfont{font} where font is the font family you want LATEX
to use. Because ntheoremheaderfont is a global setting, it changes the header
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font for all theorem-like environments in the document. The command should be
used only once. Values for font can be combined. Possible values for font are:

font Effect font Effect
nmdseries Medium Series nupshape Upright Shape
nbfseries Boldface Series nitshape Italic Shape
nrmfamily Roman Family nslshape Slanted Shape
nsffamily Sans Serif Family nscshape Small Caps Shape
nttfamily Typewriter Family nnormalfont Normal (document main

text font)

Not all combinations make sense and LaTeX compensates by placing a warning in
the .log �le and substituting a similar font.

5. If you want to change the font that LATEX uses for the body of the theorem environ-
ment, type ntheorembodyfont{font} where font is the font family you want LATEX
to use.

Use the command ntheorembodyfont{nupshape} to use upright text in the body of
a theorem.

Note that the font used for the body of a theorem-like environment can be restricted to
a single environment or a group of environments by enclosing the ntheorembodyfont
command and the nnewtheorem environments in a set of curly braces.

6. Choose OK.

Note These instructions pertain only to those documents for which theorem number-
ing schemes are de�ned in the document preamble.

Formatting Mathematical Expressions

Occasionally, long mathematical expressions create line-breaking problems. Instead of
surrounding an expression with a pair of expanding brackets, you may be able to create
more pleasing line breaks by placing TEX brackets at either end of the expression. The
brackets exist as independent objects; therefore, the program doesn't consider the entire
expression to be a single unbreakable unit as it does when you use expanding brackets.
You enter the brackets with bracket commands in TEX �elds at each end of the ex-

pression. The command has this syntax:

nSizeLocationSymboln

The Size element determines the height of the brackets. The choices are
� ordinary�the size of the ordinary bracket that you get when you press the bracket
key on the keyboard.

� big�just enough taller than ordinary so that the difference can be perceived.
� Big�50% taller than big.
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� bigg�twice as tall as big.
� Bigg�2.5 times as tall as big.
Since the brackets do not expand automatically, be sure to select a size that adequately
contains the entire expression.
The Location element determines how TEX handles the spacing before and after the

brackets. Telling the program whether the bracket occurs at the left or right end of an
expression is important. The available choices are
� l�left bracket.
� r�right bracket.
The Symbol element de�nes the kind of bracket you want. They must all be entered

as TEX macros:

Symbol Name Symbol Name
( left parenthesis nrangle right angle bracket
) right parenthesis / slash
[ or nlbrack left bracket nbackslash reverse slash
] or nrbrack right bracket j or nvert vertical bar
n{ or nlbrace left curly brace nj or nVert double vertical bar
n} or nrbrace right curly brace nuparrow upward arrow
nl�oor left �oor bracket nUparrow double upward arrow
nr�oor right �oor bracket ndownarrow downward arrow
nlceil left ceiling bracket nDownarrow double downward arrow
nrceil right ceiling bracket nupdownarrow up-and-down arrow
nlangle left angle bracket nUpdownarrow double up-and-down arrow

You don't have to use a left bracket symbol at the left end of the expression or a right
bracket symbol at the right end.

Thus, the command nBigl( yields
�
, and the command nBiggr] creates

#
, a

bracket over twice the size of the ] symbol on the keyboard.

I To use TEX brackets around an expression
1. Remove the expanding brackets from around the expression.

2. Place the insertion point at the beginning of the expression with the insertion point
in mathematics.

3. Enter a TEX �eld.

4. In the entry area, enter the command for the left bracket and choose OK.

5. Place the insertion point at the end of the expression with the insertion point in
mathematics.

6. Enter a TEX �eld.

7. In the entry area, enter the command for the right bracket and choose OK.

8. Typeset your document and examine the line breaks.
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Tailoring Graphics and Tables
The layout of graphics and tables depends on the typesetting speci�cations for your
document. By using LATEX packages and commands in your document, you may be
able to format captions, vary the layout, wrap text around graphics and tables, resolve
problems with certain kinds of graphics, and manage objects that are too wide for the
page. Graphics and tables that �oat sometimes require special attention, particularly if
they seem to prevent LATEX from compiling your document. TEX commands in the body
of your document can force LATEX to process all �oating objects so the document can
compile successfully.

Formatting Captions
If your document contains graphics and tables, you may want special formatting for the
captions or titles, especially if they contain mathematics. With the caption package (see
page 111), you can change the font attributes of the caption text for �oating objects. If
you let the graphics and tables �oat, you can also use the caption package to center a
multiline caption or title. (Captions and titles contained on a single line are automatically
centered.) You can insert a caption for multiple �gures with the sub�g package, as
explained on page 166, or using a �oating frame.
LATEX de�nes the space above and below the captions of �oating objects (both graph-

ics and tables) with the macros nabovecaptionskip and nbelowcaptionskip.
Many typesetting speci�cations use these macros, including sebase.cls, which de-
�nes each value as 10 pt. Although the Style Editor doesn't provide a method for chang-
ing these values, you can alter the space between �oating objects and their captions by
adding an external macro that is associated with the typesetting speci�cations for your
document. Alternatively, you can change the spacing for all �oating objects in a doc-
ument by modifying the document preamble, and you can change the spacing for an
individual �oating object by placing TEX commands before and after the object.
To avoid typesetting dif�culties, you must use correct LATEX commands to enter any

mathematics appearing in the caption for a �oating object, such as this:

The mathematics in the caption appears correctly because it is surrounded with LATEX
nprotect statements. You can adapt the process described in the instructions that
follow to include mathematics in any TEX �eld.
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I To include mathematics in the caption for a �oating table
1. Create the table:

a. Place the insertion point where you want the table to appear and enter the Table -
(4x3, �oating) fragment, which looks like this in your document:

b. Edit the number of rows and columns as necessary and replace the prede�ned cell
contents with the information you want.

c. Save your document.

2. Create the caption:

a. Open a new document using the Blank - Standard LaTeX Article shell.
b. In a new paragraph, enter the text of the table caption.
c. Apply the Section tag to the paragraph.
d. Save the document using the same �le type as for the document containing the
table.

e. Using an ASCII editor, open the new document and scroll to the caption.
The caption will begin with nsection, as in this example:
nsection{According to the rule $nsin ^{2}nprotectntheta

+ncos ^{2}nprotectntheta =1$}
f. Change the word section to caption.
g. Select both lines of the caption and copy them to the clipboard.

3. Place the caption in the table:

a. Return to the document containing the table.
b. Place the insertion point to the right of the Caption gray box and choose Proper-
ties.

c. Select the entire contents of the �eld.
d. Paste the contents of the clipboard into the �eld, and choose OK.

4. Save and typeset your document.

I To change the caption font attributes for a �oating object
1. Add the caption package to your document.

2. On the Typeset toolbar, click the Options and Packages button or, from the
Typeset menu, choose Options and Packages.
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3. Choose the Package Options tab.

4. In the Packages in Use box, select caption, and then chooseModify.

5. If you're using Version 5.5,

a. In the Category box, choose the font attribute category you want to change:
Category Controls font attributes for
Caption and label font attributes Both caption and label of �oating object
Caption font attributes Caption of �oating object
Label font attributes Label of �oating object

b. In the Options box, select the font size you want and choose OK.

or

If you're using an earlier version,

a. In the Category box, choose Caption font size.
b. In the Options box, select the font size you want.
c. In the Category box, choose Caption label attribute.
d. In the Options box, choose the font attribute you want.
e. Choose OK to close the dialog boxes and return to your document.

I To center a multiline caption for a �oating object
1. Add the caption package to your document.

2. On the Typeset toolbar, click the Options and Packages button or, from the
Typeset menu, choose Options and Packages.

3. Choose the Package Options tab.

4. In the Packages in Use box, select caption and then chooseModify.

5. In the Category box, choose Caption justi�cation.

If you're using Version 3.5, choose Alignment.

6. In the Options box, choose Centered.

7. Choose OK to close the dialog boxes and return to your document.

I To apply a single caption to multiple �gures
1. Enter a �oating frame:

a. Place the insertion point where you want the �gures to appear.
b. Insert the Table - (4x3, �oating) fragment.
c. Replace the table in the fragment with a new table that contains a cell for each
�gure to which you want to apply the caption.
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2. Insert the �gures:

a. Place a �gure in each cell of the new table.
b. For each �gure:
i Select the �gure and choose Properties.
ii Select the Layout tab.
iii In the Placement section, choose In Line.
iv Choose OK.

3. Create the caption:

a. Select the gray box marked caption.
b. In TeX Field dialog box, replace the words Table Caption with the caption
you want all the �gures to share.

c. Choose OK.

4. If you want the �gures to be labeled as Figure x instead of Table x,

a. Select the gray button labeled B and choose Properties.
b. Change the contents of the TEX �eld from nbegin{table}[tbp] ncentering
to nbegin{�gure}[tbp] ncentering.

c. Choose OK.
d. Select the gray button labeled E and choose Properties.
e. Change the contents of the TEX �eld from nend{table} to nend{�gure}.
f. Choose OK.

5. If you want individual captions in addition to the single caption created in step 3, for
each �gure,

a. Select the �gure and choose Properties and select the Labeling tab.
b. In the Caption Text box, enter the caption for the selected �gure.
c. Choose OK.

You may need to add space or additional table cells before or after the caption to
achieve the typeset appearance you want.

I To change the caption spacing for all �oating objects in a document
1. Open your document.

2. From the Typeset menu, choose Preamble and click the mouse in the entry area.

3. Enter these lines:

nsetlength{nabovecaptionskip}{0pt}
nsetlength{nbelowcaptionskip}{0pt}

4. Choose OK.

You may need to experiment with the values in the commands to achieve the spacing
you want.
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I To change the caption spacing for an individual �oating object
1. Place the insertion point at the end of the line before the �oating object and press
ENTER.

2. Enter a TEX �eld.

3. In the entry area, type

nsetlength{nabovecaptionskip}{0pt}
nsetlength{nbelowcaptionskip}{0pt}

4. Choose OK.

You may need to experiment with the values in the commands to achieve the spacing
you want.

5. To restore the default values, place the insertion point on the line after the �oating
object and press ENTER.

6. Enter a TEX �eld.

7. In the entry area, type

nsetlength{nabovecaptionskip}{10pt}
nsetlength{nbelowcaptionskip}{10pt}

8. Choose OK.

Wrapping Text Around Graphics and Tables

Pi

Wrapping text around graphics and tables adds interest to the appearance of a docu-
ment. You can wrap text around objects at the side of the page with the wrap�g
package. The package creates an arti�cial �oating environment, so the graph-
ics and tables can carry captions that appear in the text and the list of graph-
ics. Suppose you want to wrap text around a graphic with a caption, as we do here.
We have placed the graphic on the inside edge of the page, with no overhang into the
margin. We've wrapped four lines of text around the graphic, allowing room for both
the graphic and the caption. To create this effect, we followed the instructions on the
next page, using this command in an encapsulated TEX �eld to de�ne the placement:
nbegin{wrapfigure}[4]{i}[0pt]{0pt}.

Choose To
Typeset/Print Print with LATEX
File/Print Print without LATEX

In this paragraph, we've again used the wrap�g
package to place a small table on the outside edge of
the page, this time with an overhang of about half an
inch into the margin. We've wrapped �ve lines around
the table and have omitted both a table title and the

space for one. We used this command in an encapsulated TEX �eld to de�ne the place-
ment: nbegin{wraptable}[5]{o}[35pt]{0pt}.
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Another package, picins (see page 149), provides precise control over the placement
of inline graphics, but doesn't support inline tables.

I To wrap text around a �oating object
1. Add the wrap�g package to your document.

2. Place the insertion point where you want to insert the �oating object.

3. Begin the wrap�gure or wraptable environment:

a. Enter an encapsulated TEX �eld and in the entry area, type
nbegin{wrap�gure}[w]{x}[y]{z} or nbegin{wraptable}[w]{x}[y]{z}
where

w is the number of vertical lines to be narrowed to accommodate the graphic
or table (optional).
x is the placement of the graphic or table (required). Uppercase indicates

�oat; lowercase indicates exactly here:
Position Effect
r or R Right side of text
l or L Left side of text
i or I Inside edge, near the binding (two-sided documents)
o or O Outside edge, away from the binding (two-sided documents)

y is the amount of overhang�the distance the graphic or table should extend
into the margin (optional).
z is the width of the graphic or table (required). If you specify a width

of zero (0pt), the package uses the actual width of the graphic or table to
determine the wrapping width.

b. Choose OK.

4. Insert the inline object.

5. If you want the object to have a caption or title,

a. Enter an encapsulated TEX �eld.
b. In the entry area, type ncaption{text} where text is the caption or title you want,
and choose OK.

6. End the wrap�gure or wraptable environment:

a. Enter an encapsulated TEX �eld.
b. In the entry area, type nend{wrap�gure} or nend{wraptable}, and choose OK.

If your document combines both objects wrapped around text and objects that �oat,
LATEX may not sequence both kinds of objects correctly, although the graphic or table
numbers will be correct. You may be able to correct the situation by adding the �oat
package and revising each regular �oating object�but not the wrap�gure or wraptable
objects�to specify the Here placement option. See page 127 for more information about
the �oat package.
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Managing EPS Graphics in DVI Files
Documents containing Encapsulated PostScript (EPS) graphics can appear incorrectly
typeset in DVI �les because the PostScript �lter supplied with the program occasionally
misrenders the graphics. Letters that appear in the graphics may be displaced, or the
appearance of the graphic may be incorrect. You can bypass the problem using the
graphicx package. This problem doesn't occur with typeset PDF �les.
The graphicx package (see page 131) has options for several different typeset output

drivers. When the driver option is unchanged, LATEX typesets your document using the
default driver for the current LATEX installation. For SWP and SW installations, the
default driver is tcidvi, which uses the supplied graphics �lter. Thus, the graphics can
be misrendered. However, if you actively choose the dvips driver option, which is the
default driver for typical LATEX installations, LATEX uses the native PostScript capabilities
for the current display device. Thus, when you typeset, the graphic appears on the
TrueTEX Previewer screen as a box containing the path name of the EPS �le, but it
appears in print correctly using the PostScript interpreter in the printer.

I To bypass dif�culties with EPS graphics in DVI �les
1. Add the graphicx package to your document.

2. Save the document as a Portable LATEX �le.

3. On the Typeset toolbar, click or, from the Typeset menu, choose Options
and Packages.

4. Choose the Package Options tab.

5. In the Packages in Use box, select graphicx, and then chooseModify.

6. In the Options box, select dvips.

7. Choose OK to close the dialog boxes and return to your document.

If your document is a Style Editor document or a LATEX 2.09 document, it can't be
saved as a Portable LATEX �le. However, you can import the contents of your document
into a new document, modi�ed as described above, and successfully bypass the EPS
dif�culty.

Formatting Tables
Although the typesetting speci�cations automatically create space between the rows of
tables in your documents, you can change the distance between rows for a single table,
a group of tables, or all tables in the document.

I To change the distance between rows for a single table
1. Place the insertion point immediately before the table.

2. Insert a TEX �eld.
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3. In the TeX Field window, enter nrenewcommand{narraystretch}{x} where x is the
factor by which you want to multiply the default distance between the rows.

For example, the command nrenewcommand{narraystretch}{1.5}will in-
crease the distance between the rows by 50%.

4. Choose OK.

5. Place the insertion point immediately after the table and insert another TEX �eld.

6. In the TeX Field window, enter nrenewcommand{narraystretch}{1} to return to
the default.

7. Choose OK.

You can apply the spacing factor to several subsequent tables by placing the �rst TEX
�eld before the �rst table in the series and the second one after the last table in the series.

I To change the distance between table rows for the entire document
1. From the Typeset menu, choose Preamble and click the mouse in the entry area.

2. In the entry area, enter nrenewcommand{narraystretch}{x} where x is the factor
by which you want to multiply the default distance between the rows for all tables in
the document.

3. Choose OK.

Creating Landscaped Objects
If a table is too wide for portrait orientation, you can place it on a landscaped page using
the portland package as described on page 14. Remember that you may need to change
the printer settings to print landscape pages properly. You may also need to print any
landscaped pages in a separate printing run.
Alternatively, you can orient pages differently with one of the packages, such as

lscape (page 139) or rotating (page 156), that rotate text. Note that packages that
use rotation aren't compatible with the TrueTEX Previewer provided with SWP and
SW. Therefore, to produce a DVI �le that uses one of these packages, you must use a
DVI previewer and print driver that also support text rotation. PDF viewers do support
rotation, so you can successfully use the packages to rotate text in typeset PDF �les.
The rotating package implements several environments within which you can rotate

graphics or tables by an arbitrary number of degrees. You enter the environments as
commands in encapsulated TEX �elds, one to begin and another to end the environment.
The graphic or table to be rotated sits between the two.

I To rotate an inline graphic or table
1. Add the rotating package to your document.

2. Place the insertion point where you want the rotation to begin and begin the rotation
environment:
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a. Enter an encapsulated TEX �eld.
b. In the entry area, type nbegin{environment}{x)where environment is one of these
commands:
environment Effect
sideways Turn the contents of the environment 90 degrees
turn Turn the contents of the environment an arbitrary number of

degrees
rotate Turn the contents of the environment an arbitrary number of

degrees (space for the results may not be created)
and x is the number of degrees to be rotated. When x is positive, the rotation is
counterclockwise; when negative, clockwise. The sideways command doesn't
require the degree argument.

c. Choose OK.

3. Enter the graphic or table to be rotated.

4. End the rotation environment:

a. Enter an encapsulated TEX �eld.
b. In the entry area, type nend{environment} where environment is the rotation en-
vironment.

c. Choose OK.

I To rotate a �oating graphic or table
1. Add the rotating package to your document.

2. Place the insertion point where you want the rotation to begin and begin the rotation
environment:

a. Enter an encapsulated TEX �eld.
b. Type nbegin{sideways�gure}ncentering or nbegin{sidewaystable}ncentering.
c. Choose OK.

3. Enter an inline graphic or table.

4. If you want a caption,

a. Enter an encapsulated TEX �eld and in the entry area, type ncaption{text} where
text is the caption for the graphic or table.

b. Choose OK.

5. If you want to add cross-references to the object, enter a marker.

6. End the rotation environment:

a. Enter an encapsulated TEX �eld.
b. Type nend{sideways�gure} or nend{sidewaystable} and choose OK.
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Managing Floating Objects

Documents that contain many �oating objects may occasionally encounter LATEX process-
ing problems. When you typeset your document, LATEX tries to process �oating objects
as it encounters them, anchoring them throughout the document. However, if it can't
place an object because of its size or if �oat placement options don't �t, LATEX will hold
the �oating object, and all following �oating objects, until the end of the document and
then generate the error �Too many unprocessed �oats.� You can force LATEX to process
�oating objects with a TEX command in the body of your document. Also, if you're not
creating a Portable LATEX or PDF �le, you can use the �oat package (see page 127) to
manage the placement of �oating objects. Finally, you can add the placeins package
(see page 7) to create barriers in your document beyond which �oating objects can't be
typeset.

I To force the output of �oating objects
1. Place the insertion point in an appropriate location in your document, such as the end
of a chapter or section.

Because forcing the output will end the page, you may have to experiment to �nd
the best location for the TEX command. See page 96 for information about using the
afterpage package, which offers more �exibility in the placement of the TEX �eld.

2. Enter a TEX �eld.

3. In the entry area, type nclearpage and choose OK.
When LATEX encounters this command as it typesets your document, it outputs any
�oating objects that occur in the document before the command.

If you add the �oat package to a document and select only the here placement option
for a �oating graphic, the program automatically uses the H placement option. (This
option isn't available if you are using the Portable LATEX �lter.)

I To manage the output of �oating objects
1. Add the �oat package to your document.

2. Revise the properties of all �oating graphics to select only the here option.

3. Revise the properties of all tables that �oat:

Remember that a table that �oats is implemented with the fragment Table - (4x3,
�oating), which has this structure:
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a. Select the TEX �eld named [B] and choose Properties.
The program opens the �eld, which contains the string
nbegin{table}[tbp]ncentering.

b. Change [tbp] to [H].
c. Choose OK.

I To prevent �oating objects from appearing in the next section
1. Add the placeins package to your document.

2. On the Typeset toolbar, click the Options and Packages button or, from the
Typeset menu, choose Options and Packages and then choose the Package Op-
tions tab.

3. Select the placeins package from the Packages in Use list and chooseModify.

4. In the Category list, select Barrier at section and, in the Options list, select Yes.

5. Choose OK to close each dialog box and return to your document.

I To prevent a �oating object from appearing after a designated point
1. Add the placeins package to your document.

2. Position the insertion point where you want accumulated �oating objects to appear.

3. Enter an encapsulated TEX �eld.

4. In the entry area, type nFloatBarrier.

5. Choose OK.

Making Additional Typesetting Changes

Your typesetting tasks may differ from those discussed in this chapter. The table begin-
ning on the next page identi�es many additional tasks and suggests packages that can
help you accomplish them. Most of these packages work with most SWP and SW doc-
uments; that is, the documents will compile successfully. However, you may not be able
to preview the document with TrueTEX. See Chapter 3 �Using LATEX Packages� for more
information.
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To Use Package
Acronyms
- Create a list of acronyms. Acronym
- Ensure that all acronyms are spelled out at least once. Acronym
Additions and Deletions
- Mark additions and deletions to text (legislative format). Ulem
Algorithms
- Prevent algorithm statements from breaking over page bound-
aries.

Algorithm

- Create a list of algorithms on the table of contents page. Algorithm
- Include complex algorithm statements in documents. Algorithmic
AMS Documents
- Produce documents for publication in AMS journals. AMSMath,

AMSFonts
APA Documents
- Format citations according to APA requirements. Apacite
- Produce documents meeting requirements of APA Publication
Manual.

Apalike, Apalike-
plus

Arrays
- Format columns. Array
- Align numbers on decimal point in tabular or array columns. Dcolumn
Bibliographies
- Indicate references in citations and reference lists with labels
instead of numbers.

Drftcite

- Find uncited bibliography items. Drftcite
- Print the key for each bibliography item in the margin of the
page on which it occurs.

Showkeys

- Produce bibliography entries acceptable to APA journal style. Apalike, Apalike-
plus

- Improve bibliography spacing in a 2-column document. Bibmods
- Automatically include the bibliography in the table of contents. Tocbibind
BIBTeX Bibliographies
- Produce BIBTEX bibliographies formatted according to The
Chicago Manual of Style, Ed. 13.

Chicago

- Format documents for astronomy journals. Astron
- Customize citations for seven BIBTEX bibliography styles. Harvard
- Required with BIBTEX bibliography style newapa.bst. Newapa
- Produce BIBTEX bibliographies with four varieties of author-
date citations.

Authordate1-4

- Create separate BIBTEX bibliographies for each included �le
and for the document as a whole.

Chapterbib
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To Use Package
Boxes
- Create a boxed area on the page. Boxedminipage
- Place boxes around content. Fancybox
- Create simple bar charts. Bar
Captions
- Rotate a �gure or table caption. Rotating
- Customize width, alignment, style, and font of captions for
�oating objects, including objects presented in landscape.

Caption

- Place captions to the right or left of �oating graphics or ta-
bles.

Sidecap

Changes to Text
- Mark additions and deletions to text (legislative format). Ulem
Citations
- Compress and order inline or superscripted lists of numerical
citations to show a range of numbers.

Cite

- Format citations according to APA requirements. Apacite
- Indicate references in citations and reference lists with labels
instead of numbers.

Drftcite

Color
- When the installed dvi driver supports color, produces boxes
or entire pages with colored backgrounds.

Color

Columns
- Improve bibliography spacing in a 2-column document. Bibmods
- Format text in up to 10 columns. Multicol
- In multi-column documents, balance the �nal columns of text
for an attractive appearance.

Multicol

- In 2-column documents, save marks from �rst column. Fix2col
- Align text in two columns or on facing pages. Parallel
Comments
- Include material that may or may not be typeset. Version
Crop Marks
- Print crop marks. Crop
Cross-references
- Print the key for each cross-reference in the margin of the
page on which it occurs.

Showkeys

- Create cross-references to labels outside the document. Xr
Deletions and Additions
- Mark additions and deletions to text (legislative format). Ulem
Double-sided Printing
- Specify margin offsets for two-sided printing. Geometry
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To Use Package
Double Spacing
- Specify double spacing. Setspace
Endnotes
- Create end notes instead of footnotes. Endnotes
Equations
- Enhance the typeset appearance of displayed equations, sub-
and superscripts, and other mathematical constructs.

AMSMath

- Change placement of equation numbers and tags. AMSMath
- Change placement of equations in displayed mathematics. AMSMath
Exam Questions
- Print point value of questions in margin. Newpnts, Points
Exercises
- Bind a solution to its exercise. Answers
Figures and Graphics (see also Floating Objects)
- Rotate a graphic. Rotating
- Include graphics in documents. Graphicx
- Produce small graphics in larger �oating graphics or tables. Sub�g
- Wrap text around graphics. Wrap�g, Picins
- Produce simple commutative diagrams. AMSCD
- Produce simple bar charts. Bar
Floating Objects
- Place �oating elements on the next page output. Afterpage
- In 2-column documents, keep �oating elements in sequence. Fix2col
- Ensure that a �oating element appears in print only after ref-
erence to it.

Flafter

- Produce small graphics and tables within larger �oating ta-
bles and graphics.

Sub�g

- De�ne �oating objects. Float
- Create a point past which a �oating object must not be type-
set.

Placeins

Fonts
- Scale a font up or down. Scalefnt, Relsize
- Substitute PostScript fonts. PSNFSS
- Use the Times font for text but leave mathematics in CM
fonts.

PSNFSS

- Insert symbol fonts for Blackboard bold, Fraktur. AMSFonts,
AMSSymb

- Change uppercase text to lowercase, or lowercase to upper-
case, leaving certain LATEX elements unchanged.

Textcase

- Sample the appearance of a font family. Fontsmpl
- Read and write verbatim TEX code. Fancyvrb
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To Use Package
Fonts for Mathematics
- Use the AMS Euler fonts in mathematics. Euler
- Use Times fonts for text and mathematics and to provide lig-
atures and improved kerning.

Mathtime

- Insert AMS symbol fonts for Blackboard bold and Fraktur. AMSFonts
- Use large symbols. Exscale
- Use 11 symbols not normally available: 0 1 2 3 ;<= C

E B D.
Latexsym

- Use Feynman slashed character notation. Slashed
Footnotes
- Place footnotes in tables. Blkarray
- Customize the appearance of footnotes. Footmisc
- In 2-column documents, print all footnotes at foot of right-
hand column.

Ftnright

- Create end notes instead of footnotes. Endnotes
- Create independent series of footnotes. Manyfoot
Headers and Footers
- Customize content and format of headers and footers. Fancyhdr
- Specify headers and footers. Geometry
- In 2-column documents, save marks from �rst column. Fix2col
Headings
- Modify the appearance of division headings. Sectsty, Titlesec,

Fncychap
Hypertext Links
- Make cross-references into hypertext links for PDF output. Hyperref
Hyphenation
- Handle hyphenation, punctuation, and other language-
speci�c issues for non-English documents.

Babel

- Disable hyphenation in selected parts of a document. Hyphenat
Indention
- Indent the �rst line of all sections. Indent�rst
Indexes
- Create a document index. Makeidx
- Print index commands in the margin of the page on which
they occur.

Showidx

- Automatically include the index in the table of contents. Tocbibind
Justi�cation
- Create less ragged justi�cation. Ragged2e
Labels
- Print the key for each label in the margin of the page on which
it occurs.

Showkeys

- Print all keys and markers in the margin of the page on which
they occur.

Showlabels
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To Use Package
LATEX
- Format LATEX counters with a separator every three digits. Comma
- Prevent counters from being reset. Remreset
- In 2-column documents, save marks from �rst column. Fix2col
Legislative Format
- Mark additions and deletions to text (legislative format). Ulem
Limit Placement
- Change placement of limits for integrals, operators, summa-
tions, and other symbols.

AMSMath

Line Breaks
- Break path statements, URLs, and email addresses for better
line breaks.

Url

Line Numbers
- Add line numbers to paragraphs. Lineno
Line Spacing
- Produce double, single, or one-and-a-half spacing. Setspace
List of Figures/List of Tables
- Automatically include the list of �gures and list of tables in
the table of contents.

Tocbibind

- Create a table of contents, list of �gures, and list of tables for
major document divisions.

Minitoc

- Modify the appearance of the table of contents, list of �gures,
and list of tables.

Titletoc, Tocloft

List of Symbols
- Create a nomenclature list. Nomencl
Lists
- Change spacing for list items. Paralist
Lowercase Text
- Change uppercase text to lowercase, leaving certain LATEX
elements unchanged.

Textcase

Margins
- Customize margins. Geometry
Mathematics
- Enhance the typeset appearance of displayed equations, sub-
and superscripts, and other mathematical constructs.

AMSMath

- Create non-standard mathematical accents. Accents
Non-English Documents
- Manage language-speci�c issues for non-English documents. Babel
Numbered Lists
- Change the style of the counter for numbered lists. Enumerate
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To Use Package
Page Breaks
- Break tables between pages. Xtab
Page Layout
- Customize page layout (margins, orientation, paper size,
headers, footers, etc.).

Geometry

- Draw an illustration of the LATEX layout of the current docu-
ment.

Layout

Page Numbers
- Remove page numbers from opening and other pages. Nopageno
Page Orientation
- Rotate content. Fancybox
- Rotate parts of a page. Graphicx
- Rotate text 90 degrees. Lscape
- Change page orientation (portrait, landscape). Geometry
Page References
- Print the key for each page reference in the margin of the
page on which it occurs.

Showkeys

- Automatically enhance page references with text such as �on
the next page� or �on the facing page�.

Varioref

- Create page references to labels outside the current docu-
ment.

Xr

Paper Size
- Change paper size. Geometry
Plots and Diagrams
- Produce simple bar charts. Bar
- Produce simple commutative diagrams. AMSCD
Punctuation
- Manage punctuation and other language-speci�c issues for
non-English documents.

Babel

Scaling
- Scale parts of a page. Graphicx
Strikethroughs
- Strike through text with lines or slashes. Ulem
Symbols
- Use large symbols. Exscale
- De�ne the lambdabar � and other symbols. Revsymb
- Display characters properly in ASCII editors. Inputenc
- Use 11 symbols not normally available: 0 1 2 3 ;<= C

E B D.
Latexsym

- Use Feynman slashed character notation. Slashed
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To Use Package
Table of Contents
- Automatically include front and back matter in the table of
contents.

Tocbibind

- Create a table of contents, list of �gures, and list of tables for
major document divisions.

Minitoc

- Modify the appearance of the table of contents, list of �gures,
and list of tables.

Titletoc, Tocloft

Tables (see also Floating Objects)
- Rotate a table. Rotating
- Change table headings on last page. Xtab
- Control horizontal lines in tables. Hhline
- Create environments similar to array and tabular. Blkarray
- Break long tables between pages. Longtable
- Create footnotes in tables. Longtable
- Produce colored backgrounds and rules for table columns
and rows.

Colortbl

- Align numbers on decimal point in tabular or array columns. Dcolumn
- Create tables longer than one page. Ltxtable
- Rotate text 90 degrees. Lscape
- Produce small tables within larger �oating tables or graphics. Sub�g
- Create tables longer than a page. Supertabular
- Create a table with a speci�ed width. Tabularx
- Break tables between pages. Xtab
- Wrap text around �oating tables at the side of the page. Wrap�g
- Format columns in tabular environments. Array
Theorems
- Customize the appearance of theorem and theorem-like envi-
ronments.

Theorem

Underlining
- Underline text with single, double, or wavy lines. Ulem
Uppercase Text
- Change lowercase text to uppercase, leaving certain LATEX
elements unchanged.

Textcase

Verbatim Representations
- Include programming and other verbatim statements in doc-
uments.

Alltt

- Display information exactly as it is entered at a terminal. Verbatim
- Read and write verbatim TEX code. Fancyvrb
Wrapped Text
- Wrap text around �oating elements at the side of the page. Wrap�g, Picins





2 Working with Typesetting
Speci�cations and Document
Shells

Every SWP and SW document is created from a template called a document shell. Each
shell carries several sets of speci�cations that determine its fundamental structure and
appearance. Those speci�cations, and the structure and appearance they de�ne, extend
to each new document you create with a given shell.
One set of speci�cations consist of page setup speci�cations, print options, and a

style �le with a .cst extension. These speci�cations determine the appearance of the
shell (and any documents created with the shell) when you preview or print it without
typesetting or when you display it in the document window. These speci�cations have
no effect on the typeset appearance of your document and they aren't our focus here.
The other set�the typesetting speci�cations�determines the appearance of the shell

(and any documents created with the shell) when you typeset preview or typeset print it.
These speci�cations have no effect on the appearance of your document in the document
window or when you preview or print without typesetting. The typesetting speci�cations
govern all aspects of the typeset appearance of your document, and they are our primary
concern.
In this chapter we discuss several kinds of typesetting speci�cations and their role

in the creation and typesetting of SWP and SW documents. We explain how to mod-
ify the typesetting speci�cations from within your SWP or SW document and how
to choose an appropriate shell for your work so that extensive modi�cation of typeset-
ting speci�cations is minimized. The chapter also explains how to open and work with
LATEX documents not created with SWP or SW, and how to install and use typesetting
speci�cations obtained from an outside source, such as a publisher.

Note Before Version 3.5, we used the word style to refer to the typesetting speci�ca-
tions. In newer versions of LATEX, the document style has been renamed the document
class. We now use the word style to refer to the .cst �le and not to the typesetting
speci�cations.

Working with Typesetting Speci�cations

The typesetting speci�cations establish an essential characteristic of any shell�the LATEX
document class, which determines the kind of document the shell will produce. A shell's
typesetting speci�cations may also call LATEX packages�sets of additional typesetting
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instructions that provide a particular typesetting capability, such as the creation of an
index or the production of endnotes. Class and package speci�cations are contained
in separate LATEX formatting �les with extensions of .cls, .clo, and .sty. Individ-
ual typesetting instructions may also be contained in TEX and LATEX commands in your
document. Taken together, this collection of speci�cations governs type face; type size;
margins; page size; line spacing; location and appearance of headers, footers, and di-
vision headings; title pages; paragraph layout; indention; page breaks; automatic gen-
eration of cross-references, tables of contents, and other document elements; and other
typographic details too numerous to mention. Regardless of whether you typeset to cre-
ate a DVI �le or, in Version 5, a PDF �le, this collection of speci�cations completely
controls the typeset appearance of your document.
LATEX documents de�ne the typesetting speci�cations in a mandatory section at the

beginning of the document �le, called the preamble. Beginning with a ndocumentclass
command and, optionally, one or more nusepackage commands, the preamble names
the .cls, .clo, and .sty �les required by the document. (Note that those �les may in
turn call other �les, which are not named in the preamble.) It may also contain TEX
and LATEX commands that control speci�c aspects of typesetting behavior. Following
the preamble is a nbegin{document} command that signals the body of your docu-
ment. If there is front matter such as a title page or table of contents, it precedes the text
of the document; if there is back matter such as an appendix or index, it follows it. The
�le closes with an nend{document} command.
Most LATEX document �les follow this structure, and �les created with SWP and

SW are no exception. Whenever you open a new document, the program automatically
creates a preamble, which de�nes the typesetting speci�cations for your document by
naming the .cls, .clo, and .sty �les as speci�ed in the shell. If you save your �le as an
SWP/SW document (using the SWP/SW/SN Document (*.tex) option), the program
also inserts at the end of the preamble the command ninput{tcilatex}, which calls
a special set of macros. The program automatically places nbegin{document} and
nend{document} commands around the body of your document. You can see the
entire structure of an SWP/SW document if you open the .tex �le for the document
using an ASCII editor.
When your document is open in SWP or SW, you can examine the speci�ed docu-

ment class and packages as described on pages 67 and 74. You can examine the remain-
der of the preamble from the Preamble command on the Typeset menu.

I To examine the preamble
1. From the Typeset menu, choose Preamble.

2. If you're using Version 4.1 or earlier, click the mouse in the entry area.

Caution If you begin typing without �rst clicking in the area, you will overwrite
any commands already in the preamble. Choose Cancel to leave the preamble un-
changed.

3. Choose OK to return to the body of the document.
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LATEX Document Classes
The document class named in the typesetting speci�cations determines the basic struc-
ture of the shell and of any documents you create with it. The class speci�es the kind
of document to be produced and de�nes its general structure as a book, report, article,
or other kind of document. The class also determines the elements, environments, and
constructs allowed in the document. Document class �les have an extension of .cls.
About half of the 150 or so shells provided with SWP and SW have standard LATEX

base classes; they are created with book.cls, report.cls, or article.cls. Al-
though many of the other shells produce similar kinds of documents, they have different,
more specialized base classes, as we see with the shells that produce articles formatted
for a speci�c journal or theses formatted to meet the requirements of a particular univer-
sity.
The rest of the shells have the base class sebase; they were developed with the

Style Editor. Using the Style Editor itself to modify Style Editor typesetting speci�ca-
tions is usually more ef�cient than working from within SWP or SW. The typesetting
techniques we suggest in this manual don't necessarily apply to Style Editor shells or to
the documents created with them. You can easily determine the document class for any
document.

I To determine the document class for a document

1. On the Typeset toolbar, choose the Options and Packages button or, from the
Typeset menu, choose Options and Packages.

2. Choose the Class Options tab.

The �rst line of information indicates the class; in this example, the class is article:

3. Choose OK to return to the document.

Using LATEX Class Options
Although the document class de�nes a shell document in broad typesetting terms, LATEX
needs additional typesetting instructions to format a document completely. Some of
these instructions come from document class options, a collection of formatting instruc-
tions that de�ne typesetting in more detail. The options can control body text font size,
page orientation, number of text columns, print quality, page size, and many other as-
pects of document design and typesetting.
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Default Class Options
Usually, each class option has several available settings, one of which has been selected
as the default, such as 10 point for the body text font size or portrait for the page orienta-
tion. The options and their corresponding defaults differ from class to class. The default
settings for the three LATEX base document classes�article, book, and report�appear
below. The class option defaults are in effect unless otherwise noted in the shell.

Class Option Defaults for article.cls
Category Default Options
Body text point size 10 pt 11 pt, 12 pt
Paper size 8.5x11 a4, a5, b5, Legal size, Executive size
Orientation Portrait Landscape
Print side One side Both sides
Quality Final Draft
Title page No title page (Title Title page

area on page 1)
Columns One Two
Equation numbering On right On left
Displayed equations Centered Flush left
Bibliography style Compressed Open

Class Option Defaults for book.cls
Category Default Options
Body text point size 10 pt 11 pt, 12 pt
Paper size 8.5x11 a4, a5, b5, Legal size, Executive size
Orientation Portrait Landscape
Print side Both sides One side
Quality Final Draft
Title page Title page No title page
Columns One Two
Start chapter on left No Yes
Equation numbering On right On left
Displayed equations Centered Flush left
Open bibliography style Compressed Open

Class Option Defaults for report.cls
Category Default Options
Body text point size 10 pt 11 pt, 12 pt
Paper size 8.5x11 a4, a5, b5, Legal size, Executive size
Orientation Portrait Landscape
Print side One side Both sides
Quality Final Draft
Title page Title page No title page
Columns One Two
Start chapter on left Yes No
Equation numbering On right On left
Displayed equations Centered Flush left
Open bibliography style Compressed Open
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The option settings differ from shell to shell. If you're using a shell based on a
customized document class, the default categories and the corresponding options may
differ. You can learn which document class options are in effect for a particular shell.

I To examine the class option defaults for a shell
1. Open a document created with the shell.

2. On the Typeset toolbar, choose the Options and Packages button or, from the
Typeset menu, choose Options and Packages.

3. Choose the Class Options tab.

If settings other than the document class defaults are in place, the program displays
them in the Options box, like this:

In this example, three options use settings different from the defaults: body text font
size (12pt), paper size (a4paper), and title page (titlepage).

4. Choose OK to return to your document.

Default Page Layouts
The following page layout images for the LATEX article, book, and report document
classes re�ect the standard defaults for those classes. The keyed notes provide infor-
mation about the size of the margins, headers, footers, text area, and margin notes, if
any. Most measurements are given in points; a point is 1

72 inch.
If your document uses different class option settings, these page layouts may not

apply. For example, if a document uses A4 paper instead of 8.5x11 or two columns
instead of one, the margins differ from those shown in these diagrams. You may want to
add the layout package to your document to generate a page layout diagram (see page
137).
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1 one inch + \hoffset 2 one inch + \voffset
3 \oddsidemargin = 62pt 4 \topmargin = 16pt
5 \headheight = 12pt 6 \headsep = 25pt
7 \textheight = 550pt 8 \textwidth = 345pt
9 \marginparsep = 11pt 10 \marginparwidth = 65pt

11 \footskip = 30pt \marginparpush = 5pt (not shown)
\hoffset = 0pt \voffset = 0pt
\paperwidth = 614pt \paperheight = 794pt

Default page layout for article.cls
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\paperwidth = 614pt \paperheight = 794pt

Default page layout for report.cls
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Modifying the Document Class Options
You can override the class option defaults set by the shell. As noted in Chapter 1 �Tai-
loring Typesetting to Your Needs,� modifying the class options may be the easiest way
to make the typesetting changes you need. The modi�cation process is fast and easily
reversed if it doesn't have the effect you want. If the shell you choose produces the type-
setting results you want except, perhaps, for the body text font size or the size of the
paper, try modifying the class options before you attempt more complex modi�cations.
We urge you not to modify the shell itself, but rather to save any modi�cations in a new
shell, as explained on page 84.
If no options are listed when you try to modify the document class, you can go native,

or add LATEX commands to force the program to use a given option. When you typeset
your document, the program passes the information directly to LATEX or PDFLATEX. Thus,
you must be careful to enter commands using correct syntax to prevent LATEX errors. If
you enter incorrect commands, LATEX may not be able to typeset your document and you
can damage your document beyond repair. We strongly encourage you to save a copy of
your document before you attempt any of the modi�cations suggested here.

Note Be careful to enter commands correctly. Incorrect commands can cause LATEX
to fail and may damage your document permanently.

I To modify the class options

1. On the Typeset toolbar, click the Options and Packages button or, from the
Typeset menu, choose Options and Packages.

2. Choose the Class Options tab.

3. ChooseModify.

4. In the Category box, scroll the list to select the category you want to modify.

5. In the Options box, select the option you want and then choose OK.

6. If you want to add class options that aren't listed, choose Go Native, enter the com-
mand for the option you want, and choose OK.

7. Choose OK to return to your document.

8. Save your document and typeset preview it.

LATEX interprets the class options according to the typesetting instructions in the .cls
�le for the document class. Some class options can take precedence over other instruc-
tions, such as those speci�ed in packages; other class options may be ignored when
certain packages are in use. In other words, although you may specify certain class
option settings, LATEX may ignore them. Document classes and packages don't always
interact smoothly. If you're making extensive modi�cations, you may �nd that you must
proceed by trial and error as you experiment with the various sets of speci�cations and
learn how they interact.
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LATEX Packages
The document class speci�cations establish a basic set of typesetting instructions. LATEX
packages�sets of additional typesetting instructions�extend typesetting instructions
by enabling some speci�c LATEX behavior or customizing some aspect of the docu-
ment appearance. When you install SWP or SW, you automatically install those pack-
ages that are included with the standard LATEX distribution. The packages are installed
in the base, required, and AMS subdirectories of the TCITeXnTeXnLaTeX di-
rectory. Additionally, the TCITeXnTeXnLaTeXncontrib directory includes a col-
lection of packages from the Comprehensive TEX Archive Network (CTAN), and the
TCITeXnTeXnLaTeXnSWmisc directory contains packages from other sources in-
cluding publishers and universities. Most packages have an .sty �le extension.
Together, the packages enable a variety of customized typesetting behaviors, such as

the creation of an index, the special formatting of footnotes, the content and design of
headers and footers, the style of numbered lists, the generation of a list of symbols, and
many others. These behaviors are often controlled by options for which you can specify
settings, much as you specify class option settings.
When you typeset, LATEX or PDFLATEX uses the class and package speci�cations to

determine the typeset appearance of your document. Occasionally, document classes and
packages can con�ict. If you expect to work frequently with LATEX packages, we urge
you to learn how each package interacts with other packages, with document classes, and
with the program. Chapter 3 �Using LATEX Packages� describes the packages available
with SWP and SW. You can �nd links to additional and, often, extensive information
about the packages in the online Help system.
When you open a document with a particular shell, the program automatically adds

to the document any packages that are speci�ed for the shell. You can easily determine
which packages are in use for your document.

I To determine the packages in use

1. On the Typeset toolbar, choose the Options and Packages button or, from the
Typeset menu, choose Options and Packages.

2. Choose the Package Options tab.

The Packages in Use box lists the packages currently in use, as in this example:

3. Choose OK.
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When you typeset your document, the program may call additional packages. For
example, it adds the amsmath package by default to nearly every SWP and SW doc-
ument. Also, many packages in turn call other packages when LATEX or PDFLATEX runs;
that is, when you typeset the document. The list you see in the Packages in Use box
includes only those packages that are directly called by the document.

Adding and Removing LATEX Packages
The packages used by SWP and SW document shells have been carefully chosen to
achieve certain typesetting results. However, you may decide that your document needs
a package that has not yet been added. Documents created with most shells�that is,
documents in most document classes�can accept additional packages. From the Pack-
age Options tab, you can see the list of packages that are available to be added to your
document; the list differs for different versions of the program. You can also remove a
package from your document if you don't need the capability it provides.

Note Unless you're very familiar with LATEX and LATEX packages, we urge you not to
remove packages speci�ed by the document shell.

From the Package Options tab, you can see the list of packages in effect and those
that are available to be added to your document. The list of available packages differs
for different versions of the program. The order in which the packages are speci�ed can,
on occasion, affect typesetting behavior; see the package documentation.
By default, the program automatically manages LATEX packages, adding certain pack-

ages such as amsmath to most SWP and SW documents. If you have Version 5, you
can prevent the program from adding packages automatically.

I To add a package to your document

1. On the Typeset toolbar, click the Options and Packages button or, from the
Typeset menu, choose Options and Packages and then choose the Package Op-
tions tab.

2. If the package you want isn't listed in the Packages in Use box, choose Add.

3. Scroll the Packages list to select the package you want and then choose OK.

4. If you need to reorder the packages in the Packages in Use list, select a package
and use theMove Up or Move Down controls to position the package correctly.

5. Choose OK to return to your document.
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If the package you want isn't listed as available in your version of SWP or SW,
you can go native to add the LATEX commands that force the program to use the pack-
age. When you typeset your document, the program passes the typesetting information
directly to LATEX for processing. If the commands are in error, LATEX won't be able to
typeset your document or to create a DVI or PDF �le. Further, incorrect syntax can
damage your document beyond repair.

Note Be careful to enter commands correctly. Incorrect syntax can cause LATEX to fail
and may damage your document permanently.

I To add a package by going native

1. On the Typeset toolbar, click the Options and Packages button or, from the
Typeset menu, choose Options and Packages.

2. Choose the Package Options tab and choose Go Native.

3. Click the mouse in the Native LaTeX Packages dialog and scroll to the end of any
commands that appear there.

4. On a new line, enter the name of the package you want, enclosed in curly braces.

Remember: The program passes your entries directly to LATEX and PDFLATEX.
Incorrect syntax will cause typesetting to fail.

5. Choose OK twice to return to your document.

You can add package options and arguments for the packages you specify. See �Mod-
ifying LATEX Package Options� on page 79.

I To remove a package from your document

1. On the Typeset toolbar, click the Options and Packages button or, from the
Typeset menu, choose Options and Packages.

2. Choose the Package Options tab.

3. From the list of packages in the Packages in Use box, select the package you want
to remove.

4. Choose Remove and then choose OK.
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I To suppress program management of LATEX packages

1. On the Typeset toolbar, click the Options and Packages button or, from the
Typeset menu, choose Options and Packages.

2. Choose the Package Options tab and then choose Go Native.

3. Check Suppress Package Management and chooseOK to close the dialog boxes
and return to your document.

Adding LATEX Packages to the Program Installation
On occasion, you may want to use a package that isn't part of the program installation.
Before you can add the package to your document, you must �rst obtain it from a source
such as CTAN and then add it to your installation, placing it in an appropriate program
directory so that LATEX can �nd it when you typeset your document.

I To add a LATEX package to the program installation
� Move the package �les to the TCITeX/TeX directory or one of its subdirectories in
your program installation.
You may want to create a new subdirectory for packages that aren't part of the orig-
inal program installation.
After you have added a package to your installation, you can modify the program

interface so that the package and any package options are available via theOptions and
Packages dialog box. Modifying the interface simpli�es working with added packages,
but it is optional; alternatively, you can work with an added package by going native to
specify options.
Modifying the interface involves adding information to two �les (classes.pkg

and packgs.opt) in the Typeset directory of your program installation. The �le
classes.pkg contains a section for each available document class that lists packages
that are available to be added to documents of that class. A typical listing begins like
this:
[article]
acronym
afterpage
algorithm
algorithmic
alltt
amscd
amsfonts
amsmath
amssymb
amstext
answers
apacite
apalike
...
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For each package in the program installation, the packgs.opt �le lists the options
available, as shown in this example for the titletoc package:

[titletoc]
1=Label alignment
1.1=Left - default,leftlabels
1.2=Right,rightlabels
2=Dot after label
2.1=No - default,nodotinlabels
2.2=Yes,dotinlabels

The �rst-level numbers indicate the option category. In this example, the categories are
Label alignment and Dot after label. The second-level numbers indicate
the option as it appears in the Options for package dialog box, followed by a comma
and the name of the option as de�ned in the package itself. You can determine the
available options for an added package by reading the package documentation.

I To modify the program interface for a new LATEX package
1. Modify the classes.pkg �le:

a. Using an ASCII editor, open the classes.pkg �le in the Typeset directory
of your program installation.

b. For each document class, add a new line and enter the package name.
c. Save and close the �le.

The package name will appear in the list of available packages the next time you
open the Options and Packages dialog box.

2. Modify the packgs.opt �le:

a. Using an ASCII editor, open the packgs.opt �le in the Typeset directory of
your program installation.

b. On a new line, enter the package name in square brackets and press ENTER.
c. For each option category, type a �rst-level entry in the form
x=categoryname
where x is the number of the category and categoryname is the category name as
you want it to appear in the Options for package dialog box.

d. For each option category, type a series of second-level entries in the form
x.y=optionname,option
where x is the number of the category, y is the number of the option within the
category, optionname is the description of the option as you want it to appear in
the Options for package dialog box, and option is the name of the option as it is
de�ned in the package. You can leave the option �eld blank.

e. Save and close the �le.
The categories and their corresponding options will appear in the Options for
package dialog box the next time you open the Options and Packages dialog
box.
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Modifying LATEX Package Options
Many packages have a series of options for which you can specify settings; the options
differ from package to package. If a package has options available, the program gener-
ally lists them on the Package Options tab. If an option is marked as default, it is in
effect. Defaults usually don't appear in theCurrently Selected Options box. Selecting
a default option has no effect other than to display it in the box.
When you select a package option setting that is listed in the Package Options tab,

the program creates the correct LATEX syntax for your selection. You can also go native
to specify package option settings. However, if you go native, the program passes your
commands directly to LATEX without checking for correct syntax. Be careful to enter the
commands correctly.
For information about modifying the options for speci�c packages, see Chapter 3

�Using LATEX Packages� and the package documentation provided with the program.

I To modify package options

1. On the Typeset toolbar, click the Options and Packages button or, from the
Typeset menu, choose Options and Packages and then choose the Package Op-
tions tab.

2. Select the package you want to modify and choose Modify.

3. If the Options dialog box lists options for the package,

a. In the Category box, select the option you want.
b. In the Options box, select the setting you want.
The program displays the selected options in the Currently Selected Options
area.

Repeat steps a and b for each option you want to modify.
c. Choose OK to return to the Package Options tab.
Note that if you select the package, the program lists the options you've speci�ed
in the Currently Selected Options area.

or
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4. If the program displays a message indicating that no options are listed for the pack-
age,

a. Choose Go Native.

b. In the Native LaTeX Options dialog box, enter the commands for any package
options you want to apply.
The documentation for each package outlines the syntax and arguments of the
commands for the available options. Additional information is available in Chapter
3 �Using LATEX Packages.� Remember that incorrect syntax can prevent typesetting
and can damage your document.

c. Choose OK twice to return to the Package Options tab.
Note that if you select the package, the program lists the options you've speci�ed.

5. Choose OK to return to your document.

TEX and LATEX Commands
In addition to package options, many packages de�ne a series of commands that you can
use to send precise typesetting instructions to LATEX or PDFLATEX. The documentation
for each package outlines the syntax and arguments of any available commands and
explains whether the commands should be placed in the preamble or in TEX �elds in
the body of your document. In either case, you must make certain you enter correctly
formatted LATEX to avoid typesetting dif�culties and possible damage to your document.
The preamble of your document can contain de�nitions such as nnewtheorem,

nrenewcommand, ndef, and nnewcommand, but must not contain any commands
that generate typeset output. Incorrect commands in the preamble can damage your
document irreparably.

I To add a command in the preamble of your document
1. From the Typeset menu, choose Preamble.

2. If you're using Version 4.1 or earlier, click the mouse in the entry area.

Caution If you begin typing without �rst clicking in the area, you will overwrite
what is already in the preamble. Choose Cancel to leave the preamble unchanged.

3. Enter the commands and choose OK.

Commands in the body of your document appear in TEX �elds, which appear on
the screen as small gray boxes containing the words TeX �eld, like this: . When
you save your document, the program interprets the TEX command and inserts it directly
into the document �le. If you want to prevent the program from interpreting the com-
mand in a TEX �eld, you can encapsulate and name the �eld. Then, when you save your
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document, the program stores the name and the command exactly as you entered them.
The program preserves the exact syntax of the �eld when you save and reload the docu-
ment. When you open the document again, the program displays the �eld on the screen
as a small gray box with the �eld name in brackets, like this . When you
typeset, TEX interprets the encapsulated �eld and inserts the command in the DVI �le.

Note Incorrect code in an encapsulated TEX �eld won't cause the program to fail
when you open your document, because the code remains hidden. However, it will
prevent LATEX from typesetting the document. Incorrect code in an unencapsulated TEX
�eld could damage your document.

I To enter a TeX �eld

1. In Version 4.0 or later, click the TEX button on the Typeset Object toolbar or,
from the Insert menu, choose Typeset Object and then choose TeX Field.

or

In earlier versions, click the TEX button on the Typeset Object toolbar or, from
the Insert menu, choose Field and then choose TeX.

2. If you want to encapsulate the �eld, check Encapsulated and name the �eld.

3. In the entry area, type the TEX command preceded by a backslash (n) and choose
OK.

Working with Document Shells

When you want to create a new document, you must �rst choose a shell that will form
the basis of the new document. The program then opens a new document and copies the
shell into it, along with the shell's typesetting speci�cations, style, page setup, and print
options. Until you change it in some way, the new document is identical to the shell. It
has the same class and structure, uses the same LATEX packages, and produces the same
appearance in print.

Choosing a Document Shell

The Shells directory of your program installation contains over 150 document shells,
which have the extension .shl. In addition to many general-purpose shells, the program
includes a collection of shells designed to meet the typesetting requirements of speci�c
universities and scholarly journals. The shells produce documents that fall into these
categories, which are re�ected in the Shells directory in your program installation:
� Articles�short documents intended for publication in scholarly journals or confer-
ence proceedings.

� Author Packages for AMS�articles intended for publication in journals or confer-
ence proceedings published by the American Mathematical Society (AMS).
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� Books�large documents intended for publication as a separate volume.
� Exams and Syllabi�short documents intended for use in the classroom.
� International�non-English documents, including German, Russian, Greek, Chi-
nese, and Japanese. You can write and typeset documents in languages that use a
non-Roman character set (such as Japanese or Simpli�ed Chinese) with the Omega/
Lambda typesetting system included in Versions 4.x and 5.x of SW and SWP. There
is no PDFOmega program, so creating a PDF �le from such documents isn't possible
from within the program.

� Other Documents�miscellaneous document types including faxes, letters, memos,
overhead transparencies, slides, and some books and reports, usually developed for
earlier releases of SWP and SW.

� Scienti�c Notebook�documents created with Scienti�c Notebook. Documents
created with these shells are intended for printing without the bene�t of typesetting.

� Standard LaTeX�documents created with the LATEX base document classes with-
out the addition of any packages.

� Style Editor�documents created with shells developed using the Style Editor.
� Theses�documents that ful�ll thesis formatting requirements at several universities.
In addition to using the shells provided with the program, you can create your own
shells; see page 84.
Although many shells are similar, no two are exactly alike. Some shells create doc-

uments with a structure and components common to books; other shells create docu-
ments with a structure and components common to theses, reports, or articles. Cer-
tain shells provide for front matter that includes only a short title section; others pro-
vide a title page, table of contents, list of �gures, list of tables, acknowledgments, and
preface. Some shells create double-spaced, single-column pages; others create single-
spaced, double-column pages. Many, but not all, shells provide item tags for theorem
environments�such as theorems, lemmas, corollaries, propositions, and conjectures.
As you choose a shell for your new document, keep your typesetting needs in mind,

especially if you expect to create a complex document. Make sure the shell you choose
produces the type of document you want to create. Don't attempt to write a book using
a letter shell or an article using a report shell. Make sure that the shell contains the tags
appropriate for your work. If you need theorem environments, for example, choose a
shell that has theorem and theorem-like item tags.
If you're unsure of your typesetting requirements, we urge you to choose the Stan-

dard LATEX shell for the type of document you need. These standard shells provide the
greatest �exibility and portability. You can achieve almost any typesetting effect by
beginning with a standard shell and adding LATEX packages as necessary.

Important We strongly recommend that you begin all new documents using one of
the standard LATEX shells, unless you have a compelling reason (such as publisher's
instructions) to do otherwise.

AGallery of Document Shells, provided on your program CD as a PDF �le, illustrates
the appearance of sample documents that have been typeset with each shell provided
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with the program. Examine the samples and note the features they illustrate, such as
the absence or presence of headers and footers, the placement of page numbers and
footnotes, the size of the margins, the appearance and placement of the headings, the
extent of the front matter, the use of single or double columns, and the use of single
or double spacing. When you �nd a shell that looks appropriate, open and print a new
document with the shell to see if it meets your requirements. The closer the shell �ts
your requirements, the easier your typesetting tasks will be.
Each time you start SWP or SW, the program automatically opens a new, untitled

start-up document using a default shell. If the shell is appropriate for your work, you
can start entering information right away. If you want to create some other kind of
document, however, open a new document with a different shell. You can change the
default document shell to suit your needs.

I To open a new document with the default shell
� Start SWP or SW.
The program automatically opens a new, empty document.

I To open a new document with a different shell

1. On the Standard toolbar, click the New button or, from the File menu, choose
New to open the New dialog box.

2. From the Shell Directories list in the New dialog box, select the kind of document
you want.

3. From the Shell Files list, select the shell you want and choose OK.

If most of the documents you create are similar, you can save time by changing the
default shell so that the program automatically opens a start-up document that �ts your
needs.

I To identify the default shell for start-up documents

1. On the Editing toolbar, click or, from the Tools menu, choose User Setup,
and then choose the Start-up Document tab.

The default document shell is highlighted.

2. Choose OK.

I To change the default shell

1. On the Editing toolbar, click or, from the Tools menu, choose User Setup,
and then choose the Start-up Document tab.

2. From the Shell Directories list, select the type of document you want.

3. From the Shell Files list, select the shell you want as the default and choose OK.



84 Chapter 2 Working with Typesetting Speci�cations and Document Shells

Tailoring a Document to Your Needs

Once you've opened a new document with a shell that comes close to meeting your
typesetting requirements, name and save the new .tex document. Then, you can begin
tailoring the document to meet your requirements more precisely. When the document
has the typeset appearance you want, save it (or in Version 4.0 and later, export it) as a
new shell, as explained on page 84.
Although it is possible to achieve the typesetting results you want by tailoring your

document outside SWP or SW, we focus in this manual on tailoring your document
from within the program by
� Modifying the document class options (see page 73).
� Adding or removing LATEX packages (see page 75).
� Modifying the LATEX package options (see page 79).
� Adding TEX or LATEX commands to the preamble or body of your document (see
page 80).

These techniques often involve adding raw TEX or LATEX code to your document. That
is, they involve adding code that isn't processed by the program but is rather passed
directly to LATEX or PDFLATEX from SWP or SW when you typeset your document.
Thus, you must be careful to enter commands using correct syntax to prevent LATEX
errors. Incorrect TEX or LATEX code can cause permanent damage to your document.
We strongly encourage you to save a copy of your document before you attempt any
modi�cation of the typesetting speci�cations.

Important Be sure to enter TEX or LATEX commands correctly. Otherwise, you can
damage your document permanently.

Creating a Document Shell

You can create your own shells by saving any document as a shell �le in one of the
Shells subdirectories in your program installation. If you have carefully tailored a
document so that its typeset output meets your needs, we urge you to save your work
so that you can use it again. Similarly, if you have obtained typesetting speci�cations
or shells from another source, such as a publisher, you should save them for future use.
See Using Typesetting Speci�cations from Outside Sources on page 86.
Of course, you can use any SWP or SW document as the shell for a new document�

it doesn't have to have an .shl extension�but creating a new shell removes the risk of
changing something unintentionally in the original document. Further, if you place a
new shell in one of the Shell subdirectories, its name appears in the shell list dis-
played when you start a new document. If you place the shell in some other directory,
the name doesn't appear in the list of available shells and you can't create a new docu-
ment with the shell using the New command. You can create new shell subdirectories
as necessary.
In Version 4.0 and later, you save shells by exporting them as .shl �les. Earlier

versions use the Save As command.
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I To create a shell
1. Open the document you want to use as a shell.

2. If you're using Version 4.0 or later, from the File menu, choose Export Document.

or

If you're using Version 3.5 or earlier, from the File menu, choose Save As.

3. Select a location for the new shell:

a. In the box labeled Save in, select the Shells directory in your program instal-
lation.

b. Select the appropriate subdirectory or create a new subdirectory for the new shell.

4. In the box labeled File name, type a name for the shell.

The name can include spaces and nonalphabetic characters.

5. In the box labeled Save as type, specify Shell (*.shl).

6. Choose Save.

The next time you open a new document, the shell name appears on the Shell Files
list corresponding to the shell subdirectory you speci�ed.

Working with Documents from Outside Sources
Occasionally you may have to work with LATEX documents that have been created with-
out the bene�t of SWP or SW. Some existing LATEX documents can be opened directly
by the program with little or no dif�culty, but others present more of a challenge. Cer-
tain LATEX constructs need modi�cation with an ASCII editor before they can be opened.
In particular, statements of the form nnewcommand and ndef often cause problems,
and macro de�nitions that contain unknown environment changes (signaled by nbegin
and nend statements) always do. In general, constructs that differ from Plain TEX (such
as array versus matrix) should be modi�ed to use the LATEX construct.
If you are working with Version 5.0 or earlier of SWP and SW and the program

can't successfully open a non-SWP/SW LATEX document, it displays an error message
such as those described on pages 202, 189, or 191. If the program successfully opens
a non-SWP/SW LATEX document, you may �nd that it has not been able to recognize
every TEX or LATEX construct in the �le. When it can't recognize a construct, the program
attempts to read the code and places the results in gray boxes labeled unrecognized. You
must try to reconstruct the commands in each unrecognized gray box.
If you are working with Version 5.5 of SWP and SW, you can take advantage

of a new import �lter that facilitates your collaborative efforts by successfully reading
and interpreting many more TEX and LATEX constructs than did earlier versions of the
program. If you are working with colleagues who use LATEX directly instead of using
SWP or SW, you may be able to use the �lter to import the contents of their documents
into SWP or SW �les even if opening them directly in the program is unsuccessful.
Similarly, you may be able to import the contents of old LATEX documents. The new
�lter can read many macro de�nitions not created with the program, although some
constructs may still result in unrecognized gray boxes.
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I To import a non-SWP/SW LATEX document

1. Place the �le you want to open in a writable directory so that the program can create
the necessary temporary �les.

2. From the File menu, choose Import Non-SWP/SW LaTeX.

3. Select the �le and choose Open.

The program imports as much of the �le as possible into a new document, and
gives the document a name using the format �lename-tmp000.tex, where 000
is a number. Thus, the �rst attempt to import a given �le will result in a �le named
filename-tmp0.tex; the second attempt will yield filename-tmp1.tex;
and so on.

If you are very familiar with TEX and LATEX, you can tell the �lter how to interpret
certain constructs in non-SWP/SW LATEX documents. See the online Help system for
more information.
If you successfully read and modify a LATEX document, then save it as an SWP/SW

document (using theSWP/SW/SNB Document (*.tex) option), the program inserts the
command ninput{tcilatex} in the document preamble and uses in the �le macros
de�ned in tcilatex, a special set of macros. If instead you save the document as a
Portable LATEX �le, the command isn't inserted in the preamble.

Working with Typesetting Speci�cations from Outside Sources

Although many shells and typesetting speci�cations are provided with SWP and SW,
you may need to add speci�cations that you obtain from a publisher or from some other
source for TEX and LATEX �les, such as the CTAN. The CTAN directory on your program
CD contains the typesetting speci�cations and �les as distributed on CTAN, but only
those �les needed for typesetting are installed with the program.
We have tested the shells and speci�cations that we provide with the program to

ensure that they work correctly and are compatible with SWP and SW. However,
we can't guarantee that other speci�cations will work with our products, nor can we
guarantee that the documents you create with those speci�cations will behave as the
speci�cations advertise. Nonetheless, it's important to install speci�cations correctly,
and we offer the instructions below as an aid.

Important We don't support documents created with typesetting speci�cations not
provided with SWP or SW.

Adding LATEX typesetting speci�cations to your installation involves these steps:
1. Placing the speci�cation �les in an appropriate directory.

2. Completing any required installation steps.

3. Testing the speci�cations by running the associated sample documents through LATEX.

4. Opening the sample documents in SWP or SW.
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5. Creating or modifying a .cst �le, if necessary.

6. Creating a shell for the typesetting speci�cations.

Note Don't attempt to add LATEX typesetting speci�cations to your installation if you
aren't familiar with TEX and LATEX.

We illustrate these instructions by showing how to install the speci�cations contained
in \CTAN\macros\latex\contrib\uaclasses on your program CD. These
�les adhere to the typesetting requirements for theses and dissertations at the University
of Arizona.
These instructions assume you have installed SWP in the directory c:nswp55.

If you're using SW or your directory is different, remember to substitute the correct
directory path in the instructions.
Step One: Place the typesetting speci�cation �les in an appropriate directory
A set of LATEX speci�cations usually involves a collection of �les with extensions

including .cls, .clo, and .sty. The speci�cations may also include installation �les
with an .ins extension. Most speci�cations have accompanying sample documents and
readme �les, which often contain installation instructions.
Whether you download the speci�cations from a website or receive them by email or

on diskette, you must place them in the correct program subdirectory to ensure they are
available to TrueTEX. You can place the �les anywhere in the TCITeXnTeX directory
or its subdirectories. We suggest that for each set of speci�cations you create a new
subdirectory within TCITeXnTeX. If you obtained the �les from CTAN, follow the
directory structure used there.
Before you move the new speci�cations to a directory, search SWP or SW to make

certain an older version of the speci�cations is not installed. If you �nd an older version,
rename it before you add the new �les to the installation directory structure.

I To place typesetting speci�cation �les in a program directory
1. Create a new subdirectory for the speci�cations within TCITeXnTeX.
For our example, we create a new subdirectory called uaclasses in the existing
directory c:\swp50\TCITeX\tex\latex\contrib.

2. Move all the typesetting speci�cation �les to the new directory.

Step Two: Complete any required installation steps
Simply moving the �les to the new directory may not complete the installation of the

speci�cations. More steps may be required.

I To complete the installation of typesetting speci�cations
1. Read the readme �le accompanying the speci�cations and follow any installation
instructions it contains.

2. If you must process any �les through LATEX, use the TrueTEX Formatter outside SWP
or SW:
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a. From the Windows Start menu, select SWP or SW and then select TrueTeX
Formatter.

b. In theOpen TeX File dialog box, specify the directory containing the speci�cation
�les.

c. In the File name box, type *.* to display all �les in the directory.
d. Select the �le you want to process and choose OK.

Processing these �les often creates additional �les required by the speci�cations. In
our example, the readme �le tells us to run LATEX on two �les: ua-classes.ins
and ua-classes.dtx.

Step Three: Test the speci�cations by opening the associated sample documents
Most speci�cations have associated sample documents that demonstrate the features

of the typesetting speci�cations. Test the sample documents by running them through
LATEX before you try to open them in SWP or SW.

I To test the sample documents
1. If a sample document is provided as a .tex �le, process it through the TrueTEX
Formatter outside SWP or SW as described in Step Two to create a DVI �le.

In our example, both ua-example.tex and ua-example.dvi are available.
To make sure the installation is working, we copy and rename ua-example.tex
as newua-example.tex, and then process the renamed �le through the TrueTEX
Formatter to create a new DVI �le.

2. Preview the DVI �le with the TrueTEX previewer:

a. From the Windows Start menu, choose Programs.
b. Select the SWP or SW submenu from theWindowsPrograms list and then select
TrueTeX Previewer.

c. From the File menu, choose Open.
d. In theOpen DVI File dialog box, specify the directory containing the speci�cation
�les.

e. Select the �le you want to process and choose OK.

Step Four: Open the sample documents in SWP or SW
Opening sample documents created with native LATEX can have unpredictable results

in SWP and SW. The program may not handle the documents correctly and might even
crash while it tries to load the �le. We suggest you make a copy of the .tex �les for the
sample documents before you attempt to open them.

I To open a sample document in SWP or SW
1. Make a copy of the .tex �le if you have not already done so.

2. Choose or, from the File menu, choose Open.
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3. Select the subdirectory you created in Step One.

4. Select the copy of the sample document and choose OK.

5. If the program displays a message indicating that an appropriate .cst �le was not
found, choose Yes to load the document using a default .cst �le.

The program chooses a default style from the appropriate Styles directory.

6. Typeset preview the document and compare the results to those obtained when you
previewed the DVI �le in Step Three.

Similar results indicate a successful installation. If the document fails to compile,
refer to the instructions on page 221 for �nding and correcting LATEX errors.

Step Five: Create and modify a new .cst �le
When you open a document, the program uses the associated .cst �le to display

the document on the screen and to re�ect the available environments, objects, and tags.
The .cst �le has no effect on the document's typeset appearance. Because the new
speci�cations aren't yet associated with a .cst �le, you must create a new .cst �le.
If the LATEX speci�cations you're adding are similar to an existing document class

and include no new objects, you can probably create a successful .cst �le by copying
and modifying the .cst �le for a similar document class. The.cst �les are installed
in the Styles directory of your program installation or in one of its subdirectories.
However, if the speci�cations you're adding implement a new base document class, you
need to create a new .cst �le that re�ects all the environments in the new speci�cations.
If the .cst �le doesn't re�ect all the environments in the new speci�cations, SWP or
SW can't open the sample document successfully. After you have created the new .cst
�le, you must change the sample document to re�ect the new .cst �le.
In our example, the ua-classes speci�cations represent a new base document class

called ua-thesis, so we must create a new .cst �le and save it in a new subdirectory
in the Styles directory. Then we have to modify the �le so that the screen display
re�ects any new document elements, objects, and environments implemented by the
typesetting speci�cations.
Modifying the .cst �le involves determining which new objects are implemented by

the typesetting speci�cations and then creating corresponding sections in the .cst �le.
Study the new typesetting speci�cations and the sample document, if any, to determine
which tags the new .cst �le must have. Look in the .cls �le for new environments,
theorem objects, and especially front matter elements. These objects are often signalled
with ndef or nnewcommand statements. You may be able to �nd another .cst �le
that re�ects the object. If so, you can copy the object to the new .cst �le.
In our example, the ua-thesis speci�cations add an abstract to the standard LATEX

report class, so the .cst �le must re�ect the new object. We can search other .cst �les
to �nd an abstract object, copy it, and add it to ua-thesis.cst. You can �nd the
resulting .cst �le, Stylesnua-thesisnua-thesis.cst, on your program CD.
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I To create a new .cst �le
1. Use an ASCII editor to open the .cls �le associated with the new typesetting spec-
i�cations.

2. Search for a statement that indicates the base document class for the new speci�ca-
tions.

In our example, the .cls �le indicates that the ua-thesis document class derives from
the standard LATEX report document class.

3. In the Styles directory of your program installation, �nd a .cst �le that corre-
sponds to the document class basis.

In our example, we use report.cst in the Stylesnreport directory.

4. Rename the �le using the same name as the document class name and save it in the
Styles directory, either in a new subdirectory or in the [Special] subdirectory.

We copy Stylesnreportnreport.cst and rename the copy as Stylesnua-
thesisnua-thesis.cst.

5. If the new speci�cations have an environment that isn't contained in the .cst �le,
search for another .cst �le that contains a similar object and copy the object to the
new .cst �le.

6. When you have added all necessary environments, save the new .cst �le in a new
subdirectory in the Styles directory.

Note If the new subdirectory contains only one .cst �le, you don't have to
change the name of the .cst �le in the sample document.

I To change the sample document so that it will use the new .cst �le
1. Change the name of the .cst �le:

a. Open the �le in SWP or SW, and from the File menu, choose Style.
b. Choose Advanced.
c. In the Style File box, browse to the directory containing the new .cst �le.
d. Select the �le and choose OK.

2. Change the appearance of the tag environments in the document window, if neces-
sary:
� If you're using Version 4.0 or later, use the Appearance command on the Tag
menu to change the tag attributes.
or

� If you're using an earlier version, use an ASCII editor to modify the tag attributes.

Remember Modi�cations to the .cst �le have no effect on the typeset appear-
ance of your document.
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Step Six: Create a new shell document for the typesetting speci�cations

We suggest you use the sample document as the shell document, modifying it as
needed.

I To create a shell document for the typesetting speci�cations
1. In SWP or SW, open the .tex �le for the sample document.

2. Make any changes you want to the �le.

3. Save the �le as a shell:

a. If you're using Version 4.0 or later, from the File menu, choose Export Docu-
ment.
or
If you're using an earlier version, from the File menu, choose Save As.

b. In the Save in box, specify the directory for the shell.
Choose an appropriate subdirectory within the Shells directory of your program
installation. In our example, we save the shell as Thesis - University of
Arizona Thesis.shl in the ShellsnTheses directory.

c. In the File name box, type the name of the shell.
d. In the Save as type box, select Shell (*.shl).
e. Choose Save.

Optional steps: Modify the program interface

Although it isn't necessary, you can modify the program interface to simplify work-
ing with added typesetting speci�cations:
� Modify Typeset/classes.pkg as explained on page 77 to be able to select new
packages from the Options and Packages dialog box.

� Modify Typeset/classes.opt in your program installation to be able to se-
lect document class options from the Options and Packages dialog box. The
classes.opt �le contains a section for each available document class. Each
section lists the options available for the class, as shown in this partial list for the
document class article:
[article]
1=Body text point size
1.1=10pt - default,
1.2=11pt,11pt
1.3=12pt,12pt
2=Paper size
2.1=8.5x11 - default,letterpaper
2.2=a4,a4paper
2.3=a5,a5paper
2.4=b5,b5paper
2.5=Legal size,legalpaper
2.6=Executive size,executivepaper
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I To modify the program interface for a new LATEX document class
1. Using an ASCII editor, open the classes.opt �le in the Typeset directory of
your program installation.

2. On a new line, enter the document class name in square brackets and press ENTER.

3. For each option category, type a �rst-level entry in the form

x=categoryname

where x is the number of the category and categoryname is the category name as
you want it to appear in the Options for documentclass dialog box.

4. For each option category, type a series of second-level entries in the form

x.y=optionname,option

where x is the number of the category, y is the number of the option within the
category, optionname is the description of the option as you want it to appear in the
Options fordocumentclass dialog box, and option is the name of the option as it is
de�ned in the document class You can leave the option �eld blank.

5. Save and close the �le.
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LATEX packages extend TEX typesetting capabilities by enabling some speci�c behavior
for your document. The creation of an index, the inclusion of special bibliography lists,
the use of color, the formatting of footnotes, and many other typesetting behaviors can
be enabled with packages.
When you install SWP or SW, you automatically install those packages that are in-

cluded with the standard LATEX distribution. In addition, the installation includes pack-
ages that add speci�c typesetting capabilities to SWP and SW documents or that sup-
port the shells designed for certain publishers or universities. Certain packages are in-
cluded in the installation only for purposes of compatibility with earlier versions of the
program. Packages have an .sty extension and are loaded into the TCITeX/TeX di-
rectory and its various subdirectories at installation. The directory assignments, which
are noted in the discussion below, re�ect TEX convention:

Directory Contents
TCITeX/TeX/generic Input �les used by many different formats
TCITeX/TeX/LaTeX Files used with new versions of LATEX
TCITeX/TeX/latex209 Files used only with LATEX2.09*
TCITeX/TeX/plain Files used only with Plain TEX
*Note that packages that are installed in the latex209 directory may or may not work
for later implementations of LATEX.

If the package you want doesn't appear in the list of packages available for your docu-
ment, you can go native to add it, as described on page 76.
Most of the packages included with your installation work successfully with most

SWP and SW documents; that is, you can correctly compile most SWP and SW doc-
uments to which one or more of these packages have been added, whether you are creat-
ing a device independent (DVI) �le or, in Version 5, a Portable Document Format (PDF)
�le. However, even though LATEX correctly compiles a document, you may not be able
to preview it. Also, certain packages require the use of different print drivers. You may
need to change your driver con�guration to use certain packages.
Note, though, that when you change drivers, you tell LATEX not to use the default

driver con�guration for the local LATEX installation. If you subsequently try to compile
your document in a different LATEX installation, LATEX will ignore the defaults for the
new installation. Thus, you may need to make additional changes to your document to
accommodate the new LATEX setting. For the greatest portability, we recommend that
you usually leave the driver con�gurations unchanged.
This chapter focuses on those packages that enhance general typesetting capabilities

in most typeset documents. We have omitted a discussion of any packages (such as those
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whose names begin with sw20) that have been designed to support a single document
shell rather than provide a capability for LATEX documents in general. You can learn
more about these packages from their .sty �les and from the corresponding document
shell. See also A Gallery of Document Shells on your program CD to explore the typeset
appearance of documents created with the many shells provided with the program.
Organized alphabetically by package, this chapter explains the function of each pack-

age and brie�y describes any available package options and commands. The chapter
notes any known package con�icts with document classes and with preview and print
drivers. Because complete instructions for using each package are outside the scope
of this chapter, we encourage you to read the documentation accompanying the pack-
ages you want to use. You can �nd links to additional and, often, extensive package
information in the SWSamples\OptionsPackagesLaTeX.tex �le in your SWP
or SW installation. Also, you may �nd helpful information in the .sty �les for cer-
tain packages. A basic knowledge of TEX and LATEX will help you understand some of
the more technical information. See Chapter 2 �Working with Typesetting Speci�ca-
tions and Document Shells� for information about basic program tasks related to using
packages, such as adding packages, selecting options, and inserting commands in en-
capsulated TEX �elds or in the document preamble.

Important Modifying the typesetting speci�cations can damage your document. Do
not attempt extensive modi�cations unless you are familiar with TEX and LATEX.

Although many packages are available for use with SWP and SW documents, you
may be able to obtain all the typesetting capability you need by learning to use just a few
of them. The table beginning on page 57 will help you identify the packages that you
need most often. In particular, these packages often prove useful: breakcites, caption,
cite, color, endnotes, fancyhdr, �oat, geometry, longtable, nomencl, setspace,
tocbibind, and wrap�g.

Accents

The accents package provides several tools for creating mathematical accents. Using
commands in TEX �elds in the body of your document, you can create arti�cial mathe-
matical accents using nonstandard accent symbols such as *. You can also group multi-
ple accents vertically, using standard and nonstandard accent symbols. Accents can ap-
pear above or below the accented character; the package modi�es the leading between
symbols to create a pleasing image. See the package documentation for information
about the available commands, generally of the form ncommand{accent}{symbol}.
The package is installed in the TCITeX/TeX/LaTeX/contrib/bezos direc-

tory.

Acronym

The acronym package helps you manage acronyms and acronym lists in your docu-
ments. You can de�ne each acronym within a special acronym environment and then
use macros in the text to de�ne how each occurrence of the acronym will appear when
you typeset the document. If you de�ne the list in the document preamble, it appears



Acronym 95

before the body of the document. If you de�ne the list in the body of the document, it
appears where you place it. You may want to add a heading to designate the list. The
acronym package requires that you typeset your document with two LATEX passes for
proper resolution of any acronyms in use.
The program doesn't understand the package macros, but you can successfully use

the macros in your document if you place them inside encapsulated TEX �elds.

I To de�ne acronyms in the text
1. Add the acronym package to your document.

2. Begin the acronym environment:

a. Place the insertion point where you want the list to appear in your document.
b. Enter a TEX �eld.
c. In the entry area, type nbegin{acronym}.
d. Choose OK.

3. For each acronym,

a. Enter an encapsulated TEX �eld.
b. To de�ne the acronym and include it in the list of acronyms, type
nacro{acronym}{de�nition} and choose OK.
or
To de�ne the acronym and exclude it from the list of acronyms, type
nacrodef{acronym}{de�nition} and choose OK.

4. Following the last de�nition, end the environment:

a. Enter an encapsulated TEX �eld.
b. In the entry area, type nend{acronym} and choose OK.

I To de�ne acronyms in the preamble
1. Add the acronym package to your document.

2. From the Typeset menu, choose Preamble.

3. Click the mouse in the entry area.

4. On a new line, type nbegin{acronym} and press ENTER.

5. For each acronym,
� To de�ne the acronym and include it in the list of acronyms, type
nacro{acronym}{de�nition} and press ENTER.
or

� To de�ne the acronym and exclude it from the list of acronyms, type
nacrodef{acronym}{de�nition} and press ENTER.

6. Type nend{acronym} and choose OK.
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I To use acronyms
1. Place the insertion point where you want an acronym to appear.

2. Enter an encapsulated TEX �eld.

3. In the entry area, type the command to insert the acronym formatted according to
your preferences:

Command Effect
nac{acronym} Expand and identify the acronym the �rst time; use only

the acronym thereafter
nacf{acronym} Use the full name of the acronym
nacs{acronym} Use the acronym, even before the �rst corresponding

nac command
nacl{acronym} Expand the acronym without using the acronym itself

Suppose you've de�ned the acronym SW as Scienti�c Word. Now you want to use it
in the sentence (acronym) documents are beautifully typeset.

These examples show the result of using the four available acronym commands,
assuming that the acronym has already been used once in the document:

Command Effect
nac{SW} SW documents are beautifully typeset.
nacf{SW} Scienti�c Word (SW) documents are beautifully typeset.
nacs{SW} SW documents are beautifully typeset.
nacl{SW} Scienti�c Word documents are beautifully typeset.

4. Choose OK.

In addition to using the available commands, you can change the package option
to place expanded acronyms in the body of the document or at the foot of the page as
footnotes. The option is available through the Options and Packages command on
the Typeset menu.
See an example of the package in use in the PackageSample-acronym.tex

�le in the SWSamples directory of your program installation. The package is installed
in the TCITeX/TeX/LaTeX/contrib/acronym directory.

Afterpage

The package implements the nafterpage command and causes LATEX to expand its
argument after the current page is �lled and output. Although you can specify any
command in the nafterpage argument, using the nclearpage command is a par-
ticularly useful way to force the printing of any �oating objects (graphics and long ta-
bles) that haven't yet been anchored to a position. LATEX �lls the page on which the
nafterpage command occurs and then prints any unanchored �oating objects before
continuing with the text. Use the nafterpage command in an encapsulated TEX �eld.
The package has no options.
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I To use the afterpage package to output �oating objects
1. Add the afterpage package to your document.

2. Place the insertion point on the page after which you want accumulated �oating
objects to appear.

3. Enter an encapsulated TEX �eld.

4. In the entry area, type nafterpage{nclearpage}.

5. Choose OK.

Although you can add the afterpage package to documents in most document
classes, note that the package doesn't work for two-column layouts. The package is
installed in the TCITeX/TeX/LaTeX/required/tools directory and is part of
the Standard LATEX Tools Bundle.

Algorithm

The algorithm package de�nes a �oating environment for algorithm descriptions so they
don't break over a page boundary. The package also enables algorithm numbering. If
you're using a report or book shell, you can produce a list of numbered algorithms for
inclusion after the table of contents. The list appears on a separate page, similar to a
list of �gures or list of tables. You must process your document through LATEX outside
SWP or SW to generate the list of algorithms and you must run LATEX at least twice.
Options that affect the appearance and numbering of algorithm environments are

available through the Options and Packages command on the Typeset menu. The
package is designed to be used with the algorithmic package, but it can be used sepa-
rately.

I To use the algorithm environment
1. Add the algorithm package to your document.

2. If it is present, remove the de�nition of the algorithm newtheorem environment
from the document preamble:

a. From the Typeset menu, choose Preamble.
b. Click the mouse in the entry area.
c. Delete the de�nition, which looks something like this:
nnewtheorem{algorithm}[theorem]{Algorithm}

d. Choose OK.

3. Place the insertion point where you want the algorithm to appear and begin the algo-
rithm environment:

a. Enter an encapsulated TEX �eld.
b. Type nbegin{algorithm}.
c. Choose OK.
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4. Type the commands for the entire algorithm.

5. End the algorithm environment:

a. Enter an encapsulated TEX �eld.
b. Type nend{algorithm}.
c. Choose OK.

I To add a list of algorithms to a document
1. Place the insertion point at the beginning of the body of your document.

2. Enter an encapsulated TEX �eld.

3. Type nlistofalgorithms.

4. Choose OK.

5. Save the document.

6. From outside SWP or SW, typeset compile the document �le:

a. From the SWP or SW program group, choose the TrueTEX Formatter.
b. Select the �le and choose OK.
LATEX generates an .loa �le for the document.

7. Typeset preview the document.

The package is installed in the TCITeX/TeX/LaTeX/contrib/algorithms
directory.

Algorithmic
The algorithmic package de�nes an environment in which you can use a number of
commands for typesetting complex algorithmic constructs. Available commands include
if-then-else constructs; for, while, until, and in�nite loops; pre- and postconditions; and
comments. Please see the package documentation for information about the commands.
Line numbering is optional. An option to suppress end statements is available for the al-
gorithmic environment. The package is designed to be used with the algorithm package,
but can be used separately.

I To use the algorithmic environment
1. Add the algorithmic package to your document.

2. Begin the algorithm environment:

a. Enter an encapsulated TEX �eld.
b. Type nbegin{algorithmic} and choose OK.

3. Type the commands for the entire algorithm.
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4. End the algorithm environment:

a. Enter an encapsulated TEX �eld.
b. Type nend{algorithmic} and choose OK.

Here is an example of how an algorithm presented in the algorithmic environment:
Require: n � 0
Ensure: y = xn
y ( 1
X ( x
N ( n
while N 6= 0 do
if N is even then
X ( X �X
N ( N=2
else {N is odd}
y ( y �X
N ( N � 1
end if
end while
The �le PackageSample-algorithmic.rap in the SWSamples directory of

your program installation contains additional examples of the algorithmic package in
use. The �le includes instructions for modifying a style (.cst) �le to add the algorithmic
environment as a Section/Body tag. The packages are installed in the TCITeX/TeX/
LaTeX/contrib/algorithms directory.

Alltt
The alltt package provides a verbatim-like environment in which the meaning of slashes
and curly braces is unchanged by LATEX. Thus, you can embed other TEX commands
and environments inside the alltt environment to produce formatted mathematics and
mathematics symbols.
Assume you want to include mathematics in a typeset verbatim paragraph. Ordinar-

ily, the mathematics appears as LATEX code when you typeset the document without the
alltt package, as shown here:

With the package, the mathematics appears as correctly formatted mathematics:

You must place the entire alltt environment in an encapsulated TEX �eld.
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I To use mathematics in a verbatim-like environment
1. Add the alltt package to your document.

2. Enter an encapsulated TEX �eld.

3. Type nbegin{alltt} to begin the alltt environment.

4. Begin entering the content of the verbatim environment.

5. For each mathematical element,

a. Type n( to begin mathematics.
b. Type the commands for the mathematical statement or symbol you want.
c. Type n) to end mathematics.

6. Complete the content.

7. Type nend{alltt} to close the environment.

8. Choose OK.

The package has no options. Alltt is provided automatically with LATEX and is in-
stalled in the TCITeX/TeX/LaTeX/base directory.

AMS Packages

The American Mathematical Society (AMS) publishes three main types of publications:
articles, proceedings, and books or monographs. Each has detailed publication format
speci�cations, which are re�ected in threeAMS shell documents: AMS Journal Article;
AMS Proceedings Article; and AMS Book or Monograph. The speci�cations are sup-
ported by AMS-LATEX, a required component of the standard LATEX distribution, and by
a series ofAMS packages. Most of the packages are installed in the amscls and ams-
math subdirectories of the TCITeX/TeX/LaTeX directory. The amsfonts package
is installed in the TCITeX/TeX/plain directory.

AMSCD
The amscd package de�nes a CD environment to produce simple rectangular commu-
tative diagrams, such as this:

The package provides single and double horizontal and vertical arrows, with or without
labels; see the package documentation for details. No diagonal arrows are provided. The
notation is easier to use than standard LATEX code and the results are more attractive.
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After adding the package to your document, create the diagram inside a CD environ-
ment de�ned in a TEX �eld in the body of your document.

AMSFonts
The amsfonts package is a collection of fonts of symbols and characters that aren't
always included in standard distributions of TEX, but that correspond to those used
in AMS print and online publications and in the MathSci online database. The fonts
include Blackboard Bold, Fraktur, the Euler family; certain sizes of Computer Mod-
ern mathematics, caps, and small caps fonts; extra mathematical symbols; and Cyrillic.
SWP and SW automatically call the amsfonts package when it is required.
Other than adding the package to your document, no action is required. No options

are available for the amsfonts package. Note that the program adds the package if it
is needed by features in use in the document. The Portable LATEX �lter always adds the
amsfonts package, along with amsmath, amssymb, and graphicx.

AMSSymb
The amssymb package is a subset of amsfonts that de�nes the full set of symbol names
for two fonts of extra symbols included in the amsfonts collection. The two fonts, msam
and msbm, contain symbols, including uppercase Blackboard Bold, needed by theAMS
publishing program and MathSci online database. The package requires no special com-
mands in the document, and no options are available. The program adds the package if
it is needed by features in use in the document.

AMSMath
This package, which is provided automatically with LATEX, enhances the typeset appear-
ance of mathematical formulas, especially those involving displayed equations, multi-
line sub- and superscripts, and other mathematical constructs. The amsmath package
is included automatically in most SWP and SW shells. The program adds the package
if it is needed by features in use in the document.
The package calls several auxiliary packages as needed:

� amstext�Allows typesetting of a small amount of text inside mathematics mode
and adjusts font sizes for text in sub- and superscript locations.

� amsopn�Allows the declaration of new operator names.
� amsbsy�Included for backward compatibility only. This package has been super-
seded by the newer bm package that comes with LATEX.

In documents created with AMS document shells, you can also use the amsxtra pack-
age, which provides miscellaneous seldom-used commands that enhance compatibility
with documents created using earlier versions of AMS-TEX.

AMSMath Options
With the Options and Packages command on the Typeset menu, you can set six op-
tions for the amsmath package. They affect the placement of limits, equation numbers,
and equations themselves. The options you set for this package may override options set
for the document class.
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Answers

The answers package provides a way to bind a solution to an exercise in a LATEX envi-
ronment. This package was designed for the general LATEX community and may not be
the best choice for SWP and SW documents. We urge the use of the Exam Builder.
With the answers package, you can store the bound solutions in several different

�les at once, so that you can print them at different times, such as in the appendix of
a book as well as a handout for students. Further, you can create and include many
different solutions �les in a document, such as one for each section or chapter of a book.
The package supports any number of solution types, including hints for students.
Available commands associate the exercises with the solutions and de�ne, open, and

close the solutions �les. See the package documentation for more information about us-
ing the commands and for examples of using the package. The option to create solutions
�les is available through the Options and Packages command on the Typeset menu.
The package is installed in the TCITeX/TeX/LaTeX/contrib/answers di-

rectory.

Apacite

The apacite package formats citations according to the complex requirements of the
American Psychological Association (APA). The package works with the bibliography
style �le apacite.bst to produce citations in a variety of APA formats. It improves
on the capabilities of the apalike, apalike-plus, and newapa packages. In particular,
the package provides �no parentheses� citation commands. Except in rare cases, the
package will format every reference correctly.
Note that incorrect typesetting can occur when the apacite package is added to docu-

ments that have no chapter headings (such as articles) and that are saved as SW/SWP/SN
(*.tex) documents. The problem doesn't occur with documents saved as Portable LATEX
�les.

I To avoid incorrect typesetting with apacite
1. From the Typeset menu, choose Preamble.

2. On a new line following the ninput{tcilatex} line, enter
nletnchapternunde�ned

3. Choose OK.

Commands are available to handle various types of citations. See the package doc-
umentation for more information. The apacite package is installed in TCITeX/TeX/
latex/contrib/bibtex.

Apalike and Apalike-plus

The apalike package formats text according to speci�cations in the American Psycho-
logical Association Publication Manual (4th edition), to produce typesetting suitable for
APA journals. In particular, the package works in conjunction with apalike.bst to
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produce BIBTEX bibliography entries that are formatted alphabetically by author's last
name. The package also produces single and multiple author-date citations in the text.
The apalike-plus package extends the features of apalike with TEX commands that

provide optional titles for the list of references and include the selected title in headers
and the table of contents. The commands are as follows:
� nbibtitle�generates References as the default bibliography title.
� nbibheadtitle�generates REFERENCES as the default text to be used in page
headers.

� naddcontentsline{toc}{...}{nbibtitle}�generates an appropriately
titled entry for the bibliography in the table of contents.
These two packages have no effect on manual bibliographies. To use the packages

successfully, you must specify that you want to create a BIBTEX bibliography and choose
the corresponding BIBTEX style.

I To create a list of references with apalike or apalike-plus
1. Add the apalike or apalike-plus package to your document.

2. From the Typeset menu, choose Bibliography Choice.

3. Check BibTeX and choose OK.

4. Insert BIBTEX citations as needed throughout your document.

5. Insert the list of references:

a. Place the insertion point where you want the bibliography to appear in your docu-
ment.

b. If you're using apalike-plus, enter package commands in an encapsulated TEX
�eld to specify the bibliography title and page headers and to include the list in the
table of contents.

c. From the Insert menu, choose Typeset Object and then choose Bibliography.
d. Select the BIBTEX database �le you want to use.
e. Scroll down the Style list to select apalike.bst or apalike2.bst.
f. Choose OK.

6. Save and compile the document.

No options are available for either package. Both apalike and apalike-plus are
installed in TCITeX/TeX/latex209/contrib/misc.

Appendix

The appendix package provides for modifying the typesetting of appendix titles. It
provides a subappendix environment for use as an appendix to a chapter or section.
Although package commands are available, you can use the package more effectively
with the options available from the Options and Packages command on the Typeset
menu. The options affect the formatting of headers and titles in the appendix.
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The subappendices environment creates an appendix section at the end of a chapter or
an appendix subsection at the end of a section. It numbers the subappendix in sequence
with the other sections or subsections and attaches an uppercase letter to the section
number. Subappendices appear in the table of contents.

I To create a subappendix
1. Add the appendix package to your document.

2. Begin the subappendices environment:

a. Place the insertion point where you want the subappendix to appear.
b. Enter an encapsulated TEX �eld.
c. In the entry area, type nbegin{subappendices} and choose OK.

3. Type a heading for the subappendix.

4. If the subappendix is in a chapter, apply the section tag to the heading.

or

If the subappendix is in a section, apply the subsection tag to the heading.

5. Enter the content of the subappendix.

6. End the subappendices environment:

a. At the end of the subappendix, enter an encapsulated TEX �eld.
b. In the entry area, type nend{subappendices} and choose OK.

The appendix package is designed to work only with those document classes that
have chapters or sections. The package is known to con�ict with the LATEX kernel
ninclude command. See the package documentation for additional information. The
appendix package is installed in TCITeX/TeX/LaTeX/contrib/appendix.

Array
The array package extends the implementation of the LATEX array and tabular envi-
ronments by providing options for column formatting, including lines and paragraph
indention. You can use the package to achieve alignment within cells, like this:
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You can also obtain special effect using vertical rules with variable widths:

and you can format paragraph indention within cells:

The package provides other column spacing capabilities.
The package has no options, so you must enter commands for the entire tabular

environment in an encapsulated TEX �eld. See the package documentation for in-
structions and for additional examples of package effects. The package is installed in
the TCITeX/TeX/LaTeX/required/tools directory and is part of the Standard
LATEX Tools Bundle.

Astron
The astron package produces author-year citations in two forms: (Author, year) and
(year). It is required by these BIBTEX bibliography styles:
� astron.bst�produces bibliographies in the format required by the European
astronomical journal Astronomy and Astrophysics.

� apa.bst�produces bibliographies in the American Psychological Association for-
mat.

� bbs.bst�produces bibliographies approximately in the format of Behavioral and
Brain Sciences.

� cbe.bst�produces bibliographies approximately in the Council of Biology Edi-
tors format.

� humanbio.bst�produces bibliographies with a format similar to that used in
Human Biology.

� humannat.bst�produces bibliographies with a format of Human Nature and
American Anthropologist.

� jtb.bst�produces bibliographies based loosely on the format used in the Journal
of Theoretical Biology.
Other than adding the package to your document, no action is required. The astron

package is installed in the TCITeX/TeX/LaTeX/contrib/bibtex directory.

Authordate1-4
The package implements four options for creating author-date citations. The options are
required when using the BIBTEX styles authordate1.bst, authordate2.bst,
authordate3.bst, or authordate4.bst. The package has no effect on manual
bibliographies. It produces BIBTEX bibliographies in four slightly differing formats:
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� authordate1 produces author-date reference lists with the author's name typeset in
Roman. Any uppercase letters that occur in the titles of articles, journals, or books
are left as given in the BIBTEX �le.

� authordate2 produces author-date reference lists with the author's name typeset in
Roman and �downstyle� titles. That is, working from the BIBTEX �le, the package
changes to lowercase any uppercase letters except the �rst that occur in the titles of
articles, journals, or books; any letter that follows a colon; and any letters protected
by the right and left parenthesis marks.

� authordate3 produces author-date reference lists with the author's name typeset in
small capitals. Otherwise, the lists are as produced by authordate1.

� authordate4 produces author-date reference lists with the author's name typeset in
small capitals and downstyle titles as in authordate2.

The formats are based loosely on the recommendation of British Standard 1629 (1976
edition), Butcher's Copy-editing (Cambridge University Press, 1981) and The Chicago
Manual of Style (1982 edition).
Be sure to select BIBTEX bibliographies from the Bibliography Choice dialog box

on the Typeset menu. Once you have added the package to your document, you must
specify the .bst �le you want when you insert the BIBTEX �eld.

I To create an author-date reference list
1. Add the authordate1-4 package to your document.

2. From the Typeset menu, choose Bibliography Choice.

3. Check BibTeX and choose OK.

4. Insert BIBTEX citations as needed throughout your document.

5. Specify a .bst �le for the authordate package:

a. Place the insertion point where you want the bibliography to appear in your docu-
ment.

b. From the Insert menu, choose Typeset Object and then choose Bibliography.
c. Select the BIBTEX database �le you want to use.
d. Scroll down the Style list to select the .bst �le for authordate1, authordate2,
authordate3, or authordate4.

e. Choose OK.

6. Save and compile the document.

The package has no options. The package is installed in the TCITeX/TeX/LaTeX/
contrib/bibtex directory. See the harvard package on page 132 and the chicago
package on page 113 for information about other ways to create author-date citations.

Babel
The babel package addresses language-speci�c issues so that TEX works more reliably
to typeset documents written in languages other than English. When the appropriate
language hyphenation patterns are included in the format �le, the package switches the
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active hyphenation patterns as the base language is switched. The multilingual format
�le created with a standard SWP or SW installation includes these hyphenation pat-
terns: English, American English, French, German, and German new orthography.
If you need a different pattern, you must use a different TrueTEX format �le. The pro-

gram CD for Version 3.51 and for Version 4.1 and later (but not for Version 4.0) includes
several format �les in the Extras/TrueTeX/TrueTeXFormatFile directory. If
these don't include the hyphenation pattern you need, you must create a format �le that
does. You can �nd instructions in the online Help.
The babel package also corrects problems with embedded English strings in LATEX,

such as Chapter or Bibliography. When babel is running with a speci�c language,
it uses strings appropriate for that language in place of the embedded English strings.
However, theorem objects must be treated separately. Typically, words that are typeset
in the lead-in objects of theorem statements are set in the nnewtheorem statements in
the document preamble. To change the words, modify the statements in the document
preamble.
If you're working with a non-English document created with a Style Editor style, you

may need to modify the style so that babel substitutes the correct strings for automatic
division headings. The online Help contains instructions.
With the babel package, LATEX can successfully typeset multiple languages in the

same document. The language options shown on the next page are available through the
Options and Packages command on the Typeset menu.
Once you have added the package to a document, you can switch languages within

your document. When you typeset the document, LATEX uses the appropriate language
to typeset embedded strings and hyphenate text.

I To typeset documents using multiple languages
1. Add the babel package to your document.

2. Ensure that the appropriate language hyphenation patterns are included in the format
�le in use.

3. Modify the package options to select the language or languages you want.

LATEX uses the last language you specify as the default language for embedded strings
and hyphenation. See page 69 for information about viewing package options.

4. If you want to switch to a different language at some point in your document,

a. Place the insertion point where you want to begin the language.
b. Enter an encapsulated TEX �eld.
c. In the entry area, type nselectlanguage{language}
where language is the language you want to use at this point in the document. Be
sure you have selected the language option.

d. Choose OK.
When you typeset, LATEX treats the new language correctly.

No standard exists for transporting �les that rely on the availability of a certain lan-
guage. Each �le must be handled on an ad hoc basis. In Version 3.5 and earlier, the
package requires the Multilingual LATEX installation option. The babel package is in-
stalled in the TCITeX/TeX/LaTeX/required/babel directory.
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Language Options Language Options
Afrikaans Include, Exclude Hungarian Magyar, Hungarian,
Bahasa Include, Exclude None of the above
Breton Include, Exclude Irish Gaelic Include, Exclude
Catalan Include, Exclude Italian Include, Exclude
Croatian Include, Exclude Lower Sorbian Include, Exclude
Czech Include, Exclude Norwegian Norsk, Nynorsk,
Danish Include, Exclude None of the above
Dutch Include, Exclude Polish Include, Exclude
English English, U.S. English, Portuguese Portuges, Portuguese,

American, UK British, Brazilian, Brazil,
British, None of the None of the above
above Romanian Include, Exclude

Esperanto Include, Exclude Russian Include, Exclude
Estonian Include, Exclude Scottish Gaelic Include, Exclude
Finnish Include, Exclude Spanish Include, Exclude
French Use French, Use francais, Slovakian Include, Exclude

None of the above Slovenian Include, Exclude
Galician Include, Exclude Swedish Include, Exclude
German Austrian, Austrian new Turkish Include, Exclude

orthography, German, Ukrainian Include, Exclude
German new ortho- Upper Sorbian Include, Exclude
graphy, GermanB, Welsh Include, Exclude
None of the above

Greek Greek, Polutroniko,
None of the above

Bar
The bar package produces simple �at and three-dimensional bar charts. The commands
de�ning the chart are wholly enclosed in a barenv environment housed in a TEX �eld in
the body of the document. Commands in this form

nbar{ordinate}{hatchmark_index}[optional value]

de�ne each data point. These hatchmarks are available:
hatchmark_index
Effect

A series of nset commands de�nes the chart axes and labels.
The package has no options. See the package documentation for more information

about available commands. The package is installed in the TCITeX/TeX/latex209/
contrib/misc directory.

Bibmods
The bibmods package modi�es the TEX thebibliography environment to improve spac-
ing, especially for two-column documents. Adding the package to your document pro-
vides the package functions; no further action is required. No options or commands are
de�ned for the package. The package is installed in the TCITeX/TeX/latex209/
contrib/misc directory.
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Blkarray

The blkarray package de�nes array and tabular environments not unlike those de�ned
by the array package. When the insertion point is in math, the blkarray package im-
plements a blockarray environment that functions similarly to the array environment in
standard LATEX. When the insertion point is in text, the package implements an environ-
ment that functions similarly to the tabular environment.
However, the blkarray package differs in that it de�nes column types differently,

making all column speci�ers equal. The package lends itself to detailed formatting of
blockarray environments. The package implements different formatting for blocks of
cells within a table, such as a header row. Information can span several columns and
doesn't have to be aligned with information in other cells. You can add rules to separate
rows.
Additionally, the package implements the use of delimiters as column speci�ers.

That is, you can use a delimiter around blocks of cells within an array, like this:

2
6664

3
7775

9>>>=
>>>;

1 2 3
4 5 6
7 8 9
1 2 3
4 5 6

Blkarray environments can accept footnote commands. Depending on options selected,
resulting footnotes may appear at the end of the table or the foot of the page.
Package options aren't available. You must specify them in encapsulated TEX �elds,

just as you do for the array package. The content of the encapsulated �eld includes and
de�nes the entire tabular environment. See the package documentation for complete
instructions and for additional examples of blkarray effects. The standard LATEX com-
mand nhline doesn't work with blkarray. While the package produces various kinds
of tables, it may not be an appropriate substitution for array and tabular environments.
The amsmath package, which is added automatically to documents that you save as

SW/SWP/SN (*.tex) or Portable LaTeX (*.tex) documents, has been updated since the
blkarray package was released and now con�icts with the blkarray package. To avoid
the con�ict, modify the preamble of documents that use the blkarray package.

I To modify the preamble of documents that use the blkarray package
1. Save and close the �le, then reopen it.

2. From the Typeset menu, choose Preamble and click the mouse in the entry area.

3. On a new line at the end of the preamble, type
nmakeatletter nnewboxnBA@�rst@box nmakeatother

4. Choose OK.

The package is in TCITeX/TeX/LaTeX/contrib/carlisle.
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Boxedminipage

The package creates a LATEX minipage environment surrounded by rules, like this:

This environment is useful for
emphasizing information.

You can control the width of the environment. Additionally, you can use the standard
TEX commands nfboxrule and nfboxsep to determine the thickness of the rules
and the distance between the rules and the inside edge of the box, respectively.

This environment is useful for emphasizing
information of a mournful nature.

No package options are de�ned for the package. Instead, you enter the package com-
mands in encapsulated TEX �elds. The package is installed in TCITeX/TeX/LaTeX/
contrib/misc.

I To use the boxedminipage environment
1. Add the boxedminipage package to your document.

2. Place the insertion point where you want the boxed environment to begin.

3. Enter an encapsulated TEX �eld and type nbegin{boxedminipage}{x} where x is the
desired width of the minipage.

The command for �rst example on page 110 is

nbegin{boxedminipage}{1.75in}
The commands for the second are

nsetlength{nfboxrule}{4pt}
nsetlength{nfboxsep}{12pt}
nbegin{boxedminipage}{3in}

4. Choose OK.

5. Move the insertion point to the end of the information you want to box.

6. Enter an encapsulated TEX �eld.

7. Type nend{boxedminipage}.

8. Choose OK.
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Breakcites

The breakcites package allows LATEX to create line breaks within long citations or ci-
tations with remarks, resulting in better line spacing in your typeset document. No ac-
tion is required beyond adding the package to your document and creating the citations
you need. The package has no options. It is installed in the TCITeX/TeX/LaTeX/
contrib/misc directory.

Caption

The caption package implements customized captions within �oating environments. In
particular, the package allows de�nition of the caption width and alignment, caption
label font size and font attributes, and caption font size. The package also supports
rotated captions for �oating objects that are presented sideways.
Note that the TrueTEX Previewer provided with SWP and SW doesn't support ro-

tation; you must use a different DVI previewer and print driver if you want to use the
caption package to rotate captions in a DVI �le. However, PDF viewers do support
rotation, so you can use the package to create rotated captions in typeset PDF �les.
With the Options and Packages command on the Typeset menu, you can set op-

tions that affect the alignment, centering, font size, and font attributes of captions. Addi-
tional commands are available for changing other caption attributes, such as the margins
used for captions and the space around captions. The installation program places the
package in the TCITeX/TeX/LaTeX/contrib/caption directory.

Chapterbib

With the chapterbib package, you can create a BIBTEX bibliography for each �le you
include in your document. If each included �le represents a separate chapter, then each
chapter can have its own bibliography. Thus, your document can contain multiple small
BIBTEX bibliographies as well as a comprehensive BIBTEX bibliography for the whole.
You can also create a bibliography for the whole document, such as a recommended
reading list, that is unrelated to cited works. The bibliography items can be cited in
more than one bibliography.
Your document requires several changes to use chapterbib. Each �le that you in-

clude must have its own nbibliographystyle and nbibliography commands.
To generate the bibliography, you must run BIBTEX on each included �le separately.
If you also want a bibliography for the whole document, the master document should
have its own nbibliographystyle command. Generally, to generate the bibliogra-
phies, you must typeset your document (one pass through LATEX), run BIBTEX on each
included �le, and then typeset your document again (two passes through LATEX). The
more complex your document, the more complex the process.

I To generate bibliographies for included �les
1. Add the chapterbib package to your master document.

2. Scroll through the document to �nd each subdocument you have included.

Subdocuments appear as gray boxes containing the subdocument name.



112 Chapter 3 Using LaTeX Packages

3. Replace each subdocument with a TEX �eld:

a. Enter an encapsulated TEX �eld.
b. In the entry area, type ninclude{subdoc} where subdoc is the name of the subdoc-
ument to be included. Do not include the .tex �le extension; LATEX will provide
that automatically.

c. Choose OK.

4. If you are creating a comprehensive BIBTEX bibliography for the entire document,
add a BIBTEX �eld at the point where you want the bibliography to appear.

5. Save the document.

6. For each subdocument that contains citations and for which you want a separate
bibliography, add a BIBTEX �eld at the point where you want the bibliography to
appear.

7. From outside SWP or SW, typeset compile the document �le:

a. From the SWP or SW submenu on the Windows Programs list, choose the
TrueTEX Formatter.

b. Select the �le and choose OK.
LATEX generates .aux �les for each subdocument included.

8. Run BIBTEX on the .aux �le for each subdocument and for the master document, if
it also has a bibliography:
� In Version 4.0 and later,
i From the Typeset menu, choose Tools.
ii Choose Run BibTeX.
or

� In earlier versions,
i From the Windows Start menu, choose Run.
ii In theOpen box, type swp35nTCITeXnSWToolsnbinnbibtex.exe and choose
OK.
Change the name of the program directory as necessary.

iii Specify the .aux �le.
iv Choose Create.
BIBTEX creates a .bbl �le.
v Choose OK.

9. From outside SWP or SW, typeset compile the document �le at least twice more.

10. From inside SWP or SW, typeset preview the document.

Additional commands provide customized entries in a list of citations and multiple
bibliographies without using the ninclude command. With package options you can
repeat or gather all chapter bibliography entries at the end of the document, create a
bibliography for the entire document, and format the bibliography title.
This package is compatible with the cite package (see page 114) and the drftcite

package (see page 120). The �les are in the TCITeX/TeX/LaTeX/contrib/cite
directory.
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Chbibref

The LATEX document class article sets a default name of References for the bibliography,
but the report and book classes set the default name to Bibliography. The chbibref
package sets a standard name for the bibliography for all three LATEX document classes.

I To change the title of the bibliography for all three document classes
1. If you're using Version 3.5 or earlier, obtain and install the chbibref package. (The
package is distributed with later versions.)

2. Add the chbibref package to your document.

3. From the Typeset menu, choose Preamble, and click the mouse in the entry area.

4. At the end of the preamble, add a new line and type nsetbibref{name} where name
is the bibliography title you want.

Note If you're using babel, place the command in the body of the document inside
a TEX �eld.

5. Choose OK.

No package options are available. The package is installed in the TCITeX/TeX/
LaTeX/contrib/misc directory.

Chicago

The chicago package is used in combination with chicago.bst to produce BIBTEX
bibliographies formatted according to The Chicago Manual of Style, Edition 13.

I To create a bibliography formatted according to The Chicago Manual of Style
1. Add the chicago package to your document.

2. From the Typeset menu, choose Bibliography Choice, check BibTeX, and choose
OK.

3. Specify the chicago.bst �le:

a. Place the insertion point where you want the bibliography to appear.
b. From the Insert menu, choose Typeset Object and then choose Bibliography.
c. Select the BIBTEX database �les you want to use.
d. Scroll down the Style list to select chicago.bst and choose OK.

4. Save and compile the document.

The package supports a variety of citation formats, as shown on the next page.
Although the program interface doesn't directly support these modi�cations, you can
achieve the citation format you want by using the commands shown in the table.



114 Chapter 3 Using LaTeX Packages

I To modify the format of bibliography citations
1. Place the insertion point where you want the citation to appear and enter an encap-
sulated TEX �eld.

2. Type the command for the citation format you want, substituting the key for the
BIBTEX reference, and choose OK.

No package options are available. For more information, open a new document with the
Standard LATEX Article (Chicago) shell. The package is installed in the TCITeX/TeX/
LaTeX/contrib/bibtex directory.
Command Citation Format
ncite{key} Full author list and year:

(Pearson 2005; Swanson, MacKendrick, and Medd 2003)
nciteNP{key} Full author list and year, but without enclosing parentheses:

Pearson 2005; Swanson, MacKendrick, and Medd 2003
nciteA{key} Full author list without year:

(Pearson; Swanson, MacKendrick, Medd)
nciteANP{key} Full author list without parentheses:

Pearson; Swanson, MacKendrick, Medd
nciteN{key} Full author list, no parentheses around authors, parentheses

around year:
Swanson, MacKendrick, Medd (2003) note that....

nshortcite{key} Abbreviated author list and year:
(Swanson et al. 2003)

nshortciteNP{key} Abbreviated author list and year, no parentheses:
Swanson et al. 2003

nshortciteA{key} Abbreviated author list:
(Swanson et al.)

nshortciteANP{key} Abbreviated author list, no parentheses:
Swanson et al.

nshortciteN{key} Abbreviated author list and year, parentheses around year:
Swanson et al. (2003)

nciteyear{key} Year information only, with parentheses:
(2005)

nciteyearNP{key} Year information only, without parentheses:
2005

Cite
The cite package sorts numerical citations in ascending order and compresses lists of
at least three consecutive numerical citations that occur together in the text. The sorted
and compressed citations appear inline by default but can be superscripted. The pack-
age produces in-line citations that are preceded by a space, enclosed in brackets, and
separated by a comma and a small space. For superscripted citations, the package omits
surrounding brackets, ignores spaces that occur before a citation, moves most trailing
punctuation in front of the superscript, and suppresses doubled punctuation.
For example, when you typeset using the cite package, a citation of bibliography

items 7, 5, 1, and 4 becomes1; 4; 5; 7 or [1, 4, 5, 7] and a citation of items 2, 6, 4, 7, and 3
becomes2�4; 6; 7 or [2-4, 6, 7].
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I To order and compress citations created with SWP and SW citations

1. Add the cite package to your document.

2. If you want superscripted citations,

a. On the Typeset toolbar, click the Options and Packages button or, from the
Typeset menu, choose Options and Packages.

b. Choose the Packages Options tab.
c. From the Packages in Use list, select the cite package and chooseModify.
d. In the Category list, select Superscript citations and, in the Options list, select
Yes.

e. Choose OK to close each dialog box and return to your document.

3. Create the bibliography list.

4. Place the insertion point where you want a citation to occur.

5. Choose or, from the Insert menu, choose Typeset Object and then choose
Citation.

6. In the Key box,
� Type the keys for the references you want to cite, in any order and separated by a
comma.

or

a. Select the key for the �rst reference from the drop-down list.
b. Select the contents of the Key box and copy the selection to the clipboard.
c. Select the key for the next reference from the drop-down list.
Note that because the �rst key was selected, the new key overwrites the previous
one.

d. Type a comma.
e. Paste the contents of the clipboard to the Key box.
f. Repeat steps b�e until you have entered all the references you want to cite.

7. Choose OK.

When you typeset the document, LATEX orders and compresses the list.

In addition to the command to create superscripted citations, many commands are
available through the Options and Packages command on the Typeset menu to vary
the spacing within a list of citations and in the text immediately surrounding it. Com-
mands are also available to disable sorting and compression. By adding a command to
the preamble, you can omit the brackets surrounding in-line citations.

I To omit the brackets surrounding in-line citations
1. From the Typeset menu, choose Preamble and click the mouse in the entry area.

2. On a new line at the end of the preamble entries, type nletncite=nciten and choose
OK.
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The cite package is compatible with two packages also installed in the TCITeX/
TeX/LaTeX/contrib/cite directory: drftcite (see page 120) and chapterbib (see
page 111). The cite package now includes the features previously contained in another
related package, overcite, which has been superseded.

Color
The color package produces boxes or entire pages with colored backgrounds. The pack-
age implements LATEX support for color when the active typeset output driver can pro-
duce colored text. Many driver options are available through the Options and Pack-
ages command on the Typeset menu. For �exibility, we recommend that you leave the
options unmodi�ed. The local LATEX installation sets the driver defaults. If you leave the
con�guration unchanged, you can compile your document without changes in another
LATEX environment. The package works successfully with PDF �les.
You can prede�ne the colors you want to use in the preamble of your document or

specify them at the point you need them with commands in encapsulated TEX �elds. The
commands specify whether you want a box or a page in color. The commands also spec-
ify which of four common color models you want to use: rgb (red, green, blue); cmyk
(cyan, magenta, yellow, black); gray; or named (names known to the selected driver).
The monochrome option turns off all colors and is useful if you want to preview your
document using a previewer that cannot produce color. Command arguments specify
the exact color. See the package documentation for more information about using the
package commands.

I To use color in a document
1. Add the color package to your document.

2. If necessary, change the driver con�guration:

a. Modify the package options to select the driver you want to use.
b. Use the Expert Settings command on the Typeset menu to modify the format,
preview, and print driver settings to re�ect the driver.
For instructions, see the online Help or Creating Documents with Scienti�c Work-
Place and Scienti�c Word. The drivers must have been installed separately. They
aren't included with SWP or SW.
Important Don't attempt to modify the driver settings if you're not very familiar
with TEX and LATEX.

The color package is part of the Standard LaTeXGraphics Bundle along with graph-
icx (see page 131). For more information, see the PackageSample-color.tex �le
in the SWSamples directory of your program installation. The package is installed in
the TCITeX/TeX/LaTeX/required/graphics directory.

Colortbl
The package produces colored background panels and rules for speci�ed columns or
rows of a table or array. The package implements LATEX support for color when the
active typeset output driver can produce colored text.
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You can add color to a row in a table by inserting a package command in the table.
Adding color to a column is more complex: you must enter the colortbl package com-
mands, along with commands for the entire tabular environment, in an encapsulated TEX
�eld. You indicate the size of each color panel and the corresponding color you want
with commands placed at the start of the tabular environment.
The basic command syntax is as follows:

ncolumncolor[w]{x}[y][z] or nrowcolor[w]{x}[y][z]

where
w is the color model: rgb (red, green, blue); cmyk (cyan, magenta, yellow, black);

gray; or named (names known to the selected driver),
x is the selected color,
y is the amount of left overhang past the widest entry in the column, and
z is the amount of right overhang past the widest entry in the column.

See the package documentation for instructions and for additional examples of package
effects.

I To add color to a table row
1. Add the colortbl package to your document.

2. Create a table.

3. Place the insertion point in the table at the beginning of the row you want to appear
in color.

4. Enter an encapsulated TEX �eld.

5. In the entry area, type nrowcolor[w]{x}[y][z], completing the command as described
above.

6. Choose OK.

I To add color to a table column
1. Place the insertion point where you want the table to appear.

2. Enter an encapsulated TEX �eld.

3. In the entry area, enter the complete tabular environment.

4. Place the insertion point at the beginning of the column you want to appear in color.

If your table is de�ned with the command nbegin{tabular}{jljljlj}, for ex-
ample, and you want to add color to the �rst column, place the insertion point after
the �rst j.

5. Type >{ncolumncolor[w]{x}[y][z]}, completing the command as de�ned above.

6. Choose OK.
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Many driver options are available through theOptions and Packages command on
the Typesetmenu. The package is installed in the TCITeX/TeX/LaTeX/contrib/
carlisle directory. It should work successfully with other packages that have syntax
compatible to that of the array package, such as longtable and dcolumn. The package
works successfully with PDF �les.

Comma

The comma package formats LATEX counter values so that they print with a separator
(such as a comma) every three digits. That is, the package prints a counter value of 1374
as 1,374 when the comma package is added to the document. The default separator is
a comma, but you can customize it to use a period, thin space, or any other symbol that
can be represented by a TEX command. LATEX uses the same separator for all counters.
To use the package, you must add TEX commands to the document preamble or

insert TEX �elds containing those commands in the body of your document. To place
the separator in all counters of more than three digits, place the command at the start of
the body of the document. LATEX applies the command from that point forward.

I To insert separators in printed LATEX counters
1. Add the comma package to your document.

2. Add the package commands to the preamble of your document:

a. From the Typeset menu, choose Preamble.
b. Click the mouse in the entry area and scroll to the end of the entries.
c. Type nrenewcommandnthecounter{ncommaform{counter}} where counter is
the LATEX counter to be printed with a separator, such as the section number counter.

d. If you want to change the separator from a comma to some other symbol, add
nrenewcommandncommaformtoken{x} where x is any TEX command.

e. Choose OK.

or

Add the commands in the body of the document:

a. Place the insertion point at the start of the text.
b. Enter an encapsulated TEX �eld.
c. Type the package commands you need.
d. Choose OK.

No package options are available. The package is installed in the TCITeX/TeX/
LaTeX/contrib/carlisle directory.

Crop

The crop package provides a variety of corner crop marks to be used for camera align-
ment, trimming paper stacks, and visualizing physical page dimensions.
With the many available options, you can specify the type and location of crop marks,
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print page information outside the page area on every page, declare standard or custom
paper dimensions, specify a printer driver, and change the orientation and location of the
document on the printed page. Other options allow the rotation, mirroring, or inversion
of the output. The package options also allow the printing of the document text and
graphics separately if necessary, and provide for better collaboration with certain printer
drivers.
The crop package handles color with the color package, which it loads automati-

cally. It also uses the geometry package. The crop package doesn't work for docu-
ments created with Style Editor shells.
Use theOptions and Packages command on the Typesetmenu to add the package

to your document and specify options. See the package documentation for details. The
package is installed in the TCITeX/TeX/LaTeX/contrib/crop directory

Dcolumn

The dcolumn package provides decimal point alignment for columns of entries in a
tabular or array. You can de�ne the separator (usually a period or comma) on which the
columns align. Also, you can de�ne a separator for the DVI output �le and the maximum
number of decimal places allowed in the column.
You must enter the dcolumn command, along with the commands for the entire

tabular environment, in an encapsulated TEX �eld. The basic syntax of the column
separator command is

D{separator for the tex �le}{separator for LaTeX}{decimal places}

where separator for the tex �le is the punctuation used in the document to indicate the
decimal point; separator for LaTeX is the punctuation you want LATEX to use when you
typeset; and decimal places is the maximum number of decimal places in the column. A
negative number in the decimal places argument indicates that any number of decimal
places is acceptable.

I To align column entries on a decimal point
1. Place the insertion point where you want the table to appear.

2. Enter an encapsulated TEX �eld.

3. In the entry area, type

nnewcolumntype{d}[0]{D{separator for the tex �le}{separator for LaTeX}
{decimal places}}

and complete the command as de�ned above.

4. Enter the complete tabular environment, beginning with a nbegin{tabular}{d....d}
command and ending with an nend{tabular} command.

5. Choose OK.

No package options are available. The package is installed in the TCITeX/TeX/
LaTeX/required/tools directory and is part of the Standard LATEX Tools Bundle.
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Delarray
The package enhances the array package by adding a system of large paired delimiters
around the array. This feature is built into SWP and SW.

I To de�ne delimiters for an array
1. Add the delarray package to your document.

2. Place the insertion point where you want the delimited array to appear.

3. Enter an encapsulated TEX �eld.

4. Type n[nbegin{array}j{c}j where j is the delimiter you want and c is repeated for
each column in the array.

5. Enter the contents of the array.

6. Type nend{array}n] and choose OK.

The package has no options. The package is installed in the TCITeX/TeX/LaTeX/
required/tools directory and is part of the Standard LATEX Tools Bundle.

Doublespace
This package has been superseded by the setspace package (see page 161) and is in-
cluded in SWP and SW for compatibility purposes. The package produces double
spacing by rede�ning the LATEX parameter nbaselinestretch to 2. After you have
added doublespace to your document, you need no additional commands to create a
document that is double spaced throughout, with the exception of footnotes. No pack-
age options are available. The doublespace package is installed in the TCITeX/TeX/
latex209/contrib/misc directory.

Drftcite
The drftcite package is designed to manage citations and bibliography items in docu-
ment drafts. Remove the package or replace it with the cite package when you're ready
for �nal printing. Drftcite forces LATEX to print citations and reference lists using the la-
bels of the bibliography items instead of their numbers. (LATEX stores the correct citation
numbers in the .aux �le for subsequent use.) In the reference list, the package uses su-
perscripted numbers to note the order in which bibliography items are cited in the text.
Thus, the numbers also indicate the order in which the bibliography items should ap-
pear in the reference list. Uncited bibliography items are easy to �nd because they have
no superscripted number. Unlike cite, the drftcite package doesn't order the items in
the citation list. Drftcite works with both BIBTEX and manual bibliographies. Create
citations as usual from the Insert menu or Typeset Field toolbar.

I To print citations and reference lists using item labels
1. Add the drftcite package to your document.

2. Place the insertion point where you want a citation to occur.
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3. Click or, from the Insert menu, choose Typeset Object and then choose Ci-
tation.

4. Enter the key of the reference you want to cite.

5. Choose OK.

Several citation formatting options are available through the Options and Pack-
ages command on the Typeset menu.
The drftcite package is compatible with the cite package (see page 114) and the

chapterbib package (see page 111) It is installed in the TCITeX/TeX/LaTeX/contrib/
cite directory.

Dropping

The dropping package creates large dropped letters, as you see at the beginning
of this paragraph. The number of lines over which you want the letters to extend
determines their size. Experimentation will help you determine the most visually

pleasing size for your document.

I To enter a dropped letter
1. Add the dropping package to your document.

2. Place the insertion point at the beginning of a paragraph.

3. Enter an encapsulated TEX �eld.

4. In the entry area, type ndropping[x]{y}{z} where x indicates how far from the left
margin the letter should start (0pt is the default); y is the number of lines over which
you want the capital letter to extend; and z is the letter or letters you want to enlarge.

5. Choose OK.

6. Type the remainder of the sentence.

In addition, many driver options are available through the Options and Packages
command on the Typeset menu. We recommend that you leave the driver option un-
changed. The package is in the TCITeX/TeX/LaTeX/contrib/dropping direc-
tory.

Endnotes

The package forces LATEX to produce footnotes in a list of notes set in small type at the
end of the document, instead of as footnotes set on the bottom of the page on which
they occur. The package stores the endnotes in an extra external �le with the �le ex-
tension .ent. LATEX generates a new version of the .ent �le each time you typeset the
document.
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I To replace footnotes with endnotes
1. Add the endnotes package to your document.

2. Modify the document preamble:

a. From the Typeset menu, choose Preamble.
b. Click the mouse in the entry area.
c. Scroll to the end of the entries and add a new line.
d. Type nletnfootnote=nendnote and choose OK.

3. Create the footnotes:

a. From the Insert menu, choose Note.
b. In the Type of Note box, select footnote.
c. Type the footnote and choose OK.

4. Place the insertion point at the end of the document, where you want the endnotes to
appear.

5. Enter an encapsulated TEX �eld.

6. Enter the commands you need:

a. If you want the endnotes to begin on a new page, type nnewpage and press ENTER.
b. Type nbegingroup and press ENTER.
c. If you want an entry for the endnotes to appear in the table of contents, type
naddcontentsline{toc}{section}{Notes} and press ENTER.

d. If you want the endnotes to be set in a normal size font instead of a smaller font,
type nrenewcommand{nenotesize}{nnormalsize} and press ENTER.

e. Type ntheendnotes and press ENTER.
f. Type nendgroup and choose OK.

7. Typeset your document.

LATEX places any footnotes in the document in a list at the location of the encapsulated
�eld.

The package implements additional commands to produce numbered endnotes; pro-
duce the endnote mark in the text but no corresponding endnote; or produce an endnote
but no corresponding mark in the text. Additional commands change the endnote size
and produce endnote numbers or marks. See the package documentation for additional
information about using the package and see an example of the package in use in the
PackageSample-endnotes.tex �le in the SWSamples directory of your pro-
gram installation. No package options are available for the endnotes package. The
package is installed in the TCITeX/TeX/LaTeX/contrib/misc directory.
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Enumerate
The enumerate package provides an optional argument for the enumerate (numbered
list) environment so that you can de�ne the style in which LATEX prints the counter.
Argument parameters include designations for upper and lowercase alphabetic charac-
ters, upper and lowercase Roman numerals, and arabic numerals. To use the enumerate
package, you must place the entire list in an encapsulated TEX �eld. Lists may be nested.

I To de�ne a counter style for numbered lists
1. Add the enumerate package to your document.

2. Place the insertion point where you want the numbered list to appear.

3. Enter an encapsulated TEX �eld.

4. Type nbegin{enumerate}[x] where x is the designation of the counter numbering
scheme:
Scheme Example Produces
A A, B, C, ... uppercase letters (as produced by nAlph)
a a, b, c, ... lowercase letters (as produced by nalph)
I I, II, III, ... uppercase roman numerals (as produced by nRoman)
i i, ii, iii, ... lowercase roman numerals (as produced by nroman)
1 1, 2, 3, ... arabic numbers (as produced by narabic)

5. Choose OK.

6. For each item in the list,

a. Enter an encapsulated TEX �eld.
b. Type nitem text where text is the content of the list item.
c. Choose OK.

7. At the end of the list, enter an encapsulated TEX �eld.

8. Type nend{enumerate} and choose OK.

No package options are available for the enumerate package. The package is
installed in the TCITeX/TeX/LaTeX/required/tools directory as part of the
Standard LATEX Tools Bundle.

Euler
The euler package produces mathematics in LATEX documents using the AMS Euler
family of fonts (Euler Roman, Euler Fraktur, Euler Script, and Euler Extension). After
you add the euler package to your document, LATEX produces all mathematics in the
document using the Euler font family. Several package options for formatting with
Euler fonts are available through theOptions and Packages command on the Typeset
menu. The package is in the TCITeX/TeX/LaTeX/contrib/euler directory.
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Exscale
The exscale package provides different sizes of large mathematical symbols in LATEX
documents. The symbols are based on certain sizes of the cmex10 font and on cmex
7-point to 9-point variants, which are part of the amsfonts package. The exscale
package is redundant in SWP and SW documents, in which mathematical operators and
delimiters are scaled automatically. The package has no options. Exscale is installed in
the TCITeX/TeX/LaTeX/base directory.

Fancybox
The fancybox package provides several different styles of boxes for framing and rotat-
ing content in your document. Fancybox provides commands that produce boxes with
shadows, square-cornered boxes with single or double lines, and round-cornered boxes
with normal or bold lines, such as these:

Text with shadow box �� ��Text with oval box Text with double box

The boxes can contain words, lines, paragraphs, or whole pages, and the boxes can be
centered or right- or left-justi�ed.
Note that the TrueTEX Previewer provided with SWP and SW doesn't support ro-

tation; you must use a different DVI previewer and print driver if you want to rotate
boxed content in a DVI �le. However, PDF viewers support rotation, so you can use the
package to create rotated boxes in typeset PDF �les.
Package options aren't available for the fancybox package. Use encapsulated TEX

�elds to box information in your document.

I To box information in your document
1. Add the fancybox package to your document.

2. Enter an encapsulated TEX �eld.

3. Type ncommand{content to be boxed} where command is the fancybox command
you need:

Command Effect
fbox square box
shadowbox square box with shadow
doublebox double square box
ovalbox thin oval box
Ovalbox thick oval box

4. Choose OK.

Package documentation includes useful information about using LATEX box macros.
The PackageSample-fancybox.tex �le in the SWSamples directory of your
program installation contains more examples of fancybox effects. The package is in-
stalled in the TCITeX/TeX/LaTeX/contrib/fancybox directory.
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Fancyhdr
The fancyhdr package is a page layout customizing package that replaces the fan-
cyheadings package. It handles footers and headers ef�ciently, but also works with
placement of �oats. With the package, you can de�ne headers and footers with multi-
ple parts and on multiple lines, place rules in headers and footers, and use a header and
footer width different from that of the text. Additionally, you can use different head-
ers and footers for even and odd pages, �rst pages of chapters, and on pages containing
�oats, and you can produce dictionary-style headers re�ecting the �rst and last words on
a page. Fancyhdr also provides control over fonts and upper- and lowercase letters.
No package options are available. However, the package uses a simpli�ed syntax for

entering commands.

I To de�ne the content of headers and footers
1. Add the fancyhdr package to your document.

2. Specify a new header and footer setup in the document preamble:

a. From the Typeset menu, choose Preamble.
b. Click the mouse in the entry area.
c. On a new line, type npagestyle{fancy}.

3. De�ne the content of the header (note that the text argument in these commands can
contain TEX commands):

a. On a new line, type nlhead{text} where text is the information you want left-
justi�ed in the header.

b. On a new line, type nchead{text} where text is the information you want centered
in the header.

c. On a new line, type nrhead{text} where text is the information you want right-
justi�ed in the header.

d. If you want a rule under the header, type nrenewcommand{nheadrulewidth}{x}
where x is the point size of the rule you want.

4. De�ne the content of the footer (note that the text argument in these commands can
contain TEX commands):

a. On a new line, type nlfoot{text} where text is the information you want left-
justi�ed in the footer.

b. On a new line, type ncfoot{text} where text is the information you want centered
in the footer.

c. On a new line, type nrfoot{text} where text is the information you want right-
justi�ed in the footer.

d. If you want a rule over the footer, type nrenewcommand{nfootrulewidth}{x}
where x is the point size of the rule you want.

5. Choose OK.
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De�ning different headers and footers for double-sided documents increases the de-
�nitions, some for even (left) and others for odd (right) pages. You can occasionally
combine de�nitions in the same command by specifying when they should appear. The
package uses these settings:

Setting Prints on
E Even page
O Odd page
L Left
C Center
R Right
H Header
F Footer

I To de�ne the content of different headers and footers for even and odd pages
1. Add the fancyhdr package to your document.

2. Specify a new header and footer setup in the document preamble:

a. From the Typeset menu, choose Preamble.
b. Click the mouse in the entry area.
c. On a new line, type npagestyle{fancy}.
d. On a new line, type nfancyhf{} to clear all �elds in the header and footer.

3. Specify the header:

a. On a new line, type nfancyhead[location]{text} where location speci�es the page
and �eld of the header and text speci�es the information you want to appear.
For example, the command nfancyhead[LE,RO]{nthepage} puts the page
number in the left �eld of the header on even (left) pages and in the right �eld of
the header on odd (right) pages.

b. Repeat step a as needed to specify the header �elds on both even and odd pages.

4. Specify the footer:

a. On a new line, type nfancyfoot[location]{text} where location speci�es the page
and �eld of the footer and text speci�es the information you want to appear.

b. Repeat step a as needed to specify the footer �elds on both even and odd pages.

5. Choose OK.

Additional instructions about using the fancyhdr package appear earlier in this man-
ual. See page 8 for instructions about adding a rule under a header, page 11 for instruc-
tions about moving page numbers, and page 6 for instructions about specifying header
and footer information. The package documentation contains complete instructions and
useful diagrams of LATEX page layout elements. The installation program places this
package in the TCITeX/TeX/LaTeX/contrib/fancyhdr directory.
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Fancyvrb

The fancyvrb package provides customizable environments and commands for typeset-
ting and manipulating verbatim text. You can change the font family and size, number
lines of text, and create frames around code examples with optional arguments to the
main package environment, Verbatim. All package commands and the text to be pre-
sented in the Verbatim environment must appear in unencapsulated TEX �elds, each on a
separate line in the body of your document. The package works line by line and creates
effects such as this:

1 The�normal�case�with�1pt�rules,
2 spaces�marked,�and�line�numbers�on�the�left.

See the package documentation for information about commands and variations on
the environment. The fancyvrb package is installed in the TCITeX/TeX/LaTeX/
contrib/fancyvrb directory.

Fix2col

The �x2col package modi�es the LATEX two-column output routine by improving the
handling of marks. If the �rst column of a two-column page contains marks, the package
tells LATEX to use nfirstmark from the �rst column rather than discarding it. Also,
the package improves the handling of �oating objects by anchoring both one- and two-
column �oating objects in a single sequence. Without the package, LATEX may anchor
two-column �oating objects after those with a single column.
No action is required beyond adding the package to your two-column document.

No package options are available for the �x2col package, which is installed in the
TCITeX/TeX/LaTeX/contrib/carlisle directory.

Flafter

Ordinarily, LATEX tries to place �oating objects at the top of the page, regardless of where
the reference to the object occurs. The �after package overrides the ordinary placement
to force LATEX to print the �oating object after the reference to it.
No action is required beyond adding the �after package to your document. No

package options are available. The package is installed in the TCITeX/TeX/LaTeX/
base directory as part of the Standard LATEX Base System.

Float

Instead of being anchored at a speci�c point in a LATEX document, �oating objects are
movable. LATEX determines their best placement and �nal position in the typeset docu-
ment after taking into consideration line and page breaks and division headers. You can
suggest a preferred placement to LATEX by specifying t (top of a page), b (bottom of a
page), p (on a page of �oating objects), or h (where the �oating object appears in the
document �le, if possible).
The �oat package improves the interface for de�ning and placing �oating objects

by de�ning the H (Here) placement option of the superseded Here package. It uses
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the H placement option with the FRAME macro in tcilatex.tex to tell LATEX to
place a �oating object where it appears in the document �le, even if the placement is
typographically ill advised. If not enough room remains on the page to hold the object,
LATEX moves it to the next page, leaving blank space on the page before.
SWP and SW work differently with the �oat package depending on how you save

your document. If you save it as an SWP or SW document, the program automatically
uses the H placement option when you select only the Here placement for a �oating
graphic. If you save the document as a Portable LATEX document, the program ignores
the H option. Using the package reduces the likelihood that LATEX will accumulate too
many �oating objects to typeset your document correctly.

Because PDFLATEX and the Portable LATEX output �lter bypass the FRAME macro, the
�oat package can't be used to control the placement of �oating objects in PDF or
portable LATEX �les. The placeins package provides an option.

I To force the placement of �oating objects where they appear in the document �le
1. Add the �oat package to your document.

2. Enter a �oating object. (Use the fragment named Table - (4x3, �oating) to enter a
table that �oats.)

3. Edit the properties of the �oating object to specify only the Here placement:
� If the object is a graphic,
i Edit the properties of the graphic to open the Graphic Properties dialog box.
ii Choose the Layout tab.
iii In the Placement area, select Floating, check Here, uncheck the other three
placement options, and then choose OK.
or

� If the object is a table,

i Edit the box in the Table - (4x3, �oating) fragment, which contains the
command nbegin{table}[tbp] ncentering.
ii Change the [tbp] entry to [H] and choose OK.

The �oat package implements two �oat styles: boxed and ruled �oats. Boxed �oats
are surrounded by a box extending from the right to the left margin, regardless of the size
of the �oating object. Ruled �oats are introduced by a horizontal line; have another line
under the caption, if any; and are followed by a third line, all extending from the right to
the left margin. You must de�ne the �oat style and the �oating object in an encapsulated
TEX �eld. The package also provides a way to de�ne your own types of �oating objects,
which can be ruled or boxed. See the documentation for the �oat package for more
information.
The �oat package has no options. The installation program places the package in

the TCITeX/TeX/LaTeX/contrib/float directory.
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Fncychap
The fncychap package provides six prede�ned layout styles for chapter headings in
books and reports. The styles are provided as options for the package; the option Lenny
is shown below. You can modify the styles or use special commands in the preamble to
create your own chapter headings, as described in the package documentation.

Chapter 1
Title of the Chapter

To use the package, add it to your document and specify the style option you want.
Note that the package doesn't work reliably with numbered chapters that occur before
the main matter of the document. The installation program places the package in the
TCITeX/TeX/LaTeX/contrib/fncychap directory.

Fontsmpl
The fontsmpl package produces a test of a font family, such as Computer Modern or
Times, showing the font in use in sample text, a table of contents, and a sample of
commands. You can use the package to print a sample of the font currently in use in
your document or you can open and typeset a sample document that produces a sample
of the font family you indicate.

I To print a sample of the font currently in use
1. Add the fontsmpl package to your document.

2. Place the insertion point where you want to sample the font and enter an encapsulated
TEX �eld.

3. Type nfontsample and choose OK.

4. Typeset preview the document.

I To produce a font sample with the sample document
1. Open the �le fontsmpl.tex in the TCITeX/TeX/LaTeX/required/tools
directory.

2. Typeset preview the document.

3. When LATEX prompts you for a font family, type the font family name, such as cmr
for Computer Modern or times for Times Roman, and press ENTER.

4. Scroll through the document displayed in the TrueTEX Previewer to examine the
appearance of the font.

The package has no options. The installation program places the package in the
TCITeX/TeX/LaTeX/required/tools directory.
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Footmisc

The footmisc package was designed for customizing footnotes. The package options
address the format, positioning, and numbering of single and multiple footnotes. The
package provides for using symbols instead of footnote numbers. It also provides some
debugging tools.

I To customize footnotes
1. Add the footmisc package to your document.

2. Modify the package options to select the option you want and choose OK.

The package is installed in the TCITeX/TeX/LaTeX/contrib/footmisc di-
rectory.

Ftnright

The ftnright package formats footnotes for two-column documents. It prints all foot-
notes that occur on a page at the foot of the right-hand column. Footnotes appear in
smaller type than that used for the text. The footnote numbers are set on the baseline
rather than as superscripts. The text and the footnotes aren't separated by a line. When
you add the ftnright package to your document, specify a two-column layout with the
document class options instead of the multicol package (see page 143). The ftnright
package doesn't work successfully with multicol.
After adding the package to your document, no further action is required. The pack-

age has no options. The ftnright package is installed in the TCITeX/TeX/LaTeX/
required/tools directory as part of the Standard LATEX Tools Bundle.

Geometry

The geometry package provides a simple way to customize the page layout of your
document. If the shell you're using provides a largely adequate layout, you may be able
to use the geometry package to customize the shell so that it meets all your typesetting
requirements. In particular, the easiest way to change the typeset margins for a document
is to add the geometry package and then include in the document preamble a command
to change the margins.
You can use the package to specify portrait or landscape orientation, margins, margin

offsets for two-sided printing, elimination of the space for headers and/or footers, paper
size, horizontal and vertical offsets, and many other typesetting details. The package
uses automatic completion of layout dimensions; if you don't specify all dimensions,
the package supplies the remainder automatically. The geometry package also uses
auto-centering and auto-balancing mechanisms so that you can use simple, minimal
descriptions to de�ne the page layout you want. For example, you can set all the margins
to 3 centimeters without any space for headers or footers using this command in the
preamble of your document:

nusepackage[margin=3cm,noheadfoot]{geometry}
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The package uses the �key val� (key = value) interface. As seen in the above exam-
ple, command arguments consist of key val options, separated by commas. Options are
usually order-dependent. You can specify commands in multiple lines.
With the Options and Packages command on the Typeset menu, you can set

options for the geometry package. The options affect page orientation, paper size, print
side, margin notes, headers and footers, and magni�cation. You can make additional
speci�cations with TEX commands in the preamble of your document. See Chapter 1
�Tailoring Typesetting to Your Needs� to learn how to use the geometry package to
change margins, page orientation, header and footer space, and paper size. The package
documentation contains additional instructions and a good illustration of LATEX page
layout concepts. The package is installed in the TCITeX/TeX/LaTeX/contrib/
geometry directory.

Graphicx
The package is one of three packages�with color (see page 116) and graphics�
included as part of the Standard LATEX Graphics Bundle. Although identical to the
graphics package in function, the graphicx package has an interface that is easier to
use and more powerful.
The graphicx package implements LATEX support for including graphics �les, ro-

tating parts of a page, and scaling parts of a page. The package depends on having a
typeset output driver that can produce these effects and it has package options for many
different output drivers. If you specify a package option for a particular driver and then
typeset your document, the resulting DVI �le can only be previewed or printed with the
driver you've speci�ed. Using the package default (that is, not specifying a driver) is
more convenient, because you can switch between creating PDF and DVI �les without
having to modify the driver used by the package.
Because the TrueTEX Previewer provided with SWP and SW doesn't support ro-

tation, you must use a different DVI previewer and print driver if you want to use the
graphicx package to rotate parts of a page in a DVI �le. However, PDF viewers support
rotation, so you can use the package to rotate parts of a page in typeset PDF �les.
You provide additional information to the package with the nincludegraphics

commands placed in TEX �elds in the body of your document. The command has op-
tional arguments that de�ne the type of graphic; its desired size, shape, and angle of
rotation; and the size and shape of the box surrounding the graphic. See page 52 for in-
structions about using the graphicx package to correct problems with typesetting Post-
Script graphics. The package is installed in the TCITeX/TeX/LaTeX/required/
graphics directory.
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Harvard

The harvard package is a family of seven BIBTEX bibliography styles:

Bibliography Style Meets format requirements of
AGSM Australian Government Style Manual
APSR American Political Science Review
DCU Design Computing Unit, Department of Architectural

and Design Science, University of Sydney
JMR Journal of Management Research
J Physics B Journal of Physics B
Kluwer Kluwer Academic Publishers
Nederlands Dutch conventions

Although the format differs with each style, all seven styles implement standard
parenthetical citations:

The de�nitive work on the subject (Medd 2005)....

Citations can be complete or incomplete. Complete citations can be used as nouns:

Medd (2005) proves that....

or as possessives:

Medd's (2005) de�nitive work on the subject....

Incomplete citations can contain the author's name without the date:

The de�nitive work on the subject (Medd)....

or the date without the name:

The de�nitive work on the subject (2005)....

The options available through the Options and Packages command on the Typeset
menu determine the type of citation (full, abbreviated, or full for the �rst citation and
abbreviated thereafter), type of parentheses, and style of the citations and bibliography.
Although the package was designed for use with BIBTEX bibliographies, you can also
use it with a manual bibliography. The PackageSample-harvard-manual.tex
�le in the SWSamples directory illustrates the use of the package with a manual bibli-
ography. The Standard LATEX Article (Harvard) shell contains more information.

I To use a harvard bibliography style with a BIBTEX bibliography
1. Add the harvard package to your document and select any options you want.

2. From the Typeset menu, choose Bibliography Choice.

3. Check BibTeX and choose OK.

4. Insert citations as needed in your document.
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5. Specify the harvard .bst �le you want:

a. Place the insertion point where you want the bibliography to appear.
b. From the Insert menu, choose Typeset Object and then choose Bibliography.
c. Select the BIBTEX database �le you want to use.
d. Scroll down the Style list to select one of the harvard .bst �les and choose OK.

6. Save the document.

7. On the Typeset toolbar, click the Typeset DVI Compile button or, from the
Typeset menu, choose Compile.

8. Check Generate a Bibliography and choose OK.

9. Typeset preview your document.

The harvard package is intended to be used with BIBTEX bibliographies. You can
also use it with manually created bibliographies by inserting nharvarditem com-
mands in TEX �elds to create the bibliography list.

I To use a harvard bibliography style with a manual bibliography
1. Add the harvard package to your document and select any options you want.

2. From the Typeset menu, choose Bibliography Choice.

3. CheckManual and choose OK.

4. Create citations as needed in your document.

5. Begin the bibliography list:

a. Place the insertion point where you want the bibliography to appear in your docu-
ment.

b. Enter an encapsulated TEX �eld.
c. In the entry area, type nbegin{thebibliography}{x} where x is the longest label in
the bibliography list and determines the indention of the list items.

d. Choose OK.

6. For each item in the list:

a. Enter an encapsulated TEX �eld.
b. Name the �eld with the key to provide a visual reminder of the key.
c. In the entry area, type nharvarditem{citation}{year}{key} where citation is the
information to be cited in the text except for the year, year is the year to be cited,
and key is the key of the reference used in the citation.

d. Choose OK.
e. Type the reference in full as you want it to appear in the list of references.
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7. End the bibliography list:

a. Place the insertion point after the last item.
b. Enter an encapsulated TEX �eld.
c. In the entry area, type nend{thebibliography} and choose OK.

8. Save and typeset compile the document.

See an example of the package in use in the Harvard.tex �le in the TCITeX/
doc/latex/contrib/harvard directory of your program installation. The pack-
age is installed in the TCITeX/TeX/LaTeX/contrib/harvard directory.

Helvet

See PSNFSS Packages on page 152.

Hhline

The hhline package works with the array package (see page 104) to implement �ne
control of single and double horizontal lines (like nhline and nhlinenhline) within
typeset tables, as shown here:

a b c d
s w p 5.5
1 2 3 4
5 6 7 8

Note that you can achieve similar results in SWP and SW without the hhline package:

a b c d
s w p 5.5
1 2 3 4
5 6 7 8

However, when you use double lines around the outside of a table, the hhline package
may produce a more pleasing appearance at the outside corners.
The lines are governed by the package command nhhline. The command argu-

ments are tokens, or symbols, that indicate the absence, presence, and width of a hori-
zontal line and whether or not it breaks or is broken by an intersecting vertical line. See
the package documentation for a discussion of the tokens.

I To create horizontal lines within a tabular environment
1. Add the hhline package to your document.

2. Enter an encapsulated TEX �eld.

3. In the entry area, type nbegin{tabular} to de�ne a tabular environment.
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4. Enter the tabular content.

5. Between rows of content, use nhhline commands with appropriate tokens to de�ne
the lines you want.

6. Type nend{tabular} to end the environment and choose OK.

No package options are available. The hhline package is installed in the TCITeX/
TeX/LaTeX/required/tools directory as part of the Standard LATEX Tools Bun-
dle.

Hyperref
From LATEX cross-referencing commands, including the table of contents, bibliogra-
phies, and page-references, the hyperref package creates nspecial commands that a
driver can turn into hypertext links. The package also provides commands with which
you can write ad hoc hypertext links, including links to external documents and URLs.
The package extends the hypertext possibilities of .tex documents so that typesetting
the document with PDFLATEX produces a table of contents linked to the body of the doc-
ument, automatically creating bookmarks, thumbnails, and linked headings.
Note that the package must distinguish between chapters and sections when dealing

with appendices. If the chapter tag exists in your document, the package automatically
generates different markers for the table of contents links to appendices. When you
save a �le as a SW/SWP/SN (*.tex) document, the program includes the macro �le
tcilatex.tex and the chapter macro is de�ned. You can remove the chapter de�nition and
generate the correct markers for the appendices.

I To remove the chapter de�nition
� Place the following command in a TEX �eld immediately preceding the appendix or
place it in the document preamble following the line ninput{tcilatex}:
nletnchapternunde�ned
Note that the TrueTEX Previewer provided with SWP and SW doesn't support the

package, but PDF viewers do, so you can use hyperref to maintain active LATEX cross-
references in PDF �les that you typeset from your document. When you add the hyper-
ref package to your document, move it to the bottom of the Packages in Use list.
The package has macros and options available; see the extensive package documen-

tation for information about the commands. The hyperref package is installed in the
TCITeX/TeX/LaTeX/contrib directory.

Hyphenat
The hyphenat package disables hyphenation in parts of your document or in the doc-
ument as a whole. Also, it enables hyphenation of words containing nonalphabetic
characters, such as underscores, and text that is set in monospaced fonts.
The two available package options turn hyphenation on and off and control hyphen-

ation for monospaced fonts. Note that when you select the None option, which prevents
all hyphenation, you may get LATEX messages about bad line breaks and overfull boxes
when you compile your document. For more information, see page 37. The hyphenat
package is installed in the TCITeX/TeX/LaTeX/contrib/hyphenat directory.
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Indent�rst
The indent�rst package indents the �rst line of all sections by the usual paragraph
indention. Other than adding the package, no action is required. No package options
are available. The package works successfully with all standard document classes. It
is installed in the TCITeX/TeX/LaTeX/required/tools directory as part of the
Standard LATEX Tools Bundle.

Inputenc
The inputenc package maps non-ASCII characters to their corresponding TEX macros
according to the encoding option you select. Available options include ISO Latin-1, ISO
Latin-2, and others.
When you use SWP or SW to open a document with input encoding set, the pro-

gram correctly interprets the characters. When you use a text editor to open the doc-
ument, the encoded characters appear correctly rather than as TEX code if the input
encoding corresponds to the current code page for the system. For example, when the
ISO Latin-1 option is selected as the font encoding scheme, the character Ã appears in a
text editor as Ã instead of as n~{A}.
To maintain a consistent interpretation of any non-ASCII characters, you must choose

the ASCII (Normal) character set option when you save a document to which you have
added the inputenc package.
The package may simplify collaboration on documents written in some non-English

languages. See the package documentation for additional information. The package is
installed in the TCITeX/TeX/LaTeX/base directory.

Lastpage
The lastpage package adds a marker with the key of LastPage to the last page of your
document so that you can create references in the form page 21 of 47. By using the
package with the fancyhdr package, you can create references in this form in headers
and footers. Use this example as a model.

I To create page numbers that incorporate the number of the last page
1. Add the lastpage and fancyhdr packages to your document. to your document.

2. In the document preamble, specify a new header and footer setup:

a. From the Typeset menu, choose Preamble.
b. On a new line, enter npagestyle{fancy}.

3. On a new line in the preamble, enter the information you want right-justi�ed in the
footer, as in this example:

a. nrfoot{Page:n nthepagen of npageref{LastPage}}

4. Choose OK.

See the package documentation for more information. The package is installed in
the TCITeX/TeX/LaTeX/contrib/lastpage directory.
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Latexsym
The latexsym package provides 11 mathematical symbols originally de�ned in LATEX
2.09 but no longer de�ned in the New Font Selection Scheme. The symbols are

0 1 2 3 ; < = C E B D

These symbols are also provided by the amsfonts and amssymb packages (see page
101). Because SWP and SW call the amsfonts package automatically, ordinarily you
don't need to add the latexsym package to your document to obtain the symbols.
No package options are available. The latexsym package is installed in the TCITeX/

TeX/LaTeX/base directory.

Layout
The layout package illustrates the LATEX layout of the current document with a �gure like
the one on page 138. The circled callouts refer to the accompanying table of standard
LATEX page layout values including paperwidth, topmargin, oddsidemargin, textheight,
textwidth, and others. The package is useful for re�ning the layout of your document.
The options available for the package through the Options and Packages com-

mand on the Typeset menu determine the language in which the layout is printed and
provide debugging aids.

I To draw the layout of a document
1. Add the layout package to your document.

2. Place the insertion point in the body of your document, and enter a TEX �eld.

3. Type nlayout and choose OK.

LATEX draws the layout in your document immediately after the command. The lay-
out package doesn't work for documents created with Style Editor shells. It installs
in the TCITeX/TeX/LaTeX/required/tools directory as part of the Standard
LATEX Tools Bundle.

Lineno
The lineno package provides line numbers on typeset paragraphs. By default, the num-
bers run continuously through the document, but you can reset the line numbers on each
page. The package provides a way to create a reference to a particular line number using
the cross-reference mechanism.

I To add line numbers to a document
1. Add the lineno package to your document.

2. Modify the package options to select the options you want and choose OK.

3. From the Typeset menu, choose Preamble and click the mouse in the entry area.

4. On a new line, type nlinenumbers and choose OK.

The package installs in the TCITeX/TeX/LaTeX/contrib/lineno directory.
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9 \marginparsep = 11pt 10 \marginparwidth = 65pt

11 \footskip = 30pt \marginparpush = 5pt (not shown)
\hoffset = 0pt \voffset = 0pt
\paperwidth = 614pt \paperheight = 794pt

Longtable

The package de�nes a longtable environment that is a multipage version of tabular. The
tables produced by the package can be broken between, but not within, rows by standard
TEX page-breaking algorithms. The package maintains consistent column widths from
page to page, unlike the supertabular package (see page 170). The package provides
customized captions on the �rst and subsequent pages of the table, but you may �nd the
caption package more convenient to use for that purpose (see page 111).
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The options available through the Options and Packages command on the Type-
set menu aid in debugging. The package commands de�ne and customize the longtable
environment. Commands are available to split the table into a series of chunks for eas-
ier management by TEX. Additional commands position the table, de�ne rows, de-
�ne breaks, and make footnotes available within a table environment. The longtable
package doesn't require the array package, but if array is added to the document, the
longtable package uses extended features. See the package documentation for a discus-
sion of how to use each option, command, and parameter.
To use the longtable package in your document, you must de�ne the entire longtable

environment in an encapsulated TEX �eld. Also, you may have to process the docu-
ment through LATEX three or four times to achieve the correct appearance of columns
in a longtable environment. Using the package requires a solid knowledge of LATEX.
For more information, see the package documentation and the PackageSample-
longtable.tex �le in the SWSamples directory of your program installation. The
longtable package is installed in the TCITeX/TeX/LaTeX/required/tools di-
rectory as part of the Standard LATEX Tools Bundle.

Lscape
The lscape package creates a landscape environment within which LATEX rotates text 90
degrees. Note that PDF viewers support rotation, so you can use the lscape package to
create rotated text in typeset PDF �les. The TrueTEX Previewer provided with SWP and
SW doesn't support rotation; you must use a different DVI previewer and print driver if
you want to use the lscape package to rotate text in a DVI �le. Although you can use a
different driver, we recommend that you leave the driver defaults unchanged. The local
LATEX installation sets the driver defaults. If you leave the con�guration unchanged for
your document, you can compile it without changes in another LATEX environment.
You can de�ne the landscape environment with commands inserted in TEX �elds.

The portland package produces similar results (see page 152).

I To de�ne a landscape environment
1. Add the lscape package to your document.

2. Place the insertion point where you want landscape orientation to begin.

Place the commands carefully so that LATEX rotates the current page before adding
the page header and footer.

3. Enter an encapsulated TEX �eld.

4. Type nbegin{landscape} and choose OK.

5. Place the insertion point where you want to return to portrait orientation.

6. Enter an encapsulated TEX �eld.

7. Type nend{landscape} and choose OK.

Many driver options are available for lscape through the Options and Packages
command on the Typesetmenu. The package is installed in the TCITeX/TeX/LaTeX/
required/graphics directory as part of the Standard LATEX Graphics Bundle.
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Ltxtable

The ltxtable package is a combination of two other packages�longtable and tabu-
larx�that are part of the Standard LATEX Tools Bundle. The package produces multi-
page tables with column widths calculated automatically to meet a total speci�ed table
width.
Using the package involves placing the longtable environment in a �le all its own,

then including it in the main document. The command syntax for inputting the �le is

nLtxtable{width}{file}

No options are available for ltxtable. The package is installed in the TCITeX/TeX/
LaTeX/contrib/carlisle directory.

Makeidx

The makeidx package creates an index for your document based on information in
nindex commands in the text. SWP and SW automatically add themakeidx package
to your document when you create the index, but you must add the package yourself if
you plan to save your document as a Portable LATEX �le.

I To create an index with makeidx
1. Create index entries throughout your document, as needed.

2. Place the insertion point where you want the index to appear.

3. Import the index fragment.

4. Typeset compile your document and choose Generate an Index or, from the Type-
set menu, choose Tools and then choose Run MakeIndex.

The program adds the makeidx package to your document and the nmakeindex
command to the document preamble, and generates the index. Note that if you plan
to save your document as a Portable LATEX �le, you must add the makeidx package
to your document.

No package options are available. The package is installed in the TCITeX/TeX/
LaTeX/base directory.

Manyfoot

Themanyfoot package provides independent series of footnotes for your document and
groups the footnotes by series at the bottom of the page. The package automatically
separates groups of footnotes with vertical space; you can also add separating rules. The
package provides a customized appearance for footnotes, either in standard footnote
form or grouped in run-in pragraphs. You can control enumeration automatically or
manually using standard enumeration schemes. Note that using the scheme fnsymbol is
not recommended. The package is useful for producing critical editions and for other
applications that require multiple independently numbered series of footnotes.
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Using the package involves placing nnewfootnote or nDeclareNewFootnote
commands in the preamble of your document, then placing TEX �elds containing the
commandsnfootnotemark and nfootnotetext in the body of the document where
you want footnotes.
The paragraph format created by the manyfoot package con�icts with the footmisc

package; otherwise, the two packages are compatible. The package is installed in the
TCITeX/TeX/LaTeX/contrib/ncctools directory. See the package documen-
tation for more information about implementing the features.

Mathpazo
See PSNFSS Packages on page 152.

Mathptmx
See PSNFSS Packages on page 152.

Mathtime
The package enables the use of PostScript New Font Selection Scheme (PSNFSS) Math-
Time fonts, including MathTime Plus fonts, in LATEX documents. When you typeset your
document, MathTime fonts provide ligatures and improved kerning in Times text. The
mathtime package implements mathematics set in Times and calls the times package
directly, so that documents containing both mathematics and text can use Times through-
out, rather than a combination of font families. The result is a more portable document
with a nicer appearance. See also the times package, page 154.When you add themath-
time package to your document, move it near the bottom of the Packages in Use list.
The mathtime package has several options for font use available through the Op-

tions and Packages command on the Typeset menu. The No TS1 option must be set
for use with the TrueTEX Formatter included with SWP and SW.

I To use MathTime fonts in a document

1. On the Typeset toolbar, click the Options and Packages button or, from the
Typeset menu, choose Options and Packages and then choose the Package Op-
tions tab.

2. Select the font package currently in use and choose Remove.

3. Add the mathtime package to your document.

4. Modify the package to select the No TS1 option.

The package won't work correctly without this setting.

5. Choose OK.

The package is installed in the TCITeX/TeX/LaTeX/mathtime directory. See
the online Help and the package documentation for more information about the im-
plementation of the mathtime package in a TrueTEX environment. See also the �le
OptionsPackagesLaTeX.tex in the SWSamples directory.
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Minitoc
The minitoc package uses commands in the preamble and the body of the document
to create a table of contents and, optionally, a list of �gures and a list of tables, at the
beginning of each major division of a document, as shown in this example:

Chapter 1

Standard LATEX Books

Contents
1.1 Available Divisions . . . . . . . . . . . . . . . . . . 4

1.1.1 Available Subdivisions . . . . . . . . . . . . . . . . . 4
1.1.2 More Information . . . . . . . . . . . . . . . . . . . . 4

1.2 Tags . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
1.3 Mathematics and Text . . . . . . . . . . . . . . . . 6
1.4 List Environments . . . . . . . . . . . . . . . . . . . 6
1.5 TheoremLike Environments . . . . . . . . . . . . . 7

If the document class de�nes npart, you can create a table of contents and �gure and
tables lists at the beginning of each part. If the document class de�nes nchapter,
you can create a table of contents and �gure and tables lists at the beginning of each
chapter. You can create the minitoc elements for document sections only when the doc-
ument class doesn't de�ne nchapter. That is, chapter level and section level minitoc
elements can't be used in the same document.

I To create a table of contents for a document division
1. Add the minitoc package to your document.

2. From the Typeset menu, choose Preamble and click the mouse in the entry area.

3. On a new line, type the commands for the environments you want:

Command Environment
ndoparttoc Table of contents for parts
ndopartlof List of �gures for parts
ndopartlot List of tables for parts
ndominitoc Table of contents for chapters
ndominilof List of �gures for chapters
ndominilot List of tables for chapters
ndosecttoc Table of contents for sections
ndosectlof List of �gures for sections
ndosectlot List of tables for sections

4. Choose OK.
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5. For each minitoc environment you want,

a. Place the insertion point immediately after the heading for the division for which
you want a minitoc environment.

b. Enter a TEX �eld.
c. In the entry area, type the appropriate command for the environment:
Command Environment
nparttoc Table of contents for parts
npartlof List of �gures for parts
npartlot List of tables for parts
nminitoc Table of contents for chapters
nminilof List of �gures for chapters
nminilot List of tables for chapters
nsecttoc Table of contents for sections
nsectlof List of �gures for sections
nsectlot List of tables for sections

d. Choose OK.

More information is available in the program documentation. The package is in-
stalled in the TCITeX/TeX/LaTeX/contrib/minitoc directory.

Multicol

Themulticol package implements up to 10 columns of text in the multicols environment
and balances the length of the �nal columns for a nice appearance. The package permits
both single- and multicolumn formats on the same page. It places footnotes across the
bottom of the page rather than under each column. (Thus, it is incompatible with the
ftnright package, page 130.) Note that within the multicolumn environment, only page-
wide �oating elements are permitted and not those in a selected column.

I To create multiple columns of text
1. Add the multicol package to your document.

2. Place the insertion point where you want multiple columns to begin.

3. Enter an encapsulated TEX �eld.

4. Type nbegin{multicols}{x} where x is the number of columns you want.

5. Choose OK.

6. Place the insertion point where you want multiple columns to end.

7. Enter an encapsulated TEX �eld.

8. Type nend{multicols} and choose OK.

The package has a debugging option available through the Options and Packages
command on the Typeset menu. The use of the multicol package can occasionally
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cause LATEX errors related to line spacing and footnote numbering in SWP and SW doc-
uments. The package is installed in the TCITeX/TeX/LaTeX/required/tools
directory as part of the Standard LATEX Tools Bundle.

Natbib
The natbib package is used in combination with three bibliography styles (abbrv-
nat.bst, plainnat.bst, and unsrtnat.bst) to produce both author-date and
standard numerical citations for BIBTEX bibliographies. The package is compatible with
standard BIBTEX style �les, such as plain.bst, and with those for the harvard, apa-
like, chicago, astron, and authordate packages. It serves as a single interface for most
available bibliographic styles.
The package also supports a variety of author-date and numerical citation formats,

including multiple citations, as shown in the examples in the following table. Most
are based on two basic citation commands: ncitet for text citations and ncitep for
parenthetical citations. The commands may take optional arguments to add text before
and after the citation. See the package documentation for more extensive information
about available commands.
Command Citation Format
ncitet{key} Abbreviated author list in text, year in parentheses:

Author-year: Swanson et al. (2004)
Numerical: Swanson et al. [21]

ncitet*{key} Full author list in text, year in parentheses:
Author-year: Swanson, Hughes, and Medd (2004)

ncitep{key} Abbreviated author list and year, in parentheses:
Author-year: (Swanson et al., 2004)
Numerical: [21]

ncitep*{key} Full author list and year, in parentheses:
Author-year: (Swanson, Hughes, and Medd, 2004)

ncitet[chap~2]{key} Abbreviated author list in text, year and chapter in
parentheses:
Author-year: Swanson et al. (2004, chap. 2)
Numerical: Swanson et al. [21, chap. 2]

ncitep[chap~2]{key} Abbreviated author list, year, and chapter, in parenthe-
ses:
Author-year: (Swanson et al., 2004, chap. 2)
Numerical: [21, chap. 2]

ncitep[see][]{key} Reference to abbreviated author list and year, in paren-
theses:
Author-year: (see Swanson et al., 2004)
Numerical: [see 21]

ncitep[see][chap~2]{key} Reference to abbreviated author list, year, and chapter,
in parentheses:
Author-year: (see Swanson et al., 2004, chap. 2)
Numerical: [see 21, chap. 2]

ncitep{key, key} Abbreviated author lists and years, in parentheses:
Author-year: (Medd et al, 2003; Swanson et al., 2004)
Numerical: [19; 21]
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The program interface doesn't directly support these commands, but you can achieve the
citation format you want by inserting the commands in TEX �elds.

I To create a bibliography for natbib citations
1. Add the natbib package to your document.

2. From the Typeset menu, choose Bibliography Choice.

3. Check BibTeX and choose OK.

4. Specify one of the natbib bibliography style �les:

a. Place the insertion point where you want the bibliography to appear.
b. From the Insert menu, choose Typeset Object and then choose Bibliography.
c. Select the BIBTEX database �les you want to use.
d. Scroll down the Style list to select abbrvnat.bst, plainnat.bst, or un-
srtnat.bst, and choose OK.

5. Save and compile the document.

I To create a natbib citation
1. Add the natbib package to your document.

2. Place the insertion point where you want the citation.

3. Enter an encapsulated TEX �eld.

4. Type the command for the citation format you want, substituting the key for the
BIBTEX reference.

5. Choose OK.

The natbib package is compatible with the chapterbib, hyperref, showkeys and
babel packages, and can emulate the sorting and compressing functions of the cite
package. The package is installed in the TCITeX/TeX/LaTeX/contrib/natbib
directory.

Newapa

This package is required when you use the BIBTEX bibliography style newapa.bst.
Other than adding the package to your document, no action is required. No options are
available for the package, which is installed in the TCITeX/TeX/LaTeX/contrib/
bibtex directory.

Newpnts

See Points and Newpnts on page 151.
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Nomencl
The nomencl package produces a nomenclature list or list of symbols for your doc-
ument by using TEX instructions inserted throughout the document as input for the
makeindex program. You can use the package to create a list of symbols, a glossary,
or an index-like list, such as an author index. Your document can have only one list
created with the package.
Generating a nomenclature list is a multistep process involving adding the package

to your document, identifying each symbol to be included in the list, indicating where
the list should appear in the document, and �nally running makeindex and compiling
your document with LATEX.

I To create a nomenclature list
1. Add the nomencl package to your document.

2. If your document meets these three conditions:
� you are using the SWP or SW output �lter (not the Portable LaTeX �lter)
� the highest division level in your document is section
� the chapter division isn't used

then

a. Save, close, and reopen the document.
b. From the Typeset menu, choose Preamble.
c. Click the mouse in the entry area and scroll to the bottom.
d. After the line ninput{tcilatex}, add a new line and type
nletnchapternunde�ned.

e. Choose OK.

3. Add this command to the document preamble:

a. From the Typeset menu, choose Preamble and click the mouse in the entry area.
b. Scroll to the end of the preamble commands and begin a new line.
c. Type nmakenomenclature (in Version 5.5) or nmakeglossary (in earlier versions)
and choose OK.

4. Add nnomenclature commands in the text for each symbol to be included in the
nomenclature list:

a. Place the insertion point immediately after the �rst use of the symbol.
b. Enter an encapsulated TEX �eld.
c. In the entry area, type nnomenclature{x}{y} where x is the symbol you want to
appear in the list and y is the corresponding de�nition.

d. Choose OK.

5. Add this command:

a. Place the insertion point where you want the nomenclature list to appear in your
document and enter a TEX �eld.

b. Type nprintnomenclature (in Version 5.5) or nprintglossary (in earlier versions)
and choose OK.
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6. Save your document and from outside SWP or SW, compile it.

a. From the SWP or SW submenu on the Windows Programs list, choose the
TrueTEX Formatter.

b. Select the �le and choose OK.
If your document contains a table of contents or cross-references, you may need
to compile it two or three times.

The compilation yields an .nlo �le (.glo in earlier versions) with the same name as
your document and places it in the same directory.

7. Run makeidx.

The makeidx package uses the .nlo or .glo �le as an input �le. It creates an
output �le with an .nls extension (.gls in earlier versions) and the same name and
directory as your document. The .nls or .gls �le contains the correctly ordered
nomenclature list.

a. From the Windows Start menu, choose Run.
b. In the Open box, type the command appropriate for your installation and substi-
tute the correct �le name for the two �les (where line breaks occur in this instruc-
tion, enter a space):
� For Version 5.5:
c:nswp55nTCITeXnweb2cnmakeindex -o
c:nswp55ndocsn�lename.nls -s
c:nswp55nTCITeXnTeXnLaTeXncontribnnomenclnnomencl.ist
c:nswp55ndocsn�lename.nlo
� For Version 4.x or 5.0:
c:nswp50nTCITeXnweb2cnmakeindex -o
c:nswp50ndocsn�lename.gls -s
c:nswp50nTCITeXnTeXnLaTeXncontribnsupportednnomenclnnomencl.ist
c:nswp50ndocsn�lename.glo
� For Version 3.5 or earlier:
c:nswp35nTCITeXnSWToolsnbinnmakeindx -o
c:nswp35ndocsn�lename.gls -s
c:nswp35nTCITeXnTeXnLaTeXncontribnsupportednnomenclnnomencl.ist
c:nswp35ndocsn�lename.glo

Correct the path names for your installation, if necessary.
c. Choose OK.

8. Typeset compile the document �le from outside SWP or SW.

If your document contains a table of contents or cross-references, you may need to
compile it two or three times.

Note that if you compile using SWP or SW, the compiler won't �nd the .nls or
.gls �le and won't include the nomenclature list in the typeset document.

The available package options include language choices and the use of equation and
page references. See more information on page 24 and additional documentation for the
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nomencl package in the PackageSample-nomencl.tex �le in the SWSamples
directory of your program installation. The package is in the TCITeX/TeX/LaTeX/
contrib/nomencl directory.

Nopageno
The nopageno package provides a simple way to remove page numbers from both
the opening pages and the normal pages of all classes of LATEX documents. Other than
adding the package to your document, no action is necessary. No package options are
available. The package installs in the TCITeX/TeX/LaTeX/contrib/carlisle
directory.

Numinsec
The numinsec package provides numbering of equations, �gures, and tables within
sections. Part of the SIAM document class distribution, the package is useful for other
types of documents. The package adds the section number to the numbers of equations,
�gures, and tables. Thus, if the �rst equation in section 2 is the eighth in the document,
it carries the number 2.1 instead of 8.
No action is required other than adding the package to your document. The package

has no options. The numinsec package is installed in the TCITeX/TeX/LaTeX/
contrib/siam directory.

Overcite
The overcite package has been superseded by the cite package (see page 114) and
is included in SWP and SW for compatibility purposes only. The overcite package
produces and superscripts compressed, sorted lists of numerical citations occurring in
the text.

Paralist
The paralist package provides new list environments for itemized, description, and enu-
merated lists. With the package, lists can be typeset within paragraphs, as paragraphs in
themselves, and in a compressed format. The package allows adjustment of the space
between list items in the compressed format. The package also provides arguments for
formatting labels in most of the list environments. The package incudes a con�guration
(.cfg) �le that makes standard list environments typeset as if they were the compressed
list environments de�ned by the package. Although the .cfg �le isn't part of the de-
fault package, the package allows adding a .cfg �le. The package may con�ict with the
babel package.
The package is installed in the TCITeX/TeX/LaTeX/contrib/paralist di-

rectory.

Parallel
The parallel package creates an environment that aligns text in two columns or on facing
pages. You can adjust the column width and separate the columns with a vertical line,
as shown here:
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This is text in the English language Dies ist Text in deutscher Sprache,
explaining the \foo command. der das Kommando \foo erläutert.

Options are available to format footnotes that occur in the text within the environ-
ment; the footnotes are typeset at the end of the environment. After adding the package,
you enter the environment and all the text within it in TEX �elds in the body of your
document. The package is useful for comparing two texts, as in translation projects.

I To enter aligned text in two columns or on facing pages
1. Add the parallel package to your document.

2. Modify the package options to select the footnote format you want. See the package
documentation for details.

3. Place the insertion point where you want the parallel environment to begin.

4. Enter an encapsulated TEX �eld.

5. In the entry area, type

nbegin{Parallel}[option]{left-width}{right-width}
where option is one of these commands:
option Effect
c (default) print aligned text in columns
v print a vertical line between columns
p print text on two facing pages

If the width parameters are left empty, the package sets each one to about half the
width of the text on the page.

6. Type

nParallelLText{text that is to appear on the left}
nParallelRText{text that is to appear on the right}
nend{Parallel}

7. Choose OK.

Note that a blank page can result if LATEX has to skip a page in order to place the
parallel text on facing pages. Also, large size differences in the right and left text can
result in unattractive output. The package is installed in the TCITeX/TeX/LaTeX/
contrib/parallel directory.

Picins
The picins package provides precise control over the placement of inline graphics. It
also provides dashed, solid, and shadow frames around the graphics, and allows space
for a caption. Tables aren't supported. The placement of graphics is controlled with
commands in TEX �elds in the body of your document. The commands are generally of
this format:
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nparpic[x]{nincludegraphics[natwidth=yin,natheight=zin]{graphic}}

where x indicates the position on the page; y and z are the width and height, respectively,
of the graphic image; and graphic is the full path name for the graphics �le. Additional
command elements are available to specify the position of the caption and the kind and
size of frame. See the package documentation for details.
For another way to wrap text around graphics, see the wrap�g package on page

180. The package is installed in the TCITeX/TeX/latex209/contrib/picins
directory.

Pifont
See PSNFSS Packages on page 152.

Placeins
The placeins package prevents �oating graphics or tables from �oating into the next
section of the document or past a designated point in the document, signaled by a
nFloatBarrier command. The package successfully controls the placement of �oat-
ing objects in DVI �les, in PDF �les, and in �les created with the Portable LATEX output
�lter. The package thus has a wider use than the �oat package, which controls the
placement of �oating objects using the H placement option with the FRAME macro in
tcilatex.tex. Because PDFLATEXand the Portable LATEX output �lter bypass the
FRAMEmacro, the �oat package method can't be used to control the placement of �oat-
ing objects in PDF or Portable LATEX �les.

I To prevent �oating objects from appearing in the next section
1. Add the placeins package to your document.

2. On the Typeset toolbar, click the Options and Packages button or, from the
Typeset menu, choose Options and Packages and then choose the Package Op-
tions tab.

3. From the Packages in Use list, select the placeins package and chooseModify.

4. In the Category list, select Barrier at section and, in the Options list, select Yes.

5. Choose OK to close each dialog box and return to your document.

I To prevent a �oating object from appearing after a designated point
1. Position the insertion point where you want accumulated �oating objects to appear.

2. Enter an encapsulated TEX �eld.

3. In the entry area, type nFloatBarrier and choose OK.

By default, the nFloatBarrier command is very strict. It prevents a �oating
object from appearing above the start of the current section or below the start of the next
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section, even though the �oating object would appear on the same page as its intended
section. Each restriction can be relaxed separately by using the above and below
package options. The package is installed in the TCITeX/TeX/LaTeX/contrib/
placeins directory.

Points and Newpnts
The points and newpnts packages were developed to help typeset exams. Both pack-
ages place point values for exam questions in the left margin. The newpnts package
places the values slightly farther into the margin for less confusion with list item num-
bers. The packages also provide a way to resume list numbering that has been interrupted
by text. The two features can be used independently.
No options are available for the packages, but you can enter the necessary macros in

TEX �elds. The packages are distributed with SWP and SW but, unlike the other pack-
ages included with the program, are not available on CTAN. The packages are installed
in the TCITeX/TeX/LaTeX/SWmisc directory.

I To place a point value for an exam question in the margin
1. Add the points or the newpnts package to your document.

2. Create the list of exam questions.

Note that you don't have to use a numbered list.

3. For each question,

a. Place the insertion point at the beginning of the list item, immediately to the right
of the lead-in object.

b. Enter an encapsulated TEX �eld.
c. Type nPOINTS{x} where x is the point value for the question.
d. Choose OK.

I To resume numbering of an interrupted numbered list
1. Add the points or the newpnts package to your document.

2. Place the insertion point at the end of the paragraph immediately after which you
want the list to begin.

The paragraph can otherwise be empty.

3. Enter an encapsulated TEX �eld.

4. In the entry area, type nsetcounter{enumi}{x}nRESUME where x is a value one
less than the starting number for the list.

If you want your list to start with 1, use nsetcounter{enumi}{0}nRESUME. Note
that the command is case-sensitive.

5. Choose OK.
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6. Create a numbered list.

7. Interrupt the list with an unnumbered paragraph.

8. Place the insertion point at the end of the unnumbered paragraph.

9. Enter an encapsulated TEX �eld.

10. In the entry area, type nRESUME and choose OK.

11. Enter the remaining numbered list items.

LATEX resumes the list with the next sequential list item number.

Portland
The portland package implements changing from portrait to landscape orientation and
back within your SWP or SW document. No special drivers are required, but you may
need to change the orientation settings for your printer so that your document prints
properly. If you have a single page with an orientation different from that of the rest
of the document, you may need to print it separately after changing the printer settings
accordingly.
You can de�ne portrait and landscape environments with simple commands inserted

in TEX �elds. No package options are available.

I To de�ne a landscape or portrait environment
1. Add the portland package to your document and move the package to the top of the
Packages in Use list.

2. Place the insertion point where you want the orientation to change in your document.

3. Enter a TEX �eld.

4. Type nlandscape to change the page layout orientation from portrait to landscape or
nportrait to change the page layout orientation from landscape to portrait.

5. Choose OK.

The portland package is installed in the TCITeX/TeX/latex209/contrib/
misc directory of your Version 3.5 or later installation. The PackageSample-
portland.tex �le in the SWSamples directory of your Version 4.0 or later pro-
gram installation contains additional information. If you have an earlier version you can
download both the package and the sample �le from our website. See also the lscape
package on page 139.

PSNFSS Packages
The PostScript NFSS bundle is a required part of LATEX. The bundle provides a complete
working setup of the LATEX font selection scheme for use with PostScript fonts. The
packages are installed in the TCITeX/TeX/LaTeX/required/psnfss directory.
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The font packages included in the bundle completely replace one or more of the font
families used by LATEX for roman, sans serif, typewriter, or mathematics fonts. If the
PostScript fonts are present on your system, adding the PSNFSS packages changes
the default font families as shown in the table below. The top row indicates the default
(Computer Modern) font family. A blank indicates that the package doesn't change
the corresponding default font family. Other than installing the packages, no change is
required to make the default replacements noted in the table.

Font Family
Package roman sans serif typewriter math
(none) CM Roman CM Sans Serif CM Type-

writer
t CM Roman

mathptmx Times t Times
mathpazo Palatino t Palatino
helvet Helvetica
avant Avant Garde
courier Courier
chancery Zapf Chancery
bookman Bookman Avant Garde Courier
newcent New Century

Schoolbook
Avant Garde Courier

utopia Utopia
charter Charter

Several packages that were included in the PSNFSS bundle in the past have been super-
seded: mathptm, mathpple, and palatino. Another superseded package, times, is still
included with SWP and SW; see more information below. Another package, pifont, is
available for use in PDF �les.

Mathptmx
The mathptmx package changes the default roman font family to Adobe Times. The
virtual mathptmx fonts are used for mathematics. The package scales large mathematical
symbols to �t the base font size. Bold math fonts are not supported.

Mathpazo
The package changes the default roman font family to Adobe Palatino. The virtual
mathpazo fonts are used for mathematics. Package options include slanted uppercase
Greek letters, upright � and 
, italic bold mathematical symbols, and large mathe-
matical symbols. Using the mathpazo package with AMS symbols requires special
attention; please refer to the package documentation.

Helvet
If you have the Helvetica PostScript font installed on your system, adding the helvet
package changes the default sans serif font family to Helvetica. (Note that Helvetica is
slightly larger that other typefaces. The package documentation explains how to adjust
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for the difference.) If the font isn't installed on your system, adding the package changes
the default sans serif font to the Windows Arial font. The other font packages�avant,
courier, chancery, times, bookman, newcent, utopia, charter�work the same way.
Adding the package doesn't affect the default serif font. If you want your entire

document to print in the Helvetica font, modify the preamble of your document.

I To change the default font
1. From the Typeset menu, choose Preamble.

2. Click the mouse in the entry area and start a new line after the last entry.

3. Type nrenewcommand{nfamilydefault}{nsfdefault} and choose OK.

Times
The times package implements the use of the NFSS Times font for text but leaves math-
ematics in the Computer Modern fonts. The package produces ligatures and improves
kerning, and its use creates more portable document �les. See also the mathtime pack-
age on page 141. This example illustrates the results produced by the times package:

By the triangle inequality for integrals and the above
inequalities, for ¸ ;

¯̄
¯̄
¯
Z

c

"
( ) ¡

nX
k=0

k
k

# ¯̄
¯̄
¯ ¢ (length of )

Since is arbitrary, the limit is zero.

1

I To use the times package

1. On the Typeset toolbar, click the Options and Packages button or, from the
Typeset menu, choose Options and Packages and then choose the Package Op-
tions tab.

2. Select the font package currently in use and choose Remove.

3. Add the times package to your document and choose OK.

No options are available. See the online Help and the package documentation for
more information about the implementation of the times package in a TrueTEX envi-
ronment.

Pifont
The pifont package supports symbol fonts and provides commands for using the Zapf
Dingbats font in PDF �les; see the package documentation for details. The package also
provides an interface to other font families.
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Ragged2e

The ragged2e package provides less extreme raggedness than the standard LATEX com-
mands nflushleft and nflushright by overwriting the LATEX default value for
interword space. The package rede�nes standard LATEX justi�cation commands and al-
lows their modi�cation by the user. See the package documentation for information
about using the large number of parameters that de�ne the new commands and envi-
ronments, and see page 31 for instructions for using the package to change paragraph
justi�cation.
The package requires the everysel package. Both packages are installed in the

TCITeX/TeX/LaTeX/contrib/ms directory.

Relsize

In LATEX, these text font size commands, listed from smallest to largest, are available:
ntiny, nscriptsize, nfootnotesize, nsmall, nnormalsize, nlarge,
nLarge, nLARGE, nhuge, and nHuge. The relsize package provides a way to change
the font size of text by stepping through the font size hierarchy. The nrelsize com-
mand has as its argument a positive or negative number that speci�es the number of steps
by which the current size should be changed. Thus, if the command nrelsize{3} oc-
curs when the current font size is footnotesize, the next text will be typeset as large.
Similarly, if the command nrelsize{-4} occurs when the current font size is large, the
next text will be typeset as scriptsize. The commands appear in TEX �elds in the body
of your document.
The package includes several shortcut commands, nlarger and nsmaller, which

change the text font size by one step in the corresponding direction. An additional
command speci�es the text font size based on a scale factor, not unlike the scalefnt
package.
Two commands are available for stepping through the mathematics size styles. From

smallest to largest, the size styles are nscriptscriptstyle, nscriptstyle,
ntextstyle, and ndisplaystyle. However, because mathematical operators and
delimiters are scaled automatically in SWP and SW, this package feature is not partic-
ularly useful. If you choose to use the commands, note that they are not always reliable
because spacing problems can occur.

I To step the text font size up or down
1. Add the relsize package to your document.

2. Place the insertion point where you want the change in font size to begin.

3. Enter an encapsulated TEX �eld.

4. In the entry area, type nrelsize{x} where x is the number of steps you want to move
through the hierarchy.

5. Choose OK.

The package is installed in the TCITeX/TeX/LaTeX/contrib/misc directory.
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Remreset

The remreset package removes a counter from the reset list controlled by a second
counter. In other words, the package prevents a designated counter from being reset
when LATEX increments a second counter. For example, most reports normally reset the
equation number at the beginning of each chapter. You can use this package to remove
the reset so that equations are numbered sequentially throughout the report.

I To prevent a counter from being reset
1. Add the remreset package to your document.

2. From the Typeset menu, choose Preamble and click the mouse in the entry area.

3. Add the commands

nmakeatletter
n@removefromreset{x}{y}
nmakeatother
where x is the counter you don't want to reset, such as footnote or theorem, and y is
the controlling counter, such as chapter or section.

4. Choose OK.

The package command n@removefromreset is the opposite of the standard LATEX
command n@addtoreset.
No package options are available. The package is installed in the TCITeX/TeX/

LaTeX/contrib/carlisle directory.

Revsymb

The revsymb package de�nes the lambdabar symbol � and other symbols unique to
REVTEX 4. Other than adding the package to your document, no action is required. The
revsymb package is part of the REVTEX 4 distribution and is installed in the TCITeX/
TeX/LaTeX/contrib/revtex4 directory.

Rotating

The rotating package implements three environments within which in-line �gures, ta-
bles, and captions can be rotated by an arbitrary number of degrees. Two additional
environments allow rotation of �oating objects, which are typeset alone on separate
pages.
Note that the TrueTEX Previewer provided with SWP and SW doesn't support ro-

tation; you must use a different DVI previewer and print driver if you want to use the
rotating package to rotate �gures, tables, and captions in a DVI �le. The package op-
tions include many drivers. However, PDF viewers support rotation, so you can use the
package to rotate �gures, tables, and captions in typeset PDF �les.
You must enter rotating environments as TEX commands in encapsulated TEX �elds,

one to begin and another to end the environment. The information to be rotated sits
between the two.
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I To rotate in-line �gures, tables, or captions
1. Add the rotating package to your document.

2. Place the insertion point where you want the rotation to begin.

3. Begin the rotation environment:

a. Enter an encapsulated TEX �eld.
b. In the entry area, type nbegin{command}{x} where command is one of the avail-
able environments:
Environment Effect
sideways Print the contents of the environment turned 90 degrees
turn Print the contents of the environment turned an arbitrary

number of degrees
rotate Print the contents of the environment turned an arbitrary

number of degrees (space for the rotated results
isn't necessarily created)

and x is the number of degrees to be rotated. When x is positive, the rotation is
counterclockwise; when x is negative, clockwise. The sideways command doesn't
require a degree argument.

c. Choose OK.

4. Enter the �gure, table, or caption to be rotated.

5. End the rotation environment:

a. Enter an encapsulated TEX �eld.
b. In the entry area, type nend{command} where command is the rotation environ-
ment.

c. Choose OK.

I To rotate �oating �gures and tables
1. Add the rotating package to your document.

2. Place the insertion point where you want the rotation to begin.

3. Begin the rotation environment:

a. Enter an encapsulated TEX �eld.
b. Type nbegin{sideways�gure}ncentering or nbegin{sidewaystable}ncentering.
c. Choose OK.

4. Enter an in-line table or an in-line graphic.

5. If you want a caption,

a. Enter an encapsulated TEX �eld.
b. In the entry area, type ncaption{text} where text is the text of the caption.
c. Choose OK.
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6. If you want to add cross-references to the table or �gure, enter a marker.

7. End the rotation environment:

a. Enter an encapsulated TEX �eld.
b. In the entry area, type nend{sideways�gure} or nend{sidewaystable}.
c. Choose OK.

The package is installed in the TCITeX/TeX/LaTeX/contrib/rotating di-
rectory.

Scalefnt
The scalefnt package implements a command that scales the current font according to a

speci�ed scale factor. A factor of 2 doubles the size of the current font, like this.
A factor of .5 reduces it by half, like this. You may specify any scale factor. With scalable
fonts, LATEX uses the requested font size. With bitmap font sizes, LATEX rounds to the
nearest available size.

I To scale the size of the current font
1. Add the scalefnt package to your document.

2. Place the insertion point where you want the font scaling to begin.

3. Enter an encapsulated TEX �eld.

4. In the entry area, type nbegingroup and choose OK.

5. Enter an encapsulated TEX �eld.

6. In the entry area, type nscalefont{x} where x is the scale factor.

7. Choose OK.

8. Place the insertion point where you want the font scaling to end.

9. Enter an encapsulated TEX �eld.

10. In the entry area, type nendgroup and choose OK.

If you don't surround the nscalefont{x} command with the encapsulated TEX
�elds containing the nbegingroup and nendgroup commands, the font scaling will
apply to the remainder of the document.
You can reverse the font scaling by using the reciprocal of the �rst scale factor in

a second scalefont command. For example, you can begin text that is one and one
half times normal size by inserting the TEX command nscalefont{1.5}. Later, you
can return to the normal font size by inserting .66667, the decimal equivalent of 1

1:5 (the
reciprocal of the scalefont factor) in the TEX command nscalefont{.66667}.
No options are available. The package is installed in the TCITeX/TeX/LaTeX/

contrib/carlisle directory.
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Sectsty
The sectsty package modi�es the typeset appearance of division headings in standard
LATEX articles, books, and reports. The package commands combine with standard LATEX
font selection commands to affect the font family, size, justi�cation, use of rules, and
numbering of division headers. Thus, you can change the text of the section headings
from a sans serif font, as used in this manual, to a serif font, such as Computer Modern
Roman. Using the package to change the justi�cation for headings that are automatically
indented is possible but not advisable.

I To change the typeset appearance of section headings
1. Add the sectsty package to your document.

If the package isn't listed as available, it will not work for your document; don't
attempt to go native to add the package.

2. From the Typeset menu, choose Preamble and click the mouse in the entry area.

3. On a new line, add the command nheadingcommand{nfontcommand} where head-
ingcommand is the package command indicating the section heading you want to
change and fontcommand is one or more standard LATEX font selection commands
(see below).

4. Repeat step 3 for each type of section heading you want to modify.

5. Choose OK.

The package has no options. Available package commands include, but aren't limited
to, those in the table below. See the package documentation for a complete listing of
available commands.

Command Effect
nallsectionsfont Changes the appearance of all section headings
npartfont Changes the appearance of all part headings and num-

bers
nchapterfont Changes the appearance of all chapter headings and

numbers
nsectionfont Changes the appearance of all section headings
nsubsectionfont Changes the appearance of all subsection headings
npartnumberfont Changes the appearance of all part numbers
nparttitlefont Changes the appearance of all part titles only
nchapternumberfont Changes the appearance of all chapter numbers
nchaptertitlefont Changes the appearance of all chapter titles only

Standard LATEX font selection commands include those to select a font family, such as
nsffamily or nttfamily; a font shape, such as nitshape or nscshape; a font
series (width and weight), such as nbfseries or nmdseries; or a font size, such as
nLarge or nhuge. Font selection commands also include those related to justi�cation:
ncentering, nraggedright, and nraggedleft.
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Thus, although the basic nsection{nfontcommand} command syntax is the
same, the actual commands can vary considerably depending on the extent of the modi-
�cations you want to make. An example shows the possibilities available with the pack-
age. The command nallsectionsfont{nraggedleft} right-justi�es all head-
ings in a standard LATEX report, changing their appearance from the one shown on this
page to the one shown on page 161.

Chapter 1

This is a Chapter

Some text goes here.

1.1 This is a Section Heading

Some text goes here.

1.1.1 This is a Subsection Heading

Some text goes here.

Because sectsty rede�nes LATEX sectioning commands, any package that requires
sectioning commands won't necessarily work with the sectsty package. The sectsty
package doesn't work with documents created with Style Editor shells or with other doc-
ument classes not derived from standard LATEX books, articles, or reports. The package
is installed in the TCITeX/TeX/LaTeX/contrib/sectsty directory.
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Chapter 1

This is a Chapter

Some text goes here.

1.1 This is a Section Heading
Some text goes here.

1.1.1 This is a Subsection Heading

Some text goes here.

Setspace

The setspace package replaces the doublespace package. It produces double and one-
and-one-half line spacing based on the point size in use. The default is single spacing.
With setspace, you can set the overall document spacing and the spacing for portions
of the document. Changing spacing in the entire document doesn't affect footnotes, for
which you must specify spacing individually.
In addition to the package commands described below, a linespacing option is avail-

able through the Options and Packages command on the Typeset menu.
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I To change the spacing for the entire document
1. Add the setspace package to your document.

2. Modify the package options to select the spacing you want.

3. Choose OK.

I To change the spacing for a portion of the document
1. Add the setspace package to your document.

2. Place the insertion point where you want the spacing to change.

3. Enter a TEX �eld.

4. Type nsinglespacing or nonehalfspacing or ndoublespacing and choose OK.
or

Type nsetstretch{x} where x is a number indicating the spacing you want, and then
choose OK.

For example, the command nsetstretch{3} produces triple spacing.

5. Place the insertion point where you want to return to the original spacing.

6. Repeat steps 3�4.

Because the onehalfspace environment increases the spacing, you should avoid using
it in a double-spaced document. The setspace package is installed in the TCITeX/
TeX/LaTeX/contrib/setspace directory.

Showidx
The showidx package prints the arguments of all index commands in the margin of the
page on which they occur. The package facilitates troubleshooting and checking index
entries. If you use the package to develop your index, remember to remove it before
you typeset the �nal copy. Besides adding the package to your document, no action is
required to use showidx. No package options are available. The package is installed in
the TCITeX/TeX/LaTeX/base directory.

Showkeys
The showkeys package prints the keys for each label, cross-reference, page reference,
citation, and bibliography item in your draft document. The package prints keys for
labels and bibliography items in small boxes in the margin. Keys for cross-references,
page references and citations appear where they occur, in small type elevated above the
line. The package simpli�es management of keys while documents are in development.
Besides adding the package to your document, no action is required to use showkeys.

However, the package options include displaying reference and citation labels and show-
ing labels in color. When you're ready to print the �nal copy of your document, choose
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the final option to suppress the action of the package or remove the package alto-
gether. The package works with the fleqn option, AMS-LATEX packages, and the
varioref, natbib, and harvard packages. The showkeys package is installed in the
TCITeX/TeX/LaTeX/required/tools directory as part of the Standard LATEX
Tools Bundle.

Showlabels

The showlabels package facilitates troubleshooting of keys and markers, including the
keys for automatically generated equation numbers. The package prints all keys and
markers in the margin of the document at the line on which they are de�ned. Besides
adding the package to your document, no action is required to use showlabels. How-
ever, you can place the labels in the inside or outside margin with the option, available
through the Options and Packages command on the Typeset menu. Remember to
remove the package before you typeset the �nal copy of your document.

The package works in two-column formats but doesn't work well with the mul-
ticol package. The package is installed in the TCITeX/TeX/LaTeX/contrib/
showlabels directory.

Sidecap

The sidecap package provides typeset captions to the left or right side of �oating graph-
ics or tables. The package de�nes two environments, SC�gure and SCtable, that create
centered side-by-side minipages of customizable width. The environments, which are
entered in TEX �elds in your document, create �oating objects that can be positioned
with standard �oat parameters. Options allow the placement of the caption on the right
or left, always on the outside, or always on the inside. Captions can have justi�ed or
ragged edges. A wide option allows the caption to extend into the margin. Starred
versions of the two environments are available for double-column layouts. Be sure to
process the document through TEX at least twice to typeset left- and right-hand pages
correctly.

I To create captions to the side of graphics or tables
1. Add the sidecap package to your document.

2. On the Typeset toolbar, click the Options and Packages button or, from the
Typeset menu, choose Options and Packages and then choose the Package Op-
tions tab.

3. From the Packages in Use list, select the sidecap package and chooseModify.

4. Choose the placement option you want:
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Option Effect
outercaption
(default)

Caption appears on left on left pages and on right on
right pages.

innercaption Caption appears on left on right pages and on right on
left pages.

leftcaption Caption always appears on left.
rightcpation Caption always appears on right.
wide Caption and �gure or table may extend into the margin.
raggedright,
raggedleft,
ragged*

Caption is better justi�ed.

5. Choose OK.

6. Begin the �gure or table environment:

a. Place the insertion point in your document where you want the graphic or table to
appear.

b. Enter an encapsulated TEX �eld.
c. In the entry area, type
nbegin{SC�gure}[relwidth][placement]
or
nbegin{SCtable}[relwidth][placement]
where relwidth is an optional caption width relative to the width of the graphic or
table, and placement is the �oating position you want:

placement Position of the �oating frame
h As close as possible to the entry point in the text
t At the top of a page
b At the bottom of a page
p On a separate page containing only �oating frames

d. On a new line, type ncaption{text} where text is the text of the caption.
e. Choose OK.

7. Enter the graphic or table.

Do not enter the graphic or table as a �oating object.

8. End the environment:

a. Place the insertion point where you want the environment to end.
b. Enter an encapsulated TEX �eld.
c. In the entry area, type nend{SC�gure} or nend{SCtable}.
d. Choose OK.

The package uses the ragged2e package, which is provided with the program. The
package is installed in the TCITeX/TeX/LaTeX/contrib/sidecap directory.
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Slashed
The slashed package provides commands that place a slash through a character to
produce the Feynman slashed character notation. The package works in mathematics.
Some customizing of the placement of the slash is possible. Note that the package
doesn't produce attractive results with some italic fonts.
You can use the package to produce Feynman characters in two ways: with TEX �elds

or with TEX �elds in combination with negated characters. The second method modi�es
the program �le tcilatex.tex to rede�ne the way a negated character is typeset.
Because tcilatex.tex isn't used if you save your document with the Portable LATEX
�lter, the method is incompatible with Portable LATEX �les.

I To produce a Feynman slashed character with TEX �elds
1. Add the slashed package to your document.

2. Place the insertion point where you want the slashed character to appear.

3. Start mathematics.

4. Enter a TEX �eld.

5. Type nslashed{x} where x is the upper- or lowercase letter you want to slash.

6. Choose OK.

I To produce a Feynman slashed character with negated characters
1. Add the slashed package to your document.

2. Place the insertion point in text in your document before the �rst use of a slashed
character.

3. Enter an encapsulated TEX �eld.

4. In the entry area, type ndefnNEG#1{nensuremath{nslashed{#1}}}.

5. Choose OK.

6. Place the insertion point where you want the slashed character to appear.

7. Enter the character you want to use.

8. Click or, from the Edit menu, choose Properties; then check the Negate box
and choose OK.

or

Press CTRL+N.

9. Repeat steps 5�8 for any additional slashed characters you want.

No options are available. The slashed package installs in the TCITeX/TeX/LaTeX/
contrib/carlisle directory.
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Sub�g

The sub�g package supports the use of small �gures and tables within a single �oating
�gure or table environment. The package supersedes the sub�gure package but isn't
completely compatible with it.
The package supports the positioning, captioning, and labeling of small �gures and

tables and, perhaps most signi�cantly, the inclusion of their captions in the list of �gures
or tables. Package options de�ne the placement and caption formatting for the sub�gures
and subtables. The options are �exible, allowing such variations as captions both for the
entire �gure and for each subelement, or a caption for the entire �gure and only a label
for each subelement.
The options available through the Options and Packages command on the Type-

set menu de�ne the placement and caption formatting of all sub�gures and subtables
in the document. Commands in TEX �elds in the document body de�ne speci�c sub�g-
ures and subtables. The package works with the caption package and uses its features
for customizing caption layout. It also requires the ragged2e and everysel packages,
which it calls automatically. The package should be compatible with other packages that
modify or extend �oat environments.
The following instructions don't apply to Portable LATEX documents, because the

FRAMEmacro that de�nes graphics is de�ned in tcilatex.tex, which isn't included
in Portable LATEX �les. Note that the instructions differ slightly depending on the kind
of �le you create when you typeset. The Output Choice setting on the Typeset menu
affects the way graphics are generated when you typeset a DVI or PDF �le. When the
Output Choice is set to DVI output, the program uses the original graphics �les. When
the Output Choice is set to PDF output or Both DVI and PDF output, graphics for the
PDF �le are generated when you save the document. These graphics must be available
when you typeset the document to avoid LATEX errors and missing graphics in the PDF
�le.

I To create sub�gures or subtables with the sub�g package
1. Add the sub�g package to your document.

Because the sub�g package automatically calls the caption package, it isn't neces-
sary to add the caption package to your document, but you may add it if you want to.
If you do add the caption package, make sure it appears before the sub�g package
in the Packages in Use list.

2. Modify the sub�g package options to format the captions as you want.

3. Create a �oating environment for sub�gures:

a. Place the insertion point in the body of your document where you want the sub�g-
ures to appear.

b. Enter an encapsulated TEX �eld.
c. Type nbegin{�gure} to specify a �oating graphics environment.
d. If you want a caption to apply to all the sub�gures in the environment, type
ncaption{title} where title is the caption you want.
This caption will appear in the list of �gures for your document.
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e. If you want to create cross-references to the environment, type nlabel{x} where x
is the key for the �oating environment.

f. Type nend{�gure} and choose OK.

4. From the Typeset menu, choose Output Choice to select the output type you want,
and choose OK.

5. Prepare each sub�gure:

a. Open a new, completely empty document.
b. From the File menu, choose Document Info and choose the Save Options tab.
c. Uncheck Store Relative Graphics Paths and choose OK.
d. From the File menu, choose Import Picture to import the graphic image you want
as a sub�gure.

e. Choose Properties and then choose the Layout tab.
f. In the Placement area, check In Line.
g. Make any other modi�cations you need and then choose OK.
h. From the Typeset menu, choose Output Choice and select the same output
choice as for the main document, then choose OK.
i. Save the document.
j. Open the .tex �le with an ASCII editor.
k. Find the lines that represent the �gure and copy them to the clipboard.
The lines appear differently depending on your output choice:
�With DVI output, the lines have an appearance like this:

�With PDF output, the lines have appearance like this:

�With Both DVI and PDF output, the like this:

6. Return to your original SWP or SW document and reopen the encapsulated TEX
�eld for the �oating environment.
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7. Create the sub�gure:

a. Place the insertion point on a new line just below the nbegin{figure} com-
mand..

b. Type nsub�oat[entry][caption] where entry is the sub�gure caption as you want
it to appear in the list of �gures and caption is the sub�gure caption as you want it
to appear in the body of your document.

c. Type { .
d. If you want to create cross-references to the sub�gure, type nlabel{x} where x is
the key for the sub�gure.

e. Press ENTER to start a new line and paste the lines representing the �gure from the
clipboard to the TEX �eld.

f. Type } and choose OK.

8. Repeat steps 5�7 for each sub�gure in the �oating environment.

9. Create a �oating environment for subtables:

a. Place the insertion point in the body of your document where you want the subta-
bles to appear.

b. Enter an encapsulated TEX �eld.
c. Type nbegin{table} to specify a �oating table environment.
d. If you want a caption to apply to all the subtables in the environment, type
ncaption{title} where title is the caption you want, and press ENTER.
This caption will appear in the list of tables for your document.

e. If you want to create cross-references to the environment, type nlabel{x} where x
is the key for the �oating environment, and press ENTER.

f. Type nend{table} and choose OK.

10. Prepare each subtable:

a. Open a new, completely empty document.

b. On the Standard toolbar, click the Table button or, from the Insert menu,
choose Table.

c. Specify the table size and alignment you want and choose OK.
d. Fill the table with information, formatted as you want.
e. Save the document.
f. Open the .tex �le with an ASCII editor.
g. Find the lines that represent the table and copy them to the clipboard.

11. Return to your original SWP or SW document and reopen the encapsulated TEX
�eld for the �oating environment.

12. Create the subtable:

a. Place the insertion point on a new line just below the nbegin{table} com-
mand.

b. Type nsub�oat[entry][caption] where entry is the subtable caption as you want it
to appear in the list of tables and caption is the subtable caption as you want it to
appear in the body of your document.



Sub�gure 169

c. Type { .
d. If you want to create cross-references to the subtable, type nlabel{x} where x is
the key for the subtable, and press ENTER.

e. Paste the lines representing the table from the clipboard to the TEX �eld.
f. Type } and choose OK.

13. Repeat steps 10�12 for each subtable in the �oating environment.

14. Save and typeset compile your document.

I To include sub�gures and subtables in the lists of �gures and tables

1. On the Typeset toolbar, click the Front Matter button or, from the Typeset
menu, choose Front Matter.

2. Place the insertion point after the Make TOC �eld.

3. Press ENTER and apply the Remove Item Tag.

4. Apply the Make LOF tag and choose OK.

5. Apply the Make LOT tag and choose OK.

6. From the Typeset menu, choose Preamble.

7. Click the mouse in the entry area.

8. On a new line at the end of the entries, type nsetcounter{lofdepth} {2} to include
sub�gure captions in the list of �gures.

or

nsetcounter{lotdepth} {2} to include subtable captions in the list of tables.

9. Choose OK.

In the �le PackageSample-subfig.tex in the SWSamples directory of your
program installation, you can �nd several examples and more information about the
sub�g package. The package is installed in the TCITeX/TeX/LaTeX/contrib/
subfig directory.

Sub�gure

This package has been superseded by the sub�g package (see page 166) and is included
in SWP and SW for compatibility purposes. The package supports the use of small
�gures and tables within a single �oating �gure or table environment. It supports the
positioning, captioning, and labeling of small �gures and tables, and the inclusion of
their captions in the list of �gures and tables. The sub�gure package is installed in the
TCITeX/TeX/LaTeX/contrib/subfigure directory.
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Sub�oat

This package enables subnumbering of separate �oating objects (both �gures and tables)
so that the relationship between them might more easily be emphasized. When typeset,
the objects, which can be separated by text, have numbers such as Table 1a, Table 1b,
Table 1c, .... The function of the package is similar to that of the subequations envi-
ronment of the amsmath package. It differs from the function of the sub�g package,
which generates numbered sub�gures and subtables within a single �oating object.
No action is needed other than adding the package to your document and enclosing

the �oating objects within a sub�gures or subtables environment. The two environments
can be intermixed. However, four macros are available to customize numbering; see the
package documentation for details.

I To create subnumbers for �oating objects
1. Add the sub�oat package to your document.

2. Place the insertion point where you want the subnumbering to begin.

3. Enter a TEX �eld.

4. In the entry area, type nbegin{sub�gures} or nbegin{subtables}.

5. Choose OK.

6. Enter the �oating objects for which you want subnumbering.

The objects can be separated by text.

7. After the �nal object, enter a TEX �eld.

8. In the entry area, type nend{sub�gures} or nend{subtables}.

9. Choose OK.

All �oating objects of the same kind between the nbegin andnend statements will
share a main �gure or table number.

The package is installed in the TCITeX/TeX/LaTeX/contrib/subfloat di-
rectory.

Supertabular

The supertabular package de�nes two environments, supertabular and supertabular*,
that support tabular environments longer than a single page. The package creates a sep-
arate tabular environment for each page. Therefore, the column widths for a continuing
table may vary from page to page. (The longtable package described on page 138,
avoids varying column widths for extended tables.)
The package supports a series of commands for de�ning the contents of the column

headings, any material to be inserted at the end of each page of the environment, and
a table caption. See the package documentation for complete information. The basic
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nsupertabular command is similar to the standard LATEX ntabular command;
please refer to LATEX sources for further information about using commands of this type.
Additionally, a package option determines the extent of error information that is written
to the .log �le.

I To create a multipage table within a supertabular environment
1. Add the supertabular package to your document.

2. Enter an encapsulated TEX �eld.

3. Enter the commands for the entire supertabular environment, beginning with
nbegin{supertabular} and ending with nend{supertabular}.

4. Choose OK.

If you place a supertabular environment inside or on the same page as a �oating ele-
ment, the results are unpredictable. See also the xtab package, page 182. The supertab-
ular package is installed in the TCITeX/TeX/LaTeX/contrib/supertabular
directory.

Tabularx

The tabularx package de�nes a tabular environment that generates a table with a spec-
i�ed width. The package automatically adjusts the widths of certain columns rather
than adding space between columns. The basic command is similar to the standard
LATEXntabular*command; please refer to the package documentation for complete
instructions and to LATEX sources for further information about using commands of this
type.

I To create a tabular environment of a speci�ed width
1. Add the tabularx package to your document.

2. Enter an encapsulated TEX �eld.

3. Type nbegin{tabularx}{w}{jXjX . . .j} where w is the desired width of the table and
X marks each column for which the width is to be adjusted.

4. Type the commands for the remainder of entire supertabular environment.

5. Type nend{tabularx}.

6. Choose OK.

The single package option involves debugging. The package is installed in the
TCITeX/TeX/LaTeX/required/tools directory as part of the Standard LATEX
Tools Bundle.
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Textcase
The textcase package implements commands that change the case of material in the
command argument. The commands change the case of text but leave unchanged any
sections of mathematics and any key names, so that references, citations, and labels still
work correctly.

I To change the case of speci�ed text
1. Add the textcase package to your document.

2. Enter an encapsulated TEX �eld.

3. Type

nlowercase{text}
or

nuppercase{text}
where text is the text you want changed to lowercase or uppercase.

4. Choose OK.

The package option addresses the use of standard text case macros. The package is
installed in the TCITeX/TeX/LaTeX/contrib/carlisle directory.

Theorem
The theorem package customizes theorem environments to meet the layout require-
ments of different journals. Theorem styles determine the appearance of theorem envi-
ronments. These styles have been de�ned:

Style Effect
plain Similar to the original LATEX de�nition, with the addition of

parameters that specify the amount of space to skip before and
after the theorem

break Place a line break after the theorem header
marginbreak Set the theorem number in the margin and place a line break

after the theorem header
changebreak Interchange the header number and text and place a line break

after the theorem header
change Interchange the header number and text but don't place a line

break after the theorem header
margin Set the theorem number in the margin; don't insert a line break

I To customize the appearance of theorem environments
1. Add the theorem package to your document.

2. From the Typeset menu, choose Preamble.
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3. Click the mouse in the entry area.

4. Place the insertion point on a new line in the preamble, before the nnewtheorem
statement for the theorem environment you want to customize.

5. If you want the style to apply to all theorem-like objects in the document, type
ntheoremstyle{style} where style is the style you want.
or

If you want the style to apply to a group of theorem-like objects in the document,
type {ntheoremstyle{style}, where style is the style you want, and then place the
insertion point at the end of the group and type } (closing curly brace).

6. If you want to change the font that LATEX uses for the header of the theorem environ-
ment, type ntheoremheaderfont{font} where font is the font family you want LATEX
to use.

Because ntheoremheaderfont is a global setting, it changes the header font for all
theorem-like environments in the document. The command should be used only
once. Values for font can be combined. Possible values for font are:
Family Effect Family Effect
nmdseries Medium Series nupshape Upright Shape
nbfseries Boldface Series nitshape Italic Shape
nrmfamily Roman Family nslshape Slanted Shape
nsffamily Sans Serif Family nscshape Small Caps Shape
nttfamily Typewriter Family nnormalfont Normal (document main

text font)

Not all combinations make sense and LaTeX compensates by placing a warning in
the .log �le and substituting a similar font.

7. If you want to change the font that LATEX uses for the body of the theorem environ-
ment, type ntheorembodyfont{font} where font is the font family you want LATEX
to use.

Use the command ntheorembodyfont{nupshape} to use upright text in the body of a
theorem. The font used for the body of a theorem-like environment can be restricted
to a single environment or a group of environments by using curly braces to enclose
the environments.

8. Choose OK.

No options are available through the Options and Packages command on the
Typeset menu. The theorem package is installed in the TCITeX/TeX/LaTeX/
required/tools directory as part of the Standard LATEX Tools Bundle.

Times

See PSNFSS Packages on page 152.
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Titlesec

The titlesec package is a complete reimplementation for LATEX heading commands that
provides a way to change the typeset appearance of division headings, such as chapter
and section. The package includes two interfaces, one basic and one extended. The basic
interface provides modi�cation of various division heading attributes (font size, font
shape, text alignment, spacing) with the package options available through the Options
and Packages command on the Typeset menu. The modi�cations are applied to all
division headings. The extended interface provides commands that allow separate and
more elaborate modi�cation of the appearance and placement of headings, including
different formats for right and left pages and numbered and unnumbered headings.

I To use the simple interface to change the formatting for division headings
1. Add the titlesec package to your document.

2. On the Typeset toolbar, click the Options and Packages button or, from the
Typeset menu, choose Options and Packages and then choose the Package Op-
tions tab.

3. From the Packages in Use list, select the titlesec package and chooseModify.

4. Select items from the Category list, and for each item select an item from the Op-
tions list, to specify the format for the division headings.

5. Choose OK to close each dialog box and return to your document.

If the options available as prede�ned formatting settings don't meet your needs, you
can use an advanced user interface to create elaborate formats for division headings. To
use the advanced interface, you add LATEX commands to the document preamble. See
the titlesec package documentation for details.
The titlesec package doesn't work for documents created with Style Editor shells.

It is installed in the TCITeX/TeX/LaTeX/contrib/titlesec directory.

Titletoc

The titletoc package provides a method for changing the appearance of the table of con-
tents, list of �gures, and list of tables. Package options, available through the Options
and Packages command on the Typeset menu, provide for setting the alignment of
division labels and placing a dot after the labels. The package provides for appropriate
page breaks in the table of contents and lists of �gures and tables.
The following example speci�es that chapter headings be typeset as bold italics.

Modify these sample instructions to create the format you want.

I To change typeset formatting for the table of contents, list of �gures, or list of tables
1. Add the titletoc package to your document.

2. From the Typeset menu, choose Preamble and click the mouse in the entry area.
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3. Create a new line at the end of the preamble entries.

4. On the new line, type
ntitlecontents{chapter}[0pt]{naddvspace{1pc}nitshape}{ncontentsmargin{0pt}
nbfseriesnmakebox[0pt][r]{nlargenthecontentslabelnenspace}nlarge}
{ncontentsmargin{0pt}nlarge}{nh�llncontentspage}[naddvspace{.5pc}]

5. Choose OK.

See the titlesec package documentation for detailed information about the com-
mands available for use with the titletoc. The titletoc package doesn't work for doc-
uments created with Style Editor shells. The package, which is distributed with the
titlesec package, is installed in the TCITeX/TeX/LaTeX/contrib/titlesec
directory.

Tocbibind
The package automatically includes the table of contents, list of �gures, list of tables,
bibliography, and index in the table of contents of your document. The package is
designed for use with the standard LATEX document classes, but may cause dif�culties
with other document classes. The tocbibind package doesn't work with the version of
LATEX included with Version 3.0.
No action is needed other than adding the package to your document, but options are

available from the Options and Packages command on the Typeset menu to exclude
front and back matter elements from the table of contents and to use and format sec-
tion headings in the table of contents. The package is installed in the TCITeX/TeX/
LaTeX/contrib/tocbibind directory.

Tocloft
The tocloft package provides a method for changing the appearance of entries in the
table of contents, list of �gures, and list of tables. The package can also be used to
create new kinds of List of ... pages.
The commands available for use with the tocloft package control the formatting,

including fonts, spacing, and dot leaders, used for part, chapter, section, and subsection
entries in the table of contents. Additional commands control the formatting of entries in
the list of �gures and list of tables, and determine whether the lists begin on new pages.
The commands are entered in the preamble of your document. See the tocloft package
documentation for command details and syntax.

I To change the typeset formatting for the table of contents, list of �gures, or list of
tables

1. Add the tocloft package to your document.

2. From the Typeset menu, choose Preamble.

3. Type the package commands to change the formatting.
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For example, if you want to list chapters in a report using the normal weight font
instead of the bold default, type nrenewcommand{ncftchapfont}{nmdseries}.

4. Choose OK.

LATEX formats the table of contents using the normal weight font.

Several package options are also available. Through the Options and Packages
command on the Typeset menu, you can use default LATEX formatting and also select an
option required when the tocloft package is used together with the sub�gure package.

The tocloft package is compatible with the tocbibind package. It doesn't work
for documents created with Style Editor shells. It is installed in the TCITeX/TeX/
LaTeX/contrib/tocloft directory.

Ulem

The ulem package provides several styles of simple underlines and strikethroughs by
temporarily changing the behavior of the nem and nemph commands. The underlining
and strikethroughs can extend across line breaks and apply to both text and mathematics.

The options available through the Options and Packages command on the Type-
set menu determine how the Emphasized tag is applied. The default, which you can
turn off, is a single underline. As illustrated below, the package also supports double un-
derlining, wavy underlining, a single line drawn through text, and text marked over with
slashes. It supports the use of a wavy underline in place of bold text.

I To add simple underlines
1. Add the ulem package to your document.

2. Select the information you want to underline.

3. Apply the Emphasized tag.

I To add varied underlines and strikethroughs
1. Add the ulem package to your document.

2. Place the insertion point where you want the underline or strikethrough to begin.

3. Enter an encapsulated TEX �eld.

4. In the entry area, type ncommand{text} where command is one of the following:
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Command Effect
nuline Single underline
nuuline Double underline
nuwave Wavy underline
nsout Line through text
nxout Text marked over with slashes

and text is the information you want emphasized.

5. Choose OK.

With Version 5.5, you can use the package options to indicate additions and deletions
in your text, a type of markup known as legislative format. A �le in the SWSamples
directory of your program installation contains additional information. Additionally,
you can add underlines and strikethroughs at speci�c points in the document. The ulem
package is for use with LATEX or plain TEX.The package installed in the TCITeX/TeX/
LaTeX/contrib/misc directory.

Url
The url package allows spacing and line breaks that result in intelligent printing of
email addresses, hypertext links, and path or directory addresses. You must enter pack-
age commands in TEX �elds. The address, link, path, or directory address speci�ed in
the command must not contain unbalanced braces. If it doesn't contain certain other
characters (such as % or #) and doesn't end with a backslash, you can use the command
in the argument to another command. Most of the path names appearing in this manual
have been formatted with the aid of the url package.

I To implement intelligent printing of hypertext links and electronic addresses
1. Add the url package to your document and set the options as necessary.

2. Place the insertion point where you want the link or address to appear.

3. Enter an encapsulated TEX �eld.

4. In the entry area, type nurl{address} where address is the address or link to be
printed.

5. Choose OK.

In addition to package commands, the package options control spacing and line
breaks. The package installs in the TCITeX/TeX/LaTeX/contrib/misc direc-
tory.

Varioref
The varioref package enhances page references with text that varies depending on the
relative typeset location of the referenced key. The package uses standard references
(using a TEX nref command) when the command and the key occur on the same page.
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However, when the command and key vary by a page or more, the package inserts strings
such as on the facing page, on the preceding page, on the following page, or on the next
page. When the difference is greater than one page, varioref inserts both an enhanced
reference and a standard reference. The varioref package supports babel so that the
strings produced are customized for different languages. Also, you can customize the
text strings as necessary. A package option is available to aid troubleshooting.

I To enhance page references
1. Add the varioref package to your document.

2. Place the insertion point where you want the reference to appear.

3. Enter an encapsulated TEX �eld.

4. In the entry area, type one of the varioref commands:

Command Effect
nvref{key} Create an enhanced reference
nvpageref[text]{key} Create an enhanced page reference
nvrefrange{key}{key} Create an enhanced range of references
nvpagerefrange[text]{key}{key} Create an enhanced range of page references

where key is the key you want to refer to and text is the enhancement text you want
to use if the keys and references are on the same page.

5. Choose OK.

The package is installed in the TCITeX/TeX/LaTeX/required/tools direc-
tory as part of the Standard LATEX Tools Bundle.

Verbatim

The verbatim environment allows for the display of information exactly as it is entered
at a terminal. The verbatim package improves that environment by handling text of
arbitrary length, even an entire �le, as verbatim input. The package also improves the
detection of the verbatim environment's closing delimiter. You can display verbatim text
with a font different from the default typewriter font.

I To display verbatim text
1. Add the verbatim package to your document.

2. Place the insertion point where you want the verbatim text to appear.

3. Enter an encapsulated TEX �eld.

4. In the entry area, type nbegin{verbatim} and choose OK.

5. Type the information as you want it to appear.



Version 179

6. At the end of the information, enter another encapsulated TEX �eld.

7. In the entry area, type nend{verbatim} and choose OK.

I To import a verbatim �le
1. Add the verbatim package to your document.

2. Place the insertion point where you want the �le to appear.

3. Enter an encapsulated TEX �eld.

4. In the entry area, type nverbatiminput{�lename} where �lename is the complete
path name of the �le to be imported, with forward slashes substituted for backslashes.

5. Choose OK.

The package has no options. It installs in the TCITeX/TeX/LaTeX/required/
tools directory as part of the Standard LATEX Tools Bundle.

Version
The version package provides a way to include or exclude material conditionally from
the LATEX typesetting process. You can use the package to include in your document
text, mathematics, graphics, and other material that will never be typeset or that may
be typeset at certain times but not others. The advantage to using the package instead
of the Comments fragment included with SWP and SW is that the material is always
displayed in the document window even though it may be ignored by LATEX.
Package environments determine whether or not the information within the environ-

ments will be typeset. A prede�ned comment environment always excludes material
from typesetting.

I To include material that will never be typeset.
1. Add the version package to your document.

2. Place the insertion point where you want the material to begin.

3. Enter a TEX �eld.

4. In the entry area, type nbegin{comment} and choose OK.

5. Create the material you want to exclude from typesetting.

6. At the end of the material, enter a TEX �eld.

7. In the entry area, type nend{comment} and choose OK.

I To include material that may or may not be typeset
1. Add the version package to your document.

2. Place the insertion point where you want the material to begin and enter a TEX �eld.
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3. In the entry area, type nbegin{name} where name is any value that doesn't con�ict
with existing TEX values.

The name is case-sensitive.

4. Create the material you occasionally want to exclude from typesetting.

5. At the end of the material, enter a TEX �eld.

6. In the entry area, type nend{name} and choose OK.

7. From the Typeset menu, choose Preamble and click the mouse in the entry area.

8. On a new line, type nexcludeversion{name} if you don't want to typeset the material
or nincludeversion{name} if you do.

9. Choose OK.

You can de�ne as many version environments as you want. The package is installed
in the TCITeX/TeX/LaTeX/contrib/misc directory.

Wrap�g

The wrap�g package allows text to be wrapped
around �oating objects at the side of the page,
as shown here. The package provides two en-
vironments, wraptable and wrap�gure. These
environments are not regular �oats and may
print out of sequence, but accompanying cap-
tions are correctly numbered. The package has
no options available through the Options and
Packages command on the Typeset menu. Find additional documentation in the
PackageSample-wrapfig.tex �le in the SWSamples directory of your program
installation.

I To wrap text around a �oating �gure or table
1. Add the wrap�g package to your document.

2. Enter an encapsulated TEX �eld.

3. In the entry area, type nbegin{wrap�gure}[w]{x}[y]{z} or
nbegin{wraptable}[w]{x}[y]{z}
where w is the number of vertical lines to be narrowed to accommodate the �gure or
table. We recommend you use this optional argument.

x is the placement of the �gure or table (required). Uppercase indicates �oat; lower-
case indicates exactly here:
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Placement Effect
r or R Right side of text
l or L Left side of text
i or I Inside edge, near the binding (for two-sided documents)
o or O Outside edge, away from the binding (for two-sided documents)

y is the amount of overhang�the distance the �gure or table should extend into the
margin (optional).

z is the width of the �gure or table (required). If you specify a width of zero (0pt),
the package uses the actual width of the �gure or table to determine the wrapping
width.

4. Choose OK.

5. Enter the �gure or table as an in-line object.

6. Enter an encapsulated TEX �eld.

7. In the entry area, type nend{wrap�gure} or nend{wraptable} and choose OK.

The package has one option available to print information in the .log �le. You
can �nd additional documentation in the SWSamples directory of your program in-
stallation. The wrap�g package is installed in the TCITeX/TeX/LaTeX/contrib/
misc directory.

Xr
The xr package uses standard TEX nref and npageref commands to create cross-
and page references to labels outside the current document. You can declare as many
external documents as you want. You must compile the document outside SWP or SW.

I To create cross-references and page references to labels in other documents
1. Add the xr package to your document.

2. Declare the external documents:

a. From the Typeset menu, choose Preamble and click the mouse in the entry area.
b. On a new line, declare the document for which you want to create a cross-reference
by typing nexternaldocument{�le} where �le is the name of another document.
Note Don't include the �le extension.

c. Repeat step c for as many �les as necessary, then choose OK.

3. Place the insertion point where you want the cross-reference to occur.

4. Enter a TEX �eld and iIn the entry area, type nref{label} or npageref{label} where
label is the label in the external document.

5. Choose OK.

No options are available. The xr package is installed in the TCITeX/TeX/LaTeX/
required/tools directory as part of the Standard LATEX Tools Bundle.
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Xtab

The xtab package improves page breaking by the supertabular package (see page 170).
The package allows headings on the last page of a table to differ from those on earlier
pages. Be sure to run LATEX twice when xtab is in use. A debugging option is available
through the Options and Packages command on the Typeset menu.

I To modify supertabular environments
1. Add the xtab and supertabular packages to your document.

2. Enter an encapsulated TEX �eld and in the entry area, type the commands for the
entire supertabular environment, beginning with nbegin{supertabular} and ending
with nend{supertabular}.

3. Modify the supertabular headings on the last page as necessary by adding xtab
ntablefirsthead and ntablelasthead commands at appropriate points in
the environment. See the package documentation for a list of available commands

4. Choose OK.

Xtab is installed in the TCITeX/TeX/LaTeX/contrib/xtab directory.
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Even the most carefully created documents sometimes contain commands, construc-
tions, or errors that prevent them from being opened, saved, compiled, previewed, or
printed. In this chapter we describe common error messages and conditions that can oc-
cur when you're working with SWP, SW, and LATEX. Explanations of error messages
begin on this page; information about other error conditions begins on page 205.For
each message or condition, we indicate which versions of the program are affected, ex-
plain why the problem occurs, and suggest ways you can resolve the situation. Although
error messages generated by the program are usually self-explanatory, this additional in-
formation may help you diagnose and correct errors quickly.
Beginning on page 221, we include basic information about isolating and identifying

LATEX errors and we provide suggestions for repairing damaged documents. This isn't
intended as an exhaustive reference for LATEX or PDFLATEX. We encourage you to seek
additional enlightenment from the TEX and LATEX resources listed on page x. These
excellent resources contain extensive lists of error messages and careful explanations
of possible causes. They also describe in detail how you can attempt to recover from
TEX and LATEX errors as your �le is being processed. In addition, you can �nd helpful
information from the Usenet news group at news:comp.text.tex.
If a problem occurs that you can't resolve with the information provided here, you

can obtain additional help from our website at

http://www.mackichan.com/techtalk/knowledgebase.html

or from our Web-based Technical Support forum at

http://www.mackichan.com/techtalk/UserForums.htm

You can also contact our Technical Support staff by email, telephone, or fax. We urge
you to submit questions by email whenever possible in case our technical staff needs to
obtain your �le to diagnose and solve the problem. See page xvi for details.

Error Messages
These error messages, listed in alphabetical order, can occur when you're working with
SWP, SW, and LATEX. Please note the version of the program that you have installed
and the version affected by each message.
If you have dif�culties when you try to open or save a document, look for information

in this section before you attempt the operation a second time. You may be able to avoid
damage to your document. Many of the problems discussed below are indicated with
messages in the LATEX or PDFLATEX window. Some can halt compilation. Errors that
don't halt compilation may nonetheless result in an incomplete or incorrect DVI or PDF
�le.
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� ! nbegin{subequations} ended by nend{(environment)}.

� SWP/SW Version 3.5x, 4.x, and 5.x

Using the subequation feature to number equations with both letters and numbers
(as in 1a, 1b, 1c, ...) sometimes results in compilation errors that yield this message,
in which the environment in the nend statement is different from the one in the
nbegin statement. The program occasionally places the end of the subequations envi-
ronment in the wrong position when you set the numbering of a displayed equation by
checking the Enable Subequation Numbering box in the advanced Display Proper-
ties dialog box.

Solution
Remove the speci�cation in the Display Properties dialog box and place encapsulated
TEX commands around the equation.

I To create a subequation environment
1. Select the equation and choose Properties.

2. In the Display Properties dialog box, check the Auto numbering option for each
line of the display for which you want an equation number to appear.

3. Choose Advanced.

4. If you've speci�ed a Key for Whole Display, delete the key.

5. Uncheck Enable Subequation Numbering, and choose OK.

6. Enter an encapsulated TEX �eld immediately before the display.

7. In the entry area, type nbegin{subequations} and choose OK.

8. If you want a key for the whole display, from the Insert menu, choose Marker and
enter the key you deleted in step 4, above, and choose OK

9. Enter another encapsulated TEX �eld immediately after the last equation.

10. In the entry area, type nend{subequations} and choose OK.

� Cannot connect to license server.

� SWP/SW Version 4.x, and 5.x

The message appears when you attempt to start the program. You may also see

error -97 or error -96

The error occurs when another program on your computer is licensed using our licensing
software, FLEXlm. The FLEXlm manager points either to the license for the other
program or to the license server itself.
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Solution
In Windows, pointers to licenses can be stored in environment variables. The default
environment variable for FLEXlm is LM_LICENSE_FILE. An environment variable
may also be set for each program that uses FLEXlm. You can resolve the problem by
modifying the default environment variable to point to a list of license �les or license
server locations, so that each application queries the list until it �nds an appropriate and
valid license. Alternatively, you can create a new environment variable for each program
that uses the licensing software.

I To modify the default environment variable
1. Using Windows XP, start the System applet from the Control Panel.

2. In the System Properties dialog, select the Advanced tab and then choose the
Environment Variables button.

The system displays lists of user and system variables. The LM_LICENSE_FILE
environment variable can be in either list.

3. Select the LM_LICENSE_FILE environment variable and then choose the Edit but-
ton.

The dialog that opens shows the variable name and value, which might look some-
thing like this: 1700@flexserver.

4. Update the variable value:

a. Place the insertion point at the beginning of the Variable value entry.
b. Enter the path to the SWPlicense �le and then enter a semicolon and a space.
For example, if you have installed SWPin the c:nswp55 directory, the complete
path to the SWPlicense �le is c:nswp55nLicensesnlicense.lic.

The previous license pointer will remain. The completed entry should look some-
thing like this:

c:nswp55nLicensesnlicense.lic; 1700@flexserver

A space after each semicolon in the value is required.

5. Choose OK to accept the entry and close the dialogs.

I To create an environment variable for each licensing �le
1. Using Windows XP, start the System applet from the Control Panel.

2. In the System Properties dialog, select the Advanced tab and then choose the
Environment Variables button.

The system displays lists of user and system variables. The LM_LICENSE_FILE
environment variable can be in either list.

3. Select the LM_LICENSE_FILE environment variable and then choose the Edit but-
ton.
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4. In the Variable name area, change the name of the LM_LICENSE_FILE environ-
ment variable to a name speci�c to the product you are using.

The following are known variable names:

MAPLELMG_LICENSE_FILE for Maple (Maplesoft)

MLM_LICENSE_FILE for MATLAB (The MathWorks, Inc.)

IDL_LMGRD_LICENSE_FILE for IDL (RSI)

ENGSWD_LICENSE_FILE for iSight (Engineous Software)

If more than one license point is included in the environment variable, you must
create a new environment variable for each additional program that uses FLEXlm.

5. Choose OK to accept the entry and close the dialogs.

You should now be able to start SWP or SW and have the program �nd the li-
cense �le in its default location. However, you may still need to add a new environment
variable.

I To add a new environment variable
1. Using Windows XP, start the System applet from the Control Panel.

2. In the System Properties dialog, select the Advanced tab and then choose the
Environment Variables button.

3. In the System Variables area, choose New.

4. In the Variable name area, enterMACKICHN_LICENSE_FILE

MACKICHN is the MacKichan Software vendor daemon.

5. In the Variable value area, enter the path to your MacKichan license �le, such as
c:nswp55nLicensesnlicense.lic.

6. Choose OK to accept the entry and close the dialogs.

� Can't �nd �le (�lename).

or

� Can't �nd �le (�lename.cst).

� SWP/SW Version 3.5x, 4.x, and 5.x
When the document you're trying to open requires a .cst �le that the program can't

�nd, you see one of these messages:

Can't find file (filename). Document may not load correctly.
Would you like to continue?

or
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Can't find file (filename.cst). File (otherfilename.cst) will
be used instead. Would you like to continue?

The .cst �le determines the appearance of the document in the document window. The
problem can occur when you try to open a document from an outside source, such as a
publisher, if that document calls for typesetting speci�cations that aren't included with
SWP or SW.

Solution
Several options are available:
� Choose Yes to ignore the message. The program opens the document using sci-

word.cst, the default .cst �le used when a more appropriate .cst �le can't be
found.

� Instead of opening the document directly, start a new document using an appropriate
document shell (see page 81) and import the contents of the original document into
it.

� Create a new subdirectory in the Styles directory of your program installation and
name it the same name as the LATEX class for your document. Then, copy sci-
word.cst to the directory, rename it with the name of the missing �le, and try to
open the document again.

� If you're working with typesetting speci�cations not provided with SWP or SW,
see page 89 for the procedure for creating a .cst �le for typesetting speci�cations
from outside sources.

� Characters in the �le name or directory are invalid on some TeX sys-
tems.

� SWP/SW Version 3.5x, 4.x, and 5.x
Underscores in �le names can cause problems when you try to compile with some

versions of TEX. Therefore, we try to be as conservative as possible with �le names so
that we don't encourage the use of names that aren't portable to all systems. If you try to
compile a document has an underscore in its name, the program displays this message:

Characters in the file name or directory are invalid on some
TeX systems....
Do you wish to continue?

If you choose to continue, everything seems to work as it should, but the names can still
cause problems on some systems.

Solution
To make your �les as widely portable as possible, use DOS 8.3 �le names.

� ! Command nproof already de�ned.

� SWP/SW Version 3.5x, 4.x, and 5.x
Adding the amsthm package to a document and then typesetting the document

causes the error message. Although many AMS packages work well with SWP and
SW, the amsthm package does not. SWP and SW include many nnewtheorem
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statements that de�ne theorem-like environments and a nnewenvironment to de�ne
the proof environment. However, the amsthm package also de�nes the proof envi-
ronment, which results in the error when you typeset. Although you can continue the
compilation, as described in Resolving LATEX Errors on page 222, any proofs in your
document will not be typeset correctly according to the amsthm package speci�ca-
tions.

Solution
If you remove the nnewenvironment statement from the preamble, the document
will compile without errors, but the proof environments in your document will appear
as TEX �elds. Instead, use a conditional statement around the nnewenvironment
statement in the preamble. The conditional statement causes the program to see the
nnewenvironment statement and to display the body of the proof in the document
window. However, LATEX does not see the nnewenvironment statement, so it uses
the one de�ned by the amsthm package, and typesets the document correctly.

I To add the conditional statement to the document preamble
1. From the Typeset menu, choose Preamble, then click the mouse in the entry area.

2. Find the single line that de�nes the proof environment:

nnewenvironment{proof}[1][Proof]{nnoindentntextbf{#1.}}{ n nrule
{0.5em}{0.5em}}

3. On a new line before the nnewenvironment line, enter niffalse

4. On a new line after the nnewenvironment line, enter n�

5. Choose OK.

� DVI �le has too few (less than 4) trailer bytes.

� SWP/SW Version 3.5x, 4.x, and 5.x
The error can occur when SWP or SW runs under Virtual PC on a Macintosh.

Virtual PC allows directories to be shared between the Windows and Macintosh �le
systems, but locating DVI �les in a shared directory can cause problems. Although
LATEX compiles the document without error, the TrueTEX Previewer cannot open the
DVI �le and instead displays the error message.

Solution
Save your SWP and SW documents in an unshared directory.

� Dvigdi32.exe has encountered a problem and needs to close.

� SWP/SW Version 3.5x, 4.x, and 5.0
The error occurs when you typeset preview and attempt to print after having changed

the clock on your computer, which can interfere with an existing DVI �le. The problem
frequently occurs after the clock has been changed for Daylight Saving Time.

Solution
Make a small change to your document and recompile it, then try to print again.



Error Messages 189

� Error parsing TeX expression.

� SWP/SW Version 3.5x, 4.x, and 5.x

When you attempt to open a �le, the program fails to interpret a TEX expression
and displays the message. If you choose OK, the program opens the document, but
may place the segment containing the problem expression in a TEX �eld. As you scroll
through the open document, you may see TEX �elds in place of entire paragraphs.

Solution
Try to isolate and correct the error using the procedure on page 223.

� Error running Tex, DVI �le not created.

� SWP/SW Version 3.5x, 4.x, and 5.x

When an error prevents the completion of a LATEX compilation, the LATEX window
closes and SWP or SW displays the message.

Solution
Follow the instructions on page 223 to identify and isolate the error. Correct the error
and typeset your document again.

� Error while attempting to execute Adobe Acrobat.

� SWP/SW Version 5.x

The program displays the message when you try to preview or print a PDF �le with
Adobe Acrobat. The error occurs if you have updated Acrobat since you installed SWP
or SW, because the program no longer has the correct address for Acrobat.

Solution

I To modify the address for Adobe Acrobat
1. From the Typeset menu, choose Expert Settings.

2. Choose the PDF Preview Settings tab.

3. In the Select box, select Acrobat and choose Add/Modify.

4. Use the Browse button next to Executable �lename to locate the version of Acrobat
that is installed on your computer.

5. Choose Open to set the address and then choose OK.

6. Choose the PDF Print Driver Settings tab.

7. Repeat steps 3�5.

8. Choose OK.
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� Error while attempting to execute BibTeX or MakeIndx.

� SWP/SW Version 5.0 prior to Build 2570

Generating a BIBTEX bibliography or an index fails in Version 5.0 of SWP and SW,
and the program displays one of these error messages:

Error while attempting to execute C:nswp35nTCITeXnSWToolsnbin
nBibTeX.exe

or

Error while attempting to execute C:nswp35nTCITeXnSWToolsnbin
nMakeIndx.exe

The error occurs because Version 5.0 has been installed over an existing Version 3.5,
changing the con�guration of BIBTEX and MakeIndex so that these typesetting tools
cannot be started from SWP.

Solution
You can resolve the problem by editing the program's initial con�guration �le. If you're
using SW, the �le and directory names differ slightly.

I To edit the initial con�guration �le
1. Close SWP or SW.

2. Using an ASCII editor, open the initial con�guration �le swp-pro.ins in the
program directory.

Because Version 5.0 has been installed over Version 3.5, the program directory for
SWP is c:nswp35.

3. Change the BIBTEX entries in the �le:

a. Find the group with entries similar to these:
[BibTeX]
BibTeXStyleDir=c:nswp35nTCITeXnbibtexnbst
BibTeXDataDir=c:nswp35nTCITeXnbibtexnbib
BibTeXexe=c:nswp35nTCITeXnSWToolsnbinnBibTeX.exe

b. Change the last line of the group to
BibTeXexe=BibTeX

4. Change the MakeIndex entries in the �le:

a. Find the group with entries similar to these:
[MakeIndex]
MakeIndxExe=c:nswp35nTCITeXnSWToolsnbinnMakeIndx.exe

b. Change the last line of the group to
MakeIndxExe=MakeIndex
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5. Find these lines:

[Installation]

MoveToIniDbase=0

6. Change the last line of the group to

MoveToIniDbase=1

7. Save the con�guration �le.

8. Start SWP. The information in the con�guration �le will be moved to the appropriate
location in the Windows registry.

� Error while reading paragraph xxx. Document has been truncated.

� SWP/SW Version 3.5x, 4.x, and 5.x

The message occurs when the program has tried to read a document and has en-
countered a LATEX construction or expression that it doesn't understand. The program
truncates the document at the indicated paragraph as it is being loaded into memory,
but the �le on your hard disk remains whole. The problem can occur particularly with
documents obtained from outside sources.

Solution
First, close the document without saving it. If you save the �le, the program saves
the truncated version to your hard disk and you will be unable to recover the truncated
information.
Then, examine the �le using an ASCII editor to see if you can detect a problem

at the indicated paragraph. Remember that paragraph numbers in the .tex �le don't
correspond exactly to the paragraphs in an SWP or SW document.
If you have Version 5.5 of SWP or SW, you may be able to open the document with

the Import Non-SWP/SW LATEX �lter. See page 85 for more information.

� Errorwhile writing paragraph xxx.Document was only partially saved.

� SWP/SW Version 3.5x, 4.x, and 5.x

The message occurs when the program has tried to save a �le ( often using the
Portable LATEX option) but has encountered something that it doesn't understand. The
program truncates the document at the indicated paragraph as it is being written to the
hard disk.

Solution
Although the document has been truncated on the hard disk, the complete �le remains
in memory, and you may be able to recover it. Don't try to save the �le the same
way again. Instead, try saving the �le to a different document name using a different
output �lter. That is, if you tried to save the document as Portable LATEX when the error
occurred originally, try saving the �le as a standard SWP or SW document using the
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SWP/SW/SN Document (*.tex) option. If the program saves the document correctly,
no other action is necessary. However, you should examine the document carefully to
make sure you haven't lost any information.
If saving with a different output �lter fails, you may be able to recover the document

using a .bak �le if automatic backups were in effect when the problem occurred. The
backup copy is the next-to-last saved version of the original �le.

I To use the backup �le
1. After the error has occurred, exit the document without saving it.

2. Rename the .bak �le and give it a .tex �le extension.

3. Make several copies of the renamed �le.

4. Open the renamed �le and try to save it.

5. If the program saves the �le without error, check the document carefully to make
certain your most recent changes have been saved.

If these methods fail, contact our Technical Support staff, as described on page xvi.

� Error writing to disk.

� SWP/SW Version 3.5x, 4.x, and 5.x
The program tries to save the temporary data generated in the course of a compi-

lation. Some of the required �les may be in use by another instance of the TrueTEX
Formatter or may be otherwise inaccessible. If the data can't be saved, the program
displays the message.

Solution
� Check to make sure that all �les associated with the document are in the correct
directories.

� Check that none of the associated �les are read-only �les.
� Make certain that multiple copies of the TrueTEX Formatter aren't running. Close all
instances of the formatter and try the compilation again. If the program still can't
save the temporary data, send the �le to our Technical Support staff, as described on
page xvi.

� Failed to �nd master document (�lename).

� SWP/SW Version 3.5x, 4.x, and 5.x
The message occurs when you try to typeset a subdocument for which the master

document is missing. The complete message is

Failed to find master document (filename). Default document
information used. Warning: Print or Preview may fail.
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Subdocuments contain no typesetting speci�cations, document information, or front
matter of their own; instead, they use the information in the master document. If the
master document is missing, the program must use default information, and the preview
or print operation may fail.
If you continue the compilation process with the default information, the program

typesets the subdocument as if it were an article. Subdocuments that are intended as
book or report chapters won't typeset properly because they contain constructs not nor-
mally contained in articles.
The master document may be missing for several reasons. If you received the sub-

document from an outside source, the master document may not have been provided
with it. Also, if you have renamed the master document, the pointers in the subdocu-
ments may still point to the old name.

Solution
If the master document is unavailable, create a new, independent document from the
subdocument. If you've renamed the master document, create a new subdocument for
the master document and import the contents of the old subdocument into the new one.

I To create a document from a subdocument
1. Open a new document.

2. From the File menu, choose Import Contents.

3. Select the subdocument and choose OK.

The program copies the content of the subdocument into the new document.

4. Create front matter for the new document as necessary.

5. Save and compile the new document.

I To create a new subdocument for a renamed master document
1. Save the renamed master document.

2. Place the insertion point where you want to include the subdocument.

3. On the Typeset Object toolbar, click the Subdocument button or, from the
Insert menu, choose Typeset Object and then choose Subdocument.

4. In the Subdocument area, enter a name for the new subdocument.

5. Choose OK.

6. Save the master document again.

The new subdocument now points to the renamed master document.
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7. Open the new subdocument and from the File menu, choose Import Contents.

8. Select the old subdocument and choose OK.

The program copies the content of the old subdocument into the new one.

� Failed to update system registry. Need permission to add?

� SWP/SW Version 5.x
This message occurs when you try to open the program under Windows Vista.

Solution
You can safely ignore the message. Choose OK and continue working.
If you don't want to see the message each time, run the program once as Adminis-

trator to update the registry and turn off the messages.

I To run the program as Administrator
1. Click Windows Start and then right click on the program shortcut.

2. Run the program as Administrator, providing the password your system uses.

� File (�lename) not found.

� SWP/SW Version 3.5x, 4.x, and 5.x
The error occurs when the compiler searches for a missing .tex �le or package.

When the compiler can't �nd the �le, it halts and asks for an alternate �le name, with
this message:

!LaTeX Error: File '(filename.tex)' not found.
Type X to quit or <RETURN> to proceed, or enter new name.
(Default extension: tex)
Enter file name:

Solution
You can try to continue the compilation or you can cancel the compilation and try to
correct the �le name in your document.
� To continue the compilation, type s or q or r and press ENTER.
� To stop the compilation, type x or e and press ENTER.
� To ask for help:

a. Type h and press ENTER.
LaTeX displays a new message containing standard error options: ENTER to con-
tinue processing, s to scroll other errors, r to run without stopping, q to run quietly,
and x to terminate the compilation

b. Enter one of the options and press ENTER.
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� I can't write on �le (�lename).log.

� SWP/SW Version 3.5x, 4.x, and 5.x
The message appears when you attempt to compile your document while a previous

compilation is still in progress. Because the formatter locks the �les during compilation,
the .log �le isn't accessible.

Solution
Make sure any previous compilations have completed and no other instances of the
TrueTEX Formatter are running before you try to compile again.

� Inaccessible Spell Check Database Directory "XXXXX.clx".

� SWP/SW Version 3.5x, 4.x, and 5.x
The message appears after you have tried to install an additional language dictionary.

The installation has not been successful although the program indicates it has been. The
Spell Check tool can't �nd the dictionary and displays the message.

Solution
First delete the Windows registry information for the program, then remove the spell
check installation information, and �nally reinstall the dictionary.

Caution Be extremely careful whenmaking changes to the registry. Incorrect changes
to the registry can cause incorrect behavior of your computer. Back up the regitry before
you attempt to make the suggested changes.

I To delete the registry information
1. Exit the program.

2. From the Windows Start menu, choose Run.

3. In the Open text box, type regedit and choose OK.

4. Find the key nHKEY_CURRENT_USER and click + to open the registry tree.

5. Find the key nSOFTWARE and click +.

6. Find the key nMacKichan Software.

7. Select the program you have installed.

8. Select the key for the program version you are using.

Be careful that you have selected the correct key.

9. Press DELETE and choose Yes when prompted to verify the deletion.

10. Close the Registry Editor.
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I To remove spell check installation information
Adding a spell check dictionary updates the installation con�guration �le. The

spell check con�guration information is then added to the registry when the program
is started. The spell check con�guration information can be removed either by remov-
ing the entire con�guration �le and then repairing your installation, or by directly editing
the con�guration �le. Follow the instructions for either method but not both.
� Method 1: Delete the installation con�guration �le
This method removes the serial number that appears in the About dialog.

1. Using Windows Explorer (or some other method), delete the installation con�gura-
tion �le in the program directory. Choose swp-pro.ins for SWP, sciword.ins
for SW, or scinoteb.ins for SNB.

2. Use the program CD to run the setup program and when pompted, select Repair.

� Method 2: Modify the installation con�guration �le
1. Using an ASCII editor, open the installation con�guration �le for your product in the
program directory. Choose swp-pro.ins for SWP, sciword.ins for SW, or
scinoteb.ins for SNB.

2. Locate the spell check installation information in the con�guration �le. The con�g-
uration �le consists of group headings listed inside brackets and group items listed
below each group heading. Two groups contain the installation information, [Lan-
guages] and [SpellChecker], as in this example:

[Languages]

Language.0004=Spanish,p,spnphon.env,spn32.clx,%INS_PATH1%

LexFile.0004=spn24.lex

LexFileDesc.0004=Spanish Proximity/Collins Linguibase

ProximityDir=C:nswp55
INS_PATH1=C:nswp55

[SpellChecker]

UserDictionary.0004=d:nswp55nspnuser.clm
UserDictionary.0001=C:nswp55nenguser.clm

3. Delete the non-American English spell check installation information:

a. In the [Languages] group, delete all the lines except the last two, which begin
ProximityDir and INS_PATH1.

b. In the [SpellChecker] group, delete any lines except the one beginning User-
Dictionary.0001.
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I To reinstall the dictionary
1. Start the program, choose Help, and then choose System Features.

The Install Dictionary button should be active.

2. Click the button.

3. Insert the program CD into your CD-ROM drive.

4. Run the InstallD.exe program from the directory for your program version:
� For Version 5.5, the ndict55 directory
� For Version 5.0, the ndict50 directory
� For Version 4.0, the ndict40 directory
� For Version 3.5, the ndict35 directory

� Invalid characters in the �le name or path directories.

� SWP/SW Version 3.5x, 4.x, and 5.x
When you try to compile a �le whose name or directory name contains a space, the

program returns this message:

Invalid characters in the file name or path directories. En-
ter alpha-numeric characters, hyphens, and periods only. No
more than one period in sequence is allowed in the name of a
file or directory. Do you wish to continue?

If you choose Yes, TrueTEX will attempt to compile your document, but will halt with a
new message:

Please type another input file name.

File or directory names that contain spaces, such as new file or My Documents,
don't cause problems if you preview or print without typesetting, but do cause problems
for LATEX. As a general rule, avoid using any spaces in directory and �le names.

Solution
Cancel the compilation. Save the �le under a new name that contains no spaces and in a
directory whose name contains no spaces. Try the compilation again.

� License veri�cation error.

� SWP/SW Version 4.x and 5.x
When you try to start SWP or SW, a message appears that begins

License verification error
Unknown license system error
Major error: -103

Our licensing software, FLEXlm, generates the error. It usually occurs when a Windows
XP system running multiple user pro�les tries to run the program under a Terminal
Service.
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Solution
� Log off and restart your computer, then restart SWP or SW.
� If you're using Windows XP, be sure to have only one active user pro�le when SWP
or SW is in use.

� ! Missing $ inserted.

� SWP/SW Version 5.x
Graphics �les whose names contain spaces cause PDF compilation errors. Files that

contain such graphics may compile correctly when you create a DVI �le with the Type-
set/Preview command, but when you try to create a PDF �le with the Typeset/Preview
PDF command, PDFLATEXdisplays several lines like those below and halts the compila-
tion.

! Missing $ inserted.
<inserted text>
$
l.54 ...temp/graphics/figure output growth_ _1.pdf}
%
?

Although you can continue the compilation, as described in Resolving LATEX Errors on
page 222, the graphic identi�ed in the message doesn't appear correctly in the PDF
viewer.
In the example above, the name of the graphics �le includes several spaces followed

by a double underscore. The PDFLATEX program assumes the name of the graphic ends
with the �rst space. It processes the rest of the name as if it were ordinary text, inter-
preting the underscores as a TEX subscript and thus, as requiring mathematics mode.
The Missing $ inserted error occurs because the underscore isn't in mathemat-
ics. The spaces in the �le name cause the original confusion. If the �le name contained
no spaces, PDFLATEX would interpret the name of the graphics �le correctly.

Solution
Avoid using spaces in directory and �le names. Also, remember that although SWP
and SW can use many different graphics formats, PDFLATEX understands only a limited
number. When you typeset a PDF �le from your SWP or SW document, the program
converts any graphics in the document to a format that PDFLATEX can understand; you can
select the format you want to use. You can also select the way you want the converted
graphics to be named. Choose an appropriate graphics �le naming option to avoid the
error caused by spaces in the �le name.

I To choose a graphics �le naming option
1. From the Typeset menu, select General Settings.

2. Choose the PDF Graphics Settings button to open the PDF Graphics Export
Options dialog box.
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3. Choose the Graphics File Naming Options button and note the naming options in
the dialog box that opens.

Two options, Original �lename and Original �lename and graphics sequence
number (the default at installation), use the original graphics �le name as the basis
for the name of the converted graphics �le. If the original name contains a space, the
error will occur when you try to typeset a PDF �le.

4. Select one of the options that doesn't include the original graphics �le name in the
naming scheme.

5. Choose OK to close each dialog box and return to your document.

6. Save the document and try to typeset the PDF �le again.

� Overfull or underfull nhbox or nvbox.

� SWP/SW Version 3.5x, 4.x, and 5.x
When you read the compilation messages, you may see frequent references to over-

full or underfull boxes, with messages like these:

Overfull nhbox (xxpt too wide) in paragraph at lines 186-187
Underfull nhbox (badness 10000) detected at line 47
Overfull nvbox (xxpt too high) has occurred while noutput is
active
Underfull nvbox (badness 10000) has occurred while noutput is
active

The warnings indicate that LATEX cannot appropriately �t material into the horizontal
or vertical space available, thus creating typeset lines or pages that are too long or too
short. The message may indicate where in the document the problem has occurred, as
in the �rst two examples above, or may indicate that the problem occurred during the
formatting of running headers and footers, as in the last two examples. The number in
parentheses indicates the severity of the problem.

Solution
You can ignore these messages until you've completed work on the content of your doc-
ument and are ready to make �nal formatting adjustments. When you examine your
typeset document, you may be satis�ed with the spacing. In that case, no action is re-
quired. However, if the overfull condition is extreme, LATEX may have created awkward
word, line, or page breaks: lines may break too soon or extend into the margin, or text
may run off the end of the page. If the message indicates a problem with horizontal
spacing (nhbox), you may need to adjust the length of one or more lines by introducing
hyphenation points, forcing line breaks, or rewording your text so that LATEX can break
the line a new way. If the message indicates a problem with vertical spacing (nvbox),
you may need to adjust the length of text on the page by including forced page breaks.
You may also want to use the enlargethispage command to increase the amount
of text on the page slightly.
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I To increase the amount of text on the page
1. Place the insertion point in the text near the top of the page you want to enlarge.

2. Apply the Enlarge Page (TeX Field) fragment.

The fragment adds the TEX command nenlargethispage*{1000pt}.

3. Place the insertion point where you want the page break to occur.

4. From the Insert menu, choose Spacing, and then choose Break.

5. Select the type of page break you want and choose OK.

6. Compile your document again and examine the typeset �le for improved spacing.

� ! Package mathtime Error: Bold math is not supported.

� SWP/SW Version 3.5x, 4.x, and 5.x
You've tried to typeset a document that uses the mathtime package and also con-

tains bold Greek characters. The bold versions of the Times fonts are missing from the
package. The Mathtime Plus fonts provide bold and heavy bold versions of characters
using the Times fonts, but these don't work with the version of TrueTEX included in
SWP and SW.

Solution
You can achieve bold Greek characters by mapping the bold Greek letters to the Com-
puter Modern bold Greek font, as described below. Note, however, that you should
use this method with care. It can occasionally result in incorrect characters, because
the Mathtime fonts and the Computer Modern fonts have incompatible encodings. The
TrueTEX Formatter doesn't issue speci�c warnings about incorrect characters.

I To map bold Greek letters to the Computer Modern bold Greek font

1. On the Typeset toolbar, click the Options and Packages button or, from the
Typeset menu, choose Options and Packages and then choose the Package Op-
tions tab.

2. If the mathtime package isn't listed in the Packages in Use area, add the package.

3. In the Packages in Use area, select the mathtime package and chooseModify.

4. From the Category list box, choose Encoding Options, then from the Options list
box, choose No TS1.

5. From the Category list box, choose Bold, then from the Options list box, choose
Computer Modern.

Note that if you don't set this option and you save the document as a Portable LATEX
�le, the document will compile and print correctly on a system that has the Mathtime
Plus fonts.
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6. Choose OK to close the dialog boxes and return to your document.

7. Save the document and typeset it again.

� Serious program error has occurred.

� SWP/SW Version 3.5x, 4.x, and 5.x

On rare occasions, SWP and SW can fail. The complete message is as follows:

A serious program error has occurred. All modified documents
have been saved with the extension .dmp. The program will now
exit.

The program exits and then displays a second message:

The program has generated a file describing the state of your
system at the time of the error: (filename.mdmp). To help us
diagnose and fix the problem, please attach this file to an email
message and send it to support@mackichan.com.

Solution
If SWP or SW fails, the program saves all open and modi�ed documents in �les of the
same name with the extension .dmp, as indicated in the message. After you reopen the
program, open the .dmp �les and check to make sure they contain your latest changes,
then save the �les. The program saves the �les with the original .tex �le extension and
you can continue working on them as usual.
At the time of failure, the program also generates a �le containing diagnostic infor-

mation that our Technical Support staff can use to determine the cause of the failure. As
the second message indicates, we urge you to create an email message and attach the
�le and the document in use when the failure occurred, then send the message to our
Technical Support staff, as described on page xvi.

� ! TeX capacity exceeded, sorry [buffer size=5000].

� SWP/SW Version 3.5x, 4.x, and 5.x

This error can occur when you typeset a document saved with the Portable LATEX
�lter, which uses the graphicx package. The package scans for line end characters in
the contents of graphics �les included in your document. If the graphics �les in your
document were originally created in a non-Windows environment, they may use either
the Macintosh or Unix line end characters, which the package doesn't see. Therefore,
when you typeset your document, LATEX doesn't see the line end and continues to search
for it until the buffer size has been exceeded. LATEX stops at that point, issuing the error
message. Because LATEX stops at the point of the error, the complete document does not
appear in the TrueTEX Previewer or in print. The error occurs with .eps graphics in
particular.
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Solution
Convert the line end characters in the graphics �le to Windows line end characters. You
may have access to specialized programs for this purpose. If not, use an ASCII editor
to search in the graphic for a carriage return and change it to a carriage return with line
break.

� The document has not been loaded.

� SWP/SW Version 3.5x, 4.x, and 5.x

If you've placed complex TEX commands in the preamble of your document or
you're attempting to open a LATEX document not created with SWP or SW, the pro-
gram may be unable to load the document into memory. You may see this message:

The document has not been loaded. SW cannot handle certain ndef
or nnewcommand statements in the LaTeX preamble of this document.

In particular, complex ndef or nnewcommand statements can prevent the document
from loading.

Solution
If you have Version 5.5 of SWP or SW, you may be able to read the document with the
Import Non-SWP/SW LATEX �lter. See page 85 for more information.
If you have an earlier version of the program, you may be able to read the document

by placing the complex statements in an external �le and then importing that �le from
the preamble of your document.

I To place complex TEX statements in an external �le
1. Open your document with an ASCII editor.

2. Select the preamble statements you want to place in the external �le and cut them to
the clipboard.

3. In place of the lines you deleted, enter ninput{�lename.tex}, where �lename.tex is
the name of the ASCII �le you will create in steps 5�8.

4. Save the document.

5. Open a new �le with the ASCII editor.

6. Paste the statements from the clipboard into the �le.

7. Name the �le using a .tex �le extension.

8. Save the �le in an appropriate subdirectory in the TCITeX directory of your program
installation.

Note If the �le is in a different directory, LATEX won't �nd it when you attempt to
typeset your document, unless you've entered a complete path name in step 3.

9. In SWP or SW, try to open and typeset the original document.
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� The �le (�lename) is not valid for the selected �lter.

� SWP/SW Version 3.5x, 4.x, and 5.x
The �le you've tried to open is a non-LATEX �le or is a traditional LATEX subdocument

that doesn't contain ndocumentclass or nbegin{document} commands. The
program can't open the �le.

Solution
� If the �le isn't a LATEX �le, open it using an ASCII editor or using the application in
which the �le was created.

� If the �le is a LATEX �le, open a new document and use the Import Contents com-
mand to read the contents of the LATEX �le into the current document.

� In Version 5.5, try reading the �le with the Import Non-SWP/SW LATEX �lter. See
page 85 for more information.

I To import a non-SWP/SW LATEX document

1. Place the �le you want to open in a writable directory so that the program can create
the necessary temporary �les.

2. From the File menu, choose Import Non-SWP/SW LaTeX.

3. Select the �le and choose Open.

� There were unde�ned references.

� SWP/SW Version 3.5x, 4.x, and 5.x
When a cross-reference in your document isn't correctly matched to a marker during

compilation, LATEX posts this warning about unde�ned references in the LATEX window
and near the end of the .log �le. Also, LATEX inserts two question marks in the typeset
text in place of the reference, like this ??.

Solution
The message occurs if you specify only a single LATEX pass when you're compiling
a document, especially a master document, that contains cross-references. The cross-
references may be correctly resolved if you specify two or more LATEX passes when you
compile your document.
Unde�ned cross-references can also occur because the referenced marker is missing

or is incorrectly referenced. Instead of looking through a long document for instances
of ??, examine the document .log �le to search for the LATEX warning about unde�ned
references. If the message doesn't appear, all cross-references have been resolved.

I To examine the .log �le
1. Open the .log �le with an ASCII editor and scroll to the end of the �le.

2. If any cross-references are unresolved, this message will appear near the end:

LaTeX Warning: There were undefined references.
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3. Look earlier in the .log �le for more detailed messages like this:

LaTeX Warning: Reference `markerx' on page xx undefined on input
line xx.

4. In your document, insert any missing markers and correct all marker misreferences.

5. Save and compile your document again.

6. Check the new .log �le to make certain all cross-references are now resolved.

� ! Too many unprocessed �oats.

� SWP/SW Version 3.5x, 4.x, and 5.x

Documents that contain many �oating objects may occasionally encounter LATEX
processing problems. When you typeset your document, LATEX tries to process �oating
objects as it encounters them, anchoring them throughout the document. However, if
it can't place an object because of its size or if �oat placement options don't �t, LATEX
holds the object and all following �oating objects until the end of the document. If there
are too many such objects for LATEX to handle, it generates the error message.

Solution
You can force LATEX to process �oating objects in several ways:
� Place the nclearpage command in a TEX �eld in the body of your document.
The command forces LATEX to output any �oating objects that occur in the document
before the command.

� If you're not using the Portable LATEX �lter or creating a PDF �le, add the �oat
package to manage the placement of �oating objects in your document. See page
55 for detailed instructions, and see page 127 for more information about the �oat
package.

� Add the placeins package to your document to create barriers in the document be-
yond which �oating objects cannot be placed. See page 55 for detailed instructions,
and see page 150 for more information about the placeins package.

� ! Unable to write to .aux �le 'swp0000.aux'.

� SWP/SW Version 3.5x, 4.x, and 5.0 prior to Build 2606

When you compile your document, the TrueTEX Formatter creates an .aux �le and
uses the information in the �le to resolve cross-references and perform other typesetting
functions. If you try to start a new compilation of your document while a previous
compilation is still in progress, the error will occur. The .aux �le is inaccessible because
the formatter locks the �les during compilation.
Also, if you used a CD-ROM disc to transfer your document and its associated aux-

iliary �les from one computer to another, the �les may have been marked as read-only in
the process. When you compile the document again, the formatter copies the �les to the
temporary directory used by the program installation and renames the existing .aux �le
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as swp0000.aux. It retains the read-only attribute, causing the error and preventing
the program from opening and writing to the �le during the compilation.

Solution
� Make sure any previous compilations have completed and no other instances of the
TrueTEX Formatter are running before you try to compile your document again.

� If you have Version 5.0 prior to Build 2606, download and install the latest patch
update for Version 5.0 from our website. Then, try to compile the document again.
The update addresses the error.

� If you have an earlier version of the software, delete any �les associated with your
document that don't have a .tex �le extension, especially any marked as read-only,
in the document directory or the temporary directory of your program installation.
Then, try to compile the document again.

� ! Unde�ned control sequence.

� SWP/SW Version 3.5x, 4.x, and 5.x

This common LATEX error has many potential causes. It can occur when a pack-
age is missing from the document or when the document uses a command name that
hasn't been de�ned. It can also occur when the command name in a TEX �eld has been
mistyped. Also, if you've opened a document from an outside source, the document
may include a macro that is unde�ned on your system.

Solution
Follow the instructions on page 223 to use the .log �le to isolate and correct the prob-
lem.

� Underfull nhbox or nvbox.

� SWP/SW Version 3.5x, 4.x, and 5.x

When you read the compilation messages, you may see frequent references to over-
full or underfull boxes. The warnings indicate that LATEX cannot appropriately �t material
into the horizontal or vertical space available, thus creating typeset lines or pages that
are too long or too short. See page 199 for details.

Error Conditions

Although your document may compile without errors or warnings, problems can arise
when you preview or print the DVI or PDF �le. Examine your previewed document
before you print to ensure that all problems have been resolved.

� AI and EPS graphics typeset incorrectly.

� SWP/SW Version 3.5x, 4.x, and 5.x

Because SWP and SW aren't compatible with all Adobe Illustrator formats, AI and
EPS graphics that have been created with Adobe Illustrator don't always import properly
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into SWP or SW documents. The graphics don't typeset correctly and they appear with
a green background in the TrueTEX Previewer.

Solution
Open the AI or EPS graphics in Adobe Illustrator and save them using the format for
Version 6.0 or earlier, then reimport the graphics into your document.

� Characters appear incorrectlywhen previewingor printingwithPCTEX.

� SWP/SW Version 3.5x, 4.x, and 5.x

Computer Modern fonts are included both with SWP and SW and with PCTEX.
Although the two sets of fonts use the same font names, the fonts are different and use
different encoding. Because Windows doesn't allow two fonts of the same name to be
on the system at the same time, the two font sets can't be on the system simultaneously.
Incompatibilities result if one product tries to use the fonts intended for the other. If the
fonts for the alternate product are installed, your previewed or printed document will
have missing or incorrect characters.

Solution
If you expect to use PCTEX all the time, follow the instructions below to install the
PCTEX fonts into the Windows Fonts folder. If you plan to switch frequently between
programs, consider creating and saving font installation batch �les to handle the process.
Note that one side effect of making this change is that the kappa character no longer
displays in the previewer for SWP and SW, but it will be displayed in PCTEX.

I To install PCTEX fonts
1. Remove most of the Computer Modern fonts already installed:

a. From the Windows Control Panel, choose the Fonts applet.
b. Remove all fonts that begin with CM except the CMSY fonts. The table on page
207 lists the fonts to remove.

2. Still in the window for the Fonts applet, install the new fonts:

a. From the File menu, choose Install New Font to display a new window.
b. Display the fonts by browsing to the FONTSnAMSnTTF folder in the directory in
which PCTEX is installed.

c. Choose the Select All button and then choose OK to begin installing the fonts.
If you receive messages that the fonts are already there, choose OK to ignore the
message.

d. Choose the FONTSnTEXnTTF folder in the PCTEX directory to display a list of
fonts.

e. Choose the Select All button and then choose OK.
If you receive messages that the fonts are already there, choose OK to ignore the
messages.

f. Choose Close.
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CMB10.TTF CMFIB8.TTF CMR9.TTF CMSSQ8.TTF
CMBSY10.TTF CMINCH.TTF CMSL10.TTF CMSSQI8.TTF
CMBX10.TTF CMITT10.TTF CMSL12.TTF CMTCSC10.TTF
CMBX12.TTF CMMI10.ttf CMSL8.TTF CMTEX10.TTF
CMBX5.TTF CMMI12.ttf CMSL9.TTF CMTEX8.TTF
CMBX6.TTF CMMI5.ttf CMSLTT10.TTF CMTEX9.TTF
CMBX7.TTF CMMI6.ttf CMSS10.TTF CMTI10.TTF
CMBX8.TTF CMMI7.ttf CMSS12.TTF CMTI12.TTF
CMBX9.TTF CMMI8.ttf CMSS17.TTF CMTI7.TTF
CMBXSL10.TTF CMMI9.ttf CMSS8.TTF CMTI8.TTF
CMBXTI10.TTF CMMIB10.TTF CMSS9.TTF CMTI9.TTF
CMCSC10.TTF CMR10.TTF CMSSBX10.TTF CMTT10.TTF
CMCSC8.TTF CMR12.TTF CMSSDC10.TTF CMTT12.TTF
CMCSC9.TTF CMR17.TTF CMSSI10.TTF CMTT8.TTF
CMDUNH10.TTF CMR5.TTF CMSSI12.TTF CMTT9.TTF
CMEX10.TTF CMR6.TTF CMSSI17.TTF CMU10.TTF
CMFF10.TTF CMR7.TTF CMSSI8.TTF CMVTT10.TTF
CMFI10.TTF CMR8.TTF CMSSI9.TTF

� Cross-references do not preview correctly in master documents.

� SWP/SW Version 3.5x, 4.x, and 5.x

By default, LATEX makes only one pass when you preview master documents, so
cross-references and other generated document elements may not compile or preview
correctly. Unresolved cross-references appear as ?? in the typeset document.

Solution
When the compilation begins, use the LATEX dialog box to specify the number of passes
you want LATEX to perform. If your document contains cross-references, specify at least
two passes. If it has a table of contents, specify three passes.

� EPS graphics in DVI �les preview and print incorrectly.

� SWP/SW Version 3.5x and 4.x

Occasionally, the PostScript �lter supplied with SWP and SW misrenders EPS
graphics. The appearance of the graphic may be incorrect or letters that appear in the
graphic may be displaced. The problem arises because LATEX typesets using the default
DVI driver for the current LATEX installation. The default driver for SWP and SW
installations is tcidvi, which uses the supplied PostScript graphics �lter. In other
words, the graphics can be misrendered if the default driver is used.

Solution
If you're creating a DVI �le, you can bypass the problem by adding the graphicx pack-
age to your document (see page 131), choosing the dvips driver, and then saving your
document as a Portable LATEX �le, following the instructions below. If your document is
a Style Editor document or a LATEX 2.09 document, it can't be saved as a Portable LATEX



208 Chapter 4 Troubleshooting

�le. However, you can successfully bypass the EPS dif�culty if you import the contents
of your document into a new document and modify it according to the instructions.
The dvips driver is the default for most LATEX installations. Note that if you actively

choose the dvips driver option, LATEX previews using the native PostScript capabilities
for the current display device. Therefore, an EPS graphic in your document appears in
the TrueTEX Previewer as a box containing the path name of the graphics �le. When
you print, the graphic appears correctly using the PostScript interpreter in the printer.

I To use the graphicx package to avoid EPS graphics dif�culties
1. Add the graphicx package to your document.

2. Save the document as a Portable LATEX �le:

a. From the File menu, choose Save As.
b. In the Save as type box, select Portable LaTeX (*.tex).
c. Change the directory and �le name as necessary.
d. Choose Save.

3. On the Typeset toolbar, click the Options and Packages button or, from the
Typeset menu, choose Options and Packages.

4. Choose the Package Options tab.

5. In the Packages in Use box, select graphicx, and then chooseModify.

6. In the Options box, select dvips, and choose OK.

7. Choose OK to return to your document.

� Graphics are missing from preview and print.

� SWP/SW Version 4.x and 5.x
When you typeset preview or typeset print your document, graphics in the document

are missing. Either the names of the graphics or the names of the directories containing
the graphics contain a space. Because TEX assigns a special meaning to the space, the
document doesn't typeset properly. See also Invalid characters in the �le name or path
directories, page 197.

Solution
Remove any spaces in the graphics �le or directory names.

I To remove spaces in graphics path names
1. Remove any spaces in the graphics �le names or the names of the directories con-
taining the graphics.

2. Reimport the graphics into your document.

3. Typeset preview the document again.
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� Graphics do not appear in PDF �les.

� SWP/SW Version 5.x
When you create a typeset PDF �le from a master document and its subdocuments,

the graphics that are included in the master document appear correctly in the PDF �le,
but the graphics included in the subdocuments are missing. When you preview the
subdocuments, the graphics in the subdocuments appear correctly. This set of circum-
stances occurs when you've saved the master document, but not the subdocuments, in a
form that correctly formats graphics for PDF output.

Solution
Unlike other typesetting speci�cations, the graphics output settings aren't transferred
automatically to the subdocuments unless each subdocument has been opened and saved
after the master document has been saved.

I To specify the graphics output format for subdocuments
1. Open the master document.

2. From the Typeset menu, choose Output Choice.

3. Select PDF output or Both DVI and PDF output, and choose OK.

4. Save the master document

5. Open the subdocument and make a change to it, such as entering and then deleting a
space, and then save the subdocument.

6. Repeat steps 5�6 for each subdocument.

7. Create a new PDF �le for the master document.

� Graphics do not appear in PDF �les when documents use graphicx.

� SWP/SW Version 5.x
The graphicx package implements LATEX support for graphics �les (see page 131).

Because it depends on the availability of an output driver that can manage the �les, the
package has options for various drivers. If a driver hasn't been speci�ed, PDFLATEXselects
a default driver and automatically uses the correct graphics instructions for creating a
PDF �le. But if the dvips driver has been selected, PDFLATEXcan't use the correct
graphics instructions when it creates a PDF �le, and the graphics don't appear.

Solution

I To change the output driver
1. Open your document.

2. On the Typeset toolbar, click the Options and Packages button or, from the
Typeset menu, choose Options and Packages.
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3. Choose the Package Options tab.

4. In the Packages in Use section, select graphicx and chooseModify.

5. In theOptions box, click the currently selected driver to turn off the driver selection.

6. Choose OK to close the dialog boxes and return to your document.

7. Save the document.

8. From the Typeset menu, choose Compile PDF to create a new typeset PDF �le.

� Graphics in DVI �les preview correctly but print incorrectly.

� SWP/SW Version 3.5x and 4.x

If graphics appear correctly when you typeset preview your document but don't ap-
pear at all when you print, processing the graphics may require more memory than is
available to the graphics handler provided with SWP and SW. Another explanation is
that your computer may be using so much virtual memory that it cannot process the
graphics.

Solution
You may be able to make the graphics print correctly by increasing the memory available
to the graphics handler, managing your virtual memory, or managing the size of your
graphics �les.

I To increase the memory available to the graphics handler (SWP/SWVersion 3.5 only)
The amount of memory available to the graphics handler was increased with Version

3.51. If you have Build 1990 of Version 3.5, follow these instructions to increase the
available memory:
1. Using an ASCII editor, open the �le tcispech.ini in the program directory.

2. Near the beginning of the �le, �nd this line:

MaxGraphicsMemoryUsage=4000 kbytes

3. Replace 4000 with a larger value, such as 8000, 16000, or 32000.

4. Save and close the �le.

I To release some of the virtual memory in use
1. Make sure the DVI �le for your document is current, then exit SWP or SW.

2. Reboot your computer.

3. From the Windows Start menu, start the TrueTEX Previewer.

4. Open the DVI �le for your document.
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5. From the File menu, choose Print.

6. Close the TrueTEX Previewer.

I To reduce the size of the graphics �les
Smaller graphics �les require less memory. If you don't need sophisticated color

graphics, use your graphics program to save the images with fewer colors or as black
and white images.

� JPG graphics preview with a green background.

� SWP/SW Version 3.5x, 4.x, and 5.x

Because SWP and SW graphics import �lters aren't compatible with all Adobe
Illustrator formats, JPG graphics that have been created with Adobe Illustrator don't
always import properly into SWP or SW documents. The graphics don't typeset cor-
rectly and they appear with a green background in the TrueTEX Previewer.

Solution
Open and save the JPG graphics in a program other than Adobe Illustrator, then reimport
them into your document.

� Plots don't preview or print.

� SWP Version 3.5x, 4.x, and 5.x
If a plot doesn't appear when you typeset preview or print the document, but does

appear when you preview or print without typesetting, no snapshot has been generated
for the plot.

Solution
Make sure that automatic snapshot generation is turned on and actively generate a snap-
shot for the plot.

I To turn on automatic snapshot generation
1. From the Tools menu, choose Computation Setup.

2. Choose the Plot Behavior tab.

3. Check Generate Plot Snapshots Automatically and choose OK.

I To generate a snapshot
1. Select the plot, choose Properties, and choose the View tab.

2. Note the �le name of the snapshot.

If the dialog box indicates No snapshot �le, a snapshot of the plot hasn't been
generated.
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3. Click the Generate Snapshot button and choose OK.

4. Typeset the document again to make certain all plots appear.

� Poor quality of graphics and plots in PDF �les.

� SWP/SW Version 5.x

PDFLATEX supports only a few types of graphics formats: .png, .jpg, .tif, and
.pdf. When you create a PDF �le, any graphics or plots in other formats are converted
to .png, .jpg, or .pdf format for inclusion in the PDF �le. (The program doesn't export
.tif �les.) The settings you make in the PDF Graphics Export Options dialog box
determine which format is used. Generally, the .png and .jpg graphics created for PDF
�les are of good quality. However, .pdf graphics may be problematic.

Solution
Try the strategies below to improve the quality of graphics in your typeset PDF �les.
� Use the latest available version of SWP or SW.
The conversion program used to create .pdf graphics was updated with Build 2606

of Version 5.0 of the program. If you're using an earlier build of Version 5.0, download
a patch update for the later build from the MacKichan Software website. The update
solves most of the graphics conversion problems. If problems persist after you've in-
stalled the new build, try one of the other strategies below.
� Change the PDF graphics export format for raster graphics to a raster export format.

I To change the PDF graphics export format
1. From the Typeset menu, choose General Settings.

2. Choose PDF Graphics Settings.

3. For both graphics and plots, set the format you want.

The program is shipped with these defaults:

Graphic Type Default Export Format Recommended Export Format
vector graphic .pdf .pdf
raster graphic .pdf .png
the set of .jpg, .png, and
.tif �les

leave unchanged leave unchanged

plot .pdf .pdf

4. Choose OK to close the dialog boxes.

� Change the value in the registry subkey.
This strategy applies only to the conversion of graphics to .pdf format. The graph-

ics �lter behaves differently depending on the graphics conversion method used by
PDFLATEX to create .pdf graphics. PDFLATEX can either use a temporary �le for the
conversion or use the internal Windows graphics format directly. When PDFLATEX uses a



Error Conditions 213

temporary �le, the conversion process �rst creates a temporary .wmf �le of the graphic
and then creates a .pdf image from the temporary �le. Any text in the resulting graphic
is positioned correctly, but the graphic and the text may be grainy, more like a bitmap
image. This is the default setting for Build 2552 of Version 5.0 of SWP and SW. When
PDFLATEX uses the internal Windows graphics format, the resulting .pdf graphic has
better resolution, but any text inside the graphic may be positioned incorrectly in the
graphic or missing altogether. Images embedded in the graphic may be distorted. This
is the default setting for Builds 2557 and later of Version 5.0.
The conversion method, and thus the behavior of the graphics �lter, depends on a

setting in the UserGraphicsExport registry key. Inside each key is a subkey whose
value determines the conversion method. When the subkey value is set to 1, PDFLATEX
uses the temporary �le. When the subkey value is set to 0, PDFLATEX uses the internal
graphics format directly. You can change the value in the registry subkey using the
registry editor.

Note Directly changing the registry is recommended only for advanced users. Incor-
rect modi�cations of the registry can result in a system that will not start.

Remember that this change affects only those graphics exported as .pdf �les. It has
no effect on the exporting of .png or .jpg �les. Changing the registry setting can result
in improved graphics, but note that graphics conversions can be affected by other factors,
such as the particular graphics in your document and by the version of Windows you're
using. In particular, results may differ between Windows XP/2000/NT and Windows
Me/98. You may also notice problems with colors or incomplete conversion.

I To change the value in the registry subkey
1. Open the registry editor:

a. From the Windows Start menu, choose Run.
b. In the Run dialog box, enter regedit and choose OK.

2. Navigate to the registry key for PDF graphics conversions:
� In SWP the registry key is

HKEY_CURRENT_USERnSoftwarenMacKichan SoftwarenScientific
Workplacen5.00nUserGraphicsExport

� In SW the registry key is
HKEY_CURRENT_USERnSoftwarenMacKichan SoftwarenScientific
Wordn5.00nUserGraphicsExport

Note The version number in the key (5.00 in these examples) may be different
for your installation.

3. Double-click the GfxPDFExportFromFile entry.

4. Change the value for the entry:
� To convert graphics by creating temporary graphics �les, set GfxPDFExport-
FromFile to 1.

� To convert graphics by using the internal graphics format directly, set GfxPDF-
ExportFromFile to 0.
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5. Choose OK.

6. Open your document, modify it in some way, then save it.

If you don't modify and save the document after changing the registry setting, the
program won't create any new graphics when you create a new PDF �le. Instead, it
will use the existing graphics.

� PostScript fonts in DVI �les don't print correctly.

� SWP/SW Version 3.5x and 4.x
Although PostScript graphics import successfully into your SWP or SW document,

the fonts may not always print. The SWP and SW graphics �lters can handle a max-
imum of 32 fonts. If the .ini �le for the PostScript graphics �lter doesn't specify the
font you want, the font will not print.

Solution
Edit the .ini �le for the PostScript graphics �lter to add the font you need or to substi-
tute it for one of the 32 fonts already listed in the �le.

I To edit the .ini �le for the PostScript graphics �lter
1. Using an ASCII editor, open the �le impsi2.ini in your SWP or SW program
directory.

The Standard Options section of the �le is organized in two columns. The column on
the left lists the Windows font names, and the column on the right lists the PostScript
font names, like this:

Font[001]="Helvetica", "Swiss:Helvetica"
Font[002]="Helvetica-Bold", "Swiss:Helvetica Bold"
Font[003]="Helvetica-Oblique", "Swiss:Helvetica Oblique"
Font[004]="Helvetica-BoldOblique", "Swiss:Helvetica Bold

Oblique"
Font[005]="Times-Roman", "Roman:Times"
Font[006]="Times-Bold", "Roman:Times Bold"
Font[007]="Times-Italic", "Roman:Times Italic"
Font[008]="Times-BoldItalic", "Roman:Times Bold Italic"
...
Font[032]="TECHMath-Mix", "TECHMath"
2. Search the �le for the name of the font you need.

3. If the name isn't listed, add a new Font line or replace one of the existing Font
lines with the information about the font you want, using the syntax shown in the
example above.

If the font doesn't have a separate PostScript name, enter the Windows name in both
columns.

4. Save and close the .ini �le.
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� Preview and print appearance of $ ncheck{L} $ doesn't match screen
appearance.

� SWP/SW Version 3.5x

The TEX command $ ncheck{L} $ displays as L' on the screen, but it previews
and prints as �L. This happens because there are two possible representations for this
particular Unicode character. Microsoft has chosen to use the �rst version shown in
the preceding sentence in its screen fonts. When you typeset your document, LATEX
interprets the character using the other representation.

Solution
You can create a fragment that contains a TEX command containing several characters,
the accent and the character itself. Because there are several characters in the group, the
software displays both characters instead of using a single Unicode character. You can
use this method to obtain a character that has the same appearance both on the screen
and when you typeset.

I To create a fragment for the character
1. From the Insert menu in Version 3.5, choose Field and then choose TeX.

2. In the entry area, type $ ncheck{L{ } } $ and choose OK.

3. Save, close, and reopen your document.

The TEX �eld should now appear as �L.

4. Select the character.

5. On the Fragments toolbar, click the Save Fragments button or, from the File
menu, choose Save Fragment.

6. Type a name to be used to recall the fragment.

Avoid using the name of an existing TEX command.

7. Choose Save and check that the fragment appears on the fragment list.

� Previewed characters appear as blue dots on systems using localized
Windows.

� SWP/SW Version 3.5x, 4.x, and 5.x

When you preview a document that uses one of the Times New Roman fonts, or occa-
sionally some other fonts, characters appear as blue dots. The problem occurs because
some localized versions of Windows rename fonts as part of the localization process.
The registry may contain the original font name but the font itself may be renamed. For
example, in Spanish Windows, the registry refers to "Times New Roman Italic," but the
font itself is named "Times New Roman Cursiva." Similarly, "Times New Roman Bold"
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is named "Times New Roman Negrita." Because TrueTEX doesn't know the localized
names, it cannot �nd the fonts and displays blue dots instead of the correct characters.
This problem occurs in Spanish Windows and French Windows, and it may occur in
other non-US versions of Windows as well.

Solution
Create a new font substitution �le that contains the correct font names, and add it to
the list of �les used by the TrueTEX Previewer. Font substitution �les for these local-
ized versions of Windows are available on the MacKichan Software website: Danish,
German, Italian, French, Spanish, Norwegian, Swedish, Greek, and Russian.

Note The font substitution �les for Greek and Russian can be used only with the
TrueTEX Previewer included with Build 2570 and later of Version 5.

If you cannot download an appropriate font substitution �le, you must create one.
The instructions below illustrate the process. These instructions, which are speci�c to
Spanish Windows, illustrate how to rename the Times New Roman, Arial, and Courier
New fonts for Spanish Windows. Modify these instructions as necessary for other local-
ized versions of Windows.

I To create a font substitution �le
1. For each font that doesn't preview correctly, determine the font name used by the
localized version of Windows:

a. From the Windows Control Panel, choose the Fonts applet.
b. In the list of fonts, double-click the font to view the font sample.
For example, double-click Times New Roman Italic.

c. Note the font name shown at the top of the window.
This name must be used in the new font substitution �le.

d. Close the font sample.

2. Create a new font substitution �le listing the localized names.

a. Using an ASCII editor, create a new �le and type the lines that follow. Lines that
begin with a semicolon are comments and can be omitted.
; Additional font substitutions to take care of localized font names (embedded
in the font names)
[fonts]
; Note: the [fonts] section header is mandatory for TrueTeX to recognize
a set of font substitution rules.
;
Times New Roman=times
Times New Roman Negrita=timesbd
Times New Roman Cursiva=timesi
Times New Roman Negrita Cursiva=timesbi
Arial=arial
Arial Negrita=arialbd
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Arial Cursiva=ariali
Arial Negrita Cursiva=arialbi
Courier New=cour
Courier New Negrita=courbd
Courier New Cursiva=couri
Courier New Negrita Cursiva=courbi

b. Save the �le to the TCITeXnTrueTeX directory of your program installation
using an appropriate name, such as SpanishSUBS.ini.

3. Add the new �le to the existing list of font substitution �les:

a. From the SWP or SW program group, choose the TrueTEX Previewer to start the
previewer.

b. From the Options menu, choose Expert.
c. Choose Font Substitution File(s) to open a dialog listing the current font substi-
tution �les.
The list usually scrolls past the width of the dialog box.

d. Press the END key to move the insertion point to the end of the existing list.
The new font substitution �le must be added to the end of the existing font substi-
tutions.

e. Type a semicolon followed by the complete path name for the new font substitu-
tion �le. Assuming your program directory is c:nswp50, you can add Span-
ishSUBS.ini for this example by typing
c:nswp50nTCITeXnTrueTeXnSpanishSUBS.ini

f. Choose OK and then choose Yes to leave the previewer.

4. Preview the document again.

You should see the correct characters instead of blue dots.

� Previewed mathematics is garbled or appears as blue dots.

� SWP/SW Version 4.x and 5.x

When you typeset preview your document, mathematical symbols appear garbled
in the TrueTEX preview window. Text and mathematical characters may also display
as blue dots. This problem is caused by missing TrueTEX fonts. It occurs when an
earlier version of SWP or SW has been uninstalled following the installation of Version
4.x or 5.x of the program. Because Windows allows only one font of a given name
to be installed on the system at any time, it discards old fonts when new fonts of the
same name are installed. Thus, when Version 4.x or 5.x and its fonts are installed,
Windows discards any fonts from earlier versions whose names are duplicated. If the
earlier version of the program is subsequently uninstalled, the fonts that are discarded
are those from Version 4.x or 5.x. When you subsequently try to typeset your document,
the necessary fonts are missing and the characters appear incorrectly.
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Solution
Sometimes, just opening the Windows Fonts applet can restore the TrueTEX fonts. If
refreshing doesn't restore the fonts, you must repair or reinstall them.

I To refresh the TrueTEX fonts
1. Close SWP or SW.

2. From the Windows Control Panel, choose the Fonts applet.

3. When the list of fonts is displayed, check that the various fonts used by SWP or SW
are present.

Look for the fonts used by the TrueTEX Previewer; they start with cm, dc, eu, and
other lowercase strings. To see the complete list of fonts used by the TrueTEX Pre-
viewer, browse the TCITeX/TeX/fonts/truetype directory in your SWP or
SW program installation.

I To repair the TrueTEX fonts
1. From the Windows Start menu, choose Run.

2. Choose Browse and select the setup.exe �le that is on the program CD or that
you downloaded.

3. When the installation program prompts you, choose the Repair option and follow
the instructions on the screen to complete the process.

I To reinstall the TrueTEX fonts
1. From the Windows Control Panel, choose the Fonts applet.

2. Select the TrueTEX Previewer fonts and delete them.

The font names start with cm, dc, eu, and other lowercase strings. To see the
complete list of fonts used by the TrueTEX Previewer, browse the TCITeX/TeX/
fonts/truetype directory in your SWP or SW program installation.

3. From the File menu in the Fonts applet, choose Install new font.

4. In the Add fonts dialog box, navigate to the TCITeXnTeXnfontsntruetype
directory in your program installation.

5. Wait for the fonts in the directory to be listed, and then choose Select All and choose
OK.

6. When all the fonts have been added, exit the applet.
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� Theorem numbers don't reset correctly.

� SWP/SW Version 3.5x, 4.x, and 5.x
The theorem numbering scheme for your document calls for theorem numbers to

re�ect the chapter and section and to reset to 1 at the beginning of each section. You ex-
pect the numbers to follow a sequence such as Theorem 3.2.1, Theorem 3.2.2, Theorem
3.3.1. However, the sequence counter is not being reset and the typeset sequence that
occurs is Theorem 3.2.1, Theorem 3.2.2, Theorem 3.3.3.

Solution
In the preamble of your document, use a form of the nnewtheorem statement to re-
set the counter for theorem objects automatically at the beginning of a new chapter or
section.

I To number theorems with the section and theorem numbers (in articles) or the chap-
ter, section, and theorem numbers (in books ad reports)

� Replace the nnewtheorem statements in the preamble with statements like these:
nnewtheorem{theorem}{Theorem}[section]
nnewtheorem{acknowledgement}{Acknowledgement}[section]
nnewtheorem{algorithm}{Algorithm}[section]
nnewtheorem{axiom}{Axiom}[section]
:
nnewtheorem{solution}{Solution}[section]
nnewtheorem{summary}{Summary}[section]

In articles, the replacement yields numbering such as Theorem 2.1, Theorem 2.2,
Corollary 2.1, Theorem 3.1, Theorem 3.2..., in which the �rst digit is the section
number and the second digit is the number of the object inside the section. In
books and reports, the replacement yields numbering such as Theorem 1.2.1, Theo-
rem 1.2.2, Corollary 2.1.1, Theorem 2.1.2, Theorem 3.2.1....

I To number theorems in books or reports with the chapter and theorem number
� Replace the nnewtheorem statements in the preamble with statements like these:

nnewtheorem{theorem}{Theorem}[chapter]
nnewtheorem{acknowledgement}{Acknowledgement}[chapter]
nnewtheorem{algorithm}{Algorithm}[chapter]
nnewtheorem{axiom}{Axiom}[chapter]
:
nnewtheorem{solution}{Solution}[chapter]
nnewtheorem{summary}{Summary}[chapter]

The replacement yields numbering such as Theorem 1.1, Theorem 1.2, Theorem
2.1, Theorem 2.2..., in which the chapter number is followed by the theorem number
within the chapter.
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� TrueTEX Previewer window is minimized.

� SWP/SW Version 3.5x and 4.0

When the TrueTEX Previewer is started from SWP or SW, the main window appears
maximized. Clicking the Restore button minimizes the previewer's main window, hiding
all but the title bar.

Solution
If you're familiar with TEX and LATEX, you can change the command line options that
determine the size and location of the TrueTEX Previewer window when it is launched
from SWP or SW. Instructions appear in the TrueTEX readme �le that is installed
with the program.

Caution Don't attempt to modify the settings unless you know TEX and LATEX very
well.

I To view the readme �le
1. Open the document OptionsPackagesLaTeX.tex in the SWSamples direc-
tory of your program directory.

2. Move to the TrueTeX Documentation section and click the �rst link to open the
readme �le in the TrueTEX Previewer.

3. Move to the section entitled Initial Window Sizing to �nd a description of the com-
mand line parameter that controls the initial window size of the TrueTEX Previewer.

I To change the command line options
1. From the Typeset menu in SWP or SW, choose Expert Settings.

2. Choose the Preview Settings tab.

3. Choose Add/Modify and note the entries in the Command line to invoke preview
driver box. You may see an entry like this:

%x "%f" -i% %I -d 0 0 -1 -1

The portion of the line beginning with -d changes the window size.

4. Change the setting:
� To specify that the previewer open as a maximized window and to yield a maxi-
mized windowwhen Restore is clicked and prevent the problemwith a minimized
window thereafter, set the �nal portion of the line to -d 0 0 -1 -1.
Don't change any other settings on the line.

� To specify that the previewer open as a maximized window and to create a
640x480 window after clicking Restore, set the �nal portion of the line to
-d -1 -1 640 480.
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You can experiment to �nd a setting that works best for you. For example, if you
have a 1280 x 1024 high-resolution screen, use -d 0 0 850 -1 to open a window
that starts at the top left corner of your screen, with a width of 850 and a maximum
height.

5. Choose OK to close each dialog box and return to your document.

� Underscores in �le names.

� SWP/SW Version 3.5x, 4.x, and 5.x

Underscores in �le names and path names can cause problems with some versions
of TEX. If you try to typeset a document with an underscore in its name, the program
displays a message about invalid characters in the �le name or path name (see page 197).

Solution
Although we don't require the use of DOS 8.3 �le names, we encourage their use be-
cause they make your �les as portable as possible.

LATEX Errors

Errors can occur occasionally when you try to start the program or when you open,
save, or typeset documents in SWP or SW. Routine SWP and SW documents usually
compile without dif�culty. However, if your document contains TEX �elds or you're
working with documents from outside sources, you may see errors when you compile
your document with LATEX or PDFLATEX. In that case, you must �nd and correct the
problem. A thorough knowledge of TEX and LATEX is invaluable in this process.

Common LATEX Errors

The simplest LATEX errors to �nd and �x result from mistyping or omitting commands.
In particular, LATEX reacts negatively when it encounters these conditions:
� Misspelled commands or environment names, as in nbeginn{wraptable}.
� Improperly matched or missing braces or delimiters, as in nbegin{multicols]{3} or
nbegin{multicols} {3.

� Improperly using a character with a special meaning in TEX, such as #, %, &, or n.
� Missing nend commands.
� Missing command arguments.
� Incorrect de�nition statements.
� Statements that hide LATEX environment changes.
To minimize errors of this type, take the time to proofread when you type TEX com-
mands in TEX �elds, in the preamble of your document, or in dialog boxes that pass
your commands directly to LATEX.
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Further, LATEX may not compile your document if it contains certain constructions,
even though the constructions are legal in SWP and SW. As you work with your docu-
ments, you can avoid many errors by following these guidelines:
� Avoid placing a display in a chapter or section heading.
� Avoid including in your document a blank line containing only a SHIFT+ENTER.
� Avoid including a graphic in a chapter or section heading if the graphic has a caption.
� Avoid including a hyperlink to a website in a chapter or section heading.
� Avoid including spaces or single quotes in the names of graphics �les.
� Avoid putting a nnewline command on a line by itself. The command is created
by choosing Insert, then Spacing, Break, and Newline.

� Avoid placing a period in a �le name, other than the period immediately preceding
the �le extension.

Techniques for Solving LATEX Errors

Messages about errors that occur during a compilation are displayed in the LATEX or
PDFLATEX window as your document is being processed. The messages, which contain
information that can help you identify and correct the problem, look something like this:

The exclamation point signals the error and the information on that line describes the
nature of the problem. The line number (line 70 in the illustration above) indicates
approximately where in your document or in a related typesetting speci�cations �le the
error has occurred. Because lines in an SWP or SW document don't correspond to
lines in the .tex �le, you may need to use an ASCII editor to locate the error precisely.
Often, the message includes a portion of the document text, which may help you �nd
the error.
If all activity ceases, LATEX may be waiting for you to tell it what to do. You can

try to ignore the problem, solve it and keep going, or halt the typesetting process. For
example, the question mark in the last line of the message above indicates that LATEX has
a question. If you type ? and press ENTER, LATEX responds with this message:

Now you can choose a course of action.
In addition to being displayed in the LATEX or pdfLATEX window during compilation,
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LATEX error messages are stored in a �le that carries the name of your document and an
extension of .log. If you've saved your document before typesetting it, the program
saves the .log �le in the same directory as the document. Otherwise, the program saves
the .log �le using a temporary name in the temporary directory associated with your
program installation. After processing stops, open the .log �le to examine the messages
at a more leisurely pace and try to isolate the error.

Using the .log File
The .log �le records precisely what happens during the process of compiling your
document. Among other information, it includes
� Any warnings and messages related to processing problems, such as unresolved
cross-references, improperly matched delimiters, misspelled commands, missing
command arguments, or overfull and underfull boxes.

� The document class and any class option �les used by the document (see page 67).
� The names of any LATEX packages used by the document (see page 93).
� The names of any �les read and closed.
� The numbers of all pages processed, in square brackets.
� The size of the typeset �le.
Open the .log �le with an ASCII editor. Pay particular attention to any errors that have
occurred in the document preamble. In the .log �le, such errors are noted before the
indiction of the �rst page of text, shown as [1].

Isolating a TEX or LATEX Error
Many error messages point precisely to the cause of the error in your SWP or SW
document, but others are more obscure. If you can't locate and correct the error easily,
use the method below to try to isolate the error in your document.

I To isolate a TEX or LATEX error
1. Make a copy of the .tex �le.

2. Open the .tex �le with an ASCII editor and scroll to the area in which the error
occurred, as indicated by the page or line number in the .log �le.

3. Comment out the portion of the document that you think contains the error by placing
a percent sign at the beginning of each line. The formatter ignores these lines.

Note Be sure not to split a TEX environment when you comment out a portion
of your document. That is, if you comment out a nbegin statement, be sure to
comment out the corresponding nend statement as well.

4. Use the TrueTEX Formatter to compile the document:

a. From the SWP or SW submenu on theWindows Programs list, choose TrueTeX
Formatter.

b. Select the �le and choose OK.
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5. Repeat steps 3 and 4, commenting out larger and larger portions of the document,
until LATEX handles the document correctly.

The area that is commented out contains the error.

6. Beginning from the top of the commented portion of the �le, remove the percent
signs from several lines of the �le.

7. Recompile the document.

8. Repeat steps 6 and 7 until you isolate the lines that seem to cause of the failure.

9. Search for the mistake in that portion of the document.

Repairing Damaged Documents

If your document has been damaged or become corrupted in some way, you may be able
to repair it if you can isolate the problem. However, not all documents can be repaired
and read successfully. The program does not handle every possible construct that might
occur in a native LATEX document.
If your document was originally written in native LATEX and then imported to SWP

or SW, some problems may persist. In general, if a LATEX document contains a construct
that differs from Plain TEX (such as array versus matrix), you may be able to open
the document in SWP or SW if you modify it to use the LATEX construct. Alternatively,
you may be able to read the document using the Import Non-SWP/SW LATEX �lter
available in Version 5.5; see page 85.

I To repair a damaged document
1. Make a copy of the .tex �le.

2. Use the TrueTEX Formatter to compile the document.

3. Isolate and correct any LATEX errors, and then recompile the document.

4. When the document compiles successfully, try to open the document in SWP or
SW.

5. As the program loads the document, carefully watch the display of paragraph num-
bers on the Status bar.

6. If the document loads successfully, you've repaired the document successfully. If
not, note the paragraph number where the error occurred.

7. Open the document with an ASCII editor.

8. Isolate the error, as described in Resolving LATEX Errors on page 222.

Because errors that occur at this level are usually document-speci�c, they don't lend
themselves to the kinds of general suggestions we offer in this manual. However, you
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may be able to make the document work in SWP or SW by enclosing the lines that
cause the error in an encapsulated TEX �eld. If so, consider it only a temporary solution
and pursue a more robust solution to the problem.

Important Encapsulating erroneous code is a temporary solution.

I To encapsulate information in a TEX �eld
1. Open the document with an ASCII editor.

2. If much of the document is still commented out, remove the percent signs from all
but the few lines surrounding and containing the error.

3. Copy the commented lines to the clipboard.

4. Save and close the �le.

5. Open the document in SWP or SW.

6. Place the insertion point where the commented lines should appear.

7. Copy the lines to an encapsulated TEX �eld:

a. Enter an encapsulated TEX �eld.
b. Paste the lines from the clipboard.
c. Remove the percent sign at the beginning of each line.
d. Choose OK.

8. Typeset compile the document.

9. If the document compiles correctly, you've successfully repaired the document.

If the document still doesn't compile correctly, remove the TEX �eld from the docu-
ment.

Complex ndef and nrenewcommand statements in the document preamble can
prevent the program from loading the document. If your document preamble contains
such commands, you may be able to read the �le if you place the statements in an
external �le and then input the �le from the preamble.

I To place statements in an external �le
1. Open the document with an ASCII editor.

2. Select the statements you want to place in another �le, and cut them to the clipboard.

3. In place of the deleted lines, type ninput{�lename.tex} where �lename is the name
of the ASCII �le you will create in steps 4�6.

4. Open a new �le with an ASCII editor.
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5. Paste the statements from the clipboard into the �le.

6. Name the �le with a .tex extension and save it in an appropriate subdirectory of the
TCITeX/TeX directory of your program installation.

The �le must be in a TCITeX/TeX subdirectory or LATEX won't �nd it when you try
to compile the document.

7. Try to open and compile the original document in SWP or SW.



Index

accents, 94
accents package, 94
acknowledgments, 17
acronym package, 94
adding packages, 75
adding shells, 86
address for technical support,

xv
Adobe Acrobat, 189
afterpage package, 96
AI graphics, 205
algorithm package, 97
algorithmic package, 98
algorithms, entering, 97
alignment of table cells, 104
alltt package, 99
American Psychological As-

sociation (APA)
bibliography format, 102,
145

citation format, 102
newapa package, 145

AMS fonts
AMSFonts package, 100
Euler characters, 123

AMS packages
about, 100
AMSCD package, 100
AMSFonts package, 101
AMSMath package, 101
AMSSymb package, 101
troubleshooting, 187

answers package, 102
APA format, 102, 145
apacite package, 102
apalike package, 102
apalike-plus package, 102
appendices
for each chapter, 23, 103
for each section, 103
in table of contents, 21
modifying titles, 103
numbering scheme, 24

appendix package, 23, 103
array package, 104
arrays, see also tables

aligning cells, 109
aligning columns, 119
colored background, 116
delimiters around, 120
formatting, 104, 109
lines, 134

article.cls
option defaults, 68
page layout, 69

astron package, 105
author index, 24
author-date citations, 105
authordate packages, 105
authors, footnotes for, 17
.aux �les, 204
Avant Garde fonts, 154

babel package, 106
back matter
appendix, 23
bibliography, 22
description, 16, 66
index, 24

bar charts, 108
bar package, 108
bibliographies
APA format, 102, 145
Chicago Manual of Style
format, 113

customizing, 102, 113, 132,
144

default name, 30, 113
for each chapter, 111, 145
Harvard format, 132
improving spacing, 108
in table of contents, 20, 175
troubleshooting, 120, 162
uncited items, 120
unnumbered, 22

bibmods package, 108
BIBTEX bibliographies
APA format, 102, 145
author-date citations, 105
Chicago Manual of Style
format, 113

citation styles, 132
customizing, 102

for each chapter, 111
Harvard format, 132
natbib package, 144
troubleshooting, 190

blkarray package, 109
body of document, 26
body text, 5
book.cls
option defaults, 68
page layout, 71

Bookman fonts, 154
boxed text, 110
boxedminipage package, 110
boxes
color, 116
creating, 110, 124

brackets, 36, 44
breakcites package, 111

can't �nd �le, 186
cannot connect to license

server, 184
caption package, 48, 111
captions
customizing, 111
font attributes, 47
for multiple �gures, 48
formatting, 46
mathematics in, 46
placement, 149, 150, 163
rotating, 54, 111
short form, 21
spacing, 46

cells, formatting, 109
chapterbib package, 111
chapters
appendices, 23, 103
bibliographies for, 111, 145
headings, 129, 159, 174
table of contents for, 142

characters
AMS packages, 100
characters are invalid, 187
Euler fonts, 123
large, 124
list of symbols, 146
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mathematical symbols, 123,
137

Charter fonts, 154
chbibref package, 30, 113
Chicago Manual of Style, 113
chicago package, 113
choosing shells, 81
citations
APA format, 102
author-date, 105
breaking across lines, 111
citation labels, 120
customizing, 102, 105
for draft documents, 120
for unnumbered bibliogra-
phies, 22

formatting, 114, 132, 144
ordering, 114
removing brackets, 36
troubleshooting, 120, 162
uncited bibliography items,
120

cite package, 36, 114
class options
about, 67
modifying, 13, 15, 73

classes.pkg, 77
.clo �les, 65, 81
.cls �les
about, 65, 81
article.cls, 68
book.cls, 68
page layouts, 69
report.cls, 68

color
in boxes, 116
in documents, 116
in tables, 116

color package, 116
colortbl package, 116
columns
aligning decimals, 119
aligning text, 148
color, 116
creating, 12, 143
delimiters, 109
�oating objects, 127
footnotes in, 130
headers, 127

comma package, 118

command nproof already de-
�ned, 187

commands, TEX, 80
comments in documents, 179
commutative diagrams, 100
compiling documents, 184,

187, 189, 190, 192�
195, 197�201, 203�
205, 221

Comprehensive TEX Archive
Network (CTAN), 74,
86

conventions, xi
counters
for numbered lists, 34
for section numbers, 29
for table of contents, 18
resetting theorem counter,
40, 42

Courier fonts, 154
crop marks, 118
crop package, 118
cross-references
and hypertext links, 135
to external documents, 181
troubleshooting, 162, 203,
207

.cst �les
about, 65, 81
modifying, 89
troubleshooting, 186

customer support, xiv

damaged documents, 224
date of publication, 18
dcolumn package, 119
defaults
bibliography name, 30, 113
for document classes, 67
for packages, 79
shell, 82

delarray package, 120
delimiters in arrays, 109, 120
device independent (DVI)

�les, ix
diagrams
bar charts, 108
commutative diagrams, 100

discussion forum, xv
division headings

changing automatic num-
bering, 29

changing generated titles,
30

formattiing, 159
formatting, 27, 129, 174
in table of contents, 18, 20
location on page, 27
numbering scheme, 28, 29
short form, 9, 20
unnumbered, 20, 28

divisions
changing generated titles,
30

formatting, 27, 129, 174
numbering scheme, 28, 29
table of contents for, 142

document class options
about, 67
modifying, 13, 15, 73

document classes, 67
document formats, see �le for-

mats
document has not been loaded,

202
document language, 106
document repair, 224
document shells
about, 65, 81
adding, 86
available shells, 81
choosing, 82
creating, 84
default shell, 83
from outside sources, 86
layouts, 137
saving, 84
standard LATEX shells, 82
tailoring, 84

document structure, 66
documents, opening, 85
double columns
creating, 12
�oating objects, 127
footnotes in, 130
headers, 127
multiple columns, 143

double spacing
creating, 4
double-spaced documents,
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120
multiple line spacing, 161

doublespace package, 120
draft documents, 120, 162,

163
drftcite package, 120
dropped letters, 121
dropping package, 121
DVI drivers
and color, 116
and packages, 93
page orientation, 14
previewing, 93
rotation, 111, 124, 131,
139, 156

DVI �les
creating, ix
DVI �le has too few trailer
bytes, 188

DVI �le not created, 189
Dvigdi32.exe, 188

email addresses, typesetting,
177

email for technical support,
xiv

Encapsulated PostScript (EPS)
graphics, 52

encapsulated TEX �elds, 80
endnotes package, 39, 121
endnotes, creating from foot-

notes, 39, 121
enlarging a page, 3
enumerate package, 123
EPS graphics, 52, 205
errors, 195, 197
error conditions, 205�217,
219�221

error executing Adobe Ac-
robat, 189

error executing BIBTEX,
190

error executing MakeIndx,
190

error messages, 183�205
error parsing TEX expres-
sion, 189

error reading paragraph,
191

error running TEX, 189

error writing paragraph,
191

error writing to disk, 192
Euler fonts, 123
euler package, 123
exam questions
answers, 102
points for, 151

exceptional pages, 6
exercise solutions, 102
exporting shells, 84
exscale package, 124

failed to �nd master document,
192

failed to update registry, 194
fancybox package, 124
fancyhdr package
page layout, 6, 8, 125
page numbers, 11

fancyvrb package, 127
fax number for technical sup-

port, xv
Feynman slashed characters,

165
�gures, see graphics
�le formats, 85
�le is not valid, 203
�le names, 186, 187, 197, 221
�le not found, 194
�lters, 85, 203
�tting text on a page, 3
�x2col package, 127
�after package, 127
�oat package, 55, 127
�oating objects
captions, 46, 48, 111
�gures within �gures, 166
forcing output, 55, 96
in double columns, 127
managing, 55
numbering, 170
output sequence, 127
placing, 46, 127, 150
titles, 46
unprocessed �oats, 204
wrapping text around, 50,
149, 180

fncychap package, 129
fonts
AMS packages, 100

attributes for captions, 47
changing body text size, 5
Euler fonts, 123
font encoding, 136
font size, 5
in theorems, 43, 172
mathematics, 123
NFSS Mathtime fonts, 141
NFSS Times font, 154
PostScript fonts, 152, 214
sampling appearance, 129
scaling, 155, 158
sizes for captions, 47
troubleshooting, 200, 206,
214�217

verbatim, 178
fontsmpl package, 129
footers
eliminating space, 8
modifying, 5, 11, 125, 130
page numbers, 11
specifying information, 6
suppressing, 7

footmisc package, 130
footnotes, see also endnotes
acknowledgments, 17
changing to endnotes, 39,
121

for double-column text, 130
formatting, 130
in tables and arrays, 109
independently numbered,
140

symbols for, 38
unnumbered, 17

formatting
arrays, 104, 109
bibliographies, 102, 113,
132, 144

body text, 5
captions, 21, 46, 111, 156,
163, 166

cells, 109
citations, 102, 105, 114,
132

columns, 12, 143
counters, 123
division headings, 9, 20, 27,
29, 159, 174

document appearance, 65,
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81
document class options, 67,
73

double spacing, 4, 161
�oating objects, 55
fonts, 129, 155, 158
footers, 5, 125, 130
footnotes, 130
front matters, 10
graphics

captions, 46
layout, 46, 50, 53, 131
wrapping text around,
149, 180

headers, 5, 125, 130
indention, 31, 136
line spacing, 4, 120, 161
list of �gures, 175
list of tables, 175
lists, 34, 123, 148
margins, 2, 130
mathematical expressions,
44

page layout, 2, 67, 130, 137
page numbers, 9, 125
page orientation, 13, 125,
139, 152

paragraphs, 31, 136
section headings, 9, 20, 27,
29, 159

shell documents, 65, 81
table of contents, 19, 174,
175

tables
arrays, 104, 109
color, 116
columns, 119
layout, 46, 50, 52, 53,
171
lines, 134
long, 138, 170

theorems, 43, 172
typesetting speci�cations,
65, 81

front matter, see also table of
contents, list of �gures,
list of tables

description, 16, 66
page numbering scheme, 10
publication date, 18

title page, 16
ftnright package, 130

geometry package
changing margins, 2
header and footer space, 8,
130

page layout, 130
page orientation, 13, 130
paper size, 15, 130

going native, 76
graphics
and color, 116
bar charts, 108
captions, 21, 46, 48, 163
commutative diagrams, 100
EPS graphics, 52
�gures within �gures, 166
formatting, 46, 131
in PDF �les, 209, 212
mathematics in caption, 46
missing, 208, 209
numbering, 170
rotated, 131, 156
spacing, 46
troubleshooting, 198, 201,
205, 207�212

wrapping text around, 50,
149, 180

graphicx package, 131, 201,
209

harvard package, 132
headers
eliminating space, 8
in double columns, 127
modifying, 5, 125, 130
page numbers, 11
rules and lines, 8
short form of headings, 9
specifying information, 6
suppressing, 7

headings, see also division
headings

formatting, 27, 129, 159,
174

generated titles, 30
in table of contents, 20
location on page, 27
numbering scheme, 29
short form, 9, 20

unnumbered, 20, 28
help
additional information, xv
discussion forum, xv
online Help, xiii
resources, xiii
technical support, xiv
TEX resources, viii
troubleshooting, 183

helvet package, 153
Helvetica fonts, 153
hhline package, 134
highlighting, xii
hyperref package, 135
hypertext links, typesetting,

135, 177
hyphenat package, 135
hyphenation, 37, 106, 135

I can't write on �le, 195
illustrations, see graphics
importing LATEX documents,

85, 203
inaccessible spell check dirc-

tory, 195
indent�rst package, 136
indention
paragraphs, 136
removing from paragraphs,
31

tables, 104
index
author index, 24
in table of contents, 20, 175
makeidx package, 140
subject index, 24
troubleshooting, 162

inputenc package, 136
installing language dictionar-

ies, 195
international documents, 82
Internet address for technical

support, xv
interparagraph spacing, 33
invalid characters, 197, 221

JPG graphics, 211
justi�cation, 31, 155

keys, troubleshooting, 162
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Lambda system, 82
lambdabar symbol (�) , 156
landscape orientation
changing, 13, 139, 152
tables, 53

languages
multiple, 106
non-English, 106, 136

lastpage package, 136
LATEX
about, viii
adding counter separators,
118

and PDFTEX, ix
article class, 68
book class, 68
cautions, 1
comments in text, 179
converting, 85
customizing counter style,
123

document class options, 67
document classes, 67
document structure, 66
errors, 189
opening documents, 85
packages, 93
report class, 68
Standard LATEX shells, 82
troubleshooting, 221

LATEX packages, see packages
latexsym package, 137
layout package, 137
letters, dropped, 121
license veri�cation error, 197
licensing the program, xiii,

184, 197
line breaks, 44
line spacing
bibliographies, 108
changing, 4
citations, 111
doublespacing documents,
4, 120, 161

multiple line spacing, 4,
161

lineno package, 137
lines
around text, 110
in tables, 105, 134

over footers, 125
under headers, 8, 125

list of acronyms, 94
list of algorithms, 97
list of �gures, 16, 21, 142, 166,

174, 175
list of symbols, 146
list of tables, 16, 142, 166,

174, 175
lists
formatting, 123
interrupted, 35
numbered, 34
spacing between items, 148

.log �le, 195, 222, 223
longtable package, 138
lowercase text, 172
lscape package, 139
ltxtable package, 140

Macintosh, 188
MacKichan Software, contact-

ing, xv
makeidx package, 24, 140
MakeIndex, 190
manyfoot package, 140
margins, 2, 130
markers, troubleshooting, 163
master documents, 192, 207
mathematical expressions, 44
mathematical symbols, 100,

123, 137
mathematics
bold math not supported,
200

fonts, 100, 123
formatting, 39, 44, 200

mathpazo package, 153
mathptmx package, 153
mathtime package, 141, 200
measurement units, 3
minitoc package, 142
missing �les, 186, 192
missing $ inserted, 198
modifying packages, 79
multicol package, 13, 143
multicolumn environments,

13, 143
multiple line spacing, 4, 161

natbib package, 144

New Century Schoolbook
fonts, 154

new documents, 81
New Font Selection Scheme,

137, 152
newapa package, 145
newpnts package, 151
NFSS, 137, 152
nomencl package, 24, 146
nomenclature list, 146
non-English documents, 106,

136
non-SWP/SW LATEX docu-

ments, 85
nopageno package, 148
notation, xi
numbered lists
changing appearance, 34
interrupted, 35
numbering scheme, 34
resetting, 34
spacing, 148

numbering appendices, 24
numbering divisions, 28, 29
numinsec package, 148

online Help, xiii
opening documents
non-SWP/SW LATEX doc-
uments, 85

troubleshooting, 186, 189,
191, 202, 203

orientation of pages, 13, 130,
139, 152

output drivers
and color, 116
and packages, 93
page orientation, 14
previewing, 93
rotation, 111, 124, 131,
139, 156

overcite package, 148
overfull boxes, 199

packages
about, 74
adding and removing, 75
defaults, 79
going native, 76
in use, 74
installed with program, 93
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modifying options, 79
accents, 94
acronym, 94
afterpage, 96
algorithm, 97
algorithmic, 98
alltt, 99
AMS packages, 100
answers, 102
apacite, 102
apalike, 102
apalike-plus, 102
appendix, 103
array, 104
astron, 105
authordate1-4, 105
babel, 106
bar, 108
blkarray, 109
boxedminipage, 110
breakcites, 111
caption, 111
chapterbib, 111
chbibref, 113
chicago, 113
cite, 114
color, 116
colortbl, 116
comma, 118
crop, 118
dcolumn, 119
delarray, 120
doublespace, 120
drftcite, 120
dropping, 121
endnotes, 121
enumerate, 123
euler, 123
exscale, 124
fancybox, 124
fancyhdr, 125
fancyvrb, 127
�x2col, 127
�after, 127
�oat, 127
fncychap, 129
fontsmpl, 129
footmisc, 130
ftnright, 130
geometry, 130

graphicx, 131
harvard, 132
hhline, 134
hyperref, 135
hyphenat, 135
indent�rst, 136
inputenc, 136
latexsym, 137
layout, 137
lineno, 137
longtable, 138
lscape, 139
ltxtable, 140
makeidx, 140
manyfoot, 140
mathpazo, 153
mathptmx, 153
mathtime, 141
minitoc, 142
multicol, 143
natbib, 144
newapa, 145
newpnts, 151
nomencl, 146
nopageno, 148
numinsec, 148
overcite, 148
paralist, 148
parallel, 148
picins, 149
pifont, 154
placeins, 150
points, 151
portland, 152
PSNFSS packages, 152
ragged2e, 31, 155
relsize, 155
remreset, 156
revsymb, 156
rotating, 156
scalefnt, 158
sectsty, 159
setspace, 161
showidx, 162
showkeys, 162
showlabels, 163
sidecap, 163
slashed, 165
sub�g, 166
sub�gure, 169

sub�oat, 170
supertabular, 170
tabularx, 171
textcase, 172
theorem, 172
times, 154
titlesec, 174
titletoc, 174
tocbibind, 175
tocloft, 175
ulem, 176
url, 177
varioref, 177
verbatim, 178
version, 179
wrap�g, 180
xr, 181
xtab, 182

packgs.opt, 77
page breaks
in long tables, 138, 182
in table of contents, 19

page layout
article.cls, 69
book.cls, 71
columns, 12
customizing, 2, 130
headers and footers, 5, 8,
125

layout diagram, 137
line spacing, 4, 125
margins, 2, 125
modifying, 2, 125
orientation, 13, 125, 139,
152

page numbers, 9, 11, 125
paper size, 15
report.cls, 72
sebase.cls, 67

page numbers
changing, 9, 125
moving, 11, 125
number style, 10, 125
removing, 148
resetting, 10, 125
suppressing, 12, 125

page orientation
changing, 13, 14, 139, 152
specifying, 130

page references
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adding text, 177
page x of y, 136
troubleshooting, 162, 203,
207

paper size, 15
paragraphs
changing justi�cation, 31
dropped letters, 121
indention, 136
removing indention, 31
spacing between, 33

paralist package, 148
parallel package, 148
parts, see divisions
path names
characters allowed in, 187,
197, 221

troubleshooting, 187, 208
typesetting, 177

PCTEX, 206
PDF �les
and Adobe Acrobat, 189
and PDFTEX, ix
color, 116
colored tables, 116
creating, ix
cross-references, 135
graphics in, 209, 212
rotated boxes, 124
rotated captions, 111
rotated graphics, 131
rotated graphics and tables,
156

rotated pages, 139
PDFTEX, ix
picins package, 149
pictures, see graphics
pifont package, 154
placeins package, 150
plots, 211
points package, 151
Portable Document Format

(PDF) �les
and Adobe Acrobat, 189
and PDFTEX, ix
color, 116
colored tables, 116
creating, ix
cross-references, 135
graphics in, 209, 212

hypertext links, 135
rotated boxes, 124
rotated captions, 111
rotated graphics, 131
rotated graphics and tables,
156

rotated pages, 139
portland package, 14, 152
portrait orientation, 13, 152
PostScript fonts, 152, 214
PostScript New Font Selection

Scheme, 152
preamble
adding commands, 80
description, 66
errors in, 202

previewer settings, 15, 220
previewing
and output drivers, 93
and typesetting, ix
blue dots, 215, 217
troubleshooting, 189, 200,
205�217, 219�221

printer settings, 14, 16
printing
output drivers, 93
PDF �les, ix
troubleshooting, 189, 205,
207�215, 219, 221

with typesetting, ix
without typesetting, x

program interface, 77, 91
programming code, typeset-

ting, 178
PSNFSS, 152
publication date, 18

ragged2e package, 31, 155
references, see bibliographies
registering the program, xiii
registry information, 195
relsize package, 155
removing packages, 75
remreset package, 156
repairing damaged documents,

224
report.cls
option defaults, 68
page layout, 72

resolving errors, 221�223
revsymb package, 156

rotating package, 156
rotation
boxes, 124
captions, 111
graphics, 131, 156
pages, 139

rows, colored background, 116
rules
around text, 110
in tables, 105, 134
over footers, 125
under headers, 8, 125

sans serif fonts, 153
saving documents, 191
scalefnt package, 158
scaling fonts, 155, 158
sebase.cls, 67
section headings
changing automatic num-
bering, 29

changing generated titles,
30

formatting, 27, 159
in table of contents, 20
location on page, 27
numbering scheme, 29
short form, 9, 20
unnumbered, 20, 28

sections
appendices for, 103
table of contents for, 142

sectsty package, 27, 159
selecting, xii
separators
for LATEX counters, 118
for tables, 109

serious program error, 201
setspace package, 4, 161
shell documents
about, 65, 81
adding, 86
available shells, 81
choosing, 81
creating, 84, 91
default shell, 83
from outside sources, 86
layout, 137
standard LATEX shells, 82
tailoring, 84

showidx package, 162
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showkeys package, 162
showlabels package, 163
sidecap package, 163
single spacing, 4
slashed package, 165
spacing
changing line spacing, 4
doublespacing documents,
4, 120

in bibliographies, 108
in citations, 111
in headers and footers, 8
in lists, 148
multiple line spacing, 4,
161

single spacing, 4
spell check dictionaries, 195
standard LATEX shells, 82
starting the program, 184, 197
strikethroughs, 37, 176
.sty �les, x, 65, 81
subdocuments, 192, 209
subequation environment, 184
sub�g package, 166
sub�gure package, 169
sub�oat package, 170
subject index, 24
supertabular package, 170
supplemental technical docu-

ments, xiv
symbols
AMS packages, 100
for footnotes, 38
large, 124
list of symbols, 146
mathematical, 123, 137
TEX brackets, 44

system registry, 194

table of contents
creating page breaks in, 19
for divisions, 142
formatting, 174, 175
including a bibliography,
21, 175

including an appendix, 21
including an index, 21
including front and back
matter, 175

including unnumbered sec-
tions, 20

level of headings in, 18
short entries, 20
short form of headings, 9

tables, see also arrays
aligning columns, 119
breaking at page bound-
aries, 182

captions, 46, 163
colored background, 116
formatting, 52, 104, 109
formatting titles, 46
landscaped, 53
lines, 134
long tables, 138, 170
mathematics in title, 46
modifying layout, 46
numbering, 170
space between rows, 52
spacing of captions, 46
speci�ed width, 171
tables in tables, 166
wrap�g package, 50
wrapping text around, 180

tabularx package, 171
tailoring shells, 84
tcilatex, 66, 86
technical support, xiv
telephone for MacKichan

Software, xv
TEX
about, viii
encapsulated TEX �elds, 80
entering TEX �elds, 80
errors, 189
measurement units, 3
resources, viii
TEX capacity exceeded, 201
TEX commands, 80

text
�tting more on page, 3
parallel, 148
wrapping around �oating
objects, 50, 149, 180

textcase package, 172
theorem package, 43, 172
theorems
formatting, 43, 172
numbering schemes, 40
resetting counters, 42, 219
theorem environments, 40

Times fonts, 154
times package, 154
title pages, 16, 17
titles
for tables, 47
for appendices, 103

titlesec package, 174
titletoc package, 174
tocbibind package, 175
tocloft package, 175
toll-free technical support, xv
too many unprocessed �oats,

204
troubleshooting
bibliographies, 120, 162
citations, 120
common problems, 221
cross-references, 162, 203,
207

damaged documents, 191,
224

error conditions, 205�212,
214, 215, 217, 219�221

error messages, 183�205
fonts, 200, 206, 214�217
graphics, 198, 201, 204,
205, 207�212

index entries, 162
keys, 162
LATEX errors, 189, 221
markers, 163
online Help, xiii
page references, 162, 203,
207

resolving errors, 222
starting the program, 197
technical support, xiv
TEX errors, 189

TrueTEX, viii
typesetting speci�cations
about, 65, 81
adding, 86
directory assignment, 87
installing, 87
modifying, 56

ulem package, 37, 176
unable to write to .aux �le, 204
unde�ned control sequence,

205
unde�ned references, 203
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underfull boxes, 199, 205
underlines, 37, 176
underscores in �le names, 221
unnumbered bibliographies,

22
unnumbered sections, 20, 28
unprocessed �oats, 204
uppercase text, 172
url package, 177

URLs, typesetting, 177
Utopia fonts, 154

varioref package, 177
verbatim information, 99, 127,

178
verbatim package, 178
version package, 179
Virtual PC, 188

website for technical support,
xiv, xv, 183

wrap�g package, 50, 180

xr package, 181
xtab package, 182

Zapf Chancery fonts, 154
Zapf Dingbats font, 154
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